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Lesson 1 Modeling assemblies

Solid Edge Assembly
An assembly is a collection of parts and subassemblies that are positioned in a
meaningful way. The parts can be in their final orientation, or have freedom of
movement in translation and rotation. Solid Edge Assembly provides the tools
needed to lay out and position the parts relative to each other. Many methods
exist to accomplish this task and these approaches to building assemblies will be
covered in this text.

Objectives

This lesson introduces the Solid Edge Assembly interface and discusses the different
workflows for creating an assembly with the most commonly used part relationships.
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Placing parts in assemblies

You can place any of the following types of solid parts in Solid Edge assemblies using
the Parts Library tab:

• A part constructed in the Solid Edge Part environment.

• A part constructed in the Solid Edge Sheet Metal environment.

• Another assembly constructed in the Solid Edge Assembly environment.

• Any file that is open in Solid Edge other than a draft file.

To place parts that were constructed in other CAD formats, you must first convert
them to Solid Edge part files.

Note

When you add an Insight-managed document to an assembly, Solid Edge
uses the SearchScope.txt file to prevent you from creating links to documents
with duplicate IDs. The SearchScope.txt file must list at least one managed
workspace, or you will not be able to place managed parts in assemblies.

Sharing assemblies

You can place parts in assemblies by selecting them from a local folder path or from
a network share. If you use local folder paths, other Solid Edge users who access
the assembly over a network will not be able to view its parts and subassemblies. If
you intend to share an assembly over a network, you should always select the parts
through a network share, even if they are stored on your computer.

To do this, use the arrow on the right side of the Look In option on the Parts
Library tab to browse to and select the folder on a network drive where the part or
subassembly is stored.

The network share approach also allows you to build an assembly using parts that
are stored on several computers on your network. For example, your company
may have one or more computers that are used as servers, where commonly used
parts are stored.

mt01416-s-1040 Solid Edge assembly 1-3



Lesson 1 Modeling assemblies

Placing the first part in an assembly

To start the part placement process, in the Parts Library tab, select the part you
want, then drag it in the assembly window. You can also start the part placement
process by double-clicking the part in the Parts Library tab.

The first part you place into an assembly is important. It serves as the foundation
upon which the rest of the assembly will be built. Therefore, the first part should
represent a fundamental component of the assembly. Because the first part is placed
grounded, you should pick a part with a known location, such as a frame or base.

Although Solid Edge makes it easy to edit parts during the design cycle, the first
part you place in the assembly should be as completely modeled as possible. In the
same way, although it is easy to delete parts from assemblies and change assembly
relationships, the first part you place should remain grounded and not be deleted.

To reposition the first part, you should first delete the ground relationship. You can
then apply assembly relationships between the first part and the assembly reference
planes or subsequent parts you place in the assembly.
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Placing additional parts in an assembly

You can use the Assembly tab on the Options dialog box to specify whether
subsequent parts are temporarily placed in the assembly window (A), or displayed in
a separate Place Part window (B).

When you set the Do Not Create a New Window During Place Part option, the part is
temporarily placed in the assembly window at the location where you dragged and
dropped the part. To make the positioning process easier, drop the part in a location
where it is easy to select the positioning elements you want to use. If you start the
part placement process by double-clicking the part in the Parts Library tab, the
display area of the assembly window is adjusted so you can see the new part.

When you clear the Do Not Create a New Window During Place Part option, the part
is displayed in a separate Place Part window. If the active window is maximized,
the Place Part window is also maximized, essentially hiding the assembly window
from view. Due to this, beginning users should not maximize the active window.
Let the windows overlap, and this will make placing parts into the assembly and
applying relationships much easier.
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Positioning parts

You use assembly relationships to position the new part relative to a part already
in the assembly. The Relationships Types option on the Assemble command bar
contains a wide range of assembly relationships for positioning parts relative to
one another.

In addition to traditional assembly relationships, the FlashFit option reduces
the steps required to position a part using the mate, planar align, or axial align
relationships. This option is recommended in most situations. For example, you can
use FlashFit to mate a face on the placement part (A) with a face on the target
part (B).

After you apply the first assembly relationship, the new part is repositioned within
the assembly.
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As you apply the remaining assembly relationships, the software positions and
reorients the part in the assembly.

Additional parts can be positioned relative to any part in the assembly, or even
relative to more than one part in the assembly. You can also position a part relative
to an assembly sketch.

For more information on positioning parts using assembly relationships, see the
Assembly Relationships Help topic.

Note

By default, Solid Edge maintains the relationships with which you position
the part. If you clear the Maintain Relationships command on the Parts
Library shortcut menu, the relationships will be used only for positioning,
and the part will be grounded. Grounded parts do not update their positions
when you make design changes.
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Placing parts that are not fully positioned

It is a good idea to fully position parts as you place them into assemblies.
Fully-positioned parts will update their positions more predictably when changes
are made. At times, though, you may want to place a part without fully positioning
it. For example, you may be placing another part later that will be used to complete
the positioning of both parts.

You can use the Esc key to interrupt the placement sequence at any time. If no
relationships have been applied, the part is placed in the assembly at the same
relative position it occupies in the part document. In other words, the part is placed
in the assembly such that the base reference planes in the part document (A) are
coincident with the base reference planes in the assembly (B).

If you work with the Do Not Create a New Window During Place Part option set,
the part is placed in the assembly at the location you dragged and dropped it into
the assembly.

If you work with the Do Not Create a New Window During Place Part option cleared,
the part is placed in the assembly such that the base reference planes in the part
document (A) are coincident with the base reference planes in the assembly (B).

You can also interrupt the placement process by selecting another command, for
example, the Select tool.
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Placing the same part more than once

If you want to place the same part in an assembly more than once, you do not have to
use the Parts Library tab every time. After you place the part the first time, you can
select it, copy it to the Clipboard, and then paste it into the assembly.

When you select the Paste command, the part is displayed in a separate window,
as if you had selected it from the Parts Library tab. You can then apply assembly
relationships between the new part and the other parts in the assembly.

You can also use PathFinder to place an existing part into an assembly again. Select
the part in PathFinder, then drag and drop it into the assembly window.

If a part is being placed in the assembly several times using the same relationship
scheme, you can use the Capture Fit command to store the relationships and faces
used to position the part the first time. This reduces the number of steps required to
define each relationship when you place the part again. When you place the part
later, you do not need to define which relationship and face you want to use on the
placement part. You only need to select a face on the target part in the assembly for
each relationship.

Positioning a set of parts

You can use the Assemble command to position a set of parts relative to each other
without fully constraining each part in an ordered sequence. This type of workflow
can make it easier to position a set of interrelated parts, such as when building
a mechanism.

First, drag and drop the set of parts into the assembly. Then click the Assemble
command and apply relationships between one part and the other parts. To position
a different part, click the right mouse button.

Finding parts

If you do not know the name and location of a part or subassembly, you can
define search criteria using Search button on the Parts Library tab. You can then
double-click the name of the part or subassembly from the list of search results to
start the part placement process.
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Part placement properties

When you place a part or subassembly into an assembly, Solid Edge sets properties
that determine the following:

• The placement name of a part or subassembly.

• Whether the part is selectable or not selectable.

• The quantity of the part.

• The x, y, and z location for grounded parts or parts or not positioned using
assembly relationships.

• Whether the part is displayed in a higher level assembly.

• Whether the part is displayed in a drawing of the assembly.

• Whether the part is considered a reference part in a drawing or parts list.

• Whether the part is used in a report, such as a Bill of Material.

• Whether the part is used in mass property calculations of the assembly.

• Whether a part is used in an interference analysis calculation.

You can also change these properties later using the Occurrence Properties button on
the Place Part command bar or the Occurrence Properties command when selecting
assembly components.

Placing simplified parts

The Use Simplified Parts command on the Parts Library shortcut menu allows you
to specify whether you want to use the simplified or designed version of a part when
placing it in the assembly. When you have the Use Simplified Parts command set
(there is a check mark adjacent to the command), any faces that were deleted when
simplifying the part will not be available for positioning purposes. To make these
faces available, clear the Use Simplified Parts command.
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Placing subassemblies

You can place a Solid Edge assembly document into another assembly in much the
same way you place an individual part. When placing an assembly, in the Place Part
window, you must first select the placement part in the assembly you want to use for
positioning purposes, then the face on the part.

If you are placing a large subassembly, you can save a display configuration in
the subassembly first, then use this configuration to make placement easier. For
example, you can hide all the parts, except those that will be used to position the
subassembly. Before you place the subassembly, make sure the Use Configuration
command on the shortcut menu is set. Then, when you place the subassembly,
you can select the configuration name from the Configuration list on the Use
Configuration dialog box. Subassemblies also place faster if parts have been hidden.

When placing a subassembly using FlashFit or the Reduced Steps mode, the
placement part step is skipped. You specify the placement part by selecting a face on
the placement part you want.

The placement part must be active before you can select a face. If the placement
part is not already active, you can use the Activate Part button on the Place Part
command bar to activate the placement part.

Note

When placing parts into a subassembly, you can set an option that controls
whether the part is displayed in higher level assemblies. If the Display When
Assembly Is Attached As Subassembly option on the Properties dialog box
is cleared for a part, that part will not be displayed in PathFinder or the
graphics window in higher level assemblies.

Locating parts

The parts and subassemblies used to build an assembly can be located on different
computers on a network. To locate a part or subassembly, you can use the Assembly
Statistics command on the Inspect tab to display the document name and location.
When the Assembly Statistics dialog box is displayed, select any document in the
list, then right-click, and then set the Show Document Name and Location option.

Non-graphic parts

Sometimes you need to place parts in assemblies that have no model associated with
them, so they can be documented in a parts list or bill of materials. For example,
items such as paint, grease, oil, and so forth require no model, but a part must
exist in the assembly for them to show up in the documentation for the assembly.
Solid Edge allows you to create non-graphic parts by adding custom properties to
an empty part document. You can then place the part in the assembly without
positioning it with assembly relationships, by pressing the Shift key, then dragging
the part into the assembly.
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PathFinder in assemblies

The PathFinder tab helps you work with the components that make up your
assembly. It provides alternate ways to view the composition and arrangement of the
assembly, besides looking at the graphics in a regular assembly window. You can
also use PathFinder to in-place activate a part or subassembly so you can make edits
to individual assembly components while viewing the entire assembly.

The PathFinder tab is available when you work in an assembly or a subassembly
within the active assembly.

In the Assembly environment, you can also use PathFinder to view, modify and
delete the assembly relationships used to position the parts and subassemblies,
reorder parts in an assembly, and to help you diagnose problems in an assembly.

In the Assembly environment, PathFinder is divided into two panes. The top
pane lists the components of the active assembly in a folder tree structure. Listed
components can include: parts, subassemblies, assembly reference planes, and
assembly sketches.

The bottom pane shows the assembly relationships applied to the part or
subassembly selected in the top pane.
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Using the top pane

The top pane of PathFinder allows you to do the following:

• View components in collapsed or expanded form. For example, when you expand
a subassembly, you can view all of its parts.

• Highlight, select and clear components for subsequent tasks.

• Determine the current status of the components within the assembly.

• Determine how the assembly was constructed.

• Reorder parts within an assembly.

• Rename reference planes, sketches, and coordinate systems.

When you pass your cursor over a component in the top pane of PathFinder, it
is displayed in the graphics window using the Highlight color. When you click a
component it is displayed using the Select color. This allows you to associate the
component entry in PathFinder with the corresponding component in the graphics
window.

Note

When you pass your cursor over or click the top-level assembly in PathFinder,
it does not display in the highlight or select color. This improves performance
when working with large assemblies.

Because the highlight and selection of components in large assemblies can impact
performance, options are available on the Assembly tab on the Options dialog box
that allow you to improve the performance when working with large assemblies. For
example, options are available that allow you to simplify the display of highlighted
and selected components in the graphics window and to disable the highlight
of components in the graphics window when you pass your cursor over them in
PathFinder.

For more information on improving performance in large assemblies, see the
Working with large assemblies efficiently Help topic.
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Determining the status of a component

The symbols in PathFinder reflect the current status of the components in the
assembly. The following table explains the symbols used in the top pane in
PathFinder:

Legend
Active part

Inactive part

Hidden part

Unloaded part

Part that is not fully positioned

Part that has conflicting relationships

Linked part

Simplified part

Missing component

Alternate components part

Part position is driven by a 2D relationship in an assembly sketch

Displayed assembly

Adjustable Part

Adjustable Assembly

Driven Reference

Fastener System

Pattern group

Pattern item

Reference planes

Reference plane

Sketch

Noncombinable sketch (synchronous only)

Combinable sketch (synchronous only)

Active sketch (synchronous only)
Group of parts and subassemblies

Motor

Available
In Work
In Review
Released
Baselined
Obsolete
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Note

The symbols in PathFinder can also represent combinations of conditions. For
example, a symbol can show that a part is hidden and not fully positioned:

Determining how the assembly was constructed

The components in the top pane of PathFinder are listed in the order in which they
were placed in the assembly. This can be useful when evaluating design changes.
For example, if you delete a single assembly relationship from a part, the symbols for
other parts could also change to indicate that the parts are no longer fully positioned.
This occurs because the positioning of the other parts depended upon the part
from which you removed the relationship. In this example, reapplying the single
relationship should cause the other parts to also become fully positioned again.

Making changes to assembly components

You can use the top pane of PathFinder to open or in-place activate a part or
subassembly so you can make design modifications. For example, you can select a
part in PathFinder, then use the Edit command on the shortcut menu to in-place
activate a part. You can then add, remove, or modify features on the part while
viewing the other assembly components. You can also use geometry on the other
assembly components to help you construct or modify features on the part. When
you use the Open command to open an assembly component, you cannot view the
other assembly components.

When you in-place activate a subassembly, the display of PathFinder changes to
make it easier to determine your current position within the assembly structure.
For example, while in the top-level assembly A1.asm, if you in-place activate into
subassembly S1.asm:1, subassembly S1.asm:1 is displayed using bold text and a
contrasting background color is used for the subassembly and its components.

When you in-place activate a part for editing, you do not need to return to the
assembly first to in-place activate another part or subassembly in the assembly.

You can select another part or subassembly in PathFinder and use the Edit command
on the shortcut menu to in-place activate the component for editing. When you are
finished making the design changes, you can use the Close and Return command on
the Home tab to return to the original assembly.
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When you in-place activate a part or subassembly for editing, you cannot collapse
the assembly structure to which the part or subassembly belongs within PathFinder.
For example, in the following illustration, part P2.par:1 has been in-place activated
and it is in subassembly S1.asm. If you click the minus (-) symbol adjacent to S1.asm
to collapse its structure, it will remain expanded.

Changing the display status of assembly components

You can use the top pane of PathFinder to control the display status of assembly
components. For example, you can hide parts and subassemblies to make it easier
to position a new part you are placing in an assembly. You can use the checkboxes
adjacent to the assembly components in PathFinder to control component display or
shortcut menu commands when one or more components are selected.

The color of the text in PathFinder also indicates whether a component is displayed
or hidden.

Reordering parts within an assembly

PathFinder allows you to drag a part to a different position within an assembly. As
you drag the part, PathFinder displays a symbol to show where you can reposition
the part in the assembly structure. The part will be positioned below the highlighted
part occurrence in PathFinder.
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Grouping parts and subassemblies within an assembly

PathFinder allows you to select a set of parts or subassemblies in the active
assembly, then specify that the selected components are a group using the Group
command on the shortcut menu. The set of components is then collected into a group
entry in PathFinder. You can then expand, collapse, or rename the group to a more
logical name. Defining a group of parts reduces the space requirements for a set of
parts, and allows you to gather together a set of similar parts into a logical group.
This can make it easier to select the parts for other operations, such as displaying
and hiding a set of parts.

You cannot select nested parts or nested subassemblies.

Grouping components is also useful when working with large assemblies that
contain few or no subassemblies. You can select a set of parts, define them as a group
with the Group command on the Pathfinder shortcut menu, then use the Rename
command to rename the group to a more logical name.

Note

Some assembly commands create a group of components automatically. For
example, the Move Components command creates a group entry in PathFinder
when you set the Copy option on the command bar.

You can ungroup a group using the Ungroup command on the shortcut menu when a
group is selected in PathFinder.

The Select Components command , on the shortcut menu when you select a group
entry in PathFinder, activates additional commands and options for manipulating
groups that would otherwise be disabled. For example, after selecting a group with
the Select Components command, you can then apply a face style to the group of
parts, or transfer the group of parts to another assembly.

Renaming PathFinder entries

You can use PathFinder to rename an entry for an assembly reference plane, sketch,
group, or coordinate system. To rename an entry, select it in PathFinder, right-click
and then click Rename. In the name box, type the new name for the entry.
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Finding parts

In a complex or unfamiliar assembly, it can sometimes be difficult to determine
which subassembly a particular part is contained in. You can use the Scroll To
Part command to quickly find a part in PathFinder. When you select a part in the
assembly window, then click the Scroll To Part command on the shortcut menu, the
display of PathFinder scrolls to the selected part. If the part is in a subassembly, the
listing for the subassembly is expanded to display the part.

Replacing the file name with the document name formula value

You can use the Document Name Formula dialog box to replace the file name
displayed in PathFinder with a value composed of document properties. Refer to the
Replace a file name with a property value help topic for instructions.

You can combine properties with additional characters to replace the file name.
For example, you can separate two properties with dashes, such as Document
Number–Revision Number.

If a property does not exist or does not have a value, the property name is displayed
in place of the property value, and the file name is displayed in parentheses after
the value.

Note

The Property list displays the properties that you can use to replace the file
name. You can add a property that is not in the active document by typing
[property name] in the Formula field.

Using the bottom pane

When you select a part or subassembly in the top pane of PathFinder, you can use
the bottom pane to view and modify the assembly relationships between the selected
part and the other parts in the assembly. The document name is also displayed,
as well as a symbol that represents the type of relationship. The following table
explains the symbols used in the bottom pane in PathFinder:

Legend
Ground relationship

Mate relationship

Planar align relationship

Axial align relationship

Connect relationship

Angle relationship

Tangent relationship

Gear relationship

Suppressed relationship
Failed relationship
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When you select a relationship in the bottom pane you can do the following:

• View which elements were used to apply the relationship.

• Edit the fixed offset value of the relationship.

• Change the offset type of the relationship.

• Delete the relationship.

• Suppress the relationship

Viewing assembly relationships

When you select a relationship in the bottom pane, the elements used to apply the
relationship are highlighted in the assembly window. For example, if you select
a planar align relationship, the planar faces or reference planes that were used
to apply the relationship highlight in the assembly window. This can help you
determine how design changes need to be applied.

Modifying assembly relationships

When you select a relationship in the bottom pane, you can use the relationship
command bar to edit the fixed offset value or change the offset type. For example,
you may want to change a mate relationship from a fixed offset to a floating offset.

Note

If you change the offset type from fixed to floating, you may have to make
other relationship edits to ensure that the part remains fully positioned.

Deleting assembly relationships

If you delete an assembly relationship, the symbol next to the part in the top pane
changes to show that the part is no longer fully positioned. The part is also placed on
the Error Assistant dialog box list. It is good practice to apply a new relationship to
the affected parts as soon as possible. If you delete too many relationships without
applying new ones, it could become difficult to fully position the affected parts. If
this occurs, you may have to delete the affected parts from the assembly and place
them again.

Replacing relationships

After you place a part in an assembly, you can replace any of its relationships. Select
the part in PathFinder or in the graphics window, then click the Edit Definition
button on the command bar. You can then select the relationship you want to replace
from the Relationship List box on the command bar. Use the Relationship Types
button to specify the new relationship you want to apply.

Note

You can also delete the current relationship in the bottom pane of PathFinder
and apply a new one using the Assemble command bar.
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Conflicting relationships

If you change the design of parts in an assembly, some assembly relationships may no
longer be applicable. When this occurs, the symbol next to the part or subassembly
in the top pane of PathFinder will change to indicate that there are conflicting
relationships and the part will be placed on the Error Assistant dialog box list.

When you select the conflicted part or subassembly, the symbols for the affected
relationships in the bottom pane of PathFinder are displayed in red. You can then
evaluate the relationship scheme to determine how to repair the assembly. For
example, you can delete the affected relationships and apply new relationships to
fully position the part.

Suppressing assembly relationships

You can use the Suppress command on the shortcut menu to temporarily suppress
an assembly relationship for a part. Suppressing an assembly relationship allows
you to use the Drag Part command to evaluate how the part interacts with other
parts in the assembly. When you suppress an assembly relationship, the symbol for
the part in the top pane of PathFinder changes to indicate that the part is no longer
fully positioned. Also, a symbol is added adjacent to the suppressed relationship in
the bottom pane to indicate that the relationship is suppressed.

Note

You can use the Unsuppress command on the shortcut menu to unsuppress
the relationship

Displaying document status in PathFinder

You can display the document status for components in PathFinder. For example,
in an Insight-managed document, the status can be Available, In Work, In Review,
Released, Baseline or Obsolete. The Status®Display Status command on the
PathFinder shortcut menu turns on and off the display of symbols adjacent to the
document names in PathFinder. For more information, see the Displaying and
updating status for documents in assemblies Help topic.
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Legend
Available

In Work

In Review

Released

Baselined

Obsolete

Dashed line in the bottom pane

Often a dashed line is displayed between sets of relationships in the bottom pane of
PathFinder. The relationships above the dashed line were applied to parts that are
above the selected part in the top pane of PathFinder. The relationships below the
dashed line were applied to parts that are below the selected part in the top pane
of PathFinder. You can edit the relationships above the dashed line and below the
dashed line. For example, when you select Valve01.asm, the relationships above the
dashed line were applied to Body01.par, which is above Valve01.asm in the top pane
of PathFinder. The relationships below the dashed line were applied to Handle01.par
and NutM15.par , which are below Valve01.asm in the top pane of PathFinder.
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Managing relationships in nested assemblies

PathFinder does not display relationships applied outside the active assembly.
Before you can view, modify, or delete an assembly relationship from a nested
subassembly, you must first open or in-place activate the subassembly where the
relationship was applied.

You can use the top pane of PathFinder to determine at which level in a multi-level
assembly a particular part was placed. You can then select the subassembly in the
top pane of PathFinder and use the Open or Edit commands on the shortcut menu to
open or in-place activate the subassembly to modify or replace the relationship.

For example, assembly A1 in the next illustration was built using part P1 and
subassemblies S1 and S2. Subassembly S1 was built using parts P2, P3, P4 and
P5. Subassembly S2 was built using parts P6 and P7. If you want to change
a relationship used to position part P5, you have to open or in-place activate
subassembly S1.

You can find part P5 by viewing the assembly in the top pane of PathFinder, as
shown in the next illustration. Since part P5 is indented under subassembly S1, you
would have to open or in-place activate subassembly S1 in order to view, modify, or
remove any relationships that control part P5.
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Assembly relationships

When placing a part or subassembly into an assembly, you must define how the
part will be positioned with respect to the other parts in the assembly by applying
assembly relationships. Available relationships include ground, mate, planar align,
axial align, parallel, connect, angle, cam, gear, tangent, and center-plane.

In addition to the traditional assembly relationships listed above, the FlashFit
option reduces the steps required to position a part using the mate, planar align, or
axial align relationships.

The relationship options and FlashFit are located on the Relationship Types list
on the Assemble command bar.

Part positioning workflows

Solid Edge provides several workflows for positioning parts in an assembly:

• FlashFit

• Traditional Workflow

• Reduced Steps

• Capture Fit

Note

New users should focus on learning both FlashFit and the Traditional
Workflow. As your expertise in building assemblies increases, you can explore
the other workflows available. All the workflows are discussed in more depth
later in this topic. The Slider tutorial demonstrates FlashFit capabilities.
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Maintaining assembly relationships

By default, Solid Edge maintains the relationships with which you position the part.
If the Maintain Relationships command is set on the Parts Library shortcut menu
when you place a part, the relationships that you apply also control the behavior of
the part when it is modified. For example:

• If you apply a planar align relationship between two parts, they remain aligned
when either part is modified.

• If you apply an axial align relationship between two parts, they remain axially
aligned when either part is modified.

Note

You can view, modify, and delete assembly relationships using the Assembly
PathFinder tab.

If the Maintain Relationships command is cleared when you place a part, you must
still use assembly relationships to position the part in the assembly. However,
instead of applying these relationships on the part, the software applies a ground
relationship. Grounded parts do not update their positions in the assembly when
other parts are modified.
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Capturing design intent

To fully control one part in relation to the other parts in an assembly, you must
use a combination of assembly relationships. There is often more than one way to
apply relationships that will position a part correctly. It is important to choose the
way that best captures design intent, because this makes your assembly easier
to understand and edit.

It may be helpful to keep in mind how the part will react to future modifications
when positioning a part. Although the part may be positioned correctly using a
particular set of assembly relationships, it may not behave as you expect when
modifications are made.

As you gain experience placing parts in an assembly, you may find it useful to make
minor design modifications and observe how the parts in your assembly react. If
the assembly does not behave as you expect, you can delete the relationships and
reapply them using a different approach. As you become more experienced, it will
become easier to see which set of relationships correctly positions the parts, and
gives you the behavior you want when design modifications are made.

Assembly relationships and part movement

When a part is fully positioned in an assembly, it cannot move in any direction in
relation to the assembly. The first assembly relationship you place controls some
part movement, but the part is still free to move in some direction by sliding along
or rotating around the X, Y, or Z axes.

Applying more relationships controls more movement until the part is fully
positioned. The types of relationships you apply and the options you use determine
how the relationships control part movement.

FlashFit

As discussed earlier, the FlashFit option reduces the steps required to position
parts using mate, planar align, and axial align relationships when compared to the
traditional workflow. Because many parts are positioned using these relationships,
FlashFit is appropriate in most situations.

When you position a part using FlashFit, you first select a face or edge on the
placement part. You then select a face or edge you want on the target part and let
the inference logic built into Solid Edge determine the most likely relationship,
based on the target part element.

For example, if you choose a planar face on the placement and target parts, the
software assumes that you want to establish a mate or planar align relationship.
When you select the target part element, the placement part is positioned in the
assembly using the closest solution.
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• If the two faces you select are closer to a mate solution, a mate relationship is
applied.

• If the two faces you select are closer to a planar align solution, a planar align
relationship is applied.
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A Flip button on the command bar allows you to select the alternate solution. You
can also use the Tab key to select an alternate solution.

When using FlashFit to position a part, it is displayed translucent to make it easier
to differentiate from the other parts in the assembly.

When possible, FlashFit moves the first part you select when applying the
relationship, and the second part remains stationary. If the first part you select is
fully constrained, the second part will move.

You can then use FlashFit to define the additional relationships required to fully
position the part in the assembly, or select another relationship type.

Note

When placing a subassembly using FlashFit or the Reduced Steps mode, the
parts in the subassembly must be active before you can select a face. If the
subassembly is not already active, you can use the Activate Part button on the
Assemble command bar to activate the placement part in the subassembly
which contains the face you want to select.

FlashFit also allows more flexibility to use edges, in addition to faces, when
positioning a part using mate, axial align, and planar align relationships.

This can be especially useful when positioning a fastener, such as a bolt into hole.
For example, when positioning a part using an axial align relationship, you cannot
use a circular edge to position a part. With FlashFit, you can use a circular edge on
both the placement part and target part to completely position the part in two steps.

FlashFit options

The Options dialog box on the command bar allows you to set the FlashFit options
you want to use. For example, you can specify the element types you want FlashFit
to recognize when placing a part. This allows you to tailor the behavior of FlashFit
for the part you are currently placing.

Moving and rotating parts with FlashFit

When using FlashFit, you can also move or rotate the placement part into a more
convenient location. To move the part, position the cursor over the part and drag
the cursor.

To rotate the part, press the Ctrl key while dragging the cursor. If any relationships
have been applied to the placement part, the movement or rotation is limited to the
available degrees of freedom.
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Traditional part positioning workflow

The traditional workflow walks you through every step required to position a
part using assembly relationships. For new users, this allows you to gain a full
understanding of the part positioning process. A command bar, which is unique to
each relationship, guides you through the positioning process.

The traditional workflow is also preferred when positioning parts using relationships
that FlashFit does not recognize, such as angle, cam, parallel, and tangent
relationships.

Reduced steps

The Reduced Steps option eliminates the part selection and accept steps in the
traditional workflow. You can set this option using the Options dialog box on
the Assemble command bar. When the Reduced Steps option is set, you specify
the placement part and target part by selecting a face on each part. This reduces
the number of steps from five to three for a typical mate relationship. There is
some trade-off when using this option. Since the part in the assembly is no longer
selected as a separate step, surfaces or cylinders on every active part are available
for selection.

In large assemblies or in assemblies with numerous overlapping parts, positioning
one part precisely to another can prove time consuming. In such cases, use QuickPick
to filter the selection process.

Note

When this option is set, you must specify the offset type and offset value before
selecting the target face. If you want to use a reference plane on the target part
to position the placement part, you must display the reference planes first.

Capture fit

The Capture Fit command captures the assembly relationships and faces used to
position a part or subassembly in the active assembly. When you place the part or
subassembly again, you simply select the faces on a new target part already in the
assembly to position the new part or subassembly. This reduces the number of steps
required to position the part.

If you used the Insert option to position a part, the Capture Fit command will
capture a mate and an axial align relationship, since these are the relationships
that the Insert option actually places.

You can also capture relationships by setting the Automatically Capture Fit When
Placing Parts option on the Options dialog box on the Assemble command bar.

Note

The Capture Fit command cannot capture Angular relationships.

1-28 Solid Edge assembly mt01416-s-1040



Modeling assemblies

Defining offset values

Some relationships let you define fixed or floating offsets between the parts, such
as the mate and align relationships. To specify an offset type, click one of the two
offset buttons on the command bar. When you specify a fixed offset, you can type
a dimensional value for the offset distance. For example, when you define a fixed
offset for a planar align relationship, you can edit the value so that the parts are no
longer co-planar.

A floating offset is useful when you need to control the orientation of a part with
respect to another part, but it is impossible to define a fixed dimensional value.
For example, you can use a floating offset to control the rotational orientation of a
part. When you apply an axial align relationship using the Unlock Rotation option
between a cylindrical shaft and the cylindrical face on another part (A), you can then
use a planar align relationship, with a floating offset (B), to control the rotational
orientation of the shaft.

If you try to apply a fixed offset for the planar align relationship, a message is
displayed, saying that the fixed option conflicts with another relationship.

Note

The range offset command is not intended to be used to for geometric
tolerances. Depending on the relationships used to position the part are
defined, this may result in an over constrained condition and cause errors.
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Locking and unlocking rotation on axial align relationships

When you apply an axial align relationship, you can use the Lock Rotation and
Unlock Rotation buttons on the command bar to specify whether the part is free to
rotate around the axis of rotation. The Lock Rotation option is useful when the
rotational orientation of the part is not important, such as placing a bolt into a hole.
When you set the Lock Rotation option, the rotational orientation of the part is locked
at a random position, but one less relationship is required to fully position the part.

When you set the Unlock Rotation option, you can define the rotational orientation
you want by applying another relationship. For example, you can apply an angle
relationship.

Assembly relationship dimensions

When positioning parts using assembly relationships, driving or driven dimensions
are created and displayed when appropriate. For example, when you position a part
using a mate relationship with a fixed offset, a driving dimension is created.
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When you position a part using a mate relationship with a floating offset (the offset
value is controlled by another relationship), a driven dimension is created, which
cannot be edited to reposition the part. Zero and negative value dimensions are
supported.

When you apply or edit an assembly relationship, you can select and edit the driving
dimension to change the offset value. You can use the Show All Dimensions option
on the Options dialog box on the command bar to control whether the dimensions
are displayed or hidden. When you set this option, dimensions display when you
select a part and then click the Edit Definition button on the command bar. You can
then select a dimension and edit its value using the command bar. When you clear
this option, no dimensions are displayed, except for when you select a relationship
in the bottom pane of PathFinder. When you select a relationship in the bottom
pane of PathFinder, the dimension is displayed and selected, which allows you to
edit its value using the command bar.

Dimensions are only created when appropriate for the relationship options you are
using. Dimensions are created when using the mate, planar align, connect, angle,
tangent, and parallel relationships. Dimensions are not created when using axial
align, ground, or cam relationships.

Assembly Relationship Assistant command

When working with assemblies whose parts are oriented correctly, but do not have
assembly relationships, such as assemblies that were imported into Solid Edge from
another CAD system, you can use the Assembly Relationship Assistant command
to apply relationships between the parts and subassemblies. The relationships are
applied based on their current geometric orientation. For more information, see the
Assembly Relationship Assistant command Help topic.

mt01416-s-1040 Solid Edge assembly 1-31



Lesson 1 Modeling assemblies

Applying a connect relationship

When two parts in an assembly cannot be positioned properly by mate and align
relationships, you can position them using connect relationships. A connect
relationship positions a keypoint on one part with a keypoint, line, or face on another
part. For example, you can apply a connect relationship to position the center of a
spherical face on one part with respect to a spherical face on another part.

You can use the following methods to apply connect relationships:

• Point-to-Point: In the following figure, a mate relationship is applied between
the mitered corners of the parts. A connect relationship, which ties a point on
one part to the appropriate point on another, connects the two corners properly.
A floating align relationship between the back surfaces fully positions the part.
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• Point-to-Line: In the following example, a mate relationship is applied between
the faces of the two parts. Because the sides of each part are drafted, there are
no part faces which you can use to apply a planar align relationship. You can
apply three connect relationships between the keypoints on the top part and
the linear edges on the bottom part.

• Point-to-Plane: In the following example, the lower right pin is positioned to a
depth that just touches the surface of a reference plane.
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• Cone-to-Cone: In the following example, the cone on the fastener is connected
to the cone on the countersunk hole on the plate. When you add a connect
relationship between two conical faces, the keypoint that represents the
theoretical intersection of the individual cones are connected. You can also apply
an offset value to a connect relationship between two conical faces.

Recognizable elements for the connect relationship

Keypoints

• End points of lines, arcs, and ellipses

• Midpoint of a line (edge centerline)

• Arc center point

• Circle center point

• Elliptical element center point

• Spherical surface center point

• Conical surface center point
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Lines

• Linear edges (including tangent edges)

• Reference axis

Surfaces

• Planar part surfaces

• Reference planes

Connect relationship combinations

• Connect a point on the first part to a point on the second part

• Connect a point on the first part to a line on the second part

• Connect a point on the first part to a face on the second part

• Connect a line on the first part to a point on the second part

• Connect a face on the first part to a point on the second part

Note

You can also use an axial align or a connect relationship to position a part
with respect to a keypoint or a line in an assembly sketch.

Differences between assembly relationships and sketch relationships

The relationships that you apply between the parts and subassemblies of an
assembly differ from the relationships that you apply while working with part
sketches. For example:

• There are no relationship handles added to the assembly to show that a
relationship has been applied. Instead, the relationships between parts are
shown in PathFinder.

• Except for the ground relationship, all assembly relationships are defined
between the part or subassembly you are placing and a part or subassembly
already placed in the assembly.

• You cannot use dimensioning commands to place relationships between parts
and subassemblies in an assembly.
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Positioning parts using coordinate systems

You can also position parts in an assembly using coordinate systems. You do this by
first defining coordinate systems in the part document on both the placement and
target parts. You can then use the Planar Align relationship, Mate relationship,
and Match Coordinate Systems option on the Assemble command bar to position
the placement part.

For example, with the Match Coordinate Systems option, the placement part is
positioned using planar align relationships that match the three principal axes on
the coordinate system for the placement part and the target part. This allows you to
position the placement part using fewer steps than applying three separate planar
align relationships. This can be useful when working with a common part that is
placed into an assembly multiple times in the same position relative to a target part.
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Capture Fit command

Captures the assembly relationships and faces used to position a part or subassembly
already placed in the assembly. You can then place the part or subassembly again
later using fewer steps. You can use the Capture Fit dialog box to specify which
relationships you want to capture.

If you used the Insert option to position a part, the Capture Fit command will
capture a mate and an axial align relationship, since these are the relationships
that the Insert option actually places.

You can also capture relationships by setting the Automatically Capture Fit When
Placing Parts option on the Options dialog box on the Place Part command bar.

Note

The Capture Fit command cannot capture angular relationships.

Capture Fit dialog box
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Capture the assembly relationships for a part

1. In the assembly window, select a part for which you want to capture relationships.

2. Choose Home tab®Relate group®Capture Fit .

3. In the Capture Fit dialog box, use the Add and Remove buttons to specify which
relationships you want to capture, and then click OK.

Tip

• You can also select the part you want to use in PathFinder.

• When you use the Capture Fit command, the relationships and faces used
to position the part or subassembly the first time are stored so you can
place the part using fewer steps later.

• If you used the Insert option to position a part, the Capture Fit command
will capture a mate and an axial align relationship, since these are the
relationships that the Insert option actually places.

• The Capture Fit command cannot capture angular relationships.

• You can also capture relationships by setting the Automatically Capture
Fit When Placing Parts option on the Options dialog box on the Place
Part command bar.
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Activity: Positioning parts with mate, axial align, planar align and
insert

Overview

This activity shows the process of positioning parts using mate, axial align, planar
align and insert. The parts will be positioned with the reduced steps option turned
off to better understand the workflow options in the command bar. Then the same
parts will be placed with the reduced steps option turned on to show how the process
can be streamlined.

Note

FlashFit is a preferred method of quickly positioning parts in an assembly
and will be covered in another activity. This activity forces you to manually
position parts so that you will understand what is occurring when parts are
positioned using flashfit and how to change a single relationship to reposition
a part if an edit is later required.

Objectives

Parts will be added to an assembly using the commands mate, planar align, axial
align and insert

In this activity you will:

• Learn how to position parts using the commands mate, axial align, planar align
and insert without using reduced steps.

• Learn how the command bar reflects the workflow during the positioning of parts.

• Use reduced steps to position parts with mate, planar align, axial align, and
insert.

Activity

In this activity you will learn the procedure for positioning parts in an assembly
using the mate, planar align and axial align relationships.
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Activity: Placing parts using mate, planar align, and axial align

This activity will position a part with reduced steps turned off to show the complete
sequence of steps involved in positioning a part. The second part will be placed with
reduced steps turned on to show a more efficient method of positioning parts.

Create a new assembly and position the first part

In this step, you will create a new assembly using the Synchronous ISO Assembly
template. You will click the Parts Library on pathfinder and browse to the folder
containing the assembly class files.

▸ Create a new assembly. After the assembly opens, click the Application button.

Choose Solid Edge Options, and then click the assembly tab. Check the box
as shown.
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▸ From the Parts Library in PathFinder, drag the part dome.par in the assembly
window.

Note

The first part placed in the assembly is placed as a grounded part.

Applying a mate relationship

In this step you will drag the part a1_part.par into the assembly window and apply a
mate relationship.

▸ Click the Options button on the command bar.

▸ Set the options shown and then click OK. Make sure the reduced steps option is
off and FlashFit as the default placement method is off.
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▸ Select the Mate Relationship.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. Notice the step is currently the Placement
Part - Element step and you are being prompted to select an element of
the placement part. For this relationship, select a face.

▸ Select the face shown.

Note

The command bar shows the Target Part step is active, and you are being
prompted to select the target part. This part has the face you will apply
the mate relationship to. If you selected the wrong face in the previous
step, you can back up by clicking the button corresponding to that step
and then select the proper geometry again.
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▸ Select the target part, dome.par as shown.

Note

Notice the Target Part - Element step is active, and you are being
prompted to select the target part element. This element is the face the
mate relationship will be applied to.
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▸ Select the face shown on dome.par.

▸ Right-click or click the OK button to accept. The mate relationship is applied.

Applying a planar align relationship

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 2 will be a planar align.

▸ Set the relationship type to Planar Align.

Note

The Locate Steps group on the command bar reflects the current placement
step in the workflow. For this relationship, you will select a face.
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▸ Select the face shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This part has the face you will apply the
planar align relationship to.
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▸ Select the target part shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. Select the element that is the face you
will apply the planar align relationship to.
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▸ Select the face shown.

▸ Right-click or click the OK button to accept. The planar align relationship is
applied.

Applying an axial align relationship

The relationship list increments to the next relationship. Relationship 3 will be
an axial align.

▸ Set the relationship type to Axial Align

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. For this relationship, you will select a
cylindrical face.
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▸ Select the cylindrical face shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This part has the cylindrical face you will
apply the axial align relationship to.
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▸ Select the target part shown.

Note

The Locate Steps group on the command bar reflects the current
placement step in the workflow. This element is the cylindrical face you
will apply the axial align relationship to.
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▸ Select the cylindrical face shown.

▸ Right-click or click OK to accept. The axial align relationship is applied, and the
part is fully positioned.
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Applying a mate relationship with reduced steps

Another occurrence of the part a1_part.par will be placed. The sequence of steps will
be the same except reduced steps will be used.

Note

When the reduced steps option is used, the step for selecting the target part is
eliminated. Valid features on every part are available for selection and the
target part is determined from the part containing the feature. This option is
more efficient in most cases, however in large assemblies where an area can
be congested with many parts, it is desirable to have more control by manually
choosing the target part as was shown in the previous steps.

▸ From the Parts Library, drag the part a1_part.par into the assembly window.
You will apply a mate relationship.

▸ Click the Options button on the command bar.

▸ Set the options shown. Make sure the reduced steps option is on and FlashFit as
the default placement method is off.

▸ Select the mate relationship.

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select an
element of the placement part. For this relationship, you will select a face.
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▸ Select the face shown.

Note

Because the reduced steps option is set, the command bar reflects the
placement step in the workflow. Notice the step is now the target part
element, and you are being prompted to select the target part element.
This element is the face the mate relationship will be applied to. The
target part is automatically assigned and is the part on which the target
element belongs.
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▸ Select the face shown.

▸ The mate relationship is applied.

Note

Using reduced steps, there is no need to click OK to complete. Once the
target element is selected, the relationship is established.

Applying a planar align relationship with reduced steps

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 2 will be a planar align.

▸ Set the relationship type to Planar Align.

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select an
element of the placement part. For this relationship, you will select a face.
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▸ Select the face shown.

Note

The command bar reflects the placement step in the workflow. Notice
the step is now the target part element, and you are being prompted to
select the target part element. This element is the face you will apply the
planar align relationship to.

▸ Select the target part element shown.

The planar align relationship is applied.

Applying a axial align relationship with reduced steps

Once this relationship is established, the relationship list increments to the next
relationship. Relationship 3 will be an axial align.
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▸ Set the relationship type to Axial Align

Note

The command bar reflects the placement step in the workflow. Notice the
step is currently the element step and you are being prompted to select
an element of the placement part. For this relationship, you will select a
cylindrical face.

▸ Select the cylindrical face shown.

Note

The command bar reflects the placement step in the workflow. Notice
the step is now the target part element, and you are being prompted to
select the target part element. This element is the cylindrical face you will
apply the axial align relationship to.
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▸ Select the cylindrical face shown.

The axial align relationship is applied, and the part is fully positioned.
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Placing a fastener with the Insert command

Insert will be used to position a fastener in a hole.

Note

Insert requires a mate and an axial align. Once you have established these
relationships, the rotation of the axial align is locked and the part is fully
positioned.

▸ Drag the part 10mm_fastener.par into the assembly window.

▸ Select the Insert Command.

Note

The mate relationship will be established first, then the axial align.
Because of the number of faces to choose from, Quickpick will be used to
aid in the selection.

▸ Fort the mate relationship, select the face shown.
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▸ Select the target face for the mate relationship as shown.

▸ For the axial align relationship, select the cylindrical face shown.
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▸ For the target face of the axial align, select the face shown.

▸ The fastener is placed and fully positioned, with the rotation locked. Click the
Select tool to exit. Close the assembly document without saving.

Activity summary

In this activity you learned the workflow for establishing relationships needed to
position parts in an assembly. You also learned that using the reduced steps option
streamlines the process of positioning parts.
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Lesson review

Answer the following questions:

1. What are the steps required to apply a mate relationship without using flashfit
or reduced steps?

2. What is the difference between mate and planar align?

3. What is a floating offset?

4. Are linear edges valid for the placement of an axial align relationship?

5. When using reduced steps, which step is eliminating when creating a
relationship?

1-60 Solid Edge assembly mt01416-s-1040



Modeling assemblies

Answers

1. What are the steps required to apply a mate relationship without using flashfit
or reduced steps?

a. Select the face to mate on the placement part.

b. Select the target part.

c. Select the face to mate to on the target part.

d. Select the face to mate to on the target part.

e. Enter an offset distance (optional).

f. Click OK.

2. What is the difference between mate and planar align?

Mated faces face each other. Faces that are planar aligned face the same
direction.

3. What is a floating offset?

A floating offset forces the faces to be parallel and the distance between the faces
is determined by other relationships.

4. Are linear edges valid for the placement of an axial align relationship?

Linear edges can be used to define an axial align relationship, as well as
cylindrical features, constant radius features such as rounds or fillets.

5. When using reduced steps, which step is eliminating when creating a
relationship?

Valid features are found on all active parts and the selection of the target part is
not required.
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Lesson summary

In this lesson you learned the workflow for establishing relationships needed to
position parts in an assembly. You also learned that using the reduced steps option
streamlines the process of positioning parts.
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Activity: Placing parts in an assembly using FlashFit

Overview

In this activity, FlashFit will be used to position parts in a valve assembly.

Objectives

The objective of this activity is for you to be able to use appropriate relationships to
position parts in an assembly.

Activity

In this activity you will learn the procedure for positioning parts in an assembly
using FlashFit to achieve the relationships of mate, planar align and axial align.
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Activity: Placing parts in an assembly with FlashFit

You will use FlashFit to position parts and subassemblies in completing the valve
assembly.

Place the first part in the assembly.

Create a new assembly and place the first part.

▸ Create a new assembly file.
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▸ On the assembly PathFinder, click the Parts Library and drag st_v_housing.par
into the assembly window. The first part placed in a new assembly file is
grounded.

Use FlashFit to position the valve parts and subassemblies

Use FlashFit to position the valve parts. Before placing additional parts, set the
FlashFit parameters. Once the parameters are set, the part will be positioned.

▸ From the Parts Library, drag the subassembly st_v_handleball.asm into the
assembly window.

▸ Click the Options button on the command bar.

mt01416-s-1040 Solid Edge assembly 1-65



Lesson 1 Modeling assemblies

▸ Set the Options shown and then click OK.

▸ Set the relationship type to FlashFit.

▸ On the command bar, click the Activate Part button.

Note

When positioning a subassembly using reduced steps, the parts making up
the subassembly come in as inactive. The parts containing the geometry
needed to position the subassembly need to be activated.
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▸ Select st_v_shaft.par to activate it. Right-click to exit the Activate command
and continue.
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▸ Select the circular edge shown. Use QuickPick for an accurate selection.

Note

Matching circular edges with FlashFit is the equivalent of using the
Insert command. A Mate relationship, and an Axial Align relationship
with locked rotation is created.
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▸ Select the inner lip of the center hole of the housing.

▸ The subassembly is positioned.
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Place the remaining parts

Place additional parts in the assembly until finished.

▸ Drag st_v_endplate.par into the assembly window.

▸ Use QuickPick to select the face shown.
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▸ Select the target face on the housing as shown. A Mate relationship is applied.

▸ The next two relationships will be established using alignment of holes in the
parts. Select the cylindrical face on the st_v_endplate.par as shown.
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▸ For the target, select the cylindrical face shown. An Axial Align relationship is
applied.

▸ For the last relationship needed to completely position the part, select the
cylindrical face shown.
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▸ For the target, select the cylindrical face shown. An Axial Align relationship
is applied and the part is positioned.

▸ Drag another occurrence of st_v_endplate.par into the assembly window.
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▸ Place st_v_endplate.par on the opposite side of the housing from the one just
place using the same procedure you used to place the previous part.

Note

FlashFit will assign either a mate or a planar align to flat faces based on
the closest orientation of the two faces being positioned. In this case, if a
planar align is assigned rather than a mate, use the flip button to change

the relationship type to a mate.

▸ Drag st_v_top.par into the assembly window.
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▸ Use FlashFit to position st_v_top.par as shown. The procedure is similar to the
one used to place the previous two parts.

▸ Drag 10mm_fastener.par into the assembly window.

▸ Using QuickPick, select the circular edge shown.
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▸ For the target, select the circular edge shown on the top cap. The fastener
is placed.

▸ Place additional occurrences of 10mm_fastener.par in the remaining holes on
the valve using the same procedure.

Note
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If FlashFit positions the fasteners incorrectly as shown, follow the steps
outlined to correct the placement. The reason for the incorrect placement of
the fastener is that FlashFit determines whether to apply a Planar Align or a
Mate relationship to the fastener based on the orientation of the face relative
to the placement face. If the part faces are closer to a planar align relationship,
then that is what is applied. Prior to selecting the circular edges in FlashFit,
the fastener can be rotated into the approximate desired orientation by
holding Ctrl while dragging it. This will result in correct placement and is
easier than correcting the placement using Flip outlined below.

• Click the Select command.

• Select the fastener.

• In the lower pane of PathFinder, right-click the Planar aAlign relationship,
and then click Flip.
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▸ This completes the activity. Close the assembly document without saving.

Activity Summary

In this activity you learned how to place parts and subassemblies from a Parts
Library and position them in an assembly. FlashFit consists of the Mate, Planar
Align and Axial Align relationships and determines which is appropriate. When
using FlashFit and selecting circular edges, fasteners can quickly be positioned
because the rotation of the fastener is locked and the part becomes fully constrained.
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Lesson review

Answer the following questions:

1. Which relationships will flashfit attempt to create when positioning a part in
an assembly?

2. When a circular edge is used on both the placement part and the target part,
which relationships are created?

3. How does flashfit determine whether to place a mate or a planar align
relationship when flat faces are selected?

4. If a planar align relationship is incorrectly created using flashfit, how can a
mate relationship be assigned instead?

5. After a part is added from the parts library, how can it be approximately
positioned to the target geometry?

6. If a relationship is created erroneously, how do you change or remove the
relationship?
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Answers

1. Which relationships will flashfit attempt to create when positioning a part in
an assembly?

Flashfit creates a mate, a planar align or an axial align relationship.

2. When a circular edge is used on both the placement part and the target part,
which relationships are created?

Using circular edges with flashfit is similar to the insert command and has fewer
steps. Like the insert command, using circular edges with flashfit is ideal for
the placement of fasteners. The edges are placed concentric creating a mate and
axial align with the rotation locked.

3. How does flashfit determine whether to place a mate or a planar align
relationship when flat faces are selected?

The closest orientation is chosen. If the faces are approximately facing each
other, mate is selected. If the faces are oriented approximately in the same
direction, a planar align relationship is created.

4. If a planar align relationship is incorrectly created using flashfit, how can a
mate relationship be assigned instead?

Click the flip command before proceeding to the next positioning step.

5. After a part is added from the parts library, how can it be approximately
positioned to the target geometry?

Drag the part to a new position with the left mouse button. Rotate the part by
holding the CTRL key and dragging with the left mouse button.

6. If a relationship is created erroneously, how do you change or remove the
relationship?

Edit the relationship by clicking on the part with the select tool. The
relationships appear in the lower pane of assembly pathfinder and can be edited,
suppressed or deleted from there.
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Lesson summary

In this lesson you learned how to place parts and subassemblies from a Parts Library
and position them in an assembly. FlashFit consists of the Mate, Planar Align and
Axial Align relationships and determines which is appropriate. When using FlashFit
and selecting circular edges, fasteners can quickly be positioned because the rotation
of the fastener is locked and the part becomes fully constrained.
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More Assembly Relationships
Positions the selected part or subassembly into the active assembly. Parts are
positioned in assemblies using a combination of assembly relationships.

Relationship List
Lists the relationships applied to the part. You can replace a previously applied
relationship by selecting a relationship from the list and then selecting a new
relationship from the Relationship Types list.

Relationship Types
Lists the assembly relationship types you can apply. Parts can be positioned
using the following relationship options:

Insert

Connect

Angle

Tangent

Cam

Parallel

Match Coordinate Systems

Gear/Motion

Note

The Insert option applies a mate relationship with a fixed offset value and
an axial align relationship with its rotational value fixed.

1-82 Solid Edge assembly mt01416-s-1040



Modeling assemblies

Connect Relationship

Applying a connect relationship

When two parts in an assembly cannot be positioned properly by mate and align
relationships, you can position them using connect relationships. A connect
relationship positions a keypoint on one part with a keypoint, line, or face on another
part. For example, you can apply a connect relationship to position the center of a
spherical face on one part with respect to a spherical face on another part.

You can use the following methods to apply connect relationships:

• Point-to-Point: In the following figure, a mate relationship is applied between
the mitered corners of the parts. A connect relationship, which ties a point on
one part to the appropriate point on another, connects the two corners properly.
A floating align relationship between the back surfaces fully positions the part.
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• Point-to-Line: In the following example, a mate relationship is applied between
the faces of the two parts. Because the sides of each part are drafted, there are
no part faces which you can use to apply a planar align relationship. You can
apply three connect relationships between the keypoints on the top part and
the linear edges on the bottom part.

• Point-to-Plane: In the following example, the lower right pin is positioned to a
depth that just touches the surface of a reference plane.

1-84 Solid Edge assembly mt01416-s-1040



Modeling assemblies

• Cone-to-Cone: In the following example, the cone on the fastener is connected
to the cone on the countersunk hole on the plate. When you add a connect
relationship between two conical faces, the keypoint that represents the
theoretical intersection of the individual cones are connected. You can also apply
an offset value to a connect relationship between two conical faces.
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Activity: Positioning assembly parts using the connect relationship

Overview

The objective of this activity is to position a part in an assembly using the connect
relationship.

Activity

In this activity you will use the connect relationship to position a part. The faces of
the parts have draft angles and because of this the connect relationship will need
to be used rather than the planar align relationship.
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Activity: Positioning assembly parts using the connect relationship

Overview
This activity shows several options available that are used to position parts within
an assembly using the connect relationship.

Objectives
An assembly with several unconstrained parts will be opened. The Connect
relationship will be used to position the parts.
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Open the assembly

Open the assembly containing the parts to be positioned, and you will set the desired
parameters.

▸ Open Connect.asm and activate all the parts.

▸ Click the Application button. Click Solid Edge Options, and then click the
Assembly tab. Check the box as shown.

Position the lid by connecting 3 points

Use the Connect relationship to position the lid. Position the lid by connecting three
of the corner arc centers together. This will completely position the lid.

Note

The connect relationship recognizes key topological features to position parts.
Like the axial align option, linear edges can be connected. Endpoints and
midpoints of linear elements are valid for connecting, as well as arc and circle
centers.

▸ Set the display to Visible and Hidden Edges. By exposing the hidden edges,
locating desired geometry is more efficient.
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▸ Click the Select command, and then select the lid shown.

▸ To position the part, select the part with the select tool and then click the edit
definition button.

▸ Set the relationship type to Connect.
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▸ Select the point on the arc center of the lid as shown.

▸ Select the corner of the other lid shown as the target point for the first
relationship.
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▸ Repeat these steps for any two of the remaining three corners. The lid is then
completely positioned.

Use spherical faces to define a connect relationship

Position the center of the sphere on the knob to the center of the half sphere
depression in the lid. This shows how spherical faces can be positioned using the
Connect relationship.

▸ Click the Select tool and select the knob. Then click the Edit Definition
Command as shown.

▸ Set the relationship type to Connect.
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▸ Select the face of the sphere on the knob as shown.

▸ As the target, select the face shown. You may need to use QuickPick to make
the selection more efficient.

Note

The center of the sphere on the knob is now connected to the center of the
spherical depression on the face. The knob has freedom to pivot about this
point. Other relationships, such as Mate with a floating offset can be used
to exactly position the knob.
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▸ As an optional step in this activity, use the Mate relationship to completely
position the knob as shown. You may also want to use the parts reference planes
to help position the knob. Close the assembly without saving. This completes
the activity.

Activity summary

In this activity you learned to use the Connect relationship to position a lid using
points, and to position a knob by connecting sphere centers together.

This activity is complete.
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Lesson review

Answer the following questions:

1. Give an example of why a connect relationship would be used to position a part
rather than mate or planar align relationship.

2. Give some examples of valid geometry that can be used to create a connect
relationship.

3. Give some examples of connect relationship combinations.
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Answers

1. Give an example of why a connect relationship would be used to position a part
rather than mate or planar align relationship.

Molded parts where the drafted faces exist do not work well with planar align or
mate relationships. Ball and socket scenarios where concentric spheres need to
be positioned is another example of using the connect relationship. The connect
relationship is useful in these situations.

2. Give some examples of valid geometry that can be used to create a connect
relationship.

Examples of valid geometry for the connect relationship:

• End points of lines, arcs, and ellipses

• Midpoint of a line (edge centerline)

• Arc center point

• Circle center point

• Spherical surface center point

• Conical surface center point

• Linear edges

• Reference planes

• Reference axis

• Planar part surfaces

3. Give some examples of connect relationship combinations.

• Connect a point on the first part to a point on the second part

• Connect a point on the first part to a line on the second part

• Connect a point on the first part to a face on the second part

• Connect a line on the first part to a point on the second part

• Connect a face on the first part to a point on the second part
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Lesson summary

In this lesson you learned to use the Connect relationship to position a lid using
points, and to position a knob by connecting sphere centers together.
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Activity: Positioning assembly parts using the angle relationship

Overview

The objective of this activity is to position a part using the angle relationship.

Activity

In this activity you will position a part using the angle relationship, then modify the
value of the angle and observe the change in position.
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Activity: Positioning assembly parts using the angle relationship

Overview

This activity shows several options available that are used to position parts within
an assembly using the Angle relationship.

Objectives

An assembly with unconstrained parts will be opened. The Angle relationship will
be used to position the parts.

Open the assembly

Open the assembly containing the parts to be positioned, and then set the desired
parameters.
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▸ Open Angle.asm with all the parts active.

Create a connect relationship

To position the lid, the first relationship you establish will be the Connect
relationship.

▸ Click the Select command and select the part shown. Then click the Edit
Definition button as shown.
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▸ Select the Connect relationship.

▸ Select the vertex point shown.

Note

You may have to rotate the view to better identify the point.

▸ For the target, select the vertex point shown.
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Create an axial align relationship

Use the Axial Align relationship for the second relationship.

▸ Click the Axial Align relationship.

▸ Select the linear edge shown.

mt01416-s-1040 Solid Edge assembly 1-101



Lesson 1 Modeling assemblies

▸ For the target, select the linear edge shown.

Position the lid using the angle relationship

Use the Angle relationship to position the lid. Once placed, the angular value will be
able to be modified to reposition the orientation of the lid.

▸ Select the Angle Relationship.
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▸ Select the face shown as the face to measure to.

▸ Click the face shown as the face to measure from.
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▸ When prompted to click on a plane in which the angle measurement will lie,
click the edge shown.

Note

The Angle measurement is established.

▸ Click the Select tool.

Edit the angle

Edit the angle and the position of the lid will change.

▸ Press Ctrl+R on the keyboard to rotate the view to a right view.

▸ In PathFinder, select lid.par:2 and then, in the lower pane, select the Angle
relationship.

Note

Variable names and angle values may differ from the picture shown. This
is not a problem.
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▸ On the Placement command bar, click the Angle Format list, and then move the
cursor over the eight options. Notice the difference in how the angle is measured
in each of the different options.

▸ Click the Angle format which gives the measurement shown below. Change
the angle to 90°.

▸ Change the angle to different values and observe the behavior. Change the
angle to 190°.
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▸ On the ribbon, choose Tools tab®Variables to display the Variable Table. Notice
this angular value is shown here and can be edited from the Variable Table. Also
the angular value can be driven via a formula to other values within the table.

▸ This completes the activity. Close the assembly document without saving.

Activity summary

In this activity you learned to use the Angle relationship to position a lid, and modify
the value of the angle to change the position of the lid.

This activity is complete.
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Lesson review

Answer the following questions:

1. What steps are used to place an angle relationship?
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Answers

1. What steps are used to place an angle relationship?

The following steps define an angle relationship:

• Select the face on the placement part to measure the angle from.

• Select the target part.

• Select the face on the target part to measure the angle to.

• Select the axis or plane the dimension will be placed on.

• Enter the angular value.

• Select the angle format. This shows the 8 options on how the angle is defined.

• Click OK.
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Lesson summary

In this lesson you learned to use the Angle relationship to position a lid, and modify
the value of the angle to change the position of the lid.
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The Assemble command
The Assemble command is an alternative method of positioning multiple parts in an
assembly that have been placed in an assembly, but that are yet to be positioned.
Utilizing Flashfit techniques, the Assemble command allows changing parts with a
right mouse click.
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Assemble command

Positions parts in an assembly. You can use this command to position a single part in
an assembly, or you can use this command to position several parts relative to each
other without fully constraining each part in an ordered sequence.

This type of workflow can make it easier to position a set of interrelated parts, such
as when building a mechanism.

After dragging and dropping a set of parts into an assembly, you can use the
Assemble command to apply relationships between one of the parts and one or more
target parts. To position a different part, click the right mouse button.

To position a series of parts using the Assemble command, you first drag and drop
the set of parts into the assembly using the Parts Library tab.

If it is a new assembly, the first part is automatically grounded. When you drag and
drop the second part into the assembly, the Assemble command bar is displayed, but
you can continue to drag and drop parts into the assembly without positioning them.

After the set of parts is placed in the assembly, you can use the Assemble command
to position the parts.

When you click the Assemble command, the Assemble command bar is displayed.
You can use the FlashFit option to apply a mate, planar align, or axial align
relationship, or choose from the complete set of ordered relationships.

After you apply a relationship between two parts, the first part you select (A)
remains selected so you can apply additional relationships to the part.
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To position a different part, click the right mouse button. You can then select a
different part (A) and apply the relationships you want.

The Assemble command is tightly integrated with the FlashFit positioning option.
When you click the Assemble command, FlashFit is the default option. For more
information on FlashFit, see the Assembly Relationships topic.

Assemble command bar
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Activity: The Assemble command

Overview

The objective of this activity is to understand how to position parts using the
Assemble command.

Activity

In this activity you will learn how to use the Assemble command.
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Activity: Assemble command

Overview

When you complete this activity, you will be able to position parts in an assembly
using the Assemble command. This activity teaches how to use the Assemble
command to manipulate and fully position parts in an assembly.

Objectives

The activity consists of the following:

• Settings that affect the Assemble Command

• Manipulation and positioning of parts using the Assemble Command

• Editing and error recovery

Note

Positioning parts with the Assemble command:

There are many ways to correctly assemble the parts and subassembly
associated with this activity. You will not be given specific instructions on how
to assemble these parts other than the order in which to assemble the parts.
How a part is positioned using FlashFit is predictable. With the Assemble
command however, parts can be positioned incorrectly or over constrained.
This activity will purposely position a part incorrectly so that the steps to
correct the positioning will be covered.

The rules on the behavior of the Assemble command are listed next. You will
be instructed to use these rules where appropriate.
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Note

Assemble Command guidelines

The following guidelines are used in positioning the parts in this assembly
using the Assemble command.

• In the assembly you will be working with valve_housing.par which was
placed first and is grounded. The other parts will be positioned relative
to this previously positioned part.

• FlashFit is the default assembly relationship creation mode and should
be used.

• Once you select a part to position, it will become transparent. Once
it is fully positioned, or another part is selected, it will no longer be
transparent.

• If, in the middle of positioning a part, you decide to position another part,
right-click to release the current part. It will no longer be transparent.
The next part you select will then become transparent.

• If you work in wireframe, rather than shaded, you will not have the
visual benefit of the selected part being transparent. For that reason, it
is suggested that you use Shaded with Visible Edges display mode while
using the Assemble command.

• Once a part is selected, it can be dragged to a new position with the left
mouse button. The selected part is the part you are applying relationships
to. Right-click to release the part.

• To rotate a selected part that is unconstrained, use Ctrl + left mouse
button.

• FlashFit will determine whether to use a Mate or Planar Align
relationship based on the closest orientation of the faces being matched. It
is good practice to rotate the selected part into the approximate position
before selecting the faces. After FlashFit, if the faces are 180° out of
position, click the Flip button on the command bar.

• Matching circular edges will quickly position a part, such as a fastener,
in one operation. The centerlines are superimposed and the rotation
is locked. You can unlock the rotation by editing the relationships in
Assembly PathFinder. Refer to the section of this activity that addresses
editing and error recovery.
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Assemble command setup

Open assemble.asm making all the parts active by using the settings shown in the
open dialog box.

▸ Choose the Home tab->Assemble group->Assemble command..

▸ Click the Options button on the command bar.
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▸ Set the options shown below, then click OK.

Note

The behavior of positioning faces with FlashFit will first be shown. For
other parts, edges will be used.

▸ Click Shaded with Visible Edges.

Assemble the parts beginning with the top cap

Move the parts to their approximate final position. Select a part to move. The part
will become transparent. With the left mouse button, drag the part to the position
shown. Right-click to release the part and left-click to select a different part to drag.
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▸ Position all the parts approximately as shown.

▸ Right-click to release the last part selected. Select the top cap. Zoom in on the
top face of the valve housing. Using FlashFit, mate the bottom face of the top
cap to the top face of the valve housing as shown.
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▸ Select the cylindrical face of a hole on the top cap, and then select the cylindrical
face of a hole in the top of the valve housing, as shown.

▸ To completely position the part, repeat the previous step beginning with a
different cylindrical face in the top cap, and a corresponding cylindrical face in
the valve housing. Once the part is completely positioned, it will become shaded
and no longer be transparent.

Position the first fasteners on the top cap

Position the first fastener on the top cap.
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▸ To begin positioning the next part, select the face shown of one of the fasteners.

▸ Select the face of the top cap as shown.
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▸ FlashFit determines whether to apply a mate or planar align relationship based
on the orientation of each of the faces. If the fastener is placed reversed, as
shown, click Flip on the command bar to correct.
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▸ Select the cylindrical shaft of the fastener and the cylindrical face of the
corresponding hole. The fastener is positioned in the hole, but is transparent
because there is freedom in the axis defined by the center of the shaft.
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▸ Select the flat face on the head of the fastener as shown, and then select the face
on the top cap as shown. The bolt rotates such that the planes become parallel
and a floating offset is applied which locks the rotation of the bolt.
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Position the other fasteners using edge selection

You will now position other fasteners by using FlashFit and selecting circular edges.

▸ Click the options button on the command bar and set the options as shown.
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▸ Position the fastener using the edges shown below.

Note

Positioning by matching circular edges completely constrains the part by
fixing the rotation. This is the preferred method.
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▸ If the fastener becomes oriented as shown, it is because the original orientation
of the faces of the fastener was closer to a planar align relationship rather than a
mate relationship.

Note

Because the part is completely constrained, the Assemble command
has released this fastener and is ready to position another part. The
fastener has become shaded indicating it is fully positioned. To position
this fastener correctly, you will need to temporarily exit the Assemble
command by clicking the Select tool. Once the fastener is positioned
correctly, click the Assemble command to continue positioning parts.

▸ If the fastener was placed upside down, select the fastener. It will become
transparent. Select the mate relationship, click Flip, then click OK to correctly
position the fastener.
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▸ To position the remaining two fasteners, use these steps. Click the Assemble
command and select one of the remaining fasteners. To rotate the fastener into
the approximate vertical position, click and hold Ctrl while you left-click and
then drag.

▸ Position the fastener by selecting the same circular edges as the previous part.
The fastener will be oriented correctly because the orientation was close to the
final position. Right-click to clear the selection when done.

Position the handle subassembly

You will now position the handle subassembly by using FlashFit and selecting
circular edges.
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▸ Position the subassembly handle and ball.asm by selecting the circular edges
as shown.
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▸ Use the Assemble command and the techniques learned from the previous steps
to position each endcap into the correct position on the valve housing. This
completes this activity. Close the assembly document.

Activity summary

In this activity you learned how to use the Assemble command to quickly assemble a
group of parts into an assembly. If all the parts making up an assembly are placed in
an assembly window, the Assemble command can be used to complete the positioning
of the parts into the final assembly.

This completes the activity.
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Lesson review

Answer the following questions:

1. How do you move an unconstrained assembly component when using the
assemble command?

2. How do you rotate an unconstrained assembly component when using the
assemble command?

3. How do you select a different assembly component to position without exiting
the assembly command?
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Answers

1. How do you move an unconstrained assembly component when using the
assemble command?

Drag using the left mouse button.

2. How do you rotate an unconstrained assembly component when using the
assemble command?

Hold the CTRL key and drag with the left mouse button.

3. How do you select a different assembly component to position without exiting
the assembly command?

Right click to release the current assembly component, the select the next
component to position.
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Lesson summary

In this lesson you learned how to use the Assemble command to quickly assemble a
group of parts into an assembly. If all the parts making up an assembly are placed in
an assembly window, the Assemble command can be used to complete the positioning
of the parts into the final assembly.
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Designing in the context of an assembly
When designing in the context of an assembly, you can construct the parts with
either ordered or synchronous geometry based on which is appropriate for the
desired outcome.

In the activity, you will experience designing parts in context of a top level assembly
using the tools provided.
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Activity: Designing in the context of a synchronous assembly

Overview

The objective of this activity is to explore designing in the context of an assembly
with Solid Edge synchronous technology. You will open an existing assembly and use
adjacent parts to refine the sizing and spacing of the faces and parts in the assembly.
You will also used geometry from one part to create a cavity in an adjacent part.

Activity

In this activity you will learn how synchronous technology can be of benefit when
designing in the context of an assembly.
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Activity: Designing in the context of a synchronous assembly

In this activity, you will modify parts in the context of the assembly using Solid Edge.
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Open the assembly

Open spindle_cover.asm with all the parts activated.

Note

Click the Select command and click on each part in PathFinder. Each
relationship that has been used to position the assembly can be viewed by
moving the cursor over the relationships in the lower pane of PathFinder.
These existing assembly relationships as well as Live Rules are honored when
manipulating geometry with Solid Edge.

▸ Open spindle_cover.asm. Activate all the parts.

Modify the plastic part to make the brackets fit

The brackets holding the axle do not fit correctly on the plastic cylindrical part,
and the face of the plastic part that the brackets attach to is not wide enough to
accommodate the brackets. You will modify the parts in the context of the assembly
to correct these problems.

▸ Set the Selection Priority to Face.
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▸ Select the face shown with the steering wheel in the position shown.

▸ Select the additional faces shown. You should have a total of 4 faces selected.
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▸ Select the axis of the steering wheel as shown.

▸ On the QuickBar, select the circle center key point.
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▸ Click the circular center of the end face of the axle. The 4 faces will move.

Note

Because symmetry about the base reference planes is set in live rules, the
parts are modified on the opposite side as well.

▸ Clear the Selection.

Shorten the brackets

Because the brackets are too tall, the axle is too far out from the plastic housing.
You will shorten the bracket.
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▸ Select the face and the cylinder shown. Move the origin of the steering wheel
to the face shown.

Note

The steering wheel can be relocated by dragging the origin knob which
is the large sphere at the center.
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▸ Drag the primary axis on the steering wheel so that the bracket becomes shorter.
Enter 30.00 mm. The axial alignment between the bracket and the axle force
the axle to stay aligned with the hole in the bracket.
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Note

The axle moves with the bracket because of the axial align relationship
used to place the axle.

▸ Clear the Selection.

Create clearance between the bracket and plastic housing

The face of the plastic part is too close to the bracket. You will move the face inward.
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▸ Select the face shown.

▸ Rotate the view to a right view and move the face somewhere between the
bracket face and the next face on the shaft. Exact placement is not important.
Because the part is symmetrical about the base, Live Rules are controlling the
behavior such that the opposite face is also positioned correctly.

In-place activate the plastic part and create inter-part geometry for cutting the part

After in-place activating the plastic part, inter-part faces and an inter-part body will
be created from other parts in the assembly.
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▸ Clear the select set.

▸ Set the selection criteria to Part.

▸ Double-click the plastic part to in-place activate the part. You are now in the
part environment but can still see the other parts in the assembly.

Note

Using Inter-Part Copy, you will copy needed geometry from the assembly.
You need two planar faces to create bolt holes in the plastic part to attach
the brackets. You will also need the body of beltdrive.par.
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▸ Click the Inter-Part Copy command.

Note

Linked Inter-Part copies of surfaces can only be created in the ordered
environment. The Inter-Part surface created for this exercise does not
need to be linked and we will stay in the synchronous environment for
this operation.

▸ Select the bracket.
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▸ In the Select Faces step in the command bar, select Face. Select the face shown.

▸ Accept and then click Finish. Repeat for the opposite side.
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▸ Click the Inter-Part Copy command and select the part shown.
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▸ In the Select Faces step in the command bar, select Body. Select the whole
body shown.

▸ Accept the body, then click finish. The body is created.

Cut the plastic part using the inter-part faces

The two inter-part faces and the inter-part body, and a cutout will be used to cut the
plastic part.

▸ Click the View tab and in the Show group, click Hide Previous Level. This will
turn off the display of the other parts in the assembly
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▸ Click the Sketching tab. Lock the sketch plane to the face containing the
inter-part copies. Click Project to Sketch and select each of the 4 holes on the
two Inter-Part faces.

▸ Hide the Inter-Part Copy faces, used to create the holes, in PathFinder. Click the
Extrude command. Create cutouts from each of the holes.
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▸ Now you will draw a sketch for the first cutout in the housing. Select the sketch
plane shown.
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▸ Draw the sketch below and create an open cutout that extends the full length of
the part.

Note

In the Relate group on the ribbon, use the Equal relationship to make
the lines the same length. The angle between the lines is 120o. Use the
Horizontal/Vertical relationship to line up the ends of the lines vertically.
Intellisketch may put a perpendicular relationship at the intersection of
the two lines. You will need to delete that relationship in order to get
the 120o driving dimension placed.
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The part is shown.

▸ Click the Surfacing tab. In the Surfaces group, click the Offset command.
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▸ In the Select step in the command bar, set Select to Body. Select the Inter-Part
Copy shown and accept.
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▸ Enter 3.00 mm for the offset distance. For the direction, click as shown. Then
click Finish.
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▸ The offset surface is shown. Notice it is bigger than the Inter-Part Copy.

Note

If the offset is smaller than the original part, you have chosen the wrong
direction and will need to repeat the operation.

▸ Turn off the Inter-Part Copy of the body in PathFinder.

▸ Click the Surfacing tab. In the Surfaces group, click the Boolean command.

▸ In the command bar in the Tool Step, set the select to Body and click Subtract.

▸ Select the offset surface and accept. Then click Finish.
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▸ Hide the offset surface in PathFinder.

The part is as shown.
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▸ Click the Home tab and then click Close and Return to return to the assembly.
The assembly is as shown.

Modify the angle of the opening in the plastic part

Now you will modify the angle of the angular cut in the plastic face.

▸ Set the Selection Priority to Face.
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▸ Select the face shown and move the steering wheel so that the primary axis
aligns with the axis of the axle as shown.
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▸ Select the steering wheel torus as shown and rotate with the mouse. Notice the
angle of the cut in the plastic part changes.

Note

Make sure the 120o dimension is unlocked so the face can move

This completes the activity.

Activity summary

In this activity you learned how to modify parts in the context of an assembly
using Solid Edge.
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Lesson review

Answer the following questions:

1. What is one advantage to modeling assemblies using synchronous components?

2. Can synchronous components in an assembly be copied using the steering wheel?

3. When using the steering wheel to move or copy an assembly component, when
can live rules be used?
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Answers

1. What is one advantage to modeling assemblies using synchronous components?

Faces and components can be selected and modified directly in the assembly
environment using the steering wheel and live rules.

2. Can synchronous components in an assembly be copied using the steering wheel?

Synchronous geometry can be moved or copied using the steering wheel. Solid
Edge will attempt to repair relationships that become invalid after a move if
directed to do so.

3. When using the steering wheel to move or copy an assembly component, when
can live rules be used?

Live rules can be used with the steering wheel in assembly when faces are
selected, and the geometry is synchronous rather than ordered.
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Lesson summary

In this lesson you learned how to modify parts in the context of an assembly using
Solid Edge.
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Assembly-based features
In some assemblies, you may want to construct a single feature that modifies more
than one part. For example, a pattern of cutouts may extend through several parts.

In other cases, you may want to construct a feature within the context of the
assembly, rather than in the Part or Sheet Metal document.

You can use the feature commands in the Assembly environment to construct
features such as cutouts, revolved cutouts, holes, chamfers, and threads. You can
also mirror and pattern these features.

In Solid Edge, you can construct two types of assembly-based features:

• Assembly Features

• Assembly-Driven Part Features

You use the Feature Options dialog box to specify whether the assembly-based
feature you are constructing affects only the selected parts (Assembly Feature),
or affects all parts with the same document names as the selected parts
(Assembly-Driven Part Feature).

Note

The Feature Options dialog box is not available until you set the
Assembly-Driven Part Feature option on the Inter-Part tab of the Options
dialog box. When this option is disabled, you can only construct assembly
features.

You can use the assembly-based feature commands to modify the solid body, but not
any surface bodies (construction bodies) that may reside in the part documents.

Some types of assembly-based features can only be constructed as assembly
features. For example, the Chamfer and Thread commands do not support the
Assembly-Driven Part Feature option.

2-2 Solid Edge assembly mt01416-s-1040



Assembly features

Assembly Features

When you set the Create Assembly Features option, the feature affects only the
parts you select.

For profile-based features, the reference plane, profile, extent definition, and surface
geometry resides in and can only be viewed from the assembly document where the
feature was constructed.

This option is useful when you want to modify one or more commonly-used parts,
but do not want to affect other instances of the same parts in the active assembly or
other assemblies that reference those parts.

You do not need write access to the affected part files to construct an assembly
feature.

Assembly-Driven Part Features

When you set the Create Assembly-Driven Part Features option, the feature affects
all parts with the same document name as the selected parts.

The reference plane, profile, and extent definition, resides in and can only be viewed
from the assembly document where the feature was constructed. The surface
geometry resides in the part documents. The surface geometry can be viewed in the
part documents, and any other assemblies that reference the part documents.

This option is useful when you want to globally modify one or more parts while
working in the assembly.

You need write access to the affected part files to construct an assembly-driven
part feature.

A part document that contains an assembly-driven part feature is associatively
linked to the assembly document where the feature definition (reference plane,
profile, and extent definition) resides.

You can break the links that control an assembly-driven part feature by in-place
activating the part document, selecting the feature in PathFinder, and clicking the
Break Links command on the shortcut menu. After the link is broken, it is likely
that some aspects of the feature will become undefined. For example, the reference
plane may no longer be associated to its parent face. You can repair the broken links
by selecting the feature, and using the Edit Definition option on the command bar to
redefine the reference plane, feature extents, and so forth.

Note

When you set the Assembly-Driven Part Feature option on the Feature Options
dialog box, any existing assembly features are temporarily hidden while
constructing the assembly-driven part feature. This prevents you from using
edges on assembly-driven part features to construct the assembly feature.

When you finish constructing the assembly-driven part feature, the assembly
features are redisplayed.
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Drawing the Profile

When constructing a profile-based assembly feature, you can draw the profile on one
of the default assembly reference planes or use a part face to define a profile plane.

You can use the draw commands to draw the profile, or if you have created an
assembly sketch, you can use the Select From Sketch option available when
constructing a cutout or revolved cutout. The Text Profile command is not available
when creating assembly features or assembly-driven part features.

Dimensioning the Profile

You place dimensions to the profile elements in the same way as you would a
profile-based features for a part. Before you can place dimensions or geometric
relationships to part edges, you must set the Peer Edge Locate command on the Tools
tab. You can then place dimensions or relationships between the assembly feature
profile elements and the edges of other parts in the assembly.

Defining the Extent

You can specify that the feature extends through all the parts, extends by a finite
distance value, or define a from/to extent. When defining a from/to extent, you
can select an assembly reference plane or a part face to define the feature extent.
Associative links are created when you select a reference plane or part face to define
the extent, and the links are displayed in the bottom pane of PathFinder when
the feature is selected.

Selecting the Parts

You do not have to apply the feature to every part that the profile geometry passes
through. The Select Parts step allows you to specify which parts you want to modify.
Parts that lie within the range of the profile and the feature extent are automatically
selected. You can add parts to the select set by clicking on the part you want to
add, and you can deselect parts by holding the SHIFT key and selecting parts that
are highlighted.

You can select a subassembly as the select set of parts to modify, and all parts that
intersect the feature are modified. If parts are added to the subassembly later,
the new parts are not added to the feature scope. If you want the new parts to
participate in the feature, you must edit the feature and return to the Select Parts
step and select the new parts to which you want to apply the feature.
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Assembly-based Features in PathFinder

Separate lists are maintained for assembly features (A) and assembly-driven part
features (B) in PathFinder. When constructing assembly-driven part features,
the symbols for the affected parts (C) are changed to show they have links to the
assembly.

When you select an assembly-based feature in the top pane of PathFinder, the
parents that control the feature are displayed in the bottom pane of PathFinder. For
example, when you select Cutout3 (A) in the top pane, in the bottom pane it shows
that C.PAR is the parent part for the coincident reference plane on which the profile
was constructed. Also listed are the parts (C) that were modified by the feature.
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Editing Assembly-based Features
To edit an assembly-based feature, select the feature entry in PathFinder and click
the Edit Definition button on the command bar. Thecommand bar for the feature
is displayed, so you can select the step you want to modify. For example, you can
return to the Select Parts step and select additional parts to which you want to
apply the feature.

The Select Feature Components command on the Pathfinder shortcut menu can be
used to select the parent components for an assembly feature. This can be useful in
determining the parent components for the feature, and for managing the component
display. For example, after you select the parent components, you can use the
Show, Show Only, and Hide commands to display or hide the parent components for
editing purposes.

Note

Assembly features and assembly-driven part features are not included in
the undo list.

Opening Part Documents with Assembly-Driven Part Features
When you open a part document that contains an assembly-driven part feature, a
dialog box reminds you that the part document has links to the assembly where the
feature was constructed. The dialog box allows you to specify whether you want to
open the assembly document or the part document.

Mirroring and Patterning Assembly Features
You can mirror and pattern only assembly features that were constructed in the
current assembly. You cannot mirror or pattern assembly-driven part features. You
can specify which parts are included in the mirror or pattern feature. If you add parts
to the mirror or pattern feature which were not in the parent feature, a message is
displayed to instruct you the parts must also be added to the parent feature.

Suppressing Assembly-based Features
You can use the Suppress and Unsuppress commands on both types of
assembly-based features, but the behavior differs somewhat.

When you suppress an assembly feature, a symbol is added adjacent to the feature
in PathFinder to indicate that the feature is suppressed. When you suppress
an assembly feature, the feature is suppressed for all the parts affected by the
assembly feature. You cannot suppress an assembly feature for individual parts
in an assembly feature.

When you suppress an assembly-driven part feature, no symbol is added to the
feature in PathFinder to indicate that the feature is suppressed. Because the surface
geometry for an assembly-driven part feature resides in the part document, the
suppress symbol is added to the part documents in PathFinder.

You can also suppress an assembly-driven part feature on an individual part by
in-place activating the part, and suppressing the feature on that part in PathFinder.
When you return to the assembly where the feature was defined, no indication of the
suppress operation is displayed in PathFinder, but the graphic display is updated to
for the part that had the feature suppressed. You can redisplay the feature using the
Unsuppress command in the assembly document or the part document.
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Placing an Assembly that contains Assembly-based Features as a
Subassembly

Both assembly features and assembly-driven part features are viewable and can be
used for positioning purposes when the assembly is placed as a subassembly in
another assembly.

Assembly-based Features and Draft Documents

When constructing drawings of an assembly that contain assembly features, you can
specify whether the assembly features are displayed in a drawing view using the
Drawing View Properties dialog box. This applies only to assembly features, not
assembly-driven part features. Because assembly-driven part features physically
modify the part document, they are always displayed in a drawing view.

Creating Stand-alone Documents for Components with Assembly Features

You can save an individual part in a assembly to a new document using the Save
Selected Model command. This is useful when you have used assembly features
to modify a part.

Because assembly features are visible only within the context of the assembly, saving
a part with assembly feature modifications to a new document allows you to create a
drawing for that part, prior to creating an assembly drawing. You can also use the
stand-alone document for manufacturing or analysis purposes.

The documents you create using the Save Selected Model command contain an
associative part copy of the part in the assembly. Associative part copies do not
contain a feature tree.

You can use the Save Selected Model dialog box to specify the new file type you
want. You can save the component as aSolid Edge Part document (.PAR) or a Sheet
Metal document (.PSM).

Assembly-based Features and Alternate Assemblies

Assembly features, but not assembly-driven part features, are allowed when working
with a family of assemblies, but certain restrictions apply. Inter-part links are not
allowed when working with an alternate assembly, and both types of assembly-based
features allow you to create inter-part links. When converting an assembly to a
family of assemblies that contains inter-part links, a dialog box is displayed to warn
you that the inter-part links will be deleted.

If you anticipate creating a family of assemblies that will contain assembly-based
features, you should consider using only assembly features and not place dimensions
or geometric relationships to part edges. This approach does not create inter-part
links. For example, you can use an assembly sketch to define the profile for an
assembly feature, and use assembly reference planes for positioning dimensions and
geometric relationships.
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Assembly Features and Simplified Parts

When you create an assembly feature (assembly-based feature or assembly-driven
part feature), any simplified parts that are displayed in simplified mode in the
assembly are redisplayed in design mode when you select them to be included in an
assembly feature.

Any parts that were selected for an assembly feature cannot be displayed in
simplified mode, whether the parts were modified by the assembly feature, or not
modified. The simplified mode is also not available if you suppress the assembly
feature.
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Activity: Assembly features
This activity guides you through creating a cutout traversing multiple parts in
an assembly.
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Activity: Assembly features

Overview

An assembly cutout allows you to cut multiple parts within the assembly
environment. The resultant cutout can be applied only in the assembly (assembly
feature) or it can be associatively linked back to the part or sheet metal files
(assembly-driven part feature). This capability reduces the chance of error through
misalignment that could happen when through holes spanning multiple parts are
cut independently.

Objectives

Learn to use the Assembly Cutout command. Assembly Cutout places a cutout in
multiple parts from within the Assembly environment. To do this, draw a sketch
on one of the assembly reference planes, and then select the parts to cut. For this
activity, construct an assembly feature cutout in the assembly as shown in the
following illustration.
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Open the assembly with inactive parts

▸ Open assembly_cut.asm. In the Open File dialog box, select the Inactivate all
option. Turn shading on or off as preferred.

▸
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Set the Inter-Part options

▸ On the Application menu, click Solid Edge Options. In the Solid Edge Options
dialog box, click the Inter-Part tab. Check all the boxes and then click OK.
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Activate parts in the assembly in order to select them for modification

▸ Activate the files baseplate.psm, motormount.psm, and motor.par. Select the
three parts by holding down the Ctrl key. Right-click to display the shortcut
menu, and then click Activate.

mt01416-s-1040 Solid Edge assembly 2-13



Lesson 2 Assembly features

Turn on the display of one of the reference planes

▸ Turn on the display of the x-z plane. In PathFinder, click the check boxes for the
x-z plane and the Reference Planes.
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Construct an assembly cutout through parts baseplate.psm and motormount.psm

▸ On the Features tab, in the Assembly Features group, choose the Cut command

.

▸ In the Feature Options dialog box, select the Create Assembly features option
and click OK.

▸ Select the assembly reference plane as shown.
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▸ On the Home tab, in the Draw group, choose the Include command. In the
Include Options dialog box, select the options shown and click OK.

▸ Select the circle on the motor.

▸ Click the Accept button.
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▸ Type 15 for the offset distance and then click to the outside direction of the
selected circle. Choose Close Sketch.
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▸ On the command bar, click the Through All extent option. Position the cursor so
the arrow points in the direction as shown, and click to accept.

▸ Click the Deselect button to deselect the parts highlighted in PathFinder. These
are all the parts that the cutout affects.
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▸ In PathFinder, select the files baseplate.psm (A) and motormount.psm (B) for the
parts to cut. Click the Accept button, and then click Finish. Both cutouts, driven
by the circle, are placed in the assembly only.
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Turn off the reference plane display

▸ Click the Select tool. Right-click in the working window to display the shortcut
menu, and then choose the Show/Hide All Components command. In the Show
All/Hide All dialog box, check the Hide All box for Reference Planes.
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Observe the changes in PathFinder

▸ Observe the changes in PathFinder. Since the Create Assembly features option
was selected, the cutout is shown as an Assembly Feature.

▸ If the Create Assembly-Driven Part features option was selected, then
PathFinder would show the following.

baseplate.psm and motormount.psm are now shown as associatively linked to
the assembly sketch. The baseplate.psm and motormount.psm files are actually
modified by the cutouts. Investigate this by saving and closing this file. Then
open either baseplate.psm or motormount.psm to verify the modification.
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The activity is complete

Save and close the assembly. This activity is complete.
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Activity summary

An Assembly Cutout can be applied in the assembly only (assembly feature) or the
cutout can be applied directly to the part or sheet metal files (assembly-driven part
feature). This activity only covered the assembly feature cutout option. You can go
back later and use the assembly-driven part feature cutout option to observe how the
part files have cutouts applied directly to them.
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Lesson review

Answer the following questions:

1. What is the difference between an assembly feature and an assembly driven
part feature?

2. Can an assembly feature, such as a cutout, operate on more than one assembly
component?

3. How are assembly features displayed in a draft document?

4. Are assembly features valid when the assembly is placed as a subassembly?
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Answers

1. What is the difference between an assembly feature and an assembly driven
part feature?

An assembly feature only exists within the assembly environment and does not
add the feature to the part or sheet metal document. Other occurrences of those
parts in other assemblies are not affected by the assembly feature.

An assembly driven part feature creates a linked feature in the part or sheet
metal file and all occurrences of that part or sheet metal document, including
other assemblies, are modified with that feature.

2. Can an assembly feature, such as a cutout, operate on more than one assembly
component?

Components to which an assembly feature is applied to are selected prior to
placing the feature.

3. How are assembly features displayed in a draft document?

When constructing drawings of an assembly that contain assembly features,
you can specify whether the assembly features are displayed in a drawing view
using the Drawing View Properties dialog box. This applies only to assembly
features, not assembly-driven part features. Because assembly-driven part
features physically modify the part document, they are always displayed in a
drawing view.

4. Are assembly features valid when the assembly is placed as a subassembly?

Both assembly features and assembly-driven part features are viewable and can
be used for positioning purposes when the assembly is placed as a subassembly
in another assembly.
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Lesson summary

An Assembly Cutout can be applied in the assembly only (assembly feature) or
the cutout can be applied directly to the part or sheet metal files (assembly-driven
part feature).
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Assembly patterning
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Patterning and mirroring components in assemblies

When building assemblies, you often need to place parts and subassemblies multiple
times in a pattern or mirror arrangement. For example, nuts, bolts, and other
fasteners are placed in a rectangular or circular pattern on the parts they are
fastening together.

Patterning parts

You can use the Pattern Parts command to quickly copy one or more parts and
subassemblies into a pattern arrangement. You can also add an existing part pattern
to a new part pattern.

The patterned parts are not positioned using assembly relationships, but according
to a pattern feature on a part or assembly sketch.

Mirroring parts

You can use the Mirror Components command to quickly copy one or more parts and
subassemblies into a mirror arrangement around a reference plane you select.
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Pattern Parts command

Copies one or more assembly components into a pattern.

You can select the following types of components to define a pattern of parts:

• Parts in the active assembly.

• Subassemblies in the active assembly.

• Patterns of parts in the active assembly.

The parts are not positioned using assembly relationships. They are positioned using
a pattern feature in a selected part or in an assembly sketch.
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Positioning the components to be patterned

Before creating a pattern of parts, you should properly position one copy of the
components you want to pattern. For example, to pattern a bolt, use the Place Part
command to place the bolt into one of the bolt holes in the part.

Note

If the pattern feature on the part was constructed using the Fast Pattern
option, you should position the first bolt in the parent feature of the pattern.
For example, if you used a hole feature to create the part pattern, position the
first bolt in the hole feature, not one of the holes in the pattern feature.

Selecting the components to be patterned

After you have positioned the components you want to pattern, use the Pattern Parts
command to select them. The Select Parts step on the Pattern Parts command bar
allows you to select the components you want to pattern. You can pattern multiple
components in one operation. You can select parts in the active assembly, entire
subassemblies, and existing patterns of parts.
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Defining the pattern

After you have selected the components you want to pattern, the Define Pattern step
on the command bar allows you to select the part that contains the pattern feature
you want to use. You can also select an assembly sketch if the assembly sketch
contains a 2D pattern profile.

Next, you must select the pattern feature on the part or assembly sketch. The part
you use as a pattern reference does not have to be the part in which you positioned
the original components. You can select pattern features that were constructed
with the following commands:

• Rectangular Pattern

• Circular Pattern

• Pattern Along Curve

• Hole
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When the pattern feature highlights in the assembly window, select a reference
position on the pattern feature. In most cases you should select the feature into
which you placed the original copy of the part to be patterned.

When you click the Finish button on the command bar, the original part is copied
to each position in the pattern.

Modifying the feature pattern

If you change the design of the part containing the feature pattern, the part pattern
in the assembly updates. For example, if you increase the number of holes in the
feature pattern, additional bolts are added to the part pattern in the assembly.
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Deleting and suppressing patterned parts

When you delete the original part in a pattern, all the patterned parts are also
deleted. You cannot delete the individual Pattern Items in a pattern of parts, but you
can suppress them. For example, you may have a pattern of 24 bolts where design
considerations require one bolt to be shorter than the rest.

After you have placed the pattern of bolts, you can suppress the Pattern Item for
that bolt in PathFinder. You can then use the Assemble command to place a shorter
bolt in that location.

When you suppress a Pattern Item, the quantity value in an assembly report or a
parts list in a drawing is adjusted accordingly. For example, if you suppress one
Pattern Item in pattern of 24 bolts, the quantity value in the parts list would be
23 bolts.

Controlling occurrence properties of patterned parts

You can control the occurrence properties of the individual parts in a pattern of
parts. When creating a pattern of parts, the parent part’s occurrence properties
are applied to all of the patterned parts when you set the Patterned Parts Inherit
Parent Part Occurrence Properties By Default option on the Assembly Tab on the
Options dialog box.

After you create a pattern of parts, you can change the occurrence properties of
individual parts in the pattern. For example, you may want to hide one of the
patterned parts in the drawing, but still display it in the assembly. You can select
the part in PathFinder or the graphics window, then use the Occurrence Properties
command on the shortcut menu to set the occurrence property Display in Drawing
Views to No for that part.

The part will be displayed in the assembly and counted in an assembly report, but
will be hidden in the drawing and not counted in a parts list in the drawing.

Replacing patterned parts

You can use the Replace Part command to replace the original part, but not the
patterned parts. When you replace the original part, all the patterned parts are
also replaced.
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Patterned parts and assembly relationships

Although the parts in a pattern are not positioned using assembly relationships,
they do change position if a relationship controlling the original part is modified.
For example, if you edit the offset value of the original part, all the patterned parts
also update.

Defining patterns productively

You can create patterns of parts that contain part patterns you defined earlier. For
example, you can create a part pattern of socket head screws, then use that part
pattern to construct another pattern.

Assembly patterns and alternate assemblies

The Pattern Parts command is available when the Apply Edits to All Members
option on the Alternate Assemblies tab is set (you are working globally) or cleared
(you are working locally).

You can only modify the inputs for a pattern of parts when the Apply Edits to All
Members option is set (you are working globally). For example, if an assembly
pattern of parts originally included a bolt and nut, you cannot modify the pattern to
add a washer to the pattern unless you are working globally.
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For more information, see the Alternate Assemblies Impact on Solid Edge
Functionality Help topic.
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Activity: Assembly patterning

Overview

The objective of this activity is to show how to create a pattern of parts within
an assembly.

Activity

In this activity you will use different options to assembly patterns.
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Activity: Generating a pattern in an assembly

Overview

This activity demonstrates options to create patterns in an assembly.

Objectives

You will create different pattern types in an assembly.

Pattern a hole feature in a part

A pattern will be created in a part that will later be used to position fasteners in
an assembly.

▸ Open the part cylinder_01.par in the folder that contains the activities.

▸ In PathFinder, select the cutout shown.

Note

This feature is the reference feature of the pattern about to be created.

▸ On the home tab in the pattern group, click the rectangular pattern command.
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▸ When prompted to select a face or reference plane, select the lock icon on the
face shown.
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▸ Orient the steering wheel as shown and set the parameters to:

• Pattern Type: Fit

• X Count: 2

• Y Count: 2

• X Distance: 285.00

• Y Distance: 170.00

▸ Accept the selection to complete the pattern.

▸ Save and close the cylinder_01.par.
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Note

It is important that the part be saved. The pattern created is used in the
upcoming steps of the activity.

Place a pattern of fasteners in an assembly

The fastener will be placed in using the reference feature of the pattern that resides
in the part.

▸ Open the assembly rotary_engine.asm with all the parts active.
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▸ Drag the fastener 25mm_fastner.par and place the fastener in the reference
feature of the part pattern as shown.

▸ On the Home tab in the Pattern group, click the Pattern command .

▸ When prompted to select the parts to be included in the pattern, select the
fastener shown and accept.
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▸ When prompted to click on the part or sketch that contains the pattern, click the
part cylinder_01.par as shown.

▸ When prompted to click on the pattern, select the whole pattern as shown.

▸ When prompted to click on the reference feature of the pattern, click the
reference feature as shown.
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▸ Click Finish. The pattern is placed.

Create an assembly pattern from an assembly layout sketch

▸ On the Home tab in the Sketch group, click the Sketch command .

▸ Select the front reference plane to place the sketch.

▸ On the Home tab in the Features group, click the Circular Pattern command

.

▸ Ensure that the full circle option is set.

▸ Set the count to 4.
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▸ Place a 450 mm radius circle centered on the origin of the reference planes
oriented as shown.

▸ When prompted to click on the arc direction, click above the part as shown.
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▸ The pattern circle is created.

▸ Click Close Sketch , and then click Finish.

▸ On the Home tab in the Pattern group, click the Pattern command .

▸ When prompted to select the parts in the pattern, click on the parts in
PathFinder as shown and accept.

▸ When prompted to select the part or sketch that contains the pattern, select
the sketch as shown.
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▸ When prompted to click on the pattern, click on the circle as shown.

▸ Click Finish to create the pattern.

Modify the pattern

▸ Select the sketch and then click Edit Profile .
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▸ Select the pattern circle as shown.
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▸ Set the count to 6. Close the sketch and then click Finish.

▸ Select the pattern in PathFinder. Click Edit Definition, and then click Finish to
recalculate the pattern.

Suppress a pattern occurrence

▸ In pathfinder, right click item_3 in the pattern and then click suppress.
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▸ Item_3 is suppressed as shown.

The occurrence is suppressed.

Excluding a pattern occurrence from reports

▸ In pathfinder, right click 25mm_fastener.par in item_2 in the pattern and then
click occurrence properties.
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▸ Set No in the assembly reports column.

The item will be removed from assembly reports and draft parts list.

Summary

In this activity you learned some of the options available for generating assembly
patterns.
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Lesson review

Answer the following questions:

1. Name two entities that control the placement of a pattern of components in
an assembly.

2. How do you suppress one of the occurrences of an assembly pattern?

3. How can a component that is part of an assembly pattern be excluded from
assembly and draft reports?
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Answers

1. Name two entities that control the placement of a pattern of components in
an assembly.

An pattern of assembly components can be controlled by either an assembly
sketch, or by a pattern that exists within one of the components placed in the
assembly.

2. How do you suppress one of the occurrences of an assembly pattern?

Right click on the item occurrence in pathfinder, then click suppress.

3. How can a component that is part of an assembly pattern be excluded from
assembly and draft reports?

Right click on the occurrence in pathfinder and then click the occurrence
properties.
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Lesson summary

In this lesson you learned some of the options available for generating assembly
patterns.
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Working with Systems Libraries in assemblies
When building assemblies, you often need to use the same group of parts more than
once. This group of parts may also need the same feature modification made to a
mating part in the assembly to facilitate placement of the group of parts.

For example, you may need to place a bracket (A) and its mounting bolts and washers
(B) in many different assemblies, or many times in one assembly. The bolts may also
need mounting holes in the part (C) to which they are fastened.

You can use the systems library functionality in Solid Edge to define the group of
parts, features, and assembly relationships so you can reuse them easily later.

The parts, features, and relationships for a systems library member are stored in an
assembly document you define.

A systems library document can consist of the following:

• Complete subassembly documents

• Part documents

• Features that are associative children of one of the part documents

Creating Systems Library members

When creating a new systems library member, you must adhere to the following
rules:

• You can only select parts and entire subassemblies that are in the top level
assembly.

• You cannot create a systems library member when working in an alternate
assembly. You can use the Save Member As command to save a copy of the
alternate assembly as a normal assembly to use this functionality.

• You cannot create a systems library member when you are in-place activated
in a subassembly.
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Creating a new Systems Library member

You create a new systems library member using the Create Systems Library
command on the Home tab in the Systems group. When you click the Create Systems
Library button, a command bar guides you through the steps required to create
the systems library member:

• Selecting the assembly components you want

• Selecting the features you want to capture (optional)

• Viewing the captured relationships

• Defining the new assembly document name, template, and location

Selecting components

Any parts and subassemblies that are in the active assembly can be added to a
systems library document. When adding a subassembly, the entire subassembly
must be added. You cannot select individual parts in the subassembly. You can
select the parts you want to capture in the assembly window or in PathFinder. If
you select an assembly pattern, the parts that were used to define the pattern are
automatically captured.

The parts and subassemblies you select are listed in the Selected Components
dialog box. When you have selected all the parts and subassemblies you want in
the new systems library member, click the Accept button on the command bar to
proceed to Captures Features Step. The relationships used to position the parts and
subassemblies are automatically captured.
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Capturing features

You can only capture features that were created using inter-part associativity
techniques. If one of the parts you selected in the Select Components Step was used
as a parent to create an associative feature on another part, the associative child
feature on that other part is available for use in the systems library member. For
example, if the hole feature (A) in the mounting plate was constructed using the
Include command to associatively include edges (B) (C) from the bracket part, the
hole feature (A) can be part of the systems library document.

Note

For more information on inter-part associativity, see the Inter-Part
Associativity Help topic.

In the previous example, the system library member will then consist of the bracket
part (A), the bolts and washers (B) (C), and the hole feature (D). When you place the
systems library document later, the plate part itself is not placed.

When you select parts that have been used as parents in an associative inter-part
feature, the child features that are available for including in the new systems library
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document are listed in the Captured Features dialog box and are highlighted in the
assembly window so you can select only the features you want to capture.

You can also capture any treatment features that modified the associative inter-part
feature. For example, if you added chamfers to the holes described earlier, you
can add them to the captured features list by selecting the chamfer feature in the
assembly window.

After you have selected the features you want to capture, click the Accept button on
the command bar. If you do not want to capture features for the new systems library
document, you can click the Next button on the command bar to bypass this step.

Capturing relationships

When you finish defining the parts and features you want to capture, the Capture
Relationships dialog box is displayed so you can review the parts, features, and
positioning relationships you captured. You can click the relationships listed on
the Capture Relationships dialog box to highlight the faces used to define the
relationship you selected, or you can click the OK button on the dialog box to dismiss
it.

Defining the Systems Library container document

When you click the Create Group button on the command bar, the Create Systems
Library dialog box is displayed so you can define the systems library document name
and location, the assembly template you want to use, and rename any features
you captured.

If you are going to share systems library documents with other users at your
company, you should define file naming and location conventions to make it easier to
use systems library documents.

Placing a Systems Library member document

You place a systems library member document by dragging the assembly document
for the systems library member from the Parts Library page in PathFinder, and
dropping it into the assembly window. When you drop the systems document in the
assembly window, a command bar and the Input dialog box are displayed to guide
you through the steps required to place the systems document:

• Positioning the parts

• Positioning the features

The parts that comprise the systems library document are also temporarily
positioned in the assembly window.

The Input dialog box lists the assembly relationships required to position the
systems library components. When placing the component parts and captured
features, options are provided on the command bar to skip captured relationships
or features. As you complete the steps required to define a relationship, the Input
dialog box is updated to indicate the steps you have completed.
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Positioning parts

You position the parts similarly to the way you would normally position a part in an
assembly, by selecting a part already in the assembly, and a face or element on that
part to define the relationship. If the Use Reduced Steps When Positioning Parts
option is set, then you will only need to select a face or element on an assembly
part to define the relationship.

When you drop the systems library member into the assembly, the face on the
placement part for the first positioning relationship is highlighted (A). You can then
select the target face in the assembly to satisfy the first relationship (B). The Input
dialog box displays the relationship type and default value for each relationship. You
can also use the command bar to define a new offset value for the first relationship,
or skip defining the relationship entirely.

After you select the target face for the first relationship, the set of parts is
repositioned, and the face on the placement part for the second positioning
relationship is highlighted (A). You can then select the target face in the assembly
to satisfy the second relationship (B).
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You continue in this fashion until all the positioning relationships have been defined
or skipped.

Positioning features

After you define the assembly relationships, you specify the part that you want to
modify with the captured features. For example, if the feature you are placing is a
hole feature, you would select a planar face on the assembly part (A) on which you
want to apply the hole feature. The hole feature is associatively linked as a child of
the parent part used to define the feature. In this example, the parent part is the
bracket part (B).

After placement, the parts behave exactly the same as any part in an assembly.
The systems library document itself is not placed into the assembly. It is used as a
container that defines the systems components.

Reviewing inter-part relationships

The inter-part relationships that you use when creating a systems library member,
and when you placing a systems library member are indicated in PathFinder, and
can be further reviewed using the Inter-Part Manager dialog box.

For example, a symbol is added to the child part (A) in PathFinder to indicate that it
is associatively linked to another part in the assembly.
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Activity – Systems library
The objective of this activity is to teach the fundamentals of creating a systems
library and then placing the library into an assembly so that the parts and features
associated with that library are correctly positioned.

When you complete this activity, you will know how to use systems libraries
to quickly create components and features, which can be used in many other
assemblies. You will learn procedures used during systems library creation that
make placement of system libraries easy and consistent.
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Activity – Systems library

In this activity you will create an assembly called a systems library that consists of
parts and the underlying features needed to modify target geometry as the assembly
is placed.
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Place the motor on the plate

The motor is first placed on the plate. Parts and features that need to accompany the
motor in a systems library are created on this plate.

The systems library consists of a group of parts and features that are meant to be
placed many times. First, you assemble the components of the systems library in
the manner you later wish them to be placed. Once the components are correctly
positioned, then you define them as a systems library.

Note

In creating a systems library, it is important to establish as many relationships
as possible between components that are going to be a part of the systems
library. Relationships to other parts need to be reestablished upon placement,
so whenever possible establish relationships with components within the
group to speed placement. Establish as many relationships as you can to
the first part that is placed.

▸ Open Create_Sys_Lib.asm with all the parts activated.

▸ The right (y-z) plane of the part base_plate.par will be used to position the motor
on the plate. The assembly reference planes can be turned off.

Hide the assembly reference planes.

▸ Show the reference planes for the part file base_plate.par. Later, these will be
used to position the motor. In PathFinder, right-click base_plate.par and then
click Show/Hide Component and select the On check box for Reference Planes.
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▸ From the Parts Library, drag motor.par into the assembly. Position the part
using the following steps.

▸ Click Options on the command bar and set the options as shown.

Note

Even though the FlashFit option is set, choose the appropriate relationship
and leave the default as FlashFit.
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▸ On the command bar, select the Mate relationship, and mate the plane of the
foot of motor.par to the top plane of base_plate.par.

▸ Select the Planar Align relationship, and align the front face of the motor
bracket on motor.par with the vertical face of base_plate.par. Set the fixed
offset to 15 mm.
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▸ Use the Planar Align relationship to create a relationship between the reference
plane of motor.par to the reference plane of base_plate.par. Access the reference
planes for the motor by turning on the construction display for reference planes
as shown.
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The motor is now centered on the base plate.
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Use Inter-Part Copy to associate the holes in the motor to the holes in the plate

Next, add holes to the base plate. Use the Inter-Part Copy command to associate the
holes with the corresponding geometry on the motor.

▸ Click the Application button.

▸ Click Solid Edge Options.

▸ Click the Inter-Part tab and set the options as shown. Then click OK.

▸ In Assembly PathFinder, right-click base_plate.par, and then click Edit.

Note

When editing a part in the context of an assembly, you can turn off the view
of the rest of the assembly. The command that does this is View tab®Show
group®Hide Previous Level. For the upcoming steps, however, do not hide
the assembly.

▸ If you cannot see the motor, select View tab®Show group®Hide Previous Level.

▸ Choose the Home tab®Clipboard group®Part Copy®Inter-Part Copy command

.
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▸ Select motor.par as the assembly part to copy from. Select the bottom plane of
each foot as the faces to copy.

▸ Click the Accept button, and then click Finish to place the inter-part copy.
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Create holes in the plate from the Inter-Part copy

Place features on the plate. These features become part of the systems library and
will be placed as features in the target part at the time of placement.

▸ Choose View tab®Show group®Hide Previous Level to turn off the display
of motor.par.

▸ Choose Home tab®Solids group®Hole command .
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▸ Click Hole Options and set the values as shown, and then click OK.
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▸ Select the reference plane shown in the image. Use the N key on the keyboard to
orient the reference plane as shown.

Note

When creating features for a systems library, it is good practice to orient
the reference plane consistently for all the features.

▸ Place four Through All holes using the center of the inter-part surfaces to place
the holes.

▸ Choose Home tab®Close group®Close Sketch.
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▸ Click with the arrow in the direction shown to define the direction of the hole
extent.

▸ On the command bar, click Finish.
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Create the pocket on the plate

▸ Click the Cut command.

▸ The reference plane is created from the top face of the plate. Use the N key to
orient the reference plane as shown.

▸ Click the Include command and set the options as shown, and then click OK.
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▸ As shown below, offset the bold lines a distance of 5 mm from the inter-part
construction surfaces.

▸ Click Trim, and trim the 4 offset lines as shown.

▸ Click Close Sketch and on the command bar, enter 7.5 mm for the extent of
the cutout.
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▸ Click to define the direction of the cutout as into the part. Click Finish to
complete the cutout.

▸ Click the Round command. Select the top edges of the cutout, and enter a radius
of 2.5 mm. Preview and finish the round.

▸ Click Close and Return to return to the assembly.
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Place the first fastener

▸ Drag 10mm_cs_screw.par into the assembly.

▸ Using FlashFit, select the circular edge of the screw, and then select the circular
edge of the hole in the foot of the motor as shown.

▸ The screw is placed.

▸ Drag 10mm_nut.par into the assembly.

Note

It is good design practice when creating a systems library to position
subsequent parts relative to a single part that will be included in the
systems library. In this case, the plate will not be a part of the systems
library, but the features on the plate will be. Because all the features need
to be placed relative to the motor, the motor will be used to establish as
many relationships to as possible.
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▸ To establish relationship 1, axial align the cylindrical face of 10mm_nut.par with
the cylindrical face of the hole in motor.par.

▸ Mate the top face of the hex face of 10mm_nut.par to the bottom face of
base_plate.par.

▸ Click the Select tool to exit the Place Part command. Select 10mm_nut.par in
Assembly PathFinder, and in the lower plane, click the axial align relationship.
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▸ Lock the rotation.

The nut is positioned.
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Pattern the fasteners

The pattern in motor.par will be used to pattern the fasteners.

▸ Click the Pattern command .

▸ In Assembly PathFinder, select 10mm_cs_screw.par and 10mm_nut.par to be
included in the pattern, and then click the Accept button.

▸ When prompted to select the part that contains the pattern, select the motor.

▸ Select the pattern shown.
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▸ Select the reference feature shown, and then click Finish to place the pattern.

4-28 Solid Edge assembly mt01416-s-1040



Assembly systems libraries

Create the systems library

All the components of the systems library are in place and can now be stored. Create
the systems library.

▸ Choose the Home tab®Assemble group®create Systems Library command .

▸ In the Assembly PathFinder, select all parts except base_plate.par.

▸ The dialog box showing the set of parts to be added to the systems library is
displayed.

▸ Click Next on the command bar.

▸ The dialog box showing which features are to be included in the systems library
is displayed.
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▸ Add the round feature to the selection set, by clicking on the feature in the
assembly window.

▸ Click Next on the command bar.

▸ The dialog box showing the Captured Relationships is displayed. Click OK.

▸ Click Create on the command bar.
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▸ Name the new systems library motor_assembly.asm. Fill in the appropriate
boxes in the dialog box. Make sure the new file location is the folder containing
the lab files for this activity.

▸ Click OK.

▸ The systems library is now created. Save and close the assembly.
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Place the systems library into an assembly

To place the systems library, you will create a new assembly with a plate. You will
place four occurrences of the systems library on the plate.

Note

During creation of the systems library, care and consideration was given in
orienting the reference planes consistently for each feature, and as many
relationships as possible were established to motor.par. This makes accurate
placement easier.

▸ Create a new assembly file. Save the assembly file as newplate.asm.

▸ Drag newplate.par into the assembly window.

▸ Hide the assembly reference planes.

▸ Right-click newplate.par and click Show/Hide Component, and then select the
check box for Reference planes. These will be used to position the systems
library on the plate.

▸ Drag motor_assembly.asm into the assembly window.

▸ The first relationship to be established is the mate between the foot of the motor
and the top face of the plate. Select the top face of newplate.par
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▸ Establish the planar align relationship with the 15 mm offset. Click the front
face of newplate.par.
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▸ Now the Mate relationship between the reference plane of the motor and the
reference plane of the plate is to be established. Click the reference plane shown.
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▸ Place the 10mm_nut.par. Establish the Mate relationship with the bottom plane
of the plate.

Note

Notice that no action is required to place the screws. This is because all
the relationships needed to position the screws were established relative
to the motor.

▸ Click the bottom face of newplate.par.
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▸ Place the Cutout feature and the Round on the plate.

Note

The orientation of the reference plane selected to place the features will be
consistent with the orientation at the time of their creation.

▸ Position the mouse so that the reference plane associated with the top face of
newplate.par highlights. If needed, use the N key to orient the reference plane
as shown, then click.
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▸ The systems library has been placed.

▸ In Assembly PathFinder, right click newplate.par and then click Show Only. You
will see the systems library placed holes for the screws as well as the cutout
and rounds under the motor.

▸ Save, but do not close, this assembly as newplate.asm.
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▸ In Assembly PathFinder, right-click the newplate.asm and then click Show All.
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Place more occurrences of the system library

▸ Repeat the placement ofmotor_assembly.asm on the other 3 sides of newplate.par
as shown. Remember to orient the reference plane correctly when placing the
features.

▸ This completes the activity.
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Activity summary

In this activity you learned how to place components into an assembly and define
them as a systems library. Relationships were, when possible, established to the
first part in the features library. Care was taken in creating profile based features
such that the reference plane was oriented consistently for each feature. When
the systems library was placed, the reference plane orientation for placement was
consistent with the orientation used to create the feature.
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Lesson review
Answer the following questions:

1. What is the definition of a systems library?

2. How are features, such as holes and cutouts linked to the system library?

3. When placing assembly components in an assembly to be used in a systems
library, is it good practice to define as many relationships as possible to a single
component that is part of the systems library?

4. When creating features that will be placed on target components of systems
library, is it good practice to keep the reference plane orientation the same for
each feature?
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Answers
1. What is the definition of a systems library?

A systems library is a group of assembly components and features that can be
repeatedly placed. Features that typically be needed on target parts, such as
cutouts and holes can be stored and placed as the systems library is placed.

2. How are features, such as holes and cutouts linked to the system library?

When creating features to be placed on the target assembly component, the
features are linked by inter-part geometry.

3. When placing assembly components in an assembly to be used in a systems
library, is it good practice to define as many relationships as possible to a single
component that is part of the systems library?

It is good practice to have as many relationships as possible to the one of the
components in the systems library. Relationships that need to vary because of
differences in target part geometry (such as varying plate thickness) do not need
to be defined by the relationships to another member in the systems library.

4. When creating features that will be placed on target components of systems
library, is it good practice to keep the reference plane orientation the same for
each feature?

When creating features that will be placed on target components of systems
library, it is good practice to orient the reference plane the same for each feature.
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Lesson summary
In this lesson you learned how to place components into an assembly and define
them as a systems library. Relationships were, when possible, established to the
first part in the features library. Care was taken in creating profile based features
such that the reference plane was oriented consistently for each feature. When
the systems library was placed, the reference plane orientation for placement was
consistent with the orientation used to create the feature.
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Working with large assemblies
When working with large assemblies, there are tools available to speed up the
process and make work more efficient. This activity will explore those techniques.
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Working with large assemblies efficiently

There are many ways you can improve interactive performance when working with
large assemblies in Solid Edge. This Help topic describes actions you can take to
improve performance when working with large assemblies.

How available memory affects performance

The amount of physical memory available on your computer affects the performance
of all your Windows applications, not just Solid Edge. When the physical memory
is completely allocated, some operations are swapped to virtual memory. Virtual
memory is disk space on your hard drive allocated for use when physical memory
resources are not available.

Virtual memory is much slower than physical memory. When any application has
to swap information between virtual memory and physical memory to complete a
task, system performance slows down considerably. You can improve performance by
increasing available physical memory in the following ways:

• Reduce the demand for physical memory

• Install additional physical memory in your computer

Note

See the readme.htm file in the Solid Edge folder for additional information on
memory recommendations for Solid Edge.

Reducing the demand for physical memory

The easiest way to reduce the demand for physical memory is to close any
applications you are not using. Doing this can speed up any application, not just
Solid Edge.

Note

You can use the Windows Task Manager to evaluate both physical and virtual
memory usage.
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Improving display performance

Display performance in Solid Edge is improved if your computer is equipped with
a graphics board that supports OpenGL acceleration. The shaded display data in
Solid Edge is manipulated directly by OpenGL during dynamic view operations. The
amount of physical memory on the graphics board also affects display performance.

The hidden line display mode in Solid Edge supports multiple processors. If your
computer contains multiple processors, hidden line performance is improved.

The Process Hidden Edge During View Manipulations option in the View tab
in the Options dialog box affects interactive performance during dynamic view
manipulations, such as when dynamically rotating a view. Processing edges during
dynamic view manipulations can negatively impact interactive performance when
working with complex parts or large assemblies. When this option is set, the display
status of edges (whether they are visible, hidden, or silhouette) is continuously
calculated during dynamic view manipulations. When you clear this option, the
display status of edges is suspended during a dynamic view manipulation. When
the dynamic view manipulation is completed, the edges are processed. This can
significantly improve performance.

You can also improve display performance from within Solid Edge Assembly by
controlling which parts in the assembly use physical memory resources. Hiding
and unloading parts frees up physical memory and improves display performance.
Hidden and unloaded parts place the least demand on computer resources.

Using display configurations to hide, unload, and inactive assembly
components

When you are building or modifying a large assembly, you often work in a localized
area, or on a limited number of parts for a period of time. You can use the display
configuration control commands in Solid Edge to make it easier to work and to
improve performance in large assemblies.

For example, you can use the Display Configurations command to capture the
current display status of the assembly components to a name you define. After you
define a display configuration, you can use the Assembly Configuration list on the
Select tool command bar to apply a display configuration. This allows you to quickly
display, hide, inactivate, and unload specific parts and subassemblies.

Each of these display states places a different demand on physical or graphic
memory. Additional configuration control commands are located in several places in
Solid Edge. For example, they are available on the PathFinder shortcut menu and
the Home tab in the Configurations group.

You can determine the current display status for parts and subassemblies using
PathFinder. Unique symbols indicate whether an assembly component is displayed,
hidden, inactive, or unloaded. For a list of these and other symbols used in
PathFinder, see the PathFinder in assemblies Help topic.

Note

If the inactive part or subassembly contains construction surfaces, the
construction surfaces will be automatically hidden. You can redisplay the
construction surfaces by activating the part or subassembly.
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Hiding components

You can hide parts and subassemblies to make it easier to visualize the area you
are working on. This makes your display less cluttered and helps you work
more efficiently because you can locate and select the proper parts quickly.
Hiding components also reduces physical memory demands, which improves
performance.

Unloading components

Once the unneeded parts and subassemblies are hidden, you can also unload
them from physical memory with the Unload Hidden Parts command on the
Tools menu. Unloading hidden parts from memory frees up memory for other
operations, which speeds up Solid Edge Assembly functions.

It also allows you to work with assemblies with higher component counts and
more unique components. In some cases, unloading hidden parts from memory
allows you to open and work with an assembly that would otherwise exceed
the memory limits on your computer.

If you hide and then unload all the parts in a subassembly, the component
structure within the subassembly listing in PathFinder is collapsed. You can use
the plus symbol (+) in PathFinder, the Expand, and the Expand All commands to
redisplay the assembly structure within PathFinder.

Inactivating components

You also can improve performance without hiding parts and subassemblies
by inactivating them. When you inactivate components with the Inactivate
command, they remain displayed but use less physical memory.

Inactivating parts unloads all the feature history and mathematical part
definition and leaves only the graphical representation of the part loaded into
memory. This significantly reduces physical memory requirements, which can
be useful when working with large assemblies.

An inactive part is automatically activated when you use it to position another
part, or when you use the Edit or Open commands to open it in the Part
environment.

You also can inactivate components automatically by setting the Inactivate
Hidden and Unused Components Every XXX Minutes option, which is on the
Assembly tab on the Options dialog box.

Expanding assemblies

The Expand command expands only next level of references for a selected
subassembly. If the subassembly also contains nested subassemblies, the
structure for the nested subassemblies is not expanded.

The Expand All command expands the entire structure for a selected
subassembly, including any nested subassemblies.

You can also use the plus (+) and minus (-) symbols in PathFinder to expand or
collapse subassembly listings in PathFinder.
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Using simplified assemblies

When working with a large assemblies, you can create and use simplified assembly
representations using the commands in the Simplify group on the Tools tab in the
Assembly environment.

A simplified representation of assembly only contains the external shell faces of the
parts in the assembly, which can significantly reduce the memory requirements
required when working with a large, nested assembly. You can then specify that
the simplified representation is used in higher level assemblies, in drawings, and
when opening assemblies.

When working with large, nested assemblies that contain simplified subassemblies,
you should work with the simplified subassemblies inactive whenever possible. This
can significantly reduce memory requirements.

For more information, see the Simplifying assemblies Help topic.

Using zones

You can use the Zone command on the Select Tools tab on PathFinder to define
a named rectangular volume of space. You can then display, hide, and select the
assembly components which are contained within the zone. For example, you can
select a zone in the Select Tools tab, then use the Hide command on the shortcut
menu to hide the assembly components within the zone.

When you add new components to the assembly, they are automatically added to the
zone(s) they fall within.

For more information on zones, see the Using zones in assemblies Help topic.
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Improving performance when opening assemblies

You can use the options on the Open File dialog box to improve performance when
opening a specific assembly. You can also use the Save As Default option on the
Open File dialog box to specify that assemblies you open using Windows Explorer
are opened with the options you set.

• You can open the assembly as read-only, then edit only the portion of the
document where you have responsibility.

• You can set the Hide All Components option to open the assembly with all parts
hidden. You can then display only the parts you want to work with. The fastest
way to open an assembly is with all parts hidden.

• You can select a display configuration from the Configuration list when opening
an assembly. This can improve performance when the display configuration
specifies that only a subset of the assembly components are displayed.

• You can select a zone from the Zones list when opening an assembly. This can
improve performance when the zone definition specifies that only a subset of the
assembly components are displayed.

• You can set the activation status of assembly components with the Apply
Activation Override option on the Open File dialog box. You can then use the
Activate command to activate only the parts you want to work with.

• You can also open the assembly with all parts active, or, by clearing the Apply
Activation Override option, open it with the active/inactive statuses that were in
use when the assembly was last saved.

When you open an assembly with all parts hidden, only the assembly document you
are opening is loaded into physical memory.

When working with an assembly with thousands of parts and dozens of
subassemblies, this can dramatically reduce the time required to open the assembly.
Because these types of large assemblies are typically shared by many users who only
work on specific subassemblies within the top-level assembly, hiding all parts when
opening the assembly allows you to work efficiently with a very large assembly.

When you open an assembly with all components hidden, the subassembly listings
in PathFinder are collapsed. You can open the next level of documents using the "+"
symbol, or you can expand the subassembly listings using the Expand and Expand
All commands on the shortcut menu.

You can expand the listings for only those subassemblies you need, then display or
activate only the parts and subassemblies you need.

Options on the Open File dialog box also enable you to specify whether the simplified
representation of assemblies are used when opening an assembly. When a simplified
representation of an assembly exists, using these options improves file open times.
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Highlighting parts

You can improve large assembly performance by setting the Fast Locate Using Box
Display option on the Assembly tab on the Options dialog box. When you pause your
cursor over a part in the assembly, it will highlight using a rectangular range box,
instead of all of the graphic display elements of the part.

Setting the Fast Locate When Over PathFinder option on the Assembly tab on
the Options dialog box also allows you to improve performance. When you set
this option, the name of the assembly component is displayed in the message field
when you pass the cursor over the component name in PathFinder, but it does
not highlight in the graphics window. When you clear this option, the assembly
component highlights in the graphics window when you pass the cursor over the
component name in PathFinder.

Selecting parts

Solid Edge provides different options for selecting parts in the Assembly environment
using the Select Tool command. Following are short descriptions of the selection
methods and related forms.

Selecting parts with the mouse

The mouse click is the fastest method for selecting single parts. Parts can be
selected either in the graphics window or from PathFinder. To select a part with
the mouse, simply click the part in the graphics window or the part name in
PathFinder. To create a select set of parts, hold down the Shift key and select
multiple parts with the mouse.

Selection Box

This command lets you select a group of parts by drawing a dynamic 3D box
in the graphics window. This button is available only when a single part is
selected. This command is used to quickly select parts that are in the proximity
of another selected part. After creating select sets, you can manipulate them
as a group. For example, the Show Only command on the PathFinder shortcut
menu can be used to hide all parts not selected, leaving on the select set in the
immediate display.

Select All Identical Parts

Selects all the parts in the assembly which are identical to the selected part.

Select Subassembly Parts

Selects all the parts in multiple occurrences of the same subassembly as the
selected part.

Select Small Parts

This command selects parts uses a spin box to select parts dynamically by their
respective size as a percentage of the entire assembly size. Use the up and down
arrows on the box to increase or decrease the size criteria.

Select Visible Parts

This option selects only those parts that are fully or partially visible in the
graphic window.
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Select Parts Constrained To

Selects parts that are constrained to one or more previously selected parts. This
option is available after you select one or more parts. This can make it easier
to perform operations on a related set of parts. For example, you can select a
set of parts constrained to a part, then use the Show Only option to hide the
remaining parts in the assembly.
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Simplifying parts

When working with an assembly, it can be useful to work with a simplified version
of a complex part. For example, a part that contains numerous rounds, chamfers,
and holes will process more slowly than a part from which these features have been
removed.

The commands in the Simplify Model environment allow you to reduce the
complexity of a part so that it processes more quickly when used in an assembly.
The ultimate goal of part simplification is to reduce the total number of surfaces
that make up the part.

You can also control whether the simplified version or the designed version of the
part is displayed in the assembly.
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Simplifying parts

You access the commands for simplifying a part using the Simplify command on the
Tools tab in the Part and Sheet Metal environments. When you set the Simplify
command, commands that can be used for simplifying a part are activated, and
commands that are not appropriate for simplifying a part are disabled. For example,
the commands on the Delete list on the Home tab in the Modify group are available
for deleting faces, regions, and so forth.

After you have simplified a part, you can return to the Part or Sheet Metal
environment with the Design command on the Tools tab.

You can also simplify a part by adding extruded and revolved protrusions, and
extruded and revolved cutouts. Feature construction commands are included in
the Simplify Model environment because sometimes it can be easier to simplify a
part by adding one new feature than deleting many features. For example, you can
construct one protrusion that obstructs several features, which then eliminates
dozens of surfaces in one operation.

The features you create in the Simplify Model environment are added to the
Simplify section of the PathFinder tab in the part document. You can also use the
commands on the shortcut menu within PathFinder to manipulate the simplified
features you construct.

Direct editing and simplifying compared

Many of the commands available when directly editing a part are also available when
simplifying a part in the Simplify Model environment. Deciding whether to directly
edit the model or simplify the model is determined by whether you want to have
access to a simplified version of the part in an assembly or when creating a drawing.

If you want to use a simplified version of the part in an assembly or a drawing,
you must set the Simplify command. No simplified version of the model is created
when you directly edit a model.
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Saving simplified parts to a separate file

You can save the simplified representation of the part out to a separate file using
the Save Model As command on the Application menu. The Save Model As dialog
box allows you to specify a file name, folder location and file format. You can save
the new document as a Solid Edge document or as a Parasolid body, and it is not
associative to the original model.

Simplified parts in assemblies

When placing a part in an assembly, you can place it using the simplified version of
the part, or the designed version of the part. When you set the Use Simplified Parts
command on the Parts Library shortcut menu, the simplified version of the part is
displayed when placing the part in an assembly. Any faces that you deleted when
simplifying the part will not be available for positioning the part in the assembly. To
make these faces available for positioning, clear the Use Simplified Part command
before placing the part.

When working with simplified parts in an assembly, you can control whether the
simplified version or as-designed version of the part is displayed. If you place the
same part in an assembly more than once, you can control the display for each
instance of the part individually. When you select a part in the assembly, you can
use the Use Designed Part and Use Simplified Part commands on the shortcut menu
to control which version of a selected part is displayed.

Note

The Use Simplified Part command is not available for parts that were selected
for an assembly feature, whether the parts were modified by the assembly
feature, or not modified.
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Simplified parts in PathFinder

The symbols adjacent to each part in the PathFinder tab in an assembly change to
indicate whether the simplified version or designed version of the part is currently
displayed.

Locating edges in simplified models

In some cases there may be edges in a simplified part that are not locatable. This
occurs when the simplified version of the part creates edges that do not have
corresponding design edges.

When this occurs you will not be able to locate an edge on a simplified part when
placing a dimension or relationship, or when including an edge.

Location of these edges is purposely prevented to ensure stability of the model in
downstream operations.
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Simplifying assemblies

When working with a large, complex assembly, it can be useful to work with a
simplified version of the assembly. For example, a large assembly with many
subassemblies can process slowly.

The commands in the Simplify group on the Tools tab in the Assembly environment
allow you to create an exterior shell of faces that represents the assembly envelope,
and exclude selected parts.

A simplified assembly processes more quickly when used in a higher level assembly
or a drawing. You can also control whether the as designed or simplified assembly
representation is used in other documents and when opening an assembly. This
allows you to work with larger data sets more efficiently.

You can also save the simplified representation of the assembly to a new document
name. This can make it easier to share or protect proprietary information when
exchanging data with other companies that need access to your data.

Simplified assemblies and memory usage

When you create a simplified representation of an assembly, the data storage
requirements for the assembly document increase because the surface data for the
simplified representation is stored in the assembly document.

The size increase required to support the simplified representation is small when
compared to the size requirements of all the documents that make up the assembly.

When you place a simplified assembly document as a subassembly into another
assembly, the memory requirements required to display the higher level assembly
drop dramatically. This improves performance and also allows you to work with
larger data sets more effectively.

This performance improvement also applies when creating a drawing of a simplified
assembly. Because less memory is required to support the simplified data set, the
drawing views will process quicker.

For more information on working with simplified assemblies in Solid Edge, see the
Simplified assemblies best practices Help topic.
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Simplifying an assembly

You access the commands for simplifying an assembly using the Simplify Assembly
command on the tools tab in the Model group. The Simplify commands allow
you to create and update the simplified representation and save the simplified
representation as a separate document. After you have simplified the assembly, you
can return to the Assembly environment using the Design Assembly command on
the Tools tab in the Model group.

When you create a simplified representation of an assembly, an entry is added to
PathFinder to indicate that a simplified representation of the assembly exists.

Creating the simplified representation

The Create Simplified Assembly command allows you to process the assembly to
show only the exterior envelope of faces and to exclude parts, such as small parts,
which reduces the total number surfaces that make up the assembly. The simplified
assembly representation is associative to the components in the assembly.

Updating simplified assemblies

When you make design changes to assembly components, you must use the Update
Simplified Assembly command to update the simplified representation before the
design changes are displayed in a higher level assembly or drawing that uses the
simplified representation.

Saving the simplified representation as a document

You can use the Save Model As command on the Application menu to save the
simplified representation of the assembly as a new Solid Edge Part document
(*.PAR) or as a Parasolid document.

This can be useful when another company uses your assembly as a part in their
assemblies. This reduces the data-management and transfer requirements to a
single document, and it can also protect any proprietary information that a complete
assembly might reveal.

Using simplified assemblies

You can specify whether the as designed version or the simplified representation of
the assembly is used in many down-stream operations. In some cases, other Solid
Edge functionality requires that the as designed version is used. For example, you
cannot create a simplified assembly representation of an alternate assembly.

If you have already created a simplified assembly representation, then try to convert
the assembly to an alternate assembly, a message is displayed to warn you that the
simplified representation will be deleted.
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Placing simplified assemblies in other assemblies

When you place an assembly as a subassembly in another assembly, you can specify
whether the assembly is placed using the as designed or simplified version. The Use
Simplified Assemblies command on the Parts Library shortcut menu allows you to
specify how the assembly is placed. When you place the simplified version of the
assembly, only the faces that comprise the simplified representation of the assembly
are available for positioning the assembly using assembly relationships.

You can use the commands on the PathFinder shortcut menu to specify whether the
as designed or simplified version of a subassembly is used. You can control each
subassembly in an assembly individually. This allows you to display the as designed
version of a subassembly when needed, and then switch to the simplified version of
the subassembly later to improve performance.

Inactivating Simplified Subassemblies

When working with large, nested assemblies that contain simplified subassemblies,
you should work with the simplified subassemblies inactive whenever possible. This
can significantly reduce memory requirements.

You can use the Inactivate and Activate commands on the PathFinder shortcut
menu to inactivate and activate a simplified subassembly. When placing or editing
relationships, you can use the Activate button on the Assemble command bar to
activate a simplified subassembly.

Creating drawings of simplified assemblies

When creating or modifying drawing views of an assembly, options on the Drawing
View Wizard and Drawing View Properties dialog box allow you to control how
simplified assembly representations are applied.

Opening simplified assemblies

When opening an assembly, options on the Open File dialog box allow you to control
how simplified assembly representations are applied.

Moving simplified assemblies

Because the simplified representation is considered a construction body, collision
detection is not available using the simplified representation.

Checking interference on simplified assemblies

Because the simplified representation is considered a construction body, interference
detection is not available using the simplified representation.

Simplified assemblies best practices

When considering whether to simplify an assembly, there are several factors that can
determine whether you receive the maximum benefit from assembly simplification.
This Help topic discusses these factors.
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Simplify both parts and assemblies

Using simplified parts in conjunction with a simplified assembly improves simplified
assembly performance in the following ways:

• Faster creation of the simplified assembly representation because there are
fewer total surfaces to evaluate.

• Reduced assembly document size, which reduces memory demand.

When you simplify parts before simplifying the assembly, you are reducing the total
number of surfaces which must be evaluated during assembly simplification. This
allows the assembly simplification process to complete faster.

The wide range of commands available for part simplification also allow you better
control over which part surfaces are removed prior to assembly simplification. For
example, there may be holes and cutouts on an exterior part that are not necessary
in the simplified assembly. If these holes and cutouts expose interior faces, the
interior faces will be included in the simplified assembly.

By simplifying the exterior part to remove the holes and cutouts, the simplified
assembly representation will contain fewer surfaces, which reduces file size and
memory demands.

Simplify assemblies that contain enclosures

Some assemblies are better suited to assembly simplification than others. In general,
assemblies that have many interior components are better candidates for assembly
simplification. This is because assembly simplification processes the assembly to
show only the exterior envelope of faces and by excluding small parts.

For example, assembly (A) is an ideal candidate for assembly simplification because
there are many complex components enclosed by the exterior housing. The exterior
housing itself also contains many interior surfaces that would be excluded by
assembly simplification.

Assembly (B) is a poor candidate for assembly simplification because there are few
interior surfaces and no interior components to exclude. If assembly (B) is also
used in a higher level assembly, where assembly (B) is enclosed, that higher level
assembly may be a better candidate for simplification.
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Open assemblies with simplified subassemblies

When you open an assembly that contains simplified subassemblies, you can specify
whether the assembly is opened with the subassemblies simplified or as designed.
When you open an assembly with the subassemblies simplified, file open times
are improved.

Simplify deeply nested assemblies

The more subassemblies and parts an assembly has, the more likely the assembly
is a good candidate for simplification. When you open a large assembly with many
subassemblies that have been simplified, file open performance is improved.

Inactivate simplified subassemblies

When working with large, nested assemblies that contain simplified subassemblies,
you should work with the simplified subassemblies inactive whenever possible. This
can significantly reduce memory requirements.

Avoid simplifying top-level assemblies

The simplified assembly representation is stored in the assembly document in which
it was created, which increases the file size. An assembly that has been simplified
will open slower than an identical assembly which has not been simplified.

This means that the top-level assembly itself does not benefit from assembly
simplification.

Although performance is improved when creating drawing views of a top-level
assembly that has been simplified, in most cases this performance improvement does
not offset the performance impact when opening the top-level assembly.
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Activity: Using Simplified Assemblies

Overview

The objective of this activity is to show how a large assembly can be simplified.

Activity

In this activity you will create a simplified assembly.
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Activity: Creating a simplified assembly

Overview

This activity demonstrates the creation of a simplified assembly.

Objectives

The objective of this activity is to take a large assembly and create a simplified
version to be used in a higher level assembly to make processing more efficient.

Open an existing assembly

The clock assembly has many internal parts that do not need to be represented in a
higher level assembly.

▸ From the Solid Edge start screen, click Open Existing Document. Browse for
clock.asm in the folder where the activity files are located.

▸ Click Tools tab®Model group®Simplify command.

▸ Click Tools tab®Simplify group®Create command .

▸ On the Create Simplified Assembly command bar, select the Options button

and review the colors that are assigned to the simplified assembly.

▸ Click the Analyze Assembly button , and then click Process.

▸ Click Preview.
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▸ Click Finish. The simplified assembly is created and ready to be used.

▸ Click Tools tab®Model group®Design command .

This restores the assembly to the design state.

▸ Save and close the assembly. This completes this activity.

Summary

In this activity you learned how to simplify an assembly. The simplified version can
be used in a higher level large assembly, and is more efficient because the interior
details do not have to be shown.
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Lesson review

Answer the following questions:

1. What is a simplified assembly?

2. Why is a simplified assembly desirable?

3. Can a simplified assembly be saved as a Solid Edge Part Document? Why is
this desirable?

4. Generally, what type of assembly is better suited as a candidate for
simplification?
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Answers

1. What is a simplified assembly?

A simplified assembly shows only the exterior envelope of faces and excludes
parts, such as small parts, which reduces the total number surfaces that make
up the assembly. The simplified assembly representation is associative to the
components in the assembly.

2. Why is a simplified assembly desirable?

When you place a simplified assembly document as a subassembly into another
assembly, the memory requirements required to display the higher level
assembly drop dramatically. This improves performance and also allows you to
work with larger data sets more effectively.

3. Can a simplified assembly be saved as a Solid Edge Part Document? Why is
this desirable?

Yes the simplified assembly can be saved as a Solid Edge Part Document.

This can be useful when another company uses your assembly as a part in their
assemblies. This reduces the data-management and transfer requirements to
a single document, and it can also protect any proprietary information that a
complete assembly might reveal.

4. Generally, what type of assembly is better suited as a candidate for
simplification?

Assemblies that are enclosures with many internal parts are generally good
candidates for simplification.
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Lesson summary

In this lesson you learned how to simplify an assembly. The simplified version can
be used in a higher level large assembly, and is more efficient because the interior
details do not have to be shown.
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Using zones in assemblies

It can be useful to define a set of components in an assembly based on the volume
of space the parts occupy. The Zones functionality on the Select Tools page in Solid
Edge allows you to define a rectangular volume of space based on one or more
assembly components you select. You can then use that named zone to select,
display, or hide all the assembly components that are contained within the boundary
of the zone. For example, you can select a named zone on the Select Tools page, then
click the Hide Components command on the shortcut menu to hide all the assembly
components in the zone.

Note

You can use a zone to show, hide, and select parts, assemblies, assembly
sketches, weld beads, coordinate systems, and reference planes in an assembly.
Defining and using zones is especially useful when working with large
assembly data sets. For more information on working with large assemblies,
see the Working with large assemblies efficiently Help topic.

Defining zones

You define a zone using the Create Zone command on the Select Tools page. When
you click the Create Zone button, a command bar is displayed, with the Origin and
Size Step active, which allows you to define the initial volume of the zone by selecting
one or more assembly components. The range box of the design body of each selected
component is used to calculate the zone box volume.

Note

Construction bodies and simplified bodies are ignored when calculating zone
box volume.
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You can select the components in the PathFinder page or the graphics window. For
example, you can select a subassembly (A) using PathFinder. When you click the
Accept button, a zone boundary box is displayed in the graphics window (B). The
command bar then advances to the Modify Size Step, which allows you to further
refine the size of the zone.

To change the size of the zone during the Modify Size Step, you can select a face on
the zone box, and then select a keypoint on an adjacent part or a point in free space.

To control which components are included in the zone, you can specify whether the
zone definition is inside or overlapping using the options on the command bar.

When you finish defining a zone, a zone boundary box is displayed in the graphics
window (B), and a zone name is added to the Select Tools page. You can also edit
the size of a zone later.

The zone boundary box volume is not associative to the parts used to define the
zone. If you move, edit, or delete the parts used to define the zone, the size of the
zone boundary box remains the same.

Note

When you create the first zone in an assembly, the assembly structure must
be updated. A message is displayed to warn you that updating the assembly
structure may take several minutes, depending on the size of the assembly.
For more information, see the Updating the assembly structure section of
this Help topic.

Modifying zones later

You can edit the size of a zone later using the Edit Definition command on the
shortcut menu when you select a zone entry in the Select Tools page, or a zone box in
the graphics window. If you click the Origin and Size Step on the command bar, you
can select new parts to redefine the zone boundary. If you click the Modify Size Step,
you can edit the size of the zone boundary as described earlier.
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Displaying zone boundary boxes

The zone box can be displayed or hidden in the graphics window.

• You can use the zone shortcut menu commands to show and hide a zone
boundary box display when you select a zone entry on the Select Tools tab or in
the graphics window.

• You can show or hide all the zone boundary boxes using the View tab®Show
group®Zones command.

Using zones

Shortcut menu commands in the Select Tools page allow you to show only, show,
hide, and select the components in a zone. You can also show all the parts in a zone
by double-clicking a zone box in the graphic window.

A part can belong to one or more zones. As you add new components to an assembly,
the components are automatically added to the zone(s) they fall within.

Drawing views of assembly zones

You can use the Drawing View Wizard to select an assembly zone volume to be
shown in a drawing view. The assembly zone captures any part components that
exist within the predefined volume.

You can choose an assembly zone from the .cfg, PMI model view, or Zone list on the
Drawing View Options page of the Drawing View Wizard.

Zones and display configurations

The functionality of zones and display configurations differ in a number of ways. For
more information, see the Comparing display configuration and zones section of the
Displaying parts in assemblies Help topic.

Updating the assembly structure

When working with zones, assembly components that are considered to be inside
or outside a zone is accurate as long as the assembly structure is up to date. The
assembly structure can become out of date when multiple people are working on
different subassemblies, and you then open a higher level assembly with some of
those changed subassemblies hidden. For example, on the Open File dialog box,
there are options that allow you to open an assembly using a display configuration,
a zone, or with all components hidden.

You update the assembly structure using the Update Assembly Structure button
on the Select Tools page. When you click the Update Assembly Structure button,
the entire assembly structure is loaded into memory to ensure that the assembly
structure is up to date.

Note

Updating the assembly structure can take several minutes, depending on the
size of the assembly.
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Activity: Working with zones

Overview

The objective of this activity is to demonstrate how to use zones to make moving
around in assemblies more efficient.

Activity

In this activity you will open an assembly with a zone, modify a zone and create
a new zone.
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Activity: Working with zones

Overview

This activity demonstrates the use of zones in a large assembly.

Objectives

You will create and manipulate zones in a large assembly.

Open an existing assembly using zones

The assembly you will open has two zones defined. You will open the assembly
using a zone, and then add a new zone.

▸ From the Solid Edge start screen, click Open Existing Document. Browse for
frame.asm in the folder where the activity files are located. In the Open File
dialog box, set the zone to right_front_tire as shown.
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▸ Observe the assembly showing the zone right_front_tire.
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▸ In the PathFinder tab set, on the Select Tools tab, right-click the zone
right_front_tire, and then click Show Zone Box.

Note

If PathFinder does not contain the tab you are looking for, such as Select
Tools, Parts Library, or Alternate Assemblies, you can display it by doing
either of the following:

• Choose View tab®Show group®Panes , and then select the tab name
from the menu.

• In any of the other open docking windows, such as the Layers tab or the

Sensors tab, click the Display Docking Window Menu button , and
then select the tab name.
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▸ Select the zone box and then click Edit Definition as shown.

▸ On the command bar, change the Zone Filter from Overlapping to Inside, and
then click Show Components. Observe the results. The parts that are not fully
contained in the zone are not shown.

▸ Click Finish to complete the editing of the zone.

Modifying the extent of a zone

The extent of an existing zone will be modified.

5-32 Solid Edge assembly mt01416-s-1040



Working with large assemblies

▸ On the Select Tools tab, right-click the zone right_rear_tire and then click Show
Components.
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▸ On the Select Tools tab, right-click the zone right_rear_tire and then click Show
Zone Box.
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▸ Edit the definition of the zone right_rear_tire just as you did for the
right_front_tire zone. Set the Zone Filter to Overlapping and click Show
Components.

▸ On the Edit Definition command bar, click Modify Size Step .
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▸ Select the face shown.
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▸ Drag the face to the approximate position shown.

Note

To precisely position the face, use a keypoint on some existing geometry.
The part has to be active for the keypoint to be available to use.
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▸ Click Next.

▸ Set the zone filter to Overlapping and then click Show Components. Click Finish.
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▸ On the Select Tools tab, select both zones. Right-click and select Hide Zone Box.
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▸ In Assembly PathFinder, right-click frame.asm, and then click Show.

Create a new zone

Create a new zone for the left rear tire assembly.
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▸ In PathFinder, right-click the subassembly rear_wheel_assembly_left.asm, and
then click Activate.

▸ In Pathfinder, right-click the subassembly rear_wheel_assembly_left.asm, and
then Show Only.

▸ On the Select Tools tab, click the Create Zone command .
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▸ In the Select Parts Step, select rear_wheel_assembly_left.asm in Pathfinder,
and then click Accept.

▸ Click Next. Name the zone rear_wheel_assembly, and then click Finish. The
new zone is created.

▸ Save and close the assembly. This completes the activity.
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Summary

In this activity you learned how to use zones to narrow down a specific volume of an
assembly to focus your work on.
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Lesson review

Answer the following questions:

1. What is a zone?

2. Where are the zone commands located?

3. Can the extent of a zone be modified?

4. What options determine which components are displayed within the volume of
a zone?

5. Is there an option to direct an assembly to be open using a zone?

6. Can zones be used to display components using the display configuration dialog
box?
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Answers

1. What is a zone?

A zone defines a set of components in an assembly based on the volume of space
the parts occupy.

2. Where are the zone commands located?

Zones can be created and maintained on the Select Tools tab in Pathfinder.

3. Can the extent of a zone be modified?

The extent of a zone can be modified by moving one of the rectangular faces.
Component key points can be used to position the zone face.

4. What options determine which components are displayed within the volume of
a zone?

Two options exist for displaying components that reside within the volume of a
zone. These are:

• Inside, which displays only those components 100% contained within the
volume defined by the zone.

• Overlapping, which displays all the components that have any portion
contained within the volume defined by the zone.

5. Is there an option to direct an assembly to be open using a zone?

In when opening an existing assembly, there is an option which specifies which
existing zone will control the display of components after the assembly is opened.

6. Can zones be used to display components using the display configuration dialog
box?

Zones can be chosen from the display configuration dialog box.
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Lesson summary

In this lesson you learned how to use zones to narrow down a specific volume of an
assembly to focus your work on.
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Using display configurations

You can save display configurations of an assembly and exploded views of an
assembly. When you save a display configuration with the Display Configurations
command, the current display status is stored so you can use it later.

Note

Display configurations store both the show/hide and the simplified/designed
status of the parts in the assembly.

For example, if you hide several parts in an assembly, you can save the display
configuration to a name you define. Later, if you want to quickly hide the same
parts, you can apply the display configuration using the Configuration drop list on
the Home tab in the Configurations group. You can also save, apply, edit, and delete
display configurations using the Display Configurations dialog box.

You can also apply a saved display configuration when doing the following:

• Opening an assembly document

• Placing a subassembly in another assembly

• Creating a drawing of an assembly

• Creating a drawing of an exploded assembly

Display configurations are stored in a document that has the same name as the
assembly document, but with a (.CFG) extension. The configuration document is
stored in the same folder as the assembly document.

Note

To support concurrent design, the configuration file allows multiple users to
simultaneously add, delete, and edit display configurations.

Using display configurations effectively

Both assembly configurations and exploded view configurations are saved to the
same configuration file. To use display configurations effectively, your company
should define a naming convention so all users can easily distinguish between types
of configurations.

Note

You should avoid using special characters in configuration names. For
example, special characters such as \ / : ! are not allowed.

You can apply an assembly configuration to an exploded view to control the
show/hide status of the parts and subassemblies. You cannot apply an exploded view
configuration to a regular assembly window. For this reason, configuration names of
exploded views are not displayed in the Configuration list on the Home tab when you
are working in a regular assembly window.
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Using a display configuration to open a document

When working with large assemblies, you can open the document faster if you use a
display configuration where some parts and subassemblies were hidden or where
simplified versions of the parts were defined. To apply a display configuration when
you open an assembly, use the Configuration list on the Open File dialog box.

Using a display configuration to place a subassembly

You can select an assembly configuration name in the Use Configurations dialog box
when placing a subassembly into an assembly. Subassemblies will place faster and
can be easier to visualize if you apply a configuration where parts not necessary for
placement are hidden. Exploded view configuration names are not displayed in the
configuration list on the Use Configurations dialog box.

To use a display configuration when placing a subassembly, you must first set
the Use Configurations command on the Parts Library shortcut menu. When you
set this option and then drag and drop a subassembly into the assembly, the Use
Configuration dialog box is displayed so you can select the configuration name you
want to use.

Using display configurations in the Draft environment

You can use both assembly and exploded view configurations when creating drawings
in the Draft environment. When you click the Drawing View Wizard command and
select an assembly document from the Select Model dialog box, you can also select an
assembly configuration or an exploded view configuration. When you select either
configuration type, the drawing view will be placed with the parts displayed or
hidden as they were when the configuration was saved.

You can also use display configurations to control the display of weld beads and
material addition features in an assembly drawing view. For example, you can
hide the display of weld beads and material addition features, then save a display
configuration. You can then use the display configuration to place a drawing view of
the assembly with these features hidden.

Using display configurations in alternate assemblies

Display configurations are available when working with alternate assemblies. The
behavior of display configurations based on whether you specify that the alternate
assembly is a family of assemblies or an alternate position assembly.

Family of assemblies

For a family of assemblies, a display configuration is member-specific. In other
words, the family of assembly member which is active when you create the
display configuration is the only member in which you can use the display
configuration later. The Configuration list on the Home tab filters the available
display configurations automatically.

Alternate position assemblies

For alternate position assemblies, display configurations are not member-specific.
In other words, you can use any display configuration for any active member.
The Configuration list on the Home tab displays all the display configurations.
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Zones and display configurations

The functionality of zones and display configurations differ in a number of ways. For
more information, see the Comparing display configuration and zones section of the
Displaying parts in assemblies Help topic.
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Displaying parts in assemblies

When you work with complex or unfamiliar assemblies, it is often useful to change
the display of the parts and subassemblies. Solid Edge makes it easy to hide and
display the components in your assembly so you can work more efficiently.

Displaying and hiding assembly components

The display commands in the Assembly environment are especially useful when you
work with large assemblies. For example, you may want to hide most of the parts in
an assembly to make it easier to place a new part. You can select the parts to display
using the PathFinder tab, then use the Show Only command to hide all other parts.

For more information, see the Working with large assemblies efficiently Help topic.

Note

When you hide parts or subassemblies in the active assembly, the symbols in
PathFinder change to indicate that the components are hidden.

Saving and applying display configurations

After you hide parts or subassemblies, you can save the display configuration with
the Display Configuration command. You can quickly apply a saved configuration
to a view using the Configuration list on the Home tab in the Configurations
group. Avoid using special characters in configuration names. For example, special
characters such as \ / : ! are not allowed.

For more information, see the Using display configurations Help topic.

Using zones

You can also use zones to show, hide, and select assembly components, such as parts,
assemblies, layouts, weld beads, and reference planes.

For more information, see the Using zones in assemblies Help topic.

Comparing display configurations and zones

Both display configurations and zones are useful tools to manage component
display in assemblies. The following information compares and contrasts display
configurations and zones.

Display configurations

A display configuration allows you to control the display status of assembly
components regardless of the components physical location in the design space.

If you add components to the assembly, they are not added to an existing display
configuration. You must apply the configuration, display the components you
want to add to the configuration, then resave the configuration. When working
in large, nested assemblies, shared by multiple users, it can sometimes be
difficult to keep track of efficiently.

When working with a family of assemblies, you can create member-specific
display configurations.
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Zones

A zone allows you to show, hide, and select assembly components based on a
rectangular volume of space you define when you create the zone. As you add
new components to the assembly, they are automatically added to any existing
zones they fall within.

You can edit the physical size of a zone later to include or exclude components.

When working with a family of assemblies, the zones functionality is not
available.

Part display and system performance

When you work with large assemblies, you can improve system performance by
hiding parts and subassemblies you are not using. For example, display commands
such as Zoom, Zoom Area, and Pan work faster if you hide parts. Assembly
documents also open faster if parts have been hidden.

Note

You can improve performance by using the Unload Hidden Parts command to
unload the hidden parts from memory.

Displaying and hiding parts during editing

When you in-place activate a part or subassembly to make changes, the remaining
parts and subassemblies are still displayed, but they change color to make it easier
to focus on the part you are editing. You can use the Hide Previous Level command
on the View tab to hide other parts and subassemblies while you edit the part.

For example, suppose you are working in assembly A1 and need to make changes in
subassembly S2.

You can select subassembly S2 in PathFinder, then click the Edit command on the
shortcut menu to in-place activate subassembly S2. In subassembly S2, you can still
see all the parts and subassemblies, but the parts and subassemblies that are not in
subassembly S2 are dimmed.
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You can use the Hide Previous Level command on the View tab to hide the other
parts and subassemblies as shown below.

If you then in-place activate part P3 in subassembly S2, you also can hide the
remaining parts in subassembly S2 using the Hide Previous Level command. The
result would be similar to the following illustration.

To redisplay the hidden parts, select the Hide Previous Level command again.
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Displaying and hiding specific geometry for assembly components

You can also control the display of a selected part or subassembly’s reference planes,
sketches, coordinate systems, reference axes, construction surfaces, and construction
curves. You can use the Show/Hide Component commands on the shortcut menu to
display and hide these element types for one or more selected parts. For example,
you can select a part, then on the shortcut menu, point to Show/Hide Component,
then click Construction Surfaces to display or hide all the construction surfaces for a
part. A checkmark is displayed adjacent to the command name when a component is
displayed. You can also display an assembly component based on how it was saved
using the As Last Saved command on the Show/Hide Component shortcut menu.

Similarly, when nothing is selected you can also hide the reference planes, sketches,
reference axes, construction surfaces, or construction curves for all the parts in an
assembly using the commands on the Hide All shortcut menu. For example, to
hide the sketches for all parts in the assembly, on the shortcut menu point to Hide
All, then click Sketches.

Note

When you display or hide reference planes, sketches, coordinate systems,
reference axes, construction surfaces, and construction curves for a part
or subassembly, the current display status for these element types is not
captured in a saved display configuration.

You can also control the display of part geometry while you place a part or edit its
position in the assembly. The Construction Display option on the Assemble command
bar allows you to display and hide reference planes, coordinate systems, and so forth
for the placement part or the target part.
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Configuration Manager command

Configuration Manager is used to manage changes in configurations. With the
Configuration Manager command, when parts are added to or deleted from
subassemblies, the configurations in the top level assembly can easily find the
changes in the subassemblies and allow the current configurations to incorporate
these changes.

Configuration Manager is useful when using large assemblies, nested assemblies, or
assemblies being shared by several designers.

For more information, see the Using display configurations and Working with large
assemblies efficiently Help topics.

Note

Exploded configurations can only be edited in the ERA environment.
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Configuration Manager dialog box

Edits a display configuration in the active assembly and searches for changes in
subassemblies.

Dialog Box Options
Configuration file
Displays the name of the current configuration file, which contains configuration
names and display information. You can type a name or use the Browse button
to find another configuration file.

Find Previous New Component
Moves the selection up the list of components and stops at a new component not
currently listed in the display configuration. Use the check box to include or
exclude the component into the display configuration.

Find Next New Component
Moves the selection down the list of components and stops at a new component
not currently listed in the display configuration. Use the check box to include or
exclude the component into the display configuration.

Clean Up Deleted Components
Finds Components that were deleted and removes them from the display
configuration.

Browse
Accesses a dialog box that allows you to search for an existing configuration.

Save
Saves the configuration to the current configuration file.

Cancel
Cancels changes made before saving.
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Activity: Using configurations in assembly

Overview

The objective of this activity show how configurations can be used to make
working in an assembly more efficient.

Activity

In this activity you will open an assembly with predefined configurations. You
will use these to change the display and assembly parameters of the assembly.
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Activity: Using configurations in assembly

Overview

This activity demonstrates the use of configurations in a large assembly.

Objectives

You will create and manipulate configurations in a large assembly.

Open an existing assembly using configurations

The assembly has several display configurations defined for it. You will open the
assembly using one configuration, and then add a new configuration.

▸ On the Solid Edge start screen, click Open Existing Document. Browse for
frame.asm in the folder where the activity files are located. In the Open File
dialog box, from the Configuration list, select all_parts_shown.
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▸ Observe in Assembly PathFinder that all the subassemblies and parts are
displayed. Not all the parts are active.

Changing configurations

There are several existing configurations in the assembly. You will change the
configuration and observe the result.

▸ Click Home tab®Configurations group®Configuration Options .
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▸ In the Display Configuration Options dialog box, select Apply activation override
and Activate all parts. This activates all the parts when selecting a configuration.

▸ Click Home tab®Configurations group®Display Configuration ..

▸ In the Display Configurations dialog box, select deck_assembly, click Apply,
and then click Close. Observe PathFinder and notice just the assembly making
up the deck is shown. Because of the activation override, all the parts in the
assembly are active.
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Change the configuration

Add a few more parts to the current configuration.

▸ In PathFinder, expand the subassembly rear_wheel_assembly_right.asm and all
the subassemblies contained within it. Display all the parts in the subassembly.

▸ Click Home tab®Configurations group®Display Configuration .
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▸ In the Display Configurations dialog box, select deck_assembly, click Update,
and then click Close. The configuration now has the display of the subassembly
rear_wheel_assembly_right.asm.

Note

The update can quickly be applied using the Save Display Configuration
button.
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▸ On the Home tab in the Configurations group, click the arrow beside the Current
Configuration list to see a menu of all the available display configurations.
Select the two shown.

Note

Using the Current Configuration list, you can combine display
configurations, and you can select zones.

▸ Practice turning on and off configurations using this menu. Also, display some
parts in PathFinder, and update a configuration to include those parts.

Configurations in the Explode-Render-Animate environment.

Configurations used to explode a part are not visible until you display the
Explode-Render-Animate environment.

▸ Choose the Tools tab®Environs group®ERA command.

▸ Click Home tab®Configurations group®Current Configuration list, notice that
now the explode configurations are available. Select the one shown.

Note

Notice the exploded view stored in the configuration is displayed.

▸ Click Close ERA to exit the ERA environment.
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More tips for working with large assemblies

There are more tools available to speed up working in large assemblies. Some
of these are there to enhance performance. Others are there to prevent you from
loading in more information that you really need to perform certain tasks. Here we
will look at these tools.

▸ Click the Application button, and then click Solid Edge Options. On the General
tab, review the circled items, which can be used to improve performance.
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▸ On the Assembly tab, the boxed items are options that can speed up performance.

▸ On the Home tab, in the Configurations group, notice the Unload command. Use
this command to inactivate any hidden parts.

▸ Save and close the assembly.

▸ On the Solid Edge startup screen, on the Open File menu, there are several
options available for speeding up the opening of large assemblies. These can be
set as the default so that this happens each time an assembly is opened.
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▸ This completes the activity.

Summary

In this activity you learned the following:

• How to use configurations to narrow down a specific volume of an assembly
to focus your work on.

• Options available to enhance performance when opening large assemblies, or
working in them.
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Lesson review

Answer the following questions:

1. What is a display configuration in an assembly?

2. Where are display configurations stored?

3. Are new parts added to an assembly automatically added to a display
configuration?

4. If a subassembly has parts removed from it, how can a display configuration
be updated to reflect these changes?

5. When creating an exploded view to place on a drawing sheet, where is the
information about how to display the exploded view stored?
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Answers

1. What is a display configuration in an assembly?

A display configuration allows you to control the display status of assembly
components regardless of the components physical location in the design space.

2. Where are display configurations stored?

Display configurations are stored in a .cfg file external to the assembly.

3. Are new parts added to an assembly automatically added to a display
configuration?

If you add components to the assembly, they are not added to an existing display
configuration. You must apply the configuration, display the components you
want to add to the configuration, then resave the configuration. When working
in large, nested assemblies, shared by multiple users, it can sometimes be
difficult to keep track of efficiently.

4. If a subassembly has parts removed from it, how can a display configuration
be updated to reflect these changes?

Configuration manager contains tools that remove deleted parts in subassemblies
from a display configuration.

5. When creating an exploded view to place on a drawing sheet, where is the
information about how to display the exploded view stored?

Exploded view display parameters are saved in a display configuration. These
displays can be viewed in the explode, render and animate environment.
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Lesson summary

In this lesson you learned the following:

• How to use configurations to narrow down a specific volume of an assembly
to focus your work on.

• Options available to enhance performance when opening large assemblies, or
working in them.
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Inspecting assemblies
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Introduction

Solid Edge supports a variety of tools to inspect and analyze assemblies. Covered
here are:

• Motion

• Collision detection

• Sensors

• Mass properties
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Objectives

After completing this lesson, you should be able to:

• Assign material densities to different parts and calculate a center of mass and
weight of an assembly.

• Use motion to analyze and detect collisions in unconstrained parts.

• Establish sensors to warn if an unconstrained part is violating a set parameter
as it moves.
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Physical properties of parts and assemblies

You can calculate the following physical properties of parts and assemblies:

• Volume

• Mass

• Center of volume

• Center of mass

• Surface area

• Orientation of the principal axis

• Mass moments of inertia

• Radii of gyration

Note

You can calculate surface area only for parts.

Center of mass, center of volume, mass moment of inertia, and principal axis
coordinates are output with respect to the global coordinate system. Principal
moments of inertia and radii of gyration are output with respect to the principal axes.

Physical property symbols

The Physical Properties command places symbols on the part or assembly to show
the center of mass location, center of volume location, and principal axis orientation.
You can display and hide the symbols individually, or display them all at once using
the Physical Properties dialog box.

Calculating and storing physical properties

When you calculate physical properties for a part, the Physical Properties command
calculates and stores the properties for the individual part. In the Assembly
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environment, the Physical Properties command calculates and stores the properties
for the entire assembly.

If you want to calculate the properties for a portion of an assembly, you can select the
individual parts in the assembly before selecting the command. The software places
property symbols indicating the center of mass, center of volume, and principal
directions for the selection set.

Physical properties for a selection set are not stored with the assembly. When you
close the Physical Properties dialog box, the property data for the entire assembly
is restored. To store physical properties of a selection set, click the Save As button
before dismissing the Physical Properties dialog box.

Using coordinate systems

You can calculate physical properties relative to a user-defined coordinate system.
A list of all user-defined coordinate systems plus an entry for the Model Space
coordinate system, which is the default, is available on the Physical Properties
dialog box. Calculating physical properties relative to a user-defined coordinate
system will affect all properties other than Mass, Volume, and Surface Area.

Defining the density

Before calculating the physical properties for a part or the weld beads in a weldment
assembly you must specify the density of the part or weld bead.

For a part, you can define the density on the Material tab of the Solid Edge Material
Table dialog box, the Physical Properties dialog box, or the Variable Table. The
Change button on the Physical Properties dialog box displays the Solid Edge Material
Table dialog box so you can edit the material type and/or the density for the part.

For weldment assemblies, you can define the weld bead material density using the
Weldment Assembly command, or the Variable Table.

When you have defined the density, click the Update button. You must provide a
positive density value. If you do not specify a density, Solid Edge uses a density of
zero and produces the error message: Density Must Be A Positive Numeric Value.

Note

You can create material-specific template files by defining the material and
density in the files you use as templates.

In the Assembly environment, the software checks each part in the assembly
to determine if a density was defined for each part in the Part or Sheet Metal
environments. If you have not specified a density for a particular part, you can
supply a density value for calculating the part’s physical properties.

When you save an assembly, part, or sheet metal document, you can also save the
density information with the document. The information can be used later to update
the physical properties.

User-defined properties

You can override physical properties calculated by the software by setting the User
Defined Properties option on the Physical Properties dialog box in the Part and
Sheet Metal environments. For example, if you know the mass for a particular part,
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you can supply the value, and it will be treated as computed data. However, if you
then update values, the software will recalculate and override any user-defined
values. The physical properties will not update using a mix of user-defined and
system calculated properties.

Note

Density, Mass, and Volume cannot be zero.

Failed parts or assemblies

Physical properties cannot be calculated for parts with features that have not
recalculated correctly. In the Part and Sheet Metal environments, you can use the
Error Assistant dialog box to determine which parts have features that have not
recalculated correctly and why.

Updating physical properties

If you change a part or assembly so that its physical properties change, the colors
of the physical properties symbols change to show that the last calculated physical
properties are out-of-date and should be updated. For example, if you change the
material density for a part, the physical properties symbols can go out of date.

A part can also become out-of-date if you add, delete, or modify a feature. An
assembly can become out-of-date if you add or delete a part from the assembly, or if
you add or remove assembly features.

In the Part and Sheet Metal environments, you can set or clear the Update on File
Save option to specify whether the physical properties are automatically updated
when you save the document. You can also update the physical properties of a part
or assembly by selecting the Update button on the Physical Properties dialog box.
A message is displayed at the bottom of the dialog box that indicates whether the
physical properties are up-to-date or out-of-date.

Physical properties manager

In the Assembly environment, you can use the Physical Properties Manager
command to view, edit, and manage the physical properties for all the parts in the
active assembly. This can be useful because you can view and edit the physical
properties for all the parts at once, rather opening each part document to view and
edit its physical properties.
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Mapping physical properties for synchronization with Teamcenter

By using mapping definition files, physical properties such as density, mass, and
volume can be stored in the Teamcenter database and displayed and modified
in both Solid Edge and Teamcenter. This synchronization allows an attribute in
one application to be updated automatically when a modification is made to the
corresponding attribute in another application. Refer to the Sold Edge Embedded
Client Administrator’s Guide, for attribute mapping syntax and examples.
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Activity: Computing mass properties of an assembly

Overview

This activity shows how to change materials, and how to compute mass
properties and center of gravity of an assembly.
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Activity: Computing mass properties of an assembly

Overview

When you complete this activity, you will be able to change material types in parts,
and then compute the center of mass in an assembly.

Objectives

The activity consists of the following:

• Editing a part in the context of an assembly.

• Changing the materials for each part.

• Computing the mass properties for the assembly.

Activity
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Open the assembly and change the material

▸ Open and activate all the parts in the assembly mass.asm located in the folder
where the activity files are located.

Note

The assembly consists of five parts: the base and the four posts with spheres.
If the posts were identical, the assembly could have been made with just two
parts, and the post placed four times. In this activity, the posts are different
because the material and density will be altered for each post.

▸ Choose the Inspect tab®Physical Properties group®Properties Manager

command .
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▸ In the dialog box, set the material for all the parts to be copper, and then click
Update All.

Note

Another way to change the material for each of the posts is to in-place activate
and change the material through File Properties®Material Table. With the
Physical Properties Manager, this task is much simpler.

▸ Notice the color of the parts have changed to match the material. Click OK to
dismiss the dialog box.
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Examine the physical properties

Since the whole assembly is symmetric about the front and right planes, you would
expect the center of gravity to be centered in the top view.

▸ Choose the Inspect tab®Physical Properties group®Properties

command .

▸ Turn on the Display Symbol for the center of mass and the center of volume.
Notice that the mass is 1.74 kilograms. Click Update, and then click Close.
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Note

Rotate the view and notice that the center of mass and the center of
volume are located in the same position. The center of volume should not
change for this assembly for the remainder of the activity. The center
of mass will change.

▸ Choose the Inspect tab®Physical Properties group®Properties

command .
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▸ Click the Principal tab to calculate the principal axes. Turn on the Display
Symbol for the principal axes. Click Update, and then click Close.
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Change the material

▸ Choose the Inspect tab®Physical Properties group®Properties Manager

command .

▸ In the dialog box, set the material for all the parts as shown, and then click
Update All. Click OK to dismiss the dialog box.

Note

Notice that Polycarbonate is much less dense than copper. This means the
center of gravity will be closer to the two copper posts.

▸ Choose the Inspect tab®Physical Properties group®Properties

command .
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▸ Click the Principal tab to calculate the principal axes. Turn off the display
symbol for the principal axes. Click Update, and then click Close.
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▸ Rotate the view to the top and observe the location of the center of mass.

▸ Continue using the Physical Properties Manager. Change the material values of
the parts in the assembly and observe how the mass and center of gravity change.

▸ Save and close the assembly. This completes this activity.
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Activity Summary

In this activity you learned out to change the material of a part using the Physical
Property Manager, and how to calculate the mass properties for an assembly.
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Lesson review

Answer the following questions:

1. In a part or sheet metal document, how is the density of the material defined?

2. In an assembly document, how is the density of the material defined?

3. Where is the radii of gyration calculated and the values displayed in an assembly
document?
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Answers

1. In a part or sheet metal document, how is the density of the material defined?

The material table allows you to define the material and density of a part or
sheet metal document.

2. In an assembly document, how is the density of the material defined?

The properties manager shows and allows edits to the material properties for
the all the assembly components.

3. Where is the radii of gyration calculated and the values displayed in an assembly
document?

The radii of gyration is calculated and displayed on the principal tab of the
physical properties dialog box.
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Lesson summary

In this lesson you learned out to change the material of a part using the Physical
Property Manager, and how to calculate the mass properties for an assembly.
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Analyzing movement and detecting collisions in assemblies

You can use the Drag Component command in the Assembly environment to analyze
physical motion and detect collisions between parts in an assembly.

The Options button on the Drag Component command bar displays the Analyze
Options dialog box so you can define the analysis options you want to use. To reduce
the performance impact when working with large assemblies, you should limit the
analysis to as few parts as possible.

The Analyze (Shown Parts Only) options allow you to specify whether only active
parts or both active and inactive parts are analyzed. With large assemblies, you can
activate only the parts you want to analyze, which can improve performance. You
can also hide the parts you do not want to analyze. These options are used when you
set the Physical Motion option on the command bar.

The Collision Options settings allow you to specify whether only the parts that
contact the selected part are analyzed or that all parts that move in tandem with
the selected part are analyzed. These options are used when you set the Detect
Collisions option on the command bar.

Analyzing motion

The Physical Motion option on the command bar allows you to simulate motion
in an assembly. This option detects contact between parts and applies temporary
constraints between the contacting parts to simulate motion. When you set this
option, you must select a part and define a movement type and value. Also with
this option, the Distance and Angle values you specify are applied incrementally,
rather than all at once. This makes it possible to analyze motion in mechanisms that
contain gears and other forms of sliding or intermittent contact.
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Collision detection

The Detect Collisions option on the command bar allows you to detect collisions
between parts. You perform collision detection by dragging a part to simulate its
movement in the assembly. The part you are dragging must be free to move in the
assembly or be grounded. You can only select grounded parts and subassemblies
when the Locate Grounded Components option on the Analysis Options dialog box
is set.

If the part is not free to move, you can use the Suppress command on the shortcut
menu to temporarily suppress one or more of its assembly relationships. When
collisions are detected, the display changes to temporarily highlight the faces that
are involved in the collision. You can also specify that the part you are dragging
stops temporarily at the point of collision or that an audible warning is given.

If you are working in a shaded view, and a hidden face is involved in a collision, you
will not be able to see the hidden face highlight. To see these faces highlight, set
the view to Vector Hidden Line.

Note

The current zoom level impacts the accuracy of collision detection. For more
accurate results, zoom in closer to the area where collisions are suspected.
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Distance and area measurement

You can measure distances or areas, even when you are in the middle of another
task. To set the units for measuring distances or areas, use the Properties command
on the Application menu.

Measuring distances in 2D

In the Draft environment, you can measure distance using the Measure Distance
command. These commands measure linear distances or measure the cumulative
linear distance along a series of points. The first point you click establishes the origin
of the measurement (A). After that, you can select any keypoint to see the distance
between it and the origin, as well as the delta distance along each principal axis (B).

Clicking the keypoint adds it to a series of measurement points. Then you can select
another point to see the new linear distance and deltas (C), or click it to see the
distance between the last two points and the total cumulative distance from the
origin to the last point (D). Click the right button to reset the command.
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Measuring distances and angles in 3D

In the Part, Sheet Metal, and Assembly environments, the Measure Distance
command measures linear distances. The first point you click establishes the origin
of the measurement (A). After that, you can select any keypoint (B) to display the
Measure Distance dialog box which displays the keypoint select type, the true
distance, the apparent screen view distance, and the delta distance along each
principal axis.

In the Part, Sheet Metal, and Assembly environments, the Measure Angle command
measures angles. You can measure between any two faces or between any three
points.

Measuring minimum distances

In the Part, Sheet Metal, and Assembly environments, you can use the Measure
Minimum Distance command to measure the minimum distance between any two
elements or keypoints. You can use the Select Type option on the Minimum Distance
command bar to filter which type of elements you want to select. When working in
the context of an assembly, you can also use the Activate Part option to activate
the parts you want to measure.
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Measuring normal distances

In the Part, Sheet Metal, and Assembly environments, the Measure Normal
Distance command measures normal distances between a planar element or line and
a keypoint. You can use the Element Types option on the Measure Normal Distance
command bar to filter which type of elements you want to select. You can use the
Key Point option to specify the type of keypoint you want to identify when measuring
the distance. You can use the Coordinate System option to select a user-defined
coordinate system to define one of the points. If you use a coordinate system, the
returned values will be relative to the specified coordinate system. When working
in the context of an assembly, you can also use the Activate Part option to activate
the parts you want to measure.

Measuring areas

The Measure Area command, available only in the Draft environment and in 2D
profiles and sketches, measures the area inside a closed boundary (A). You can also
measure the cumulative area inside more than one closed boundary by holding the
Shift key as you click elements (B). Each time you click, the area of the last element
is displayed, along with the total area. Click another element without holding the
Shift key to reset the command.

Measuring lengths

The Measure Total Length command measures the cumulative length of a select
set of 2D geometry.

Measuring automatically

In addition to the individual distance, area, length, and angle commands, you
can use the Smart Measure command in 2D and 3D environments to measure
automatically based on what you select:

• Select a single 2D element or 3D object to measure its length or its angle or
radius.

• Select two or more 2D elements or 3D objects to measure the distance or angle
between them.

The Smart Measure command works like the Smart Dimension command, except
that it does not place a dimension as a result.
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Copying measurement values

You can copy the highlighted measurement value to the Clipboard by pressing
Ctrl+C. You can then use the copied value as input for another command. For
example, you can paste the copied value into the Line command bar to define the
length of a line. Use the Tab key if you want to highlight a different value.

Measuring drawing view geometry

When you measure model geometry within a drawing view, or when you measure
distances between model edges in two drawing views, you can select the Use
Drawing View Scale check box on the command bar to specify that the measured
value is displayed using the equivalent of the model distance.

Alternatively, you can apply a user-defined scale value by selecting it from the Scale
list on the command bar.

Note

• You can show the scale of a drawing view using the General page (Drawing
View Properties dialog box).

• User-defined scale values are defined in the Drawing View Scales section
of the Custom.xml file, in the Solid Edge Program folder. See the Help
topic, Add custom drawing view scales to Solid Edge.
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Drag Component command

Translates or rotates parts in an assembly. The part being moved must be grounded
or not fully positioned. You can use this command to do the following:

• Reposition parts dynamically along the x, y, or z axis.

• Analyze physical motion in mechanisms.

• Detect collisions between parts.

Any relationships applied to the part will prevent movement along the axis
whose position is controlled by a relationship. A part will move only in an
under-constrained direction. You can use the Suppress command on the shortcut
menu to temporarily suppress one or more assembly relationships to allow the part
to move.

You can only select grounded parts and subassemblies when the Locate Grounded
Components option on the Analysis Options dialog box is set.

After you select the part you want to move, you can use the options on the command
bar to specify the type of movement you want. For example, you can click the Move
button, then position the cursor over one of the principal axes and drag the part
to a new position.

You can restart the command by clicking the right mouse button.

Note

Patterned parts do not participate in collision detection or motion analysis.

When you use the Drag Component command to move an adjustable part, the
assembly relationships positioning the adjustable part are temporarily suppressed.
When you complete a move cycle, the relationships are reapplied. If the movement
you define conflicts with the adjustable part’s relationship structure, the adjustable
part is returned to its original position or a position that is consistent with the
relationship structure.
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Activity: Analyzing motion

Overview

This activity shows how to use motion to analyze collisions in moving parts.
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Activity: Analyzing motion

Overview

This activity shows how to use the Motion command to analyze collisions in moving
parts.

Objectives

You will use the Motion command to analyze the motion of a simple bar linkage.

Activity

Open the assembly

Open the assembly and activate all the parts in the assembly.

▸ Open and activate all the parts in the assembly slider_linkage.asm located in the
folder where the activity files are located.

▸ In Assembly PathFinder, select slider_block.par. Right-click the mate
relationship, and click Delete Relationship.

Motion environment

Start the Motion application.
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▸ Choose the Tools tab®Environs group®Motion command .

▸ When prompted to automatically add the parts, click No in the dialog box.

▸ In the Motion environment, in the Settings group, select the Display Motion

Builder command .
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▸ In the Motion Builder wizard, click the Gravity tab. Verify the Gravity On box is
selected, and then click Next.

▸ On the Parts tab, drag base block.par;1, rod_a.par;1, and pin.par:1 to Ground
Parts.
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▸ Drag the remaining parts to Moving Parts. Dismiss the Simply Motion Messages
dialog box.

▸ Click Next to proceed to the Joints tab.

▸ Click the Joints plus sign to expand the joints list.

Note

Because you deleted the mate relationship before activating the motion
command, Solid Edge did not recognize or create a joint from the mate
relationship.

Find the initial collision

Simulate motion of the linkage and find the initial collision of the parts.
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▸ In the Motion Builder wizard, click the Simulation tab.

▸ Click Simulate to set the parts in motion, and watch the motion display.

▸ Click the Interferences tab.
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▸ If the wizard blocks the view of the assembly, drag the wizard window to the
right of the assembly window. Click Check Interferences.
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▸ In the assembly graphics window, click brace.par and slide_lever.par to add them
to the list of parts to test in the Find Interferences Over Time dialog box.

▸ Click the Options tab. Click Find First Contact, and then click Find Now.
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▸ Watch the assembly move and then stop when the first interference between the
two parts is detected.

Note

Part interference begins at frame 5.45257.

▸ Close the Find First Contact dialog box.

▸ On the Inspect tab, click Measure Distance. Set the element type to All elements.

▸ For the points to measure between, select the lower-right corner of the base and
the upper-right corner of the slider block.
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▸ Notice that the distance in delta Z is -110.14 mm. These parts interfere if the
distance between the base block and the slider block is 110.14 mm or greater.

▸ On the Measure command bar, click Close.

▸ Close any open dialog boxes. Click Close and Return to return to the assembly.

▸ Save and close the file. This completes the activity.

Activity Summary

In this activity you learned how to use the Motion command to analyze the
movement of a simple linkage. Parts that did not move were grounded and parts
that did move had no constraints in the their direction of travel. When motion was
applied, interference was detected and measured.
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Lesson review

Answer the following questions:

1. What is Simply motion?

2. How can you detect the initial point of a collision between moving parts?

3. Once an interference is detected how can the range of motion be limited so that
interference does not occur?
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Answers

1. What is Simply motion?

The Simply Motion module allows you to perform motion simulations on Solid
Edge assemblies. Simply Motion creates moving parts and motion joints directly
from assembly constraints. Additional joints, springs, and motion generators
can be added through an easy to use "Wizard" style interface. Simply Motion
contains a 3D dynamic motion engine that allows you to simulate problems that
are far beyond simple linkages or kinematic type problems. The simulation
results can be used to generate animations of your moving assembly, or to check
for interference as the assembly moves through its full range of simulated motion

Simply Motion is a subset of Dynamic Designer from Design Simulation
Technologies. Simply Motion is included in Solid Edge at no charge. Upgrades to
Dynamic Designer can be purchased from Design Simulation Technologies.

2. How can you detect the initial point of a collision between moving parts?

Using the interference tab in Simply motion will analyze and show where
the initial interference occurs. The drag component command also checks for
collisions and interference.

3. Once an interference is detected how can the range of motion be limited so that
interference does not occur?

The range offset values can be set for valid assembly relationships.
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Lesson summary

In this lesson you learned how to use the Motion command to analyze the movement
of a simple linkage. Parts that did not move were grounded and parts that did
move had no constraints in the their direction of travel. When motion was applied,
interference was detected and measured.
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Sensors

When constructing parts and assemblies, you often need to keep track of critical
design parameters. For example, when designing a shield or shroud that encloses a
rotating part, you must maintain enough clearance for maintenance and operational

purposes. You can use the Sensors tab on PathFinder to define and keep track
of design parameters for your parts and assemblies.

You can define the following types of sensors:

• Minimum distance sensors

• General variable sensors

• Sheet metal sensors

• Surface area sensors

• Custom sensors

Creating a sensor
Although there are several types of sensors, you follow the same basic steps when
creating any sensor:

1. From the Sensors tab on PathFinder, select the sensor type you want.

2. Define what you want to track in the design.

3. Define the operating limits for the sensor.

Every sensor you define in the document is displayed and managed on the Sensors
tab on PathFinder.

Minimum distance sensors
Minimum distance sensors are used to track the minimum distance between any two
elements. For example, you can track the minimum distance between two part faces
in an assembly. You define a minimum distance sensor similar to how you measure
the minimum distance between two elements with the Minimum Distance command.

When you click the Minimum Distance Sensor button on the Sensors tab, the
Minimum Distance command bar is displayed so you can select the two elements
you want to measure between. After you select the two measurement elements, the
Measure Distance box displays the current minimum distance value. When you click
the Close button on the command bar, the Minimum Distance Sensor Parameters
dialog box is displayed so you can define the sensor parameters you want, such as
the sensor name, display type, threshold value, sensor range, and so forth. When
you click OK, the new sensor is displayed on the Sensors tab.

General variable sensors
You can use a general variable sensor to track variables, such as driving and driven
dimensions. To create a general variable sensor, select the Variable Sensor button
on the Sensors tab, then select the variable you want in the variable table. When
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you click the Add Variable button on the Variable Sensor Parameters dialog box, the
variable value is added to the Current Value box. You can then define the remaining
sensor parameters.

Sheet metal sensors

You can use sheet metal sensors to track design parameters, such as the minimum
distance between particular types of sheet metal features and part edges. You can
create your own sheet metal sensors from scratch, or you can select from a list of
predefined examples.

Sheet metal sensors are available only in sheet metal documents.

To create a sheet metal sensor, select the Sheet Metal Sensor button on the Sensors
tab, then use the Sheet Metal Sensor command bar to define the faces and edge
sets you want to track. When you click the Finish button, the Sheet Metal Sensor
Parameters dialog box displays so you can define the remaining sensor parameters.

Note

Sheet metal sensors are not available in 64-bit systems.

Surface area sensors

You can use a surface area sensor to monitor a surface or a set of surfaces. You can
monitor both positive and negative surface area. A negative surface area sensor
monitors the "holes" or internal boundaries in a surface. For example, you may need
to track the total area for a series of ventilation holes and cutouts in a surface.

The Surface Area Sensor command bar is where you define the faces you want to
track as a sensor. When you click the Accept (checkmark) button on the command
bar, the Surface Area Sensor Parameters dialog box displays so you can define the
remaining sensor parameters. This sensor type is available only for part and sheet
metal documents.

Custom sensors

You can use a custom sensor to monitor any numeric result that is calculated from a
custom program. For example, you could create a custom program that assigns a
manufacturing cost to each feature type used for creating sheet metal parts. The
program would then monitor the part features and give you the part cost of the
completed model.

When you click the Custom Sensor button, it displays the Custom Sensor DLL dialog
box so you can define the DLL and user function you want. After you define the DLL
and user function, and click OK, the Custom Sensor Parameters dialog box displays
so you can define the sensor parameters.

Note

For more in-depth information on how to use custom sensors, see the
readme.doc file delivered to the Solid Edge\Custom\CustomSensor folder.
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Sensor alarms

When a change to the model exceeds the defined sensor threshold limit, the Sensors
tab displays a special notification symbol and a sensor violation alarm is displayed
in the upper-right corner of the graphic window.

Violation alarms

On the Sensors tab:

In the graphics window:

When one of the elements a sensor tracks is deleted, a warning notification symbol is
displayed to call attention to it.

Warning alarms

On the Sensors tab:

In the graphics window:

When you see an alarm symbol in the upper-right corner of the graphics window,
you can click it to respond to the alarm. This displays the Sensor Assistant, which
contains hyperlinks to all the sensor violations and warnings in the document.

You can activate or deactivate the Sensor Assistant and alarm notification in the
graphics window using the Show Sensor Indicator option on the Helpers page of the
Solid Edge Options dialog box. This does not affect the operation of the sensors
themselves.

To learn how to use the Sensor Assistant, see Responding to sensor alarms.
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Activity: Creating a sensor

Overview

When you complete this activity, you will be able to create a distance sensor to
track the motion of a simple bar linkage.
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Activity: Creating a sensor

Objectives

When you complete this activity, you will be able to create a distance sensor to track
the motion of a simple bar linkage.

Activity

Open the assembly with all parts active

Open the assembly and activate all the parts in the assembly.

▸ Open and activate all the parts in the assembly slider_linkage.asm located in the
folder where the activity files are located.

Reestablish the mate relationship

Reestablish the previously deleted mate relationship.

▸ In Assembly PathFinder, select slider_block.par and then click Edit Definition

.
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▸ For the next relationship, create a mate relationship with an 80 mm offset value
between the top of the slider block and the bottom of the base block.

Create sensor

Create sensors.

▸ In PathFinder, click the Sensors tab .

▸ Click the Minimum Distance Sensor .

▸ From the Element Types list, select Surfaces.
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▸ To measure between the top of the slider block and the bottom of the base block,
select the two surfaces.

▸ Click Close.
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▸ In the Sensor Parameters dialog box, enter the information as shown, and click
OK. In the previous activity, when interference was found using the Motion
command, the software determined a threshold value of 110.14. Click OK.

Note

Notice that the sensor is added to PathFinder.

Test the sensor

▸ In Assembly PathFinder, click slider block.par, and then click the mate
relationship with the 80 mm offset in the lower pane of Assembly PathFinder.
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▸ Edit the slider block offset value to 118 mm.

▸ In PathFinder, click the Sensors tab.

Note

Notice that the sensor shows the range is no longer valid.

Note

When a sensor is violated, an icon appears on the upper right corner of the
screen.
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▸ Click the icon in the corner. Information is displayed. Click for more information.
The sensors document in PathFinder is displayed.

▸ Set the offset value of the slider block back to 50.00 mm. Notice that the sensor
returns to a valid state.

Activity Summary

In this activity you learned how to create a distance sensor and establish a valid
range of travel. Parameters on the distance sensor were set so that when the travel
of the mechanism passed the valid range, alerts were triggered.
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Lesson review

Answer the following questions:

1. Name three types of sensors.

2. Is the interface for sensors a tab in pathfinder?

3. How can you tell when a sensor has been violated?
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Answers

1. Name three types of sensors.

The types of sensors are:

a. Minimum distance sensor

b. General variable sensors

c. Surface area sensors

Custom sensors and sheet metal specific sensors can also be created.

2. Is the interface for sensors a tab in pathfinder?

The sensors tab is located in pathfinder?

3. How can you tell when a sensor has been violated?

An attention icon will display. It must be turned on in Solid Edge
Options>Helpers tab.

6-54 Solid Edge assembly mt01416-s-1040



Inspecting assemblies

Lesson summary

In this lesson you learned how to create a distance sensor and establish a valid range
of travel. Parameters on the distance sensor were set so that when the travel of the
mechanism passed the valid range, alerts were triggered.
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Checking interference on parts

Solid Edge allows you to check for interference between parts in assemblies using
the Check Interference command on the Inspect tab.

Creating sets of parts

To run an interference analysis, you must create one or two sets of parts. A set of
parts typically contains many parts; however, each set can contain any number of
parts. If a set of parts will include all the parts in a subassembly, you can select
the subassembly using the PathFinder.

Note

You can also use the Select Tools tab on PathFinder to define a select set
using a query.

Checking sets of parts for interference

You can check parts in the following ways during the interference analysis:

• All parts of set one against all parts of set two.

• All parts of set one against all other parts in the active assembly.

• All parts of set one against all currently displayed parts.

• All parts of set one against themselves.

Unless you indicate otherwise, the software uses the first option, checking all the
parts of set one against all the parts of set two.
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Interference and threaded features

You can use the settings on the Options Tab (Interference Options dialog box) to
control how threaded fastener interference is checked.

Check interference can report or ignore interferences when the threaded portion
of a bolt interferes with a non-threaded hole in a mating part. For example, you
would typically want to ignore interferences when using a self-tapping bolt in a
non-threaded hole, but would want to report interferences when a standard bolt
extends past the thread depth in a threaded mating part.

The Ignore Threaded Fasteners Interfering With Non-threaded Holes option allows
you to control whether interference is detected in these situations.

Check interference also can report or ignore interferences between a threaded
cylinder and a threaded hole whose nominal diameters match. When you set the
Ignore Interferences of the Same Nominal Diameter option, if the thread pitch does
not match between a bolt and a threaded hole with the same nominal diameters, no
interference is detected.

Analyzing results

Before running the interference analysis, you can set options for analyzing results.
The following methods are available:

• Output a report to a text file.

• Display the interfering volumes.

• Save the interfering volumes as parts.

• Highlight the interfering parts.

• Dim the display of parts that do not interfere.

• Hide parts not selected for an interference check.

If no interferences were detected during the interference analysis, the software
displays a message box telling you that no interferences were detected.
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Activity: Interference checking

Overview

In this activity, you learn how to:

• Use the interference checking and measure tools to determine where parts
interfere with each other.

• Edit the part shape to correct the offending part.

• Edit part relationships.
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Activity: Interference checking

Overview

When you complete this activity, you will know how to use the interference checking
and measure tools to determine where parts interfere with each other, how to edit
the part shape to correct the offending part, and how to edit part relationships.

Objectives

The activity consists of the following:

• Inspecting parts and subassemblies to determine interference and to measure
distances required to correct the interference.

• Editing parts in the context of the assembly to correct the interference.

Activity

Open the assembly and analyze the interference

Open an assembly and check for interference between adjacent parts. Once the
interference is found, the volume representing the interference is created as surface
features.

▸ Open and activate all the parts in the assembly ball_valve.asm located in the
folder where the activity files are located.

▸ Choose the Inspect tab®Evaluate group®Interference command .

▸ Click Interference Options.
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▸ On the Options tab, set the options as shown and click OK.

▸ Select the subassembly handle and ball.asm in PathFinder. Accept the selection.

▸ Click Process.

Note

A new part is placed at the bottom of the list in PathFinder. This part
represents the volume of the interference. The interference is represented
as a construction surface. Right-click the new part and ensure that
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the construction surfaces are displayed by selecting Show Construction
Surfaces.

▸ Click the Select tool, and then select the interference part to highlight the
interference volume in the assembly window.

Find the interference

The highlighted interference is between the ball and the end caps. Modify the end
cap to remove the interference.

▸ Shade the assembly using the Visible and Hidden Edges command .
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▸ Press Ctrl+R on the keyboard to rotate the assembly to a right view. Use the
Zoom Area command for a better view of the interference.

Measure the interference

Measure the elements to help decide how to modify one of the parts.

▸ Right-click Interference1.par in PathFinder and choose Show Only.

▸ Choose the Inspect tab®3D Measure group®Inquire Element command .

▸ Select the outside radius of the ball.

▸ Notice the radius is 30 mm. Remember this value when the end cap is modified.
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▸ Right-click valve_endcap.par:2 in PathFinder and choose Show.

▸ Choose the Inspect tab®3D Measure group®Measure Distance command.
Using keypoints, measure from the radius of the ball to the midpoint on the
mating surface of the end cap. To select the center of the sphere, select the
circular edge shown, then select the face of the end cap shown.

▸ Notice the distance value is 35 mm. Remember this value when editing the end
cap. Click Close to exit the measuring command.

▸ Click the Select tool command, right-click the right end cap named
valve_endcap.par:2 in PathFinder, and then click Edit.

▸ Press CTRL+I on the keyboard to return to the isometric view.

▸ Choose the View tab®Show group®hide Previous Level command .

▸ At the bottom of the list in feature PathFinder, click the revolved protrusion.

▸ On the command bar, click the Dynamic Edit button .
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▸ Select the 40 mm dimension on the profile, and change it to 35 mm.

▸ On the Home tab, click Close and Return .

▸ Display all the parts in the assembly.

▸ Click the Select tool command, and in Assembly PathFinder highlight the
interference part. Press the Delete key.

▸ Run the interference checking against the handle subassembly and all other
parts. No interference should be found.

▸ Save the file.

Unlock the handle and reposition

Now that there is no interference between the ball and the housing, rotate the
handle to a new position. Unlock the axial relationship locking the rotation, and
then reposition the handle.

▸ In Assembly PathFinder, select the handle and ball.asm subassembly.
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▸ In the bottom pane of Assembly PathFinder, click the axial align relationship.

▸ On the command bar, click Unlock Rotation , and then click OK.
Notice that the fixed offset used by the original insert relationship is gone.

▸ Click Edit Definition .

▸ On the command bar, set the relationship type to the Angle relationship .

▸ Click the Options button .

Note

Make sure the reduced steps option is cleared.
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▸ Using QuickPick, select valve_shaft.par:1.

Note

If you have trouble picking valve_shaft.par:1 it may not be active in the
subassembly. Use the Activate button on the command bar.
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▸ Select the left planar side of the shaft.

▸ Select the main housing.
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▸ Select the left side of the housing.

▸ Type 45° for the rotation angle.

▸ Change the angle value and watch the handle and ball subassembly rotate.

▸ Save and close the file. This completes the activity.
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Activity Summary

In this activity you learned how to check for interference between parts and
subassemblies. You learned how to determine the extent of the interference and
make the modifications necessary to correct the interference.
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Lesson review

Answer the following questions:

1. After selecting a set of assembly components to check for interference, what
options are available to perform the interference detection?

2. After the interference is detected, what options exist for analyzing the
interference?
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Answers

1. After selecting a set of assembly components to check for interference, what
options are available to perform the interference detection?

The options are:

a. Select set 2

b. All other parts in the assembly

c. Parts currently shown

d. Itself

2. After the interference is detected, what options exist for analyzing the
interference?

The options are:

a. Generate Report

b. Create interfering volumes and show them or save them as a part.

c. Hide parts not in the select sets

d. Highlight interfering parts

e. Dim parts with no interference

f. Hide parts with no interference

g. Ignore interference between matching threads

h. Ignore threaded fasteners interfering with non-threaded holes
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Lesson summary

In this lesson you learned how to check for interference between parts and
subassemblies. You learned how to determine the extent of the interference and
make the modifications necessary to correct the interference.
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Lesson review
1. What do the check interference options control?

2. Where are motion tools located in Solid Edge assembly?

3. When setting up the assembly for motion, which command steps you through the
motion process?

4. What are the two types of sensors available in the assembly ?

5. Describe the difference between true/false range and horizontal range sensors.
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Lesson summary
• When creating an assembly, at some point you must test the design to see if it is
valid. Solid Edge provides tools to calculate physical properties, analyze part
motion, and check for minimum distance. Using these tools, you can quickly
identify potential problem areas and correct your design.

• The physical properties dialog box, located under the inspect tab, activates
graphics in the assembly view to illustrate physical properties.

• The motion commands in Solid Edge assembly set parts in motion so you can
analyze the motion and check for part interference. Motion is found under the
tools tab.

• Sensors help monitor critical design elements in assembly design applications
where parts must maintain a minimal clearance from others. Sensors can
monitor required conditions and warn when a condition is not met. The sensors
tab is located on PathFinder.

• Interference can be checked against a subset of parts or the whole of the
assembly. A part file representing the common volume defining the interference
can be produced to see the shape of the interference, and to measure overlapping
volumes in order to fix the problem.
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Replacing parts in an assembly
It is possible to quickly replace a part in an assembly with another part or
subassembly that has similar geometry.
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Replacing parts in assemblies

At times you may need to replace a part or subassembly in an assembly with a new
part or subassembly. For example, a part may be placed in multiple assemblies,
and at a later time, the part needs to be redesigned for one assembly only. After
creating a new version of the part, you can replace the existing part using the
Replace command.

Tip

In the Teamcenter-managed environment, you should use the Revisions
command to replace an item with a different revision of the same item.

Replacing similar parts

When you replace a part with a new version of the same part, Solid Edge attempts
to use the existing assembly relationships to position the new version. However, if
any faces used to position the old part were consumed when the part was modified;
assembly relationships can fail. If this occurs, you can delete the affected assembly
relationships using PathFinder, and then apply new relationships to completely
position the new part.

You can also use a member of a family of parts as a replacement part. If the current
part is not a family of parts member, and you want to replace it with a family of parts
member, use the Replacement Part dialog box to select a family of parts member as
the replacement part.

If the current part is a member of a family of parts, the Family of Parts Member
dialog box is automatically displayed when you select the part you want to replace.
You can then specify another family member you want to use as the replacement
part. If you want to replace the family of parts member with any other part, click the
Browse button on the Family of Parts Member dialog box to display the Replacement
Part dialog box. This allows you to select any part as the replacement part.
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Replacing dissimilar parts

When you replace a part with a different part, one that was created independently of
the part being replaced, Solid Edge compares the geometry of the two parts. If the
geometry matches sufficiently, the replacement part is positioned properly.

When replacing dissimilar parts, the original part and the replacement part are
required to be in the same relative orientation in their respective part files.

Replacing one occurrence of a part

If the part you are replacing has been placed more than once in the active assembly,
you can specify whether to replace all occurrences of the part, or only the selected one.

Replacing parts in subassemblies

The Replace command can be used to replace parts in the active assembly only. If
the part you want to replace is in a subassembly, you will have to in-place activate
the subassembly before replacing the part.

Replacing subassemblies

When you replace a subassembly, you can replace it with another subassembly or
you can replace it with a part. If the current or replacement subassembly is also a
family of assemblies, you can use the Assembly Member dialog box to specify which
family member you want to use as the replacement.

Note

For more information on working with families of assemblies, see the Family
of Assemblies and Alternate Position Assemblies topic in online Help.

Failed relationships during part replacement

Assembly relationships can fail when you are replacing parts. Normally, this
happens because the assembly cannot locate the faces in the new part that it was
connected to in the old part. When this occurs, a symbol displays to the left of the
failed relationship in the lower pane of the PathFinder.

Replacing renamed occurrences

When you replace an assembly occurrence whose default name in PathFinder has
been overridden using the Rename or Occurrence Properties commands on the

7-4 Solid Edge assembly mt01416-s-1040



Replacing parts in an assembly

PathFinder shortcut menu, you can control whether the replacement occurrence uses
the new document name or the overridden name in PathFinder.

When you set the Use Default Placement Name During Replace Part option on the
Assembly tab on the Options dialog box, the document name of the replacement
occurrence is used. When you clear this option, the overridden name is maintained.

When you override the name of an assembly occurrence, the actual document name
is not changed.
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Activity: Replacing parts in an assembly

Overview

The objective of this activity is to show how to replace a part or subassembly in
an assembly.

Activity

In this activity you will replace a subassembly with a similar subassembly inside
of the top level assembly.
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Activity: Replacing parts in an assembly

Overview

This activity demonstrates how to replace a part in an assembly.

Objectives

You will replace a subassembly in an assembly.

Open an existing assembly with all the parts active

The assembly you will open has a small pulley subassembly that you will replace
with a large pulley subassembly.

▸ From the Solid Edge start screen, click Open Existing Document. Browse for
Engine.asm in the folder where the activity files are located.
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Replacing the subassembly

The subassembly small.asm will be replaced with large.asm.

▸ In the Home tab, in the Modify group, choose the Replace Part command .

▸ In Pathfinder, select small.asm as the subassembly to replace.

▸ In the replacement part dialog box, browse for the assembly large.asm in the
folder where the activity files are located, and then click open.

The subassembly has been replaced.

▸ Save and close the assembly. This completes the activity.

Summary

In this activity you learned how to replace a subassembly within a top level assembly.
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Lesson review

Answer the following questions:

1. Can you replace subassemblies within an assembly?

2. Can parts with dissimilar geometry be replaced?

3. Can you replace parts in a subassembly, and if so, how?

4. Can you replace members when creating a family of assemblies?
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Answers

1. Can you replace subassemblies within an assembly?

Subassemblies as well as parts can be replaced in a top level assembly.

2. Can parts with dissimilar geometry be replaced?

Parts with dissimilar geometry can be replaced, however failed relationships are
likely to occur. These would have to be repaired.

3. Can you replace parts in a subassembly, and if so, how?

Parts can be replaced in a subassembly by in place activating the subassembly
and then replacing the part.

4. Can you replace members when creating a family of assemblies?

When creating a member of a family of assemblies, replacing a part as an
occurrence override.
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Lesson summary

In this lesson you learned how to replace a subassembly within a top level assembly.
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Top-Down and Bottom-Up Design in Solid Edge
Mechanical design and engineering requires careful planning and an analytical
approach to developing new products. The purpose of CAD/CAE/CAM is to reduce
the design cycle length, and eliminate fit errors by taking better advantage of
common part geometry. When designing assemblies using computer-aided design
tools, there are two basic ways of categorizing assembly design: top-down design
and bottom-up design.

Top-Down assembly modeling

Top-down assembly modeling is an assembly-centric modeling method where the
assembly design is started at the highest level possible, and individual parts and
subassemblies are defined within the context of the overall assembly. With this
approach, an assembly layout is typically created first, and this assembly layout is
used to define individual part geometry and position.

This approach is often used at companies where the product being designed is large
enough that it requires many people to complete the design. A senior-level designer
might create the initial assembly layout, then divide the assembly layout into logical
subassemblies and parts for the remainder of the organization to complete.

Bottom-Up assembly modeling

Bottom-up assembly modeling is a part-centric modeling method where the assembly
design is started with a principal structural or functional element, and individual
parts are designed in relative isolation from the overall assembly. Component
parts and subassemblies are defined as the process moves up towards the top-level
assembly. With this approach, as the design of a key component is completed, its
geometry may or may not be used to aid the design of related mating components.

This approach is often used at companies where the product being designed is small
enough that one or only a few people are needed to complete the design.

Combining both approaches

Solid Edge provides tools that allow you to take advantage of the benefits of both
approaches as needed. Many organizations use a combination of both methods,
using the method which best suits the immediate requirements. For example, you
can use the top-down approach to create the initial assembly layout and to define
the document structure needed. You can then copy the assembly layout geometry to
subassembly and part documents to divide the work among the organization.

You can shift to the bottom-up approach in areas of the design that use purchased
parts, existing parts from an earlier project, or where you are modeling standard
parts in 3D that were created on an earlier 2D CAD system.

The suite of commands and tools in Solid Edge also allow you to use either approach
associatively or non-associatively, as you see fit.
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Top-Down tools

The primary top-down assembly design tool within Solid Edge is virtual component
modeling, available in the Assembly environment. The Creating and Publishing
Virtual Components Help topic discusses this functionality in depth.

If you choose not to use virtual component modeling, you can use the Copy Sketch
command to copy layout graphics to parts and subassemblies, either associatively or
non-associatively.

The Create In-Place option on the Parts Library tab of PathFinder allows you
to create new parts associatively or non-associatively within the context of the
assembly. The Constructing New Parts within an Assembly Help topic discusses
this functionality.

You can control whether the new parts are associative to existing parts using the
suite of Inter-Part Associativity tools available. The options on the Inter-Part tab on
the Options dialog box allow you to control what types of associatively you want to
use.

The Include command also allows you to associatively or non-associatively copy
geometry between documents when working in the context of an assembly.

Many feature commands allow you to define the extent of the feature associatively
by selecting a keypoint on another part in the assembly.

Bottom-Up tools

With the bottom-up approach, you can create new 3D models in relative isolation
from the assembly by referencing existing paper or electronic drawings, or by
designing entirely new components.

A variation of the bottom-up approach involves using the Part Copy command on the
Insert menu to associatively or non-associatively copy surface geometry from one
3D model to another 3D model outside the context of an assembly. This approach is
especially useful when working with tightly related components that share common
characteristics, such as parts that make up an weldment assembly.

When used associatively, the Part Copy command allows you to control common
geometry on several child parts from one or more parent parts. You can edit the
parent document, then open and update the child documents without creating or
referencing an assembly document.

When used non-associatively, part copies allow you to quickly reuse existing
geometry in another document.
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Bringing it together

With either approach, you usually will want to view the components within one or
more assemblies. You can use assembly relationships to position the components
in the assembly, or you can use coordinate systems to define the position of each
component in the assembly structure.
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Transferring and dispersing assemblies
The ability to transfer and create subassemblies within the tree structure of an
assembly or to push the parts out of a subassembly into a higher level assembly is a
powerful tool when managing and manipulating large assemblies.
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Restructuring assemblies

Solid Edge contains commands that allow you to change the structure of an existing
assembly.

The Transfer command transfers parts and subassemblies from one assembly
to another. You can transfer these parts and subassemblies to any level of the
assembly that can be seen from the top level assembly that is open. You can also
use the Create New Subassembly dialog box to create a new subassembly for the
transferred files. To access the Create New Subassembly dialog box, on the Transfer
to Assembly Level dialog box, click the New Subassembly button.

The Disperse command transfers the parts in a subassembly to the next highest
subassembly and deletes the reference to the subassembly. The command disperses
only the top-level occurrence of a subassembly. For example, if a subassembly exists
as an occurrence within the assembly being dispersed, the subassembly remains
unchanged, but is moved up to the next higher assembly level.

To change the order of the files within an assembly, you can drag and drop parts
in the PathFinder.

Transferring parts between assemblies

You can use the Transfer command to transfer assembly files, parts containing
inter-part relationships, tube parts, and pattern parts. It is important that you
understand how Solid Edge handles these transfers so you can avoid possible
problems.

When transferring parts, it is very important that you have write access to all of
the part and assembly files involved in the transfer.

Solid Edge handles relationships during transfers just like it would if you deleted a
part from one subassembly and added it to another. It attempts to re-establish each
positioning relationship exactly like it was before the transfer, with reference to the
same reference part. If the reference part remains in the assembly tree below its
new location, the relationship should be successfully re-established. If the reference
part is not below the transferred part’s new location, it will not be converted into a
non-positioning relationship and the relationship is removed. You will not receive
warnings for affected relationships during transfers, so you should be very careful
when transferring parts with relationships. You might choose to add positioning
relationships to any occurrence that becomes underconstrained after its transfer.

If you transfer a part that is a parent of an inter-part relationship, the link is broken,
but not deleted. Inter-part Manager will show the inter-part link as broken, just as if
the parent part was deleted from the assembly. You will not receive a warning when
the parent part is deleted. You must understand the relationship dependencies
within your assembly so that you can avoid breaking links when you transfer parts.
You will be warned if you transfer a part that is inter-part child. If you continue
with the transfer, the link will be broken and automatically deleted by the command.

Pasted variable links will remain intact during transfer as long as both the parent
and child remain anywhere in the assembly.

If you transfer a tube part containing the port that defines a path, the link will be
deleted and you will not receive a warning message. If you transfer a part containing
a port to a level above the assembly containing the tube path, the tube path becomes
non-associative to the part and you will not receive a warning message.

8-6 Solid Edge assembly mt01416-s-1040



Designing in the context of an assembly

If you transfer a part containing a feature pattern that drives the assembly pattern,
the pattern disappears and you not receive a warning message.

Transferring parts to a new subassembly

Solid Edge allows you to create a new subassembly for parts you want to transfer.
The New Subassembly button on the Transfer to Assembly Level dialog box accesses
the Create New Subassembly dialog box. You can use this dialog box to specify a
template, file name and location for the new database. You can also use the dialog
box to define the position of the transferred parts in the new subassembly.

You have two options when defining the part position.

• Position First Selected Part at Origin and Others Relative to It

• Maintain Current Offsets From Assembly Origin

The first option specifies that if the new subassembly is opened outside of the parent
assembly, the parts will be positioned relative to the global reference planes so that
when you fit the view, the parts will not be remote from the reference planes. This
options provides results similar to creating a new assembly with existing parts. For
example, when you create a new assembly and drag the first part in from Parts
Library, it is grounded at the origin of the assembly file. The subassembly is then
positioned as a whole within the upper level assembly.

The second option specifies that you want to position everything relative to a single
global origin. After the new subassembly is created, if you open the subassembly
outside of the parent assembly and the fit the view, the parts might be remotely
located from the global reference planes.

Transferring part occurrences between subassemblies

If you transfer a part from one subassembly to another and there are multiple
occurrences of one or both of the subassemblies within the assembly structure, it is
very likely that the instances of the transferred occurrence will change. For example,
if a part in subassembly A, which occurs only once, is transferred into subassembly B
that occurs five times, the effect is that four instances of the transferred occurrence is
added. Likewise, if there are more occurrences of the source subassembly than there
are of the target subassembly, the number of occurrences instead could be reduced.

Things to consider when transferring parts

There are several things you need to consider when transferring parts. It is
important that you understand how Solid Edge handles these situations so you get
the desired results from your transfer.

Occurrence numbers

The occurrence number of a occurrence after its transfer into the target assembly
is the next consecutive number available for the file name that is transferred.
If you transfer more than one of the same file name occurrences at the same
time, the number that is assigned to each occurrence in the target assembly is
determined by the order in which they are numbered in the source assembly.

Display configurations
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Existing display configurations become invalid as parts are removed or added
during part transfer.

Face styles of transferred parts

If you transfer a part into a target assembly that contains a style that is assigned
to the part in the source assembly, you must reapply the style after the transfer.
If the target assembly does not contain the style assigned to the part in the
source assembly, the part is assigned the Aluminum style.

Explode configurations

Explode configurations become invalid as parts are removed or added during
part transfer. In the Draft environment, drawing views will go out-of-date when
parts are removed or added from the configuration.

Groups

Groups are not maintained during part transfer. Solid Edge handles the transfer
of groups the same as if the part was manually deleted from or added to the
source assembly.

3D section views

Since 3D section views contain a list of parts that are cut, they are affected
during transfer. Solid Edge handles the transfer of 3D section views the same as
if the part was manually deleted from or added to the source assembly.

Sensors

Sensors are not maintained during part transfer. Solid Edge handles the
transfer of sensors the same as if the part was manually deleted from or added
to the source assembly.

Motion joints

Motion joints are not maintained during part transfer. Solid Edge handles the
transfer of motion joints the same as if the part was manually deleted from or
added to the source assembly.

Physical properties

Physical Properties are not maintained during part transfer. Solid Edge handles
the transfer of physical properties the same as if the part was manually deleted
from or added to the source assembly.

Dispersing subassemblies

You can use the Disperse command to disperse a subassembly by reassigning
the parts to the next highest subassembly and removing the reference to the
existing subassembly. The command will disperse only the top-level occurrence of
a subassembly. For example, if a subassembly exists as an occurrence within the
assembly being dispersed, the subassembly remains unchanged, but is moved up to
the next higher assembly level.

The command does not modify the dispersed subassembly on the disk. The part
occurrences are copied to the next higher level and the reference to the subassembly
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is deleted. When you save the top-level assembly, since it is no longer in the assembly
structure, the dispersed subassembly occurrence is not saved.

If the subassembly being dispersed contains a pattern, the parts of the pattern are
placed at the proper location in the next higher level and a ground constraint is
placed on each of the parts. The parts will not be grouped in the PathFinder under a
pattern node, but will be ordered the same in the next higher assembly.

If you disperse a subassembly containing a tube part, the tube part and other parts
are transferred to the next higher level, but the dispersed subassembly on the disk
is not affected. Therefore, the tube part is still associative to the path when you
open the subassembly stored on the disk.
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Activity: Transferring and dispersing assemblies

The objective of this activity is to demonstrate how the assembly structure can be
altered without having to delete and replace parts and subassemblies manually.

In this activity you used the disperse and transfer commands to change the
organizational structure of an assembly.
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Activity: Transferring and dispersing in assembly

Overview

This activity demonstrates the process reorganizing an assembly structure using
the disperse and transfer commands.

Objectives

You will manipulate an existing assembly to become familiar the disperse and
transfer commands and some of the options associated with them.

Open the assembly

▸ Open the assembly Wheel_Base.asm with all the parts active.
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Examine the assembly structure

▸ In PathFinder, expand the subassemblies right_rear_wheel_assembly.asm and
left_rear_wheel_assembly.asm as shown.

Note

Notice an occurrence of the subassembly tire_assmbly.asm is present in both
right_rear_wheel_assembly.asm and left_rear_wheel_assembly.asm
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Disperse one of the subassemblies

▸ In the subassembly right_rear_wheel_assembly.asm select tire_assembly.asm
as shown.
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▸ Click the Home tab®Modify group®Disperse command.

▸ When prompted: Transfer the parts in the selected assembly to the next higher
level, and delete the selected assembly occurrence? Click Yes.

▸ When prompted: The assembly that you are dispersing contains interpart
relationships. If you continue, the interpart relationships could be broken.
Continue? Click Yes.

Note

When using Inter-part relationships, the changes in one part can control the
size and shape of geometry in another part. When changes are made to the
parent part. If this type of behavior is still desired in the assembly after
executing the disperse command, check to see if the links were broken. If they
were, you will need to reestablish them.
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Examine the results of the disperse command

▸ Compare the differences between right_rear_wheel_assembly.asm and
left_rear_wheel_assembly.asm. Notice:

• That tire_assembly.asm only exists in left_rear_wheel_assembly.asm now.

• That the parts that once existed in tire_assembly.asm have been placed in
the right_rear_wheel_assembly.asm.

• The pattern that had four occurrences of ASM_01_00601.asm is no
longer a pattern, and those four occurrences have been placed in
right_rear_wheel_assembly.asm.

Transfer parts into a subassembly

▸ Select the parts hub.par and shaft.par in Assembly PathFinder.

▸ Right-click on the selection in pathfinder, and then click Show Only to hide
the rest of the assembly.

▸ Click Fit to fit the view.

▸ Select the parts hub.par and shaft.par in Assembly Pathfinder.
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▸ Click the Home tab®Modify group®Transfer command.

Note

The Transfer command either moves the selected parts to a new location in
the assembly structure, or combines the selected parts into a subassembly.

▸ Select the top level assembly, Wheel_Base.asm, as the destination for the
subassembly being created, then click New Subassembly.
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▸ Name the new subassembly hub_shaft_assembly.asm. Direct the subassembly to
the folder where the remainder of the assembly resides as shown. Then click OK.

▸ View the destination of the new subassembly. If satisfactory, as shown, then
click OK.
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▸ Notice the new subassembly consisting of the two selected parts in the assembly
pathfinder.

▸ Right-click on Wheel_Base.asm in PathFinder and then click show to display the
complete assembly, then fit the view.

▸ Save and close the assembly. This completes the activity.

Summary

In this activity you learned the following

• How to move parts in a subassembly into a new location in the assembly
structure with the disperse command.

• How to create a new subassembly from parts within an assembly using the
transfer command, and how to locate the position in the assembly structure for
the new subassembly to reside.
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Lesson review
Answer the following questions:

1. What does the transfer command do in an assembly document?

2. What does the disperse command do in an assembly document?

3. Can you disperse a subassembly?
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Answers
1. What does the transfer command do in an assembly document?

The Transfer command transfers parts and subassemblies from one assembly
to another. You can transfer these parts and subassemblies to any level of the
assembly that can be seen from the top level assembly that is open. You can also
use the Create New Subassembly dialog box to create a new subassembly for
the transferred files. To access the Create New Subassembly dialog box, on the
Transfer to Assembly Level dialog box, click the New Subassembly button.

To change the order of the files within an assembly, you can drag and drop parts
in the PathFinder.

2. What does the disperse command do in an assembly document?

The Disperse command transfers the parts in a subassembly to the next highest
subassembly and deletes the reference to the subassembly. The command
disperses only the top-level occurrence of a subassembly. For example, if a
subassembly exists as an occurrence within the assembly being dispersed, the
subassembly remains unchanged, but is moved up to the next higher assembly
level.

3. Can you disperse a subassembly?

You can use the Disperse command to disperse a subassembly by reassigning the
parts to the next highest subassembly and removing the reference to the existing
subassembly. The command will disperse only the top-level occurrence of a
subassembly. For example, if a subassembly exists as an occurrence within the
assembly being dispersed, the subassembly remains unchanged, but is moved
up to the next higher assembly level.
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Lesson summary
In this lesson you learned the following

• How to move parts in a subassembly into a new location in the assembly
structure with the disperse command.

• How to create a new subassembly from parts within an assembly using the
transfer command, and how to locate the position in the assembly structure for
the new subassembly to reside.
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Inter-Part

Overview

Creating parts in an assembly whose size and shape can be controlled based on the
size and shape of geometry in another part in the assembly is accomplished through
Inter-part links. When the geometry of the parent part changes, the Inter-part links
in the linked part alter the geometry accordingly.
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Inter-Part associativity

When constructing the parts and assemblies for a design project, you can use
the geometry on other parts in the assembly to help you construct a new part or
subassembly. For example, you can use the Include command to create 2D geometry
for the base feature of a new part by copying edges on an existing part.

Depending on the approach you use, the included geometry can be associative or
non-associative to the original edges.

When you create new geometry associatively, then modify the original, or parent
geometry; the child geometry also updates. If you change the size of the parent part,
the included child geometry for the base feature also updates.

Note

An Inter-Part Associativity tutorial is available that demonstrates how to
create associative inter-part features.

Note

When designing in the context of an assembly, only ordered features can be
linked using Inter-part relationships. In the synchronous environment faces
can be copied, but they are not linked to geometry contained in the part that
the face was copied from.
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The following commands and functions in Solid Edge allow you to use existing
geometry associatively:

• Include command

• Inter-Part Copy command

• Assembly-Driven Part Features

• Reference Plane Definition

• Feature Extent Definition

• Variable Table

Note

Many of these options are available only when you set the proper inter-part
associativity option on the Inter-Part tab on the Options dialog box.

When one part is associatively linked to another part in Solid Edge, special symbols
are used to indicate the associative link. For example, when you include an edge
from another part in the assembly to define the profile for cutout feature in the
active part, a link symbol is displayed adjacent to the part feature in PathFinder and
adjacent to the part entry in PathFinder.

These associative links between parts are called inter-part links to indicate that one
part is dependent on another part for the definition of some of its geometry. The
link information is added to the highest level assembly that is common to both
parts, based on the assembly you opened.

For more information about managing inter-part links, see the Managing Inter-Parts
Links section of this Help topic.

8-24 Solid Edge assembly mt01416-s-1040



Designing in the context of an assembly

Including elements

You can use the Include command to include edges from the active part, an assembly
sketch, or the other parts in the assembly. When including edges from an assembly
sketch or another part in the assembly, you can control whether the included edges
are associative to the parent element using the Inter-Part Locate options on the
Include dialog box.

You can only include elements from an assembly sketch or the other parts in an
assembly when you are editing a part in the context of an assembly (you have
in-place activated a part or you are creating a part in place).

When the Allow Locate of Peer Assembly Parts and Assembly Sketches option is set,
you can locate and select elements in other parts and assembly sketches. To copy the
elements associatively, you must also set the Maintain Associativity When Including
Geometry From Other Parts in the Assembly option. When this option is cleared you
can copy elements from other parts and assembly sketches non-associatively.

Note

To include elements associatively between documents, set the Allow Inter-Part
Links Using: Include Command in Part and Assembly Sketches option on the
Inter-Part tab on the Options dialog box.

Inter-Part copies

You can use the Inter-Part Copy command in the Part and Sheet Metal environments
to associatively copy faces, features, and entire parts into another part document as
construction geometry. You can then use the Include command to associatively copy
edges from the construction geometry into a profile for a feature. To ensure that the
Include command only copies edges from the associative construction geometry, turn
off the assembly display using the Hide Previous Level command on the View tab.

The Inter-Part Copy command is only available when you are editing a part in the
context of an assembly (you have in-place activated a part or you are creating a
part in place).

Note

To copy elements associatively between documents, set the Allow Inter-Part
Links Using: Inter-Part Copy Command option on the Inter-Part tab on the
Options dialog box.
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Assembly-Driven part features

You can use the assembly feature commands such as Cutout, Hole, and Revolved
Cutout in the Assembly environment to construct assembly-driven part features
in an assembly. You can specify which parts in the assembly you want to cut.
Assembly-driven part features are added as a linked feature to each part document.

For more information on assembly-driven part features, see the Assembly-based
Features Help topic.

Note

To construct assembly-driven part features in an assembly, set the Allow
Inter-Part Links Using: Assembly-Driven Part Features option on the
Inter-Part tab on the Options dialog box.

Reference planes

When constructing a feature for a part, you can use an assembly reference plane
to define the new feature. If the assembly reference plane is modified, the feature
associatively updates. To select an assembly reference plane, press the SHIFT key,
then select the assembly reference plane.

You can only use an assembly reference plane when you are editing a part in the
context of an assembly (you have in-place activated a part or you are creating a
part in place).

Note

To use an assembly reference plane while constructing a part feature, set the
Allow Inter-Part Links Using: Assembly Reference Planes In Feature option
on the Inter-Part tab on the Options dialog box.
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Feature extents

When working within the context of an assembly, many feature commands allow
you to select a keypoint on another part in the assembly to define the extent for a
feature. For example, when constructing a protrusion in the Part environment, you
can select a keypoint (A) on another part in the assembly during the Extent Step.

The extent for the feature is associative to the keypoint on the part you select. If
the other part is modified (B) such that the keypoint location changes, the extent for
the linked feature also updates.

You can also use an assembly sketch to define the extent for a feature.

Variables

You can use the Variable Table in Solid Edge to associatively paste an assembly
variable into a part or subassembly. This allows you to control several parts at once
with one variable. For example, you can create an assembly variable to control the
size of a hole in several parts in the assembly.

For more information on pasting variables between documents, see the Linking
Variables Between Parts in an Assembly section of the Variables Help topic.

Note

To associatively paste variables between documents, set the Allow Inter-Part
Links Using: Paste Link To Variable Table option on the Inter-Part tab on
the Options dialog box.
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Managing Inter-Part Links

You can use the Inter-Part Links dialog box to view and manage the inter-part links
you create between the parts and assemblies for a design project. You display the
Inter-Parts Links dialog box using the Inter-Part Manager command on the Tools tab.

Legend
Part

Assembly

Inter-part copy
Variable

Reference plane

Sketch or Profile

Feature Extent

Link is intact
Link status cannot be determined because parent is inactive
Parent is not found
Link to parent is broken
Link has multiple solutions

Link is out-of-context with its container assembly
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The Inter-Part Links dialog box allows you to sort the inter-part links by parents
or by children. When set to Children, each part or assembly that is a child in an
inter-part relationship is displayed. Below each child is a description of the type of
inter-part relationship and the name of the parent document. When set to Parents,
each part or assembly that is a parent in an inter-part relationship is listed. Below
each parent is the name of each of its children.

In the Inter-Part Links dialog box, special symbols are used to indicate the status
of the associative links:

The link is intact and if design changes are made, the link should update properly.

The status of the link cannot be determined because the parent document is
currently inactive. You can resolve this with the Activate All command on the
shortcut menu to activate all the parts in the assembly with associative links.

Parent is not found. This can occur if, for example, you rename the parent file
outside of Revision Manager. This can be fixed by renaming the file back to its
original name.

Link to parent is broken. This can occur if a feature that another part is
dependent on is deleted. For example, a cutout feature in Part P1 is used to create
an inter-part copy in Part P2. If you then delete the parent cutout feature in Part P1,
a broken link symbol would be displayed adjacent to the inter-part copy listing for
Part P2.

Link has multiple solutions. The current assembly relationship or inter-part
link contains multiple solutions. To correct the problem, you can adjust the assembly
relationships or use Inter-Part Manager to determine which links are affected and
delete those links.

Linked document is out-of-context with its container assembly. When you create
inter-part links between documents, the link information is contained in the highest
level assembly that is common to both the child and parent documents, based on
the assembly you opened. When you open a child document out-of-context with its
container assembly, this symbol is displayed. See the Understanding In-Context
Container Assembly section for more details.

This symbol does not indicate a problem, only that inter-part links in the child
document may not update properly if the parent document is modified outside the
context of the container assembly. You can do one of the following:

• Open the assembly listed in the Tooltip, then in-place activate the child
document.

• Ignore the symbol.

• Break the link between the child document and parent document.

Understanding the In-Context Container Assembly

When you create the first inter-part link for a part, the link information is stored
in the highest level assembly possible that is common to both parts, based on the
assembly you opened (using the Open dialog box or from Windows Explorer). A
document can have only one in-context container assembly.
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For example, you start a design session by opening assembly A2. You then in-place
activate part P4. You then create a cutout feature using included geometry from part
P5, which is in assembly A5. An inter-part link is created, with part P5 being the
parent part, and part P4 being the child part.

Because the assembly you opened at the start of the design session was A2, A2
becomes the in-context container assembly for part P4. To create inter-part links for
part P4 in the future, you must open assembly A2, then in-place activate part P4.

In a future design session, if you were to open assembly A1, the inter-part
associativity options would be disabled. For example, on the Include Options dialog
box, the Maintain Associativity When Including Geometry From Other Parts in the
Assembly option would not be available.

You can determine the in-context container assembly for a part using the Inter-Part
Manager dialog box. When you position the cursor over the inter-part link entry in
the Inter-Part Manager dialog box, a Tooltip is displayed which lists the in-context
container assembly for the part.
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Links Collection

The links collection in pathfinder can be expanded to show the links in the current
open document.

RMB Links in pathfinder gives the following options:

• Expand All

• Collapse All

• Activate All

• Update All

• Freeze All

• Unfreeze All

• Break All

• Inter-part Manager

All links can be broken or froze from the top level in the links collector, or
individually by RMB on the expanded items in the collection.

Inter-Part Associativity and Inactive Parts

Before you make a design change to a part or assembly that is involved in an
inter-part relationship, you should first use the Activate All command on the
shortcut menu in the Inter-Part Links dialog box to activate the parts that contain
inter-part relationships. The Activate All command only activates those parts that
contain inter-parts links in the assembly.
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Breaking Inter-Part Links

If you want to delete any associative links between a child element and its parent,
you can select the child element in the Inter-Part Links dialog box, then use the
Break Links command on the shortcut menu. For example, you may want to break
the associative links to a part that used to be unique to the assembly, but now will
be used in other unrelated assemblies.

When you break the associative links to a part, you can still make design changes
to the individual parts, but you may need to add dimensions or edit the feature to
redefine the inputs for the feature. For example, if you define the extent for a feature
using a keypoint on another part, then break the link later, you can still edit the
extent for the feature.

After you break the associative link, you can select the feature, then use the Edit
Definition option to access the Extent Step for the feature, then type a dimension
value on the command bar to define a new extent for the feature.

Note

When you define the extent for a feature associatively using a keypoint on
another part, no driving dimension for the feature extent is created.

If you break the link and then edit the feature extent by typing an extent
value, a driving dimension for the extent is created.
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Updating Assembly Documents with Inter-Part Relationships

The methodology by which inter-part relationships (inter-part copies, associative
include from assembly sketch, associative reference planes, and multi-part cutouts)
are managed has been enhanced in version 14. The new methodology is more
reliable and flexible. Because of this enhancement, pre-version 14 assemblies with
inter-part relationships should be opened in-context and saved before new design
work is performed.

To do this, you must open the in-context assembly with write access to all affected
documents (the child documents with inter-part relationships and the assembly) and
then save the assembly.

Determining the In-Context Assembly

In many situations, it can be difficult to determine which assembly is the proper
in-context assembly. To make the update process easier, an Update dialog box is
displayed when all the inter-part documents within an assembly cannot be updated.
The Update dialog box explains the actions you need to take to successfully update
all inter-part relationships.

There are three situations that can cause an inter-part occurrence to not be updated
to the new compute methodology when you save the assembly:

• The inter-part child document is out of context with the assembly that controls
the inter-part relationship.

• Either the child document or the in-context assembly is write-protected.

• Another unknown reason. This is usually due to a problem that existed in the
previous version of the file (version 12 or earlier). One possibility is that the
child part was replaced in the assembly and became out of context in V12. To
resolve this particular problem, you can open the assembly and use Inter-part
Manager to break any unresolved links.

If any of the three situations occurs when you open the assembly, an Update dialog
box is displayed. If the Update dialog box is not displayed, the assembly and all
inter-part occurrences within the assembly were updated successfully.

The inter-part relationships in an assembly are updated on an occurrence by
occurrence basis. This means that, in some cases, only some of the inter-part child
documents in the current assembly are updated, while others are not updated.

If the Update dialog box is displayed, this indicates there were some child documents
in the current assembly that could not be updated. When this occurs, you should
still save the current assembly. The Update dialog box will display messages that
explain the actions you need to take to correct the situation.

Any child documents and related assemblies that were not updated will need to
be addressed separately. This is usually done by opening the correct in-context
assembly with write access to the child documents, and then saving that assembly.
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Note

It is very important that you update all inter-part relationships before
proceeding with further design work on the assembly and the inter-part
occurrences. Any inter-part relationships that are not updated will not
function properly, which can result in incorrect part positions and incorrect
geometry on new design work.

The in-context assembly might be in a higher-level assembly than the open assembly
in which the message is seen, or it could be a different assembly that is unrelated
to the open assembly except for the presence of the out-of-context occurrence in
both assemblies.

If a single inter-part relationship in an occurrence cannot be updated, no other
inter-part relationships in that occurrence will be updated. A child document must
be in-context of all of its inter-part relationships before the child document can be
updated. This does not prevent other child documents in the assembly from being
updated.

Examples

The following examples assume write access to all affected documents. Consider the
assembly represented in the following illustration. When an update is attempted,
the in-context assembly is the lowest assembly that is common to both the child
and parent. (A = assembly, P = Part, the arrow points from child document to
parent document)

If A4 is opened, no inter-part documents can be updated. In this example, two
messages are displayed in the dialog box:

• File. P1 / Reason. The in-context assembly is A2

• File. P2 / Reason. The in-context assembly is A1

If A2 is opened, P1 will be updated, but there will be a message for P2:

• File: P2 / Reason. The in-context assembly is A1

If A1 is opened, all inter-part documents are updated, as this is the lowest level
assembly that is common to all child and parent documents.
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Activity: Inter-part assembly modeling

When you complete this activity, you will be able to use inter-part modeling
techniques to create new parts in an assembly.

For this activity, you will model a mating cover for the sheet metal chassis shown in
the following illustration. The activity emphasizes the use of inter-part modeling in
Solid Edge Assembly. Inter-part enables the modeling and mating of parts within
an assembly to maintain like design characteristics between the parts. In other
words, when one part is changed, the mating parts change accordingly. This is a
top-down assembly modeling method.

Activity guides you through the process of associatively linking parts with Inter-part
copies, so that changes in one part will be reflected in another part.

mt01416-s-1040 Solid Edge assembly 8-35



Lesson 8 Designing in the context of an assembly

Activity: Inter-part assembly modeling

Overview

In this activity, an assembly will be created and a sheet metal part placed in the
assembly. Another sheet metal part will be created from within the assembly and
the geometry of that part will be controlled by the first part based on inter-part links

Objectives

The objective of this activity is to show how inter-part links can be used to link
geometry so that changes in one part are reflected in another part via inter-part
links. By doing this, the create in place command shows how to design in the context
of the assembly. Having access to the geometry in adjacent parts in an assembly is
a powerful design tool.

Create a new assembly file and set the parameters for inter-part

▸ Create a new metric assembly file.

▸ Hide all the assembly reference planes if they are shown.

▸ To allow inter-part links using inter-part copy, set the option in the Solid Edge
Options dialog box. Click the Application button. Click Solid Edge Options.
Click the Inter-Part tab, and select the options as shown. Click OK.

▸ Insert a part into the assembly. This part will be used as a reference part to
construct the mating cover. In Parts Library tab, drag Chassis.psm into the
main assembly window.

▸ Save the file as interpartassy.asm in the folder being used for the activity.

8-36 Solid Edge assembly mt01416-s-1040



Designing in the context of an assembly

Create a new part in-place

▸ Click the Home®Assemble®Create Part In-Place command. Fill out the Create
New Part In-Place dialog box as shown, and then click Create and Edit. Make
sure the template option is set to the sheet metal template, iso sheet metal.psm.
The name of the new part will be cover.psm. The Coincident with assembly origin
option assures proper orientation of the new part. Make sure the folder for the
New file location is the folder containing the activity files.
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▸ On the Application menu, choose Properties®Material Table. Set the gage to
20, then click Apply to Model.

Insert an inter-part copy that will be used as a construction surface to create a sheet
metal cover

▸ Right-click in PathFinder and then click Transition to Ordered.
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▸ Click Home®Clipboard®Inter-part Copy.

▸ Click Chassis.psm as the assembly part to copy from, and then select the
thickness face as shown.

▸ Click the Accept button and then click Finish. This face serves as a construction
surface within the sheet metal part file.
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▸ To turn off the display of Chassis.psm, click View®Show®Hide Previous Level.
Ensure the base reference planes are shown.

Note

When you select a part for modification (in-place activation) through the
edit command within an assembly, hide previous level turns off the display
of the remaining parts within the assembly for the sake of clarity.

▸ Ensure the base reference planes are shown.

Use the Contour Flange command to construct the sheet metal cover

Note

The modeling strategy for this activity is to use the construction surface to
control the size and shape of the cover. PathFinder shows the thickness
face as a construction surface. Constructions will need to be displayed in
PathFinder to see the linked inter-part copy.
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▸ Click the Contour Flange command. Select the reference plane as shown.

▸ Draw the profile as shown. Dimension and constrain the left side the same
as shown for the right side. Apply a horizontal/vertical relationship as shown
(A). Click Close Sketch.
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▸ Click outside the profile to accept the side step as shown.

▸ Click the Symmetric Extent button, and then select any key point on the
construction surface for the cover extent. Click Finish to complete the cover.

Note

The new cover is now in place. If an edit is made to Chassis.psm (from which
the construction surface was copied), the new cover will update when the
update links button is clicked, and then the construction surface will update.
You will do this later in the activity.

▸ Click View® Show® Hide Previous Level. This turns on the display of
Chassis.psm.

▸ Hide the reference planes.
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▸ Save, but do not exit the file. Click Yes if you see the dialog box shown.

Place a cutout and four holes on the top face of the cover linked via Inter-part

▸ Click Home®Clipboard®Inter-part Copy. Copy the four top faces of the tabs
as shown.

▸ Click View® Show® Hide Previous Level to turn off the display of Chassis.psm.
The cover and the four copied faces display.
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Place four holes on the cover using the inter-part copied faces as reference

▸ Click the Home®Sheet Metal® Hole command.

▸ Highlight the top face of the sheet metal cover for the reference plane and orient
the plane as shown. Press N to toggle reference plane orientations, then click to
select this orientation.

▸ Click the Hole Options button.
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▸ Set the options as shown.
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▸ Place four 6.35 mm Simple holes centered on the circles of each inter-part copied
face as shown.

▸ Close the sketch and select the direction as shown, then click Finish.

▸ In PathFinder, turn off the surfaces created by inter-part copy.
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▸ Save the file. The result is shown.

Add a cutout to the cover

▸ Click the Home®Sheet Metal® Hole®Cut.

▸ Select the top face of the sheet metal cover for the reference plane and orient
as shown.
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▸ Draw the profile for the cutout as shown.

▸ Click Close Sketch.

▸ Click Through Next and position the arrow as shown.
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▸ Click Finish.

▸ Save the file, and click Yes in the Save Top Level Assembly dialog box.

Turn on the display of Chassis.psm and then return to the assembly file

▸ Click Hide Previous Level to turn on the display of Chassis.psm. The two-part
assembly displays.

▸ Click Close and Return. This returns you to the assembly.

Make an edit and update the links to update the new sheet metal cover

▸ On Assembly PathFinder, right-click Chassis.psm, and then click Edit on the
shortcut menu. This opens the Chassis.psm file for editing.

▸ Right-click the first contour flange feature listed in PathFinder and then click
Edit Definition. This is the base feature for the model.

mt01416-s-1040 Solid Edge assembly 8-49



Lesson 8 Designing in the context of an assembly

▸ Select the following dimensions and edit their values:

200 mm (part length) to 250 mm

50 mm (part height) to 75 mm

▸ After Chassis.psm recomputes, click Close and Return to return to the assembly
file. If the cover has not updated at this time, click Tools®Links®Update All
Links to force the update.

▸ Repeat the editing procedure, and change dimensions on Chassis.psm back to
their original values:

250 mm (part length) to 200 mm

75 mm (part height) to 50 mm

▸ Save the file. This completes the activity.
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Activity Summary

In this activity you learned how to use the create in place command to create a new
sheet metal file in the context of an existing assembly. Inter-part functionality was
used to link geometry in the new sheet metal file to geometry in other files in the
assembly. You learned that because the faces used to create the new sheet metal
file were linked to the other parts of the assembly, changes made to those other
parts result in a change of size and shape of the new part, which responds to the
changes made via the inter-part link.
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Lesson review
Answer the following questions:

1. Name the two methods of building an assembly in Solid Edge.

2. Describe the bottom up approach to assembly modeling.

3. Describe the top down approach to assembly modeling.

4. Is it possible to combine top down and bottom up assembly modeling?

5. Describe the use of the include command when using the top down assembly
modeling approach.
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Answers
1. Name the two methods of building an assembly in Solid Edge.

The two methods are the top down approach and the bottom up approach.

2. Describe the bottom up approach to assembly modeling.

Bottom-up assembly modeling is a part-centric modeling method where the
assembly design is started with a principal structural or functional element, and
individual parts are designed in relative isolation from the overall assembly.
Component parts and subassemblies are defined as the process moves up
towards the top-level assembly. With this approach, as the design of a key
component is completed, its geometry may or may not be used to aid the design
of related mating components.

This approach is often used at companies where the product being designed is
small enough that one or only a few people are needed to complete the design.

3. Describe the top down approach to assembly modeling.

Top-down assembly modeling is an assembly-centric modeling method where the
assembly design is started at the highest level possible, and individual parts and
subassemblies are defined within the context of the overall assembly. With this
approach, an assembly layout is typically created first, and this assembly layout
is used to define individual part geometry and position.

This approach is often used at companies where the product being designed is
large enough that it requires many people to complete the design. A senior-level
designer might create the initial assembly layout, then divide the assembly
layout into logical subassemblies and parts for the remainder of the organization
to complete.

4. Is it possible to combine top down and bottom up assembly modeling?

Yes, both top down and bottom up assembly modeling can be used together
during assembly modeling.

Solid Edge provides tools that allow you to take advantage of the benefits of both
approaches as needed. Many organizations use a combination of both methods,
using the method which best suits the immediate requirements. For example,
you can use the top-down approach to create the initial assembly layout and to
define the document structure needed. You can then copy the assembly layout
geometry to subassembly and part documents to divide the work among the
organization.

You can shift to the bottom-up approach in areas of the design that use purchased
parts, existing parts from an earlier project, or where you are modeling standard
parts in 3D that were created on an earlier 2D CAD system.

The suite of commands and tools in Solid Edge also allow you to use either
approach associatively or non-associatively, as you see fit.

5. Describe the use of the include command when using the top down assembly
modeling approach.

The Include command also allows you to associatively or non-associatively copy
geometry between documents when working in the context of an assembly.
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Many feature commands allow you to define the extent of the feature
associatively by selecting a keypoint on another part in the assembly.
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Lesson summary
In this lesson you learned how to use the create in place command to create a new
sheet metal file in the context of an existing assembly. Inter-part functionality was
used to link geometry in the new sheet metal file to geometry in other files in the
assembly. You learned that because the faces used to create the new sheet metal
file were linked to the other parts of the assembly, changes made to those other
parts result in a change of size and shape of the new part, which responds to the
changes made via the inter-part link.
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Assembly layouts

Overview

Creating parts in an assembly whose size and shape can be controlled based on the
size and shape of geometry in a sketch in the assembly is accomplished through
Inter-part links. When the geometry of the sketch changes, the Inter-part links in
the linked part alter the geometry accordingly.
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Assembly layouts

As you develop the design concepts for a new assembly, it is useful to create a layout
of the preliminary design. The Sketch command in the Assembly environment allows
you to draw 2D sketch geometry on part or assembly reference planes.

You can draw assembly sketches on the three default assembly reference planes or
you can create new assembly reference planes to draw sketches on.

You can use assembly sketches to do the following:

• Create 3D ordered geometry within parts.

• Create assembly features.

• Position 3D parts relative to the sketch geometry.

• Position an assembly sketch relative to a 3D part.

Note

For more information about 2D drawing in Solid Edge, see the Drawing in
Solid Edge and Drawing Profiles topics.
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Drawing an assembly sketch

Drawing an assembly sketch is similar to drawing a sketch in the Part environment.
When you click the Sketch button and then select or define a reference plane, a sketch
view is displayed. You can position the new reference plane relative to an assembly
reference plane or relative to a face or reference plane on a part in the assembly.

You can use the 2D element creation commands to draw sketches that represent the
basic shapes of the parts. You can set style, color, type, and width options for the 2D
elements to make it easier to interpret the assembly sketch.

The 2D elements you draw are assigned to the active layer. For example, when
working with a complex assembly sketch that will be used to construct several parts,
you may want to arrange the elements on multiple layers.

You can add dimensions and relationships to control the position and size of the
sketches. You can also define functional relationships using the Variables command.
You can use the PathFinder shortcut menu commands to control the display of the
sketch elements.

You can also control the display of elements in an assembly sketch by assigning the
elements to a logical set of layers, and then display or hide the layers to control the
display of the elements.

You can use the Save and Save All commands to save an assembly sketch. When
you have finished drawing, close the sketch view using the Close Sketch command
on the Home tab.

Copying sketches

Your assembly layout might contain representations of many parts and
subassemblies, and during the course of design you might choose to copy sketches
between documents. You can use the Copy Sketch command to copy assembly and
part sketches between documents when working in the context of an assembly.
When copying sketches, you use the Copy Sketch To Target dialog box to specify
the target document, and whether the copied sketch is associatively linked to the
original sketch.
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Tearing-off sketches

You can use the Tear-Off Sketch command to move or copy elements in an assembly
sketch to new reference plane you define.

When you copy sketch elements, you can use the options on the Tear-Off Sketch
Options dialog box to specify whether the copied elements are associative to the
existing elements.

Using an assembly sketch to construct parts and subassemblies

Note

Assembly sketch geometry can be associatively linked to drive the creation of
ordered part geometry only.

When you create or modify a part or subassembly in the context of the assembly, you
can use your assembly sketches to construct part profiles and subassembly sketches.
You can also use the sketch elements to construct assembly features. For example,
you can use the Include command to include an element from an assembly sketch to
a part profile or to include an edge from a part to the assembly sketch.

To associatively include an assembly sketch element, you must first set an option
on the Inter-Part tab on the Options dialog box: Allow Inter-Part Links Using:
Include Command In Part and Assembly Sketches. Then, on the Include Options
dialog box, set the Allow Locate of Peer Assembly Parts and Assembly Sketches
option and the Maintain Associativity When Including Geometry From Other Parts
in the Assembly option.

Note

For more information about working with associative links between parts and
assemblies in Solid Edge, see the Inter-Part Associativity topic.
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Link relationship handle

A special relationship handle is added to any linked profile element (A) to indicate
that it is linked to an element in another document. You can break a link by deleting
the relationship handle for that link.

Positioning 3D components using assembly sketches

You can position parts and subassemblies with respect to a part or assembly sketch.
You can position 3D components using assembly relationships, such as mate and
planar align; or using 2D dimensions and relationships, such as distance between
and connect.

While editing an assembly sketch, you can use the Parts Library tab to add new
components to the assembly.

Positioning 3D components using assembly relationships

You can use assembly relationships, such as mate, planar align, connect and
axial align, to position a part to a keypoint or a line on a part, subassembly,
or top-level assembly sketch.

For example, it can be difficult to position a bolt in a slot using faces. In this
example, a bolt part is positioned to a point element on a part sketch.

An inferred axis that is perpendicular to the reference plane of the sketch on
which the point lies defines the axis for the axial align relationship. The arc and
point were drawn such that if the size or position of the slot changes, the arc
and point will also update properly.

Positioning 3D components using 2D dimensions and relationships

While you are editing an assembly sketch, you can use 2D dimensions and
relationships to position a 3D component relative to elements in the sketch.
For example, you can use connect relationships (A) to position roller parts (B)
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relative to an assembly sketch. When you edit the assembly sketch, the position
of the roller parts update. This can be useful when creating a new assembly
that uses existing components.

In this example, the value of the 60 millimeter dimension was edited in the
assembly sketch to 75 millimeters. Because the roller part was constrained to
the assembly sketch using a 2D connect relationship, the position of the roller
updated when the sketch dimension was edited.

When a sketch window is active, you can use the Select tool and options on the
Position 3D Component command bar to specify whether the sketch drives the
position of the 3D component or the 3D component drives the position of the
sketch. In the previous example, the Sketch Driving option was set for the roller
parts to specify that the sketch drives the position of the 3D components.

Note

When you set the Sketch Driving option, the component symbol in
PathFinder indicates that the component is driven by the assembly sketch.
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You can use the Select tool to select the 3D component in PathFinder or you can
use the Component Select Tool command to select the 3D component in the
graphics window. In either case, when you select the 3D component, the Position
3D Component command bar is displayed.

As you choose which relationships and techniques to use when you position
components in assemblies, keep in mind the following:

• That you cannot use 2D dimensions and relationships to position 3D
components that conflict with existing 3D relationships.

• When you set the Sketch Driving option for a part, it is with respect to the
current sketch. If relationships are available, the part can be driven by or
drive another sketch.

• You can set the Sketch Driving option for a part in more than one sketch and
apply 2D relationships in each sketch until the part is fully positioned. This
can make it easy to fully position a part using two or more sketches.

• When you set the Lock Alignment option on the Position 3D Component
command bar, the part is locked parallel with respect to the sketch plane and
the part face you selected. The part can still move and rotate. This can make
it easy to fully position a part using one sketch.

Positioning assembly sketches using 3D components

You can also constrain elements on an assembly sketch to a 3D assembly component
such that if the size, shape or position of the 3D component changes, the assembly
sketch updates. When you are editing an assembly sketch, you can select a 3D
component and set the Component Driving option on the Position 3D Component
command bar to specify that the 3D component drives the size, shape, and position
of the assembly sketch.

Assembly sketches and alternate assemblies

The Sketch and Copy Sketch commands are available only when the Apply Edits to
All Members option on the Alternate Assemblies tab is set (you are working globally).

For more information, see the Alternate Assemblies Impact on Solid Edge
Functionality Help topic.
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Activity: Layout sketches in assembly

When you complete this activity, you will be able to use inter-part modeling
techniques to create new parts in an assembly using sketch geometry in the top
level assembly.

For this activity, you will use sketch geometry to control the size and shape of two
halves of a radio housing.

Activity guides you through the process of associatively linking parts with Inter-part
links to sketch geometry, so that changes in the sketch will be reflected in the
parts in the assembly.
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Activity: Creating parts from assembly sketches

This activity shows how part geometry can be driven from assembly sketches that
are associatively linked to the part.

Activity – Creating parts from assembly sketches

Overview

When you complete this activity, you will be able to use inter-part modeling
techniques to create new parts in an assembly using sketch geometry in the top
level assembly.

Objectives

When you complete this activity, you will be able to model the shell of a radio housing
shown in the following illustration. This activity teaches the Include from assembly
sketches modeling capability of Solid Edge inter-part assembly. The Include from
Assembly sketches option allows you to model mating parts within an assembly that
maintains like design characteristics between its parts. Sketch sharing is the key
to maintaining like characteristics between parts. When you change a sketch, the
mating part(s) change. This is a top-down assembly modeling method.
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Set associativity parameters

Set the parameters needed to have the sketch control the geometry of the parts
created in the assembly.

▸ Open radio.asm located in the folder where you placed your activity files.

▸ Click the Application button, then click Solid Edge Options. In the Solid Edge
Options dialog box, click the inter-part tab. Select the options as shown and
click OK.

Note

For this activity, an assembly sketch is provided. This sketch will be used
to drive the creation of two parts that make up the front and back of
a radio housing.

Create a part that is the front half of the radio housing

Create a part that is the front-half of the radio housing.

▸ Click Home®Assemble®Create Part In-Place.
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▸ Type the new part file name as front. The new file location will be the same
location as the current assembly. Click Create and Edit. Solid Edge opens the
new part file and displays the sketch contained in the assembly file radio.asm.

Construct an extrusion

Construct an extrusion using the assembly sketch.

▸ If you are in the Synchronous environment, right-click in PathFinder and then
click Transition to Ordered.

▸ In PathFinder, display the base reference planes.

▸ Click the Extrude command.
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▸ Select the reference plane shown.

▸ Click the Include command.

▸ In the Include Options dialog box, make the selections as shown. Any elements
you select to include will link to the assembly sketch for associative edits. Click
OK.

▸ In the command bar, set the select box to Wireframe chain.
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▸ Select the sketch chain shown.

▸ Click the Accept button and then Close Sketch.

▸ Type 15 for the finite extent distance and select the extent direction shown.

▸ Click Finish.

▸ In Feature PathFinder, turn off all reference planes in the current part file. The
reference planes and sketch from the assembly file continue to display.
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▸ Click View®Show®Hide Previous Level. This turns off the display of the
reference planes and the sketch.

Add a round

Add a round to an edge of the part.

▸ Click the Round command.

▸ Select the edge shown.

▸ Type 3 for the radius and click the Accept button.

mt01416-s-1040 Solid Edge assembly 8-69



Lesson 8 Designing in the context of an assembly

▸ Click Preview and then Finish.

Apply a thickness to the part

Apply a thickness to the part using the thin wall command.

▸ Click the Thin Wall command.

▸ Type 3 for the common thickness. Select the face shown to be the open face.
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▸ Click Preview and then Finish. In the image below, the part was rotated 180°
to show the thin wall feature.

Add cutouts

Add several cutout features to the part in one step.

▸ Click the Cut command.

▸ Click View®Show®Hide Previous Level. This turns the display of the reference
planes and the sketch back on again.

mt01416-s-1040 Solid Edge assembly 8-71



Lesson 8 Designing in the context of an assembly

▸ Select the front face as the profile plane as shown.

▸ Click the Include command. Set the options as shown and click OK.

▸ Set the select field to Wireframe Chain.
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▸ Select the five chain sets shown and click the Accept button. Click Close Sketch.

▸ Select the Through Next option for the extent. Set the direction as shown and
click Finish.
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The front part is now complete.

▸ Click the Home tab. Click Close and Return to return to the assembly file
radio.asm.

▸ Click the Assembly PathFinder tab and notice that the part just created is now a
part of the assembly.

Create the back half of the radio housing

Create the back-half of the radio housing.

▸ Click Home®Assemble®Create Part In-Place.
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▸ Type the new part file name as back. The new file location will be the same
location as the current assembly. Click Create and Edit. Solid Edge opens the
new part file and displays the sketch contained in the assembly file radio.asm.

Construct a protrusion using the assembly sketch

Construct a protrusion using the assembly sketch.

▸ If you are in the Synchronous environment, right-click in PathFinder and then
click Transition to Ordered.

▸ In PathFinder, display the base reference planes.

▸ Click the Extrude command.
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▸ Select the reference plane shown.

▸ Click the Include command. In the Include Options dialog box, make the
selections as shown. Any elements you select to include will link to the assembly
sketch for associative edits. Click OK.

▸ Set the select field to Wireframe Chain.
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▸ Select the outside wireframe chain as shown. Click the Accept button and then
click Close Sketch.

▸ Use the Finite Extent and type 12 for the distance. Set the direction as shown
and click Finish.
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▸ Click View®Show®Hide Previous Level.

Add a cutout to the part

Add a cutout to the part.

▸ Click the Cut command.

▸ Select the face shown for the profile plane.
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▸ Draw and dimension the profile as shown. Click Close Sketch.

▸ Position the arrow as shown and click for direction of material removal.
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▸ Select the Through All Extent option and set the direction arrow to both
directions as shown and click.

▸ Click Finish.

Note

The view was rotated 180o for the image below.

Thin wall the part

Apply thickness to the part using the thin wall command.

▸ Click the Thin Wall command.

▸ On the command bar, type 3 for the common thickness.
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▸ Select the face shown as the open face. Click Preview and then Finish.

Add another cutout

Add another cutout using elements from the assembly sketch.

▸ Click the Cut command.

▸ Click View®Show®Hide Previous Level.
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▸ Select the face shown for the profile plane.

▸ Click the Include command. Click OK in the dialog box.

▸ On the command bar, set the Select field to Wireframe Chain.

▸ Select the wireframe chain as shown and click the Accept button. Click Close
Sketch.
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▸ Click the Through Next Extent option. Set the extent direction as shown and
click.

▸ Click Finish.
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The back part is now complete.

▸ Click Close and Return to return to the assembly file radio.asm.

▸ Click the Assembly PathFinder tab and notice that the part just created is now a
part of the assembly.

Edit the assembly sketch and observe changes

Now that two parts are created that are driven by the assembly sketch, edit the
assembly sketch to observe how the two parts update to the sketch changes.

▸ Click the Select tool.

▸ In Assembly PathFinder, click the assembly sketch named Sketch_1.

▸ Click the Edit Definition button.

▸ Click the Draw Profile step in the command bar.
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▸ Edit the dimensions as shown.

A=80

B=140

C=30

D=30

▸ Click Close Sketch. Click Finish, and notice how the assembly parts update to
the changes made to the assembly sketch dimensions.
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Repeat the previous step

Repeat the previous step to make the following changes to the assembly sketch.

▸ Edit the dimensions as shown.

A=90

B=60

C=25

▸ Click Close. Click Finish to update the assembly parts.
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Link the wall thickness to the two parts

The final step in the activity is to link the wall thickness variables of the two parts.
This will ensure that if a change is made to the wall thickness that both parts will
update simultaneously. Use peer variables to accomplish this.

▸ Click Tools®Variables®Peer Variables.

▸ Click front.par in the assembly window. A variable table for the selected part
displays. To display the dimensions and variables, click the Filter button. Click
dimensions and user variables in the type: field and select the radio button
for both as shown. Click OK.
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▸ Click the left-most button on the Thinwall_1_Thickness variable and then
right-click (the variable name may differ slightly). Select Copy Link as shown.

▸ Click back.par in the assembly window. A variable table for the selected part
displays.

▸ Click the left-most button on Thinwall_3_Thickness variable and then right-click
(the variable name may differ slightly). Select Paste Link.

▸ Notice the link placed in the formula field for the wall thickness variable
for back.par. If the wall thickness is edited in front.par, back.par updates
automatically to same wall thickness value.
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▸ Click Close to dismiss the variable table.

▸ This completes this activity.

Activity summary

In this activity, you learned how to use assembly sketches to create and control the
size and shape of parts created in a top down design. Inter-part links between the
assembly geometry and the part features were used to control the part features from
the assembly sketch. Variables from the assembly can be linked to variables in part
files to link dimensions and control geometric behavior as the dimensions change.

mt01416-s-1040 Solid Edge assembly 8-89



Lesson 8 Designing in the context of an assembly

Lesson review
Answer the following questions:

1. What is an assembly layout sketch?

2. What command is used to create a new part or sheet metal document from
within the context of an assembly?

3. When will changing the size and shape of geometry in a layout sketch change the
size and shape of part or sheet metal components within an assembly?
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Answers
1. What is an assembly layout sketch?

An assembly layout sketch is a sketch created in an assembly document defining
the positioning of more than one component within the assembly. Creating
assembly components from layout sketches utilizes the top down approach of
assembly modeling.

2. What command is used to create a new part or sheet metal document from
within the context of an assembly?

The create in place command within the assembly environment creates a new
part or sheet metal document within the context of an assembly.

3. When will changing the size and shape of geometry in a layout sketch change the
size and shape of part or sheet metal components within an assembly?

When creating a part in place using assembly layout sketches, extrusions and
sketches in the ordered environment can be linked to the assembly sketches
where the assembly sketches drive the geometry.
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Lesson summary
In this lesson, you learned how to use assembly sketches to create and control the
size and shape of parts created in a top down design. Inter-part links between the
assembly geometry and the part features were used to control the part features from
the assembly sketch. Variables from the assembly can be linked to variables in part
files to link dimensions and control geometric behavior as the dimensions change.
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Lesson review
1. Can the two methods named above be used in combination? Explain.

2. What method of Top down design allows you to design an assembly structure
prior to having geometrically accurate parts available? How are these parts
positioned? Can existing parts be used in harmony with yet to be designed parts
in this structure? What are these components called?

3. What is the key consideration in determining which assembly construction
method you should use?

4. What benefit is gained from modeling a part in context of an assembly?

5. What command in Solid Edge assembly is used to create a new part or sheet
metal model file? Where is the button for this command located?

6. What command in Solid Edge assembly is used to create associative relationships
between parts?

7. Describe the fundamental steps necessary to perform an inter-part copy.

8. If the Include command in part and assembly sketches process is used from the
inter-part tab on the options dialog box, what role does the assembly sketch play?

9. If the Cutout button is not active on the assembly feature commands, what
must you do to make it active?

10. Where can you view all the inter-part relationships in an assembly?

11. Can an inter-part link be broken? If yes, how?
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Revising assemblies
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Objectives

After completing this lesson, you should be able to:

• Use the Edit and Open In Solid Edge Part commands to make modifications to
parts in an assembly.

• Use the Edit Links dialog box to review and modify documents linked to an
assembly.

• Use the Update Links command to manage linked documents in an assembly.

• Use View and Markup: Revision Manager to create revisions for an assembly.

• Use the Properties command to review and enter document properties.

• Set the document status and understand the effect of status on the accessibility
of documents to different users.

• Generate bill of material reports, and preview parts and assemblies without
having to run Solid Edge.
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Introduction

Solid Edge supports assembly management, including the process of revising
assemblies. View and Markup: Revision Manager lets you copy an assembly, replace
parts in it, and create new revisions of the assembly and its parts. Document
management tools in Solid Edge enable efficient management of Solid Edge
documents and related information. Use these tools to save descriptive information
about a document, control access to files, and track the progress of a file through
the work cycle. Searching for and retrieving documents is easy with user-defined
search criteria. Documents can be routed to a group of users for review, approval, or
rejection.

Windows Explorer can access many document management tasks. A shortcut menu
displays Solid Edge-related commands when you right-click a Solid Edge file in
Windows Explorer.
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Document properties
A document’s properties are an important part of managing documents. Using
document properties, you can store document information with the document
itself, instead of in a separate database. This makes it easy to find documents
and information about them. Using the File Properties command available from
Application menu®Properties, you can view, edit, and store properties for a
document.

Propseed.txt File
Propseed.txt is an ASCII text file that is used to populate values on the Properties
dialog box. You can use a text editor, such as Notepad, to add values to the file.

By default, the file is located in the Solid Edge Program folder. For example, if
you loaded Solid Edge to drive C, the path would be C:\Program Files\Solid Edge
ST4\Program\propseed.txt.

You can instruct Solid Edge to look for propseed.txt in a different folder, including
a folder on another machine in the network. To do this, on the Application menu,
click Solid Edge Options. On the File Locations tab of the Solid Edge Options dialog
box, select Property Seed File and click Modify. On the Browse dialog box, specify
the drive and folder containing the propseed.txt file. After specifying the location,
click Update.
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General and summary properties

Some properties are updated automatically by the software; they can include the
title, the author, and keywords that identify important information. These properties
also can include document statistics, such as document size and the date that a
document was created and last modified.

Units of measure

The unit of measure settings for a document are stored as a property. When you set
the units of measure on the Units tab on the File Properties dialog box, the units
of measure for various types of measurements in a document are displayed in the
units you specified. For example, when you set the length unit of measure to inches,
then the output values for the measurement commands on the Inspect menu that
measure elements lengths are displayed in inches.

You can set units of measure for values such as length, area, or angles. You can
change the unit of measure at any time in a document.

The precision readout options set the number of significant figures to display. It sets
the accuracy of the unit readout value. The precision setting does not alter the
numbers that you type, only the display of the numbers in the box. Values ending in
5 are rounded up. For example, if the precision readout is .123 and you draw a line
that is 2.1056 inches long, then the line value length is rounded. The length value
appears as 2.106 inches long. If you are using mm as your drawing sheet units, you
can have the values display as 3.5 mm or 3.50 mm.

Note

The units of measure settings for a document do not affect the units used for
dimensions you place with the dimensioning commands.

You specify the dimensional value units you want with the Style option on the
Dimension command bar. You can modify the delivered dimension styles and
create new dimension styles using the Style command on the Format menu.
To make it easy to reuse the unit settings you want, you should define and
use document templates. You can also set the units used for an individual
dimension using the Properties command on the shortcut menu when you
select a dimension.

Document status

You can track or change the status of a document (for example, Available, In Work,
Released, Baselined) in the Status page of the File Properties dialog box.

Note

The Status page is not available in Insight XT which uses custom properties
to display status information.

You can determine the status of a document within its life cycle or browse parts of the
document tree. A document tree consists of a top-level document and subdocuments.
The status of a document can be updated using the Update Status Info command,
available from the shortcut menu in PathFinder while no item is highlighted.
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Changing Document status

The software tracks the status of a document with a status property. When you create
a document, the default status property is set to Available. If you want to work with
a document for an extended time, you can use Property Manager to change the status
to In Work. The software then stores your user name with the document. If you want
to review information in a document, you can change the status to In Review.

When a document’s status is set to In Work, the document cannot be opened for
edit by another user. However, a read-only copy of the document is available for
review. Anyone attempting to access the document can choose to be notified when
the document becomes available. When you have completed work on a document,
you can make it available to other users by using the Property Manager to change
the document status to Available.

Note

Document status available to document in Insight XT are: Working, In
Review, In Approval, Released, and Obsolete.

Preview

You can save a bitmap picture of a document’s graphic content and save it as a
property. The bitmap picture can be used in the Open dialog box and in Windows
Windows Explorer to display a preview of the document.

You can also create a custom large icon to easily view the contents of the document.
The custom large icon is displayed in the Solid Edge Find Files window when you
select the Large Icon View option in Solid Edge Find Files.

Custom properties

You can define custom properties to store information regarding your documents.
The custom property information is stored within the document and viewable on
the Custom tab of the Properties dialog box. For example, Density and Accuracy
are custom properties.

In Insight XT, custom properties store status information. Custom properties created
as a result of saving or opening a Insight XT managed document are:

PDM_Status_ID
Contains the value associated with the status.

PDM_Status
Displays the current status of the document (Working, In Review). This property
is owned by Insight XT (/master=iman).

PDM _Status_User
Displays the user of the document. This property is owned by Insight XT
(/master=iman).

PDM _Status_Date
Displays the date the document is accessed.
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Concurrent design

Concurrent design allows multiple users to access an assembly document
simultaneously. To assist in controlling concurrent access, you can define the status
of parts and assemblies with the Properties dialog box. You can provide read-only
access to the top-level assembly and write-access to the parts and sub-assemblies.
This allows multiple users to actually work in the context of the same assembly at
the same time, but on different parts.

Another advantage of concurrent design is the ability to update the display to see
the changes made to the assembly by other users. In the following example, user A
can open a part in an assembly. At the same time, user B can display a read-only
version of the entire assembly.
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As user A places two additional holes in the part, user B can update the display of
the assembly to view any changes made to the assembly.

Baselining documents

You can use the Property Manager command to baseline a document, freezing it and
preventing further modification. Documents linked to a baselined document are not
frozen. You must either baseline or release any linked documents that you want to
freeze from modifications.

The baselined document can then be used as a point of reference if changes are made
downstream. Baselining a document also forces later modifications to be made in a
new version of the document, instead of the current version.

When you baseline a base document, the individual documents are not automatically
set to baselined. You have to manually set the documents that you want to baseline.
You can also set the status of the individual documents to released.

Releasing documents

Base documents contain all the links for individual documents. Individual
documents can contain parts, floorplans, drawings, and so forth. You can use
the Property Manager command to release a base document and its individual
documents at the same time, or you can release individual documents.

Routing documents

Routing slips can be used to send documents to one or more users for review. A
routing slip allows you to list the users that should receive mail containing the
attached document. Documents can be routed to (A) all users at one time or (B)
users one after another.
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When you route a document to users one after another, and one user completes a
review, the document is routed to the next user in the list. When you receive routed
documents, you can double-click the attached document in the mail message to
activate the appropriate application for viewing the document.

The routing slip can contain a sign-off request for approval or rejection of the
contents. The software records all sign-off results. When all the users in the list
have approved the document, you can use the Properties command to change the
document status to released to freeze the document and prevent further modification.

Note

Routing is disabled for managed documents.

Managing document properties
You can use the Property Manager command to modify existing properties or create
new properties for a document in Solid Edge or Insight Connect. The command
displays the Property Manager Select dialog box that allows you to select folders and
files that contain properties that you want to edit. The dialog box reacts differently
depending on whether or not you have an active document.

If you have an active document in Solid Edge, the Property Manager Select dialog
box is not displayed. The Property Manager dialog box is displayed to allow you to
edit the properties of the active document. You can use the No Levels and BOM View
options on the Property Manager dialog box to display the document in a list view
with no levels or a BOM view with levels. By default, the view is a list view.

If you have an active document in Insight Connect, the Property Manager Select
dialog box is displayed with both the BOM View For and User View options enabled.
This allows you to edit the properties based on the BOM structure of the active
document or based on a selected list of folders and documents.

If you have no documents open in Solid Edge or Insight Connect, the Property
Manager Select dialog box is displayed with User View option disabled and the BOM
View For option enabled. You can click the folders and files that contain properties
you want to edit and click the Add button to add them to the Edit Properties box.
You can select the OK button to display the Property Manager dialog box and edit
the properties for selected documents.
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Editing document properties

Once you make selections on the Property Manager Select dialog box and click
the OK button, the Property Manager dialog box is displayed to allow you to edit
property values. Any properties that you cannot edit are disabled and appear in gray.

To edit a value, click on the appropriate property cell and type in the new value.
When you edit a property, the document containing the property is checked out to
prevent others from making changes. After you edit a property value, the property
cell is underlined to indicate that it has been changed. The cell remains underlined
until you click the Save button to save the changes or click the Restore button to
set the value back to the previous value. You can use the Copy, Cut, and Paste
buttons to edit information between cells.

Note

The Save button is disabled when you use the Property Manager command
within Solid Edge. To save your changes, use the Save command on the File
menu to maintain assembly integrity.

You can use the Show Properties dialog box to specify the properties you want to
display on the Property Manager dialog box. To display the dialog box, in the list of
displayed documents and folders in the Property Manager dialog box, click the right
mouse button on any row containing information, and then click Show Properties
on the shortcut menu.

You can add properties to the list that is displayed on the Property Manager dialog
box. To add a property to the displayed list, on the Show Properties dialog box, select
the property in the Available Properties box and click the Add button to add the
property to the Show These Properties in This Order Box. You can use the Select
Available Properties From pulldown menu to control the list of available properties.

You can remove properties from the list that is displayed on the Property Manager
dialog box. To remove a property from the displayed list, on the Show Properties
dialog box, select the property in the Show These Properties in This Order box,
and click the Remove button.

You can use the Move Up and Move Down buttons to change the display order for the
properties. Use the Move Up button to move the property further to the left in the
list and the Move Down button to move the property further to the right.

Note

You can select a column heading in the Property Manager dialog box, then use
drag and drop to change the order of the columns.
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To create new document properties, click the New button to display the New
Property dialog box. After you add the information for the new property and click
the OK button, the property appears in the Show These Properties in This Order
box. When you click the OK button on the Show Properties dialog box, the new
property is displayed in the list.

You can use the Files of Type option to control the types of documents that appear
in the list of documents. You can edit the properties for non-Solid Edge documents.
However, for non-Solid Edge documents, you can only edit profile properties for
managed documents.

Note

The Files of Type option is disabled in the BOM view.

You can edit the properties for both managed and non-managed documents.
However, you cannot edit both types at the same time. You determine the type of
documents you want to edit when you select the first folder or document on the
Property Manager Select dialog box. You must be able to check out a managed
document to edit the document properties. If you edit a property for a managed
document that is not checked out, the document is checked out when you make the
change, but the cache is not updated with linked documents. You can change the
document profile for a managed document if you have the Profile property displayed
on the Property Manager dialog box.

If a property for a managed document belongs to the workspace, but does not belong
to a profile, then the property is assigned a String data type. For example, suppose
a property, Color, belongs to a workspace named //servername/workspace. The
workspace contains a profile, SampleProfile, that does not contain the property
Color. Therefore none of the documents associated with SampleProfile contain the
property. If you use the Property Manager command and select a managed document
that is associated with SampleProfile, the data type of the selected property for the
document is String or Text. If you edit the property, the Color property is added to
the document with a data type or Text.

You can copy and paste SharePoint property values between parts. You should
understand that the copy and paste procedure uses the what you see is what you get
method. For example, suppose you have a SharePoint property that is defined to
display three decimal places. Part A in Assembly 1 has a value of 5.12493 for a
numeric property. If you open the assembly in Property Manager, the property
for Part A displays 5.125. If you copy and paste this numeric value into Part B of
Assembly 1, the defined property value is the displayed value of 5.125 instead of the
actual value of 5.12493.
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Property display

The display of property values in the list depends on whether or not the property
belongs to the profile. If the property belongs to the profile, the list displays the
property value for managed document. If the property does not belong to the profile,
the property is either a standard or custom property for the document and the list
displays the displays the property value from the unmanaged document.

For example, suppose you use the Property Manager command to change the value
of a profile property named Width from 20 to 25. Then, you save the document, but
do not close it in Solid Edge. If you re-run the Property Manager command, the
value displayed in the list is still 20. Since you have not checked in the document
that contains the changes to the Width property, the value for the property in the
library is still 20.

Property synchronization during upload and download

Each time you upload documents to a workspace or use the Create Unmanaged Copy
command to create an unmanaged copy of a document, Solid Edge synchronizes
the profile and document properties. Solid Edge creates custom properties in the
document for the profile properties that don’t exist in the document and then
populates the custom property with the profile property value.

Only properties for documents that support standard property storage are
synchronized. If the document does not support standard property storage, it is
skipped and no error is reported.

When uploading a file, if the profile and document contain different values for the
same property, the document property becomes the default value.

When using the Create Unmanaged Copy command, if a custom property already
exists, Solid Edge checks to make sure the values for the profile property and custom
property match. If the values are different, profile property becomes the default
value.

When downloading a file or using the Create Unmanaged Copy command, if there is
a custom property that matches a Solid Edge system property, such as document
number, Solid Edge copies the value of the custom property to the system property,
and then removes the custom property. This only applies to Solid Edge documents. If
there is a Solid Edge system property defined as a custom property in a non-native
document, the property is not removed from the non-native document.

SharePoint Version 2003 properties

The Property Manager command, Edit Profile command, Create Unmanaged
Copy command, Add Library command, report generation, and advanced search
results support the lookup table, currency, and calculated properties delivered with
SharePoint 2003.
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Lookup properties

When working with lookup properties, administrators can specify a SharePoint list
and a specific property used to generate the lookup list. Insight uses the list of
values to create a list from which you can choose.

If you modify a lookup property with the Solid Edge Custom Property tab and
enter a value that is not valid according to the lookup, Property Manager or Edit
Profile displays the last valid value for the property that is stored by SharePoint.
For example, you can define a lookup property named supplier with three values:
SupplierA, SupplierB, and SupplierC. Suppose you create a new file and check the
file in, selecting SupplierA for the supplier on the Edit Profile dialog box. You then
re-open the part and, on the Custom tab of the Properties dialog box, change the
value for supplier to SupplierD. When you attempt to close and save the file, Edit
Profile displays SupplierA as the supplier, since SupplierD is not a valid value.

Currency properties

Solid Edge supports all of the currencies and countries supported by SharePoint
2003. Currency properties are stored as numeric custom properties on the Custom
Properties tab of the Properties dialog box.

Calculated properties

Calculated properties are added as custom properties during property
synchronization with the appropriate data type, such as numeric, string, or date,
based on the SharePoint data type used to display the calculation. If you manually
edit a custom property that is synchronized with a calculated property, your edits
are overwritten with the value from the document library.

Note

Calculated property values are not updated until the document is checked
back into the workspace, even if the properties changed during a Solid Edge
session.

Formatting SharePoint properties

Solid Edge allows you to format information for the minimum/maximum value,
number of decimal places, and show as percentage properties.

The minimum and maximum values for numeric properties are displayed as part
of the tool tip in error messages. For example, the text in the error message for a
value that exceeded the maximum value displays The value <value entered> is above
the maximum value of <property maximum value> for <property name>. Edit the
property and enter a valid value.

You can set the number of places for decimal properties to display between 0 and 5
decimal places. Property values of 0 - 4 are rounded down to the nearest decimal
place and values of 5 - 9 are rounded up to the nearest decimal value. For example, if
decimal places is set to 3 for .1234, the value is displayed as .123.

The value you enter for a Show as Percentage property is multiplied by 100 when
it is displayed. When you enter a value, it is divided by 100 when is stored in the
document.
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Standard and Custom properties

The properties used to define the document name formula are available to
unmanaged and managed documents.

Note

Properties shown in italics are custom properties.

Part Assembly or Draft Sheet Metal
Filename Filename Filename
Material Material Material
Occurrence Occurrence Occurrence

Title Title Title
Subject Subject Subject
Author Author Author
Manager Manager Manager
Company Company Company
Category Category Category
Keywords Keywords Keywords
Document Number Document Number Document Number
Revision Number Revision Number Revision Number
Project Name Project Name Project Name
Density Density
Accuracy Accuracy

Material Thickness
Bend Radius
Relief Width
Relief Length
Neutral Factor
Minimum Arc Length
Deviational Tolerance

Many of these properties are accessible through the Summary and Project tabs on
the File Properties dialog box.

Note

Solid Edge Embedded Client displays properties in addition to what is listed
here due to the properties available in Teamcenter.
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Activity: Revision Manager (release and revise)

Overview

In this activity, you learn how to change the status of a part and draft document
to released and how to make a revision to a released part and draft and move
files to a new location. You also learn how Revision Manager can be used to copy
and rename whole or parts of and assembly and preserve the links to the parts.
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Activity: Revision Manager (release and revise)

Overview

In this activity, you learn how to change the status of a part and draft document
to released. You also learn how to make a revision to a released part and draft
and move files to a new location.

Open the part

▸ Open part_a1.par.

Create a drawing

▸ Click the Application button. Choose New®Create Drawing.

▸ Click OK in the Create Drawing dialog box.

▸ On the Drawing View Creation Wizard, click Next.

▸ Under Named Views, select front and then click Next.

▸ Click Finish.

▸ Place the view in the center of the drawing sheet and then click Fit.
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▸ Use the Smart Dimension command to place the dimensions. On the command
bar, set the dimension style to ISO and the text scale to be 5.0.

▸ Close and save the draft file as part_a1.dft. The design is approved.

▸ Close and save the part file as part_a1.par.

Change the status of the draft and part files to Released

▸ In Windows Explorer, browse for part_a1.dft in the folder containing the where
the activity files are located. Right-click the file, and then click Properties.

▸ In the Properties dialog box, click the Status tab.

▸ Click Select All.

Note
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This applies the status change to both the draft and part files.

▸ Click Released, and then click OK.

▸ Both part_a1.dft and part_a1.par are read only because the status has been
set to released.

Note

If you attempt to open the released file part_a1.par, you see the following
message box.

Create a revision of the released part and draft file

▸ Start View And Markup. Click Start®Programs®Solid Edge ST4®View and
Markup.
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▸ To start Revision Manager, click File®Open®Revision Manager.

▸ In the Open a File dialog box, click part_a1.dft and then click Open.

▸ Close the window.

Use Revision Manager Assistant

▸ Click the Revision Manager Assistant.

▸ In the Select an action list, click Copy a file, and then click Next.

Note

The Revise a file option only refers to managed documents. For
unmanaged documents, choose the action to Copy a file.
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▸ When prompted to Select a file, click Browse to locate part_a1.dft. Browse to the
working folder for this document. Make sure that the other options are checked
as shown, and then click Next.

▸ Browse to C:/Temp as the new location for the copied files, and then click Next.

▸ In the Where Used dialog box, click Next.

▸ Click Finish, and then click OK In the Revision Manager information box.

▸ In the New Filename column, rename the files. Rename the file part_a1.dft to
parta1–1.dft, and the new filename for part_a1.par is parta1–1.par.
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▸ On the Main toolbar, click Perform Actions to create the copy.

Note

These new files can now be revised.

▸ On the ribbon, click File®Close.

This completes the activity of learning the process for creating file revisions.

Summary

Activity Summary

In this activity, you learned how to change the status of a part and draft document
to released and how to make a revision to a released part and draft and move files
to a new location.
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Revision Manager

Document relationship management is a complex information management problem
facing businesses and industries. As more information is being shared and reused
between documents, tracking revisions of documents and the links they contain
becomes increasingly difficult.

Making a new revision of an existing document while maintaining the original
version is a part of every document’s life cycle. When you select a document for
revision, Revision Manager displays a hierarchy of the related documents that may
or may not need to be revised as well. Revision Manager lets you do such tasks as:

• Copy and rename documents selected for revision to locations you specify.

• Update the revision and document numbers you specify.

• Update or maintain references in the document hierarchy.

• Show the size of documents.

• Copy a row or rows of data to the clipboard for printing.

• Save previous query paths.

• Preview a document.

Revising managed documents

When you add a document to a managed library on a server, it becomes a managed
document. The Set Action To Revise command, on the Manage menu in Revision
Manager, revises managed documents. When you select the command, the existing
path and an incremented version of the existing document name are placed in the
New Filename column on the Contents window. You must have a managed library
folder as part of the new document path. If you set the Get Latest Version When
Opening Document option on the Manage page of the Options dialog box, the latest
version of the document is downloaded to the local cache before it is revised.

You can revise a single document or multiple documents. When updating multiple
documents, all of the selected documents must be managed. Since the original
document does not change when you revise it, it is not checked out of the library.

If you use the Set Action to Revise command to revise a document in the context of
an assembly, the link in the assembly updates to point to the new revision. However,
you need to run the Where Used command to find where the document is used and
manually update any other documents you want linked to the new revision.

If you use the Set Action to Revise command to revise a 3D document, a Where
Used search is performed for associated draft documents and you can choose to
revise them as well. Draft documents with a status of Obsolete are ignored in the
Where Used search.

The Cache Assistant dialog box contains two commands that work together with the
Set Action to Revise command to provide information for revised documents. The
Revised From command, on the shortcut menu in Cache Assistant, displays the
name and folder path of the document that was used as a template to create the
selected document. The Show Revisions command, on the shortcut menu in Cache
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Assistant, displays the name and folder path of any documents that are revisions of
the selected document.

Revision Manager Assistant

The Revision Manager Assistant helps you perform a variety of basic document
revision tasks. The assistant presents a list of common operations to you. You can
select from the list of operations and create a streamlined set of subsequent steps
to be completed. To use the Revision Manager Assistant command, on the Main
toolbar, click the Revision Manager Assistant button.

Disabling Revision Manager

If you work strictly with viewing and marking up Solid Edge data, you may not
be concerned with the management of the data. Therefore, your needs may be
limited to those commands need to view and mark up the data. You can use Solid
Edge Administrator to disable Revision Manager and limit user access to Revision
Manager commands and other Insight utilities. To disable the option, start Solid
Edge Administrator and set the Allow Override field to Yes. Set the Value field to
Yes. Once disabled, an error message is displayed if you select Revision Manager
from the Start menu. If you disable Revision Manager and start Insight Connect,
the default environment will be View and Markup.
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Redefining links

When you move documents from one location to another, sometimes the links to
these documents break. The Redefine Links command, located on the Tools menu,
allows you to redefine the links on a selected set of files. The command does not
actually copy or move files, but instead allows you redefine links in assemblies after
the files have already been moved.

The Redefine Links command presents a series of dialog boxes that allows you to
define information needed to redefine the links.

The first dialog box allows you to select the folders or documents containing the
links that you want to define. You can choose from several filters to specify the
location and type of files you want to process. You can specify any type of Solid
Edge file or you can choose to process files listed in an ASCII text file. When you
have determined the location of the files, you can process a selected list of files, all
files within a selected folder, or all files within a selected folder and any subfolders.
Once you have selected the files you want to process, click the OK button to proceed
to the next dialog box.

The second dialog box allows you specify the link path redefinition. First, you
specify the current link path and then specify the path to which you want to redefine
the link. The dialog box provides an example of these link path definitions work.
Once you have specified the link path redefinition, click the OK button to proceed
to the next dialog box.

Note

Redefine Links only searches and replaces the first occurrence of the Current
Link Path . It will not search the BOM tree and replace other occurrences
that you may not be aware of.

The third dialog box confirms the information you entered in the previous dialog box.
It lists the number of files you have selected and the path redefinition information.
The dialog box also contains a very important option, Do not Save Files When Links
Point to Non-existent Files. If you do not select this option and attempt to process a
link that points to a non-existent file, the system will open the parent assembly and
save the redefined link path string in the parent assembly. An error is written to
the log file stating that the non-existent files could not be found. If you select the
option, the system does not open and save the redefined link path string in the
parent assembly, but does write an error message to the log file stating that the
non-existent files could not be found. Once you have confirmed this information,
click the OK button to proceed to the final dialog box.

The final dialog box tracks the processing of the selected files. It specifies the
number of the number of documents processed and the number of links repaired.
You can click the Stop button to stop the processing. You can also click the View
button to view the ReDefLinksLog.txt file, which contains information about the
links you redefined. Once you have completed redefining the links, you can click
the Finish button.
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Redefined Links Log Files

Two log files are created when you redefine links. These files are located in the same
directory that contains the files being processed.

ReDefLinksLog.txt is an ASCII text file that contains information about the files
being processed. It contains general information, such time, date, login name, and
nodename. It also contains a list of all results, both successful replacements and
problems encountered.

ReDefLinksErr.txt contains the same information as ReDefLinksLog.txt except for
the successful replacements. This is very useful when you are processing a large
number of files, most of which are successful. You can check to the errors log to
quickly see the files that need correcting. To view these files, on Redefine Links Step
3 of 4 dialog box, select the log file you want to view and click the View button.
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Activity: Revision Manager (revise and release an assembly draft)

Overview

In this activity, you learn how to release a draft of an assembly. You will revise
the draft, assembly and a single part to a new location. You will edit a part,
update the assembly and draft. When complete, you will re-release the draft.
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Activity: Revision Manager (revise and release an assembly draft)

Overview

In this activity you release a draft of an assembly. You will then revise the draft,
assembly and a single part to a new location. You will then edit a part, update the
assembly and draft. When complete, you will re-release the draft.

Open the draft file

Open module.dft.

Release the draft file

Release the draft file module.dft.

Note

A draft cannot be released unless its children (assembly, parts) have been
released.

▸ Click the Application button .

▸ Choose Properties®file Properties.
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▸ In the Properties dialog box, click the Status tab.

Notice that the Released option is unavailable.

▸ Click the + to expand the display of the files associated with module.dft.
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▸ Click Select All, and then click Select Children and click the Released button.
Click OK.

▸ Close and save module.dft. At this point, the draft, assembly and part files are
released.

▸ Exit Solid Edge.

Create a revision

A design change is needed to one part in the assembly. Create a revision of the draft,
assembly and the part that requires a design change.

▸ Start View and Markup. Click Start®Programs®Solid Edge ST4®View and
Markup.

▸ Start Revision Manager.

Click File®Open®Revision Manager.

▸ Open module.asm.
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▸ Start the Revision Manager Wizard by clicking the Revision Manager Assistant

on the main menu.

▸ Select the action Copy a file, and then click Next.

Note

The Revise a file option only refers to managed documents. For unmanaged
documants, choose the action to Copy a file.

▸ Browse for module.dft in the folder where your activity files reside. Set the
options as shown and click Next.

▸ For the new location, browse to C:\Temp and click Next.

▸ Click Next, and then click Finish in the Where Used dialog box.

▸ Click OK in the Revision Manager information box.

Clear action

Clear files that do not need a revision. Clear action on parts block.par, F100a.par,
F200a.par and F500a.par.
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▸ Right-click the filename and click Clear Action.

▸ In the New Filename field, rename the files to the names shown.

▸ Click Perform Actions to apply the revisions.

▸ Exit Revision Manager.

Make a design change to the revision part

Make a design change to the revision part cover-1.par. Add a handle to the cover.

▸ Open C:\Temp\cover-1.par.
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▸ Create a sketch on the Right (yz) reference plane and centered on the top of
the cover.
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▸ Create a protrusion from the sketch. Use a 5 mm symmetric extent.

▸ Close and save the file.

Update the assembly and drawing

Update the assembly and draft file due to the design change.

▸ Open C:\Temp\module-1.asm.

▸ If you see the following dialog box, click Yes.

▸ Close and save the file.

▸ Open C:\Temp\module-1.dft.
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▸ Click OK in the Drawing Views information box.

The box around the drawing lets you know that the view is out-of-date.
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▸ Click the Update Views command .

▸ Save the draft file.

Re-release the draft file

The revisions have been made. Re-release the draft file.

▸ Click the Application button, and then choose Properties®File Properties.
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▸ Click module-1.asm and set the status to Released.

▸ Click module-1.dft and set the status to Released.

▸ As you did in the previous steps, open cover-1.par and set the status to Released.

▸ Exit and save the file. This completes the activity on the process for revising a
draft of an assembly.

Activity Summary

Activity Summary

In this activity, you learned how to release a draft of an assembly. You revised the
draft, assembly and a single part to a new location. You edited a part, updated the
assembly and draft. When complete, you re-released the draft.
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Activity: Editing a part in context of the assembly

Overview

In this activity you edit a part in the context of an assembly and make a new
revision of a part in the assembly.
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Activity: Editing a part in context of the assembly

Overview

In this activity you will edit a part in the context of an assembly. You create anew
revision of a part in the assembly.

Objectives

In this activity you will:

• Use the Edit command to modify a part in an assembly.

• Set document properties.

Open the assembly with all parts active

Open carrier.asm. In the Open File dialog box, select the Activate all option before
you click Open.

Edit a part in the assembly

Begin the activity by editing a part in the assembly.

▸ On the Assembly PathFinder tab, right-click the left side plate Splate.par:2, and
on the shortcut menu, click Edit. The part Splate.par is displayed in the Part
environment. Use the Hide Previous Level command on the View tab to turn on
and off the display of the other parts in the assembly as needed.

Edit the part

Splate.par is now open in the part environment. Edit the part.
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▸ Click the Cut command , and select the front face of the plate as shown.

▸ Click the Include button . Set the Include Options as shown, and then click
OK. Offset four edges from the side plate one edge at a time.
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▸ Select the first edge to offset, and then on the command bar, click the Accept
button.

▸ In the distance box, type 20 mm and press the Enter key. Click toward the inside
of the part to specify the side to offset.

▸ Repeat the steps for the remaining two lines and the circle as shown. Offset all
the lines a distance of 20 mm, and offset the circle a distance of 12 mm.

▸ Click the Trim command , and then trim the geometry to create the profile
as shown.
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▸ Use the Fillet command to add four 5 mm fillets, one at each corner, as
shown.

▸ Click Close Sketch .

▸ For the extent of the cutout, click the Through Next button , and then click
when the extent arrow points toward the part.

▸ Click Finish.
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Hide the other parts

▸ On the View tab, click the Hide Previous Level command to hide the other
parts in the assembly.

Save the file with a new name

Save the file with a new name.

▸ Click the Application button. Click Save As®Save Copy As.

▸ In the Save As dialog box, save this part as splate02.par in the folder that the
activities are in. Overwrite any existing files, if necessary.

Return to the assembly file

Return to the assembly file.

▸ Click the Application button. Click Close. Do not save changes to the assembly.

Replace parts in the assembly

Replace parts in the assembly with a new part created in the previous steps.

▸ Open carrier.asm located in the in the folder that the activities are in, with all
the parts active.

▸ Click the Replace Part command .
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▸ Select Splate.par:2 as shown as the part to be replaced.

▸ Select Splate02.par in the Replacement Part dialog box and click Open.

▸ Since there are two Splate.par occurrences in the assembly, you are asked to
replace a selected occurrence or all occurrences. Click Replace All Occurrences.

Save the assembly

Save the assembly as carrier2.asm in the folder where your activities are located and
then close the file. This completes this activity.
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Activity Summary

Activity Summary

In this activity you edited a part in the context of an assembly and made a new
revision of a part in the assembly.
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Lesson review

Answer the following questions:

1. Describe the main difference between the Edit and the Open In Solid Edge Part
commands that are used to modify parts while working in an assembly.

2. Where is Revision Manager located?

3. What purpose does the Revision Manager Assistant serve?

4. What happens when a document is opened with a status of In-Work?

5. How can properties be automatically loaded into newly created documents?
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Answers

1. Describe the main difference between the Edit and the Open In Solid Edge Part
commands that are used to modify parts while working in an assembly.

The edit command opens the part or sheet metal document in the context of the
assembly and allows geometric links to other components in the assembly. Open
in Solid Edge part opens the part document stand alone without any access to
the assembly where the part resides.

2. Where is Revision Manager located?

Revision Manager can be found in the View and Markup application in the Solid
Edge Start menu.

3. What purpose does the revision manager assistant serve?

The Revision manager assistant populates the parameters needed to revise
an assembly by interactively asking a series of questions about the intent of
the changes desired for the assembly.

4. What happens when a document is opened with a status of In-Work?

The document is opened as Read Only. It can be modified after the document
status is returned to available.

5. How can properties be automatically loaded into newly created documents?

Propseed.txt is an ASCII text file that is used to populate values in the Properties
dialog box. You can use a text editor, such as Notepad, to add values to the file.

By default, the file is located in the Solid Edge Program folder. For example, if
you loaded Solid Edge to drive C, the path would be C:\Program Files\Solid
Edge ST4\Program\propseed.txt.

You can instruct Solid Edge to look for propseed.txt in a different folder, including
a folder on another machine in the network. To do this, on the Application menu,
click Solid Edge Options. On the File Locations tab of the Solid Edge Options
dialog box, select Property Seed File and click Modify. In the Browse dialog box,
specify the drive and folder containing the propseed.txt file. After specifying the
location, click Update.
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Lesson summary

In the Assembly, you can use the Edit command to in-place activate a part to make
design modifications to the part while viewing the remainder of the assembly. A part
does not have to be activated in the assembly to edit it. When you select the Edit
command, the part is automatically activated.

Solid Edge supports assembly management, including the process of revising
assemblies. Revision Manager lets you copy an assembly, replace parts in it, and
create new revisions of an assembly and its parts.

The Application button®Manage®Edit Links command is used to manage linked
documents such as an assembly. All Solid Edge parts placed in an assembly are
linked objects.

Document properties store information about a Solid Edge document. All OLE
compatible applications, such as Microsoft Word and Excel, use document properties
to manage document information. To access document properties, use the Properties
command.

The Search button located in the Open File dialog box is used to start an advanced
search for files. The file name, file type, and date last modified boxes allow you to
search for documents using known information.

The document management tools within Solid Edge let you generate reports on files
without actually opening those files in Solid Edge.
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Assembly reports
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Assembly reports

Types of assembly reports

Solid Edge creates reports that provide information about the components that
make up an assembly. You can create:

• Assembly reports—For assembly and structural frame models, assembly reports
list the parts and subassemblies in the model. You can generate these types of
reports:

– Bill of Materials—This report supports item number levels that match the
assembly structure.

– Exploded Bill of Materials

– Summary of Atomic Reports

– Parts List—This report is a flat list that shows the quantity of each element.

• Pipe reports—For pipe and tubing models, lists the pipes and fittings in an
assembly.

• Harness reports—For wire harness models, lists the harness components and
connections in an assembly. You can create the following types of wire reports:

– Top Level

– Expanded

You can create assembly reports for managed documents and unmanaged documents.

• For unmanaged documents, the report information is collected from the local file
properties of the referenced part or assembly documents.

• For managed documents, the property information is collected from the list of
properties defined in the SharePoint managed document profile, not the local
file properties.

Producing assembly bill of material reports

To produce an assembly bill of materials, you can run the Reports command from
the Solid Edge Assembly environment, from Revision Manager, or from Windows
Explorer. In Explorer, the Reports command is available on the shortcut menu of
an assembly document (.asm).

Note

The Reports command is not available in Windows Explorer for assemblies
that are in a managed library. To create a report for a managed assembly, you
must open the assembly in Solid Edge or Revision Manager. Also, the Reports
command is not available if you have standalone Insight Connect loaded. To
create a report in standalone Insight Connect, you must open the assembly in
View and Markup or Revision Manager.
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Producing pipe reports

For pipe parts, you can use the Pipe Report command in XpresRoute to create a
report for the pipes and fittings in an assembly. This displays the Piping Report
dialog box for you to specify report type and content:

• Report all the pipes in the assembly.

• Report only the currently selected pipes.

• Include pipe fittings.

• Create a total length or cut length report.

The Pipe Report command is not available if there are no pipes in the file.

Producing harness reports

For wire harness parts, you can run the Harness Reports command from Harness
Design to create a report for the components and connections in an assembly.

When you run the Harness Reports command in Harness Design, you can specify
which harness elements to include in the report:

• All the harness components (or connections) in the assembly

• Only the currently selected components (or connections)

• Only the currently displayed components (or connections)

Note

• To create a report on selected parts, select the parts before selecting the
Reports command.

• You can use the Show and Hide commands to control which harness
elements are displayed.

Weldment assembly reports

You can use the Reports dialog box to specify whether a weldment assembly is
treated as a single component, similar to a part; or as an assembly, where all its
component parts are included in the report.

When you set the Expand Weldment Assemblies option, the component parts in the
assembly are included in the report. When you clear this option, the weldment
assembly is treated as a single part, and the component parts are excluded from
the report.

Alternate assembly reports

If the assembly has been converted to an alternate assembly, in Solid Edge the report
is created for the active member. In Windows Explorer and Revision Manager you
can use the FOA Member Names dialog box to specify which member you want to
create a report for.
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Virtual components

If the assembly for which you are creating a report contains virtual components, use
the Reports command on the Tools menu in the Assembly environment to generate
the report. Teamcenter-managed virtual components are included in the report.

Caution

If you run the Reports command from Windows Explorer on an assembly that
has virtual components, the virtual components will not be contained in the
report. In a case where the assembly contains only virtual components, a
message may be displayed that states that no parts are in the file.

Showing assembly item numbers in reports

You can show assembly item numbers in assembly and structural frame reports,
and in pipe reports. Assembly item numbers are saved with the assembly and are
available for downstream use, for example, in balloons placed on a model and in
ballooned parts lists placed on an assembly drawing. This ensures consistent part
numbering is propagated across all applications of the model.

• To create item numbers in the assembly, select the Maintain item numbers check
box in the Item Numbers page (Solid Edge Options dialog box).

• To use these item numbers in assembly reports, select the Use assembly
generated item numbers check box, which is available in the Report dialog box.

Alternatively, you can leave this option unchecked and have the assembly Report
command generate item numbers on the fly.

Formatting a report

You can format the report using the Format option on the Reports dialog box. Using
the Format Report dialog box, you can set the following:

• Font

• Column headings (based on available properties)

• Sorting method

Each property you include in the report will be a new report column. Standard
properties you can choose from include Quantity, Document Number, Revision, and
Author. You can also include custom file properties that you have recorded in the
part and subassembly documents.

After you have formatted the report, you can preview the report output by selecting
the OK button on the Format Report dialog box.
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Report Column Source

Many of the values shown in a report are stored in File Properties for individual
parts and subassemblies that make up the assembly. Other values, such as mass,
are calculated or added by choosing a material from the material table.

You can control some of the report values from the File Properties dialog box. The
following shows the tab in the File Properties dialog box where these column
headings reside:

• Document Number (Project Tab)

• Revision Number (Project Tab)

• Title (Summary Tab)

• Author (Summary Tab)

• Subject (Summary Tab)

• Keywords (Summary Tab)

• Comments (Summary Tab)

• Category (Summary Tab)

• Manager (Summary Tab)

• Company (Summary Tab)

• Project Name (Project Tab)

• Custom (Custom Tab)

More information on the File Properties dialog box is found in the Property Text
source list help topic.

Outputting the report

After previewing the report, you have the following options:

• Save the current report.

• Print the current report.

• Copy the current report to the Clipboard.

• Create another report.

Saving a report

The Save As option allows you to define a storage location, document name, and
output type. You can output the report as a text file (.txt) or rich text file (.rtf).
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Adding properties to managed documents

If you add new custom properties to managed Solid Edge documents, you must
also add these properties to the managed document profile on the SharePoint
server to make them available in an assembly report. Managed document profiles
are stored in the Document Profiles folder on the SharePoint server. To properly
synchronize the Solid Edge file properties and the SharePoint managed document
profile properties, the property names must match exactly.
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Item numbers in assemblies

Item numbers for parts and subassemblies can be created and maintained
automatically in an assembly model. Item numbers are based on the assembly
structure, that is, the order in which parts, subassemblies, and assemblies are
displayed in Assembly PathFinder.

Once created, you can use assembly item numbers in assembly reports, including
pipe and tubing reports produced in XpresRoute, and structural frame design
reports. The item numbers are saved with the assembly and are available for
downstream use, for example, in PMI balloons placed on the model and in ballooned
parts lists on an assembly drawing. This ensures consistent part numbering is
propagated across all applications of the model.

Creating item numbers in assemblies

You can create item numbers in an assembly model by selecting the Maintain item
numbers check box in the Item Numbers page (Solid Edge Options dialog box). As
new items are added to the assembly, new item numbers are created. If items are
removed from the assembly, their item numbers are not available for reuse.

You can remove item numbers from the assembly by deselecting the Maintain item
numbers check box.

Item number creation can be enabled and disabled at any time.

• Item numbers can be generated as the assembly is built by enabling item
number creation before items are added to the assembly.

• In some cases, it may be better to enable item numbers after most of the
assembly structure has been created.

Editing item numbers

You can edit item numbers in the model by selecting the top level assembly
occurrence in PathFinder and choosing the Occurrence Properties command. The
Item Number column in the Occurrences Properties dialog box shows the assembly
item numbers. You can:

• Change existing item numbers.

• Add missing item numbers using the Next Available Number command on the
shortcut menu.

• Use the Reset Item Numbers command on the shortcut menu to cancel your edits
and restore the item numbers generated by the assembly structure.

Using assembly item numbers in reports

You can use the assembly-generated item numbers in assembly reports when you
select the Use assembly generated items number check box in the assembly Report
dialog box. The item numbers are shown when you select the Format button to open
the Format Report dialog box or in the Report Output dialog box.

See the help topic, Create a report.
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Using assembly item numbers in PMI balloons

You can display assembly item numbers in PMI balloons placed on the model.

When you select the PMI tab®Annotation group®Balloon command, you can use
these options on the Balloon command bar to retrieve the item numbers from the
assembly and display them in the balloon:

• Item Number button

• Item Count button

Using assembly item numbers on a drawing

On an assembly drawing, you can:

• Review the assembly generated item numbers on the Item Number page (Parts
List Properties dialog box). The numbers shown in the first column correspond
to the assembly structure.

• Show the assembly generated item numbers in a ballooned parts list by selecting
the Use assembly generated items number check box on the Options page (Parts
List Properties dialog box).
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Item numbering schema

Use the Item Numbers page (Solid Edge Options dialog box) to select an item
numbering schema for the parts and subassemblies in the assembly model. Refer to
the following table for a comparison of item numbering options.

Example

The gray shaded cells below indicate the assembly structure, where A1 and
A2 are subassemblies, and P1, P2, P3, P4, and P5 are parts.

The unshaded cells show how flat list item numbering is applied to the
assembly structure.

The last column shows the level based item number option, which is available
only for Exploded - Top down item numbers.

Level 1 Level 2 Level 3 Top level
only

Atomic
-Top
down

Exploded
- Top
down

Use level
based
numbers

Top
assembly

A1 1 1 1
P1 1 2 1.1
P2 2 3 1.2
A2 4 1.3

P3 3 5 1.3.1
P4 4 6 1.3.2

P6 5 7 1.4
P7 6 8 1.5

P2 2 2 3 2
P4 3 4 6 3
A2 4 4 4

P3 3 5 4.1
P4 4 6 4.2

P5 5 7 9 5

Formatting item numbers

You can format the item numbers shown in the assembly model by selecting the
following options on the Item Numbers page (Solid Edge Options dialog box):

• Use level based numbers

• Start number

• Increment by
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Synchronizing Item Numbers with Teamcenter Find Numbers

In the Teamcenter-managed environment, the integration of Solid Edge Item
Numbers with Teamcenter Find Numbers is governed by the Teamcenter preference
SEEC_Synchronize_ItemNumbers. This site preference, delivered by SEEC
Administrator, provides a single point for enabling and configuring Item Number
options. When you enable SEEC_Synchronize_ItemNumbers the Solid Edge Options,
Item Numbers page is available for viewing only. Definitions are based on the values
specified by the preference.

By enabling SEEC_Synchronize_ItemNumbers, you can construct a view in
Structure Manager that is consistent with a draft’s parts list. Synchronization
is bi-directional. Existing structures that contain non-modeled items (virtual
components) and associated occurrences cannot be reset. The item numbers are
locked. However, when an Item Number is assigned either through reset or when
placing a new occurrence, the numbers assigned do not conflict with numbers locked
by virtual components.

There are a few important governing rules to be aware of:

• Item Numbers are supported at the top level only.

• Any change to the Item Number options results in a reset.

• Item Numbers assigned to non-medeled Item Revisions are considered locked or
fixed. These BOM lines are not included in Solid Edge Save.

• Solid Edge will not assign an Item Number that is currently assigned to
non-modeled Item Revisions.

• The reset command will not impact an Item Number that is currently assigned
to a non-modeled revision.

• Item Numbers must be unique by document reference. If they are not unique,
Solid Edge keeps the lowest Item Number and assigns it to all occurrences of
that reference.

The Teamcenter Preferences section of the Solid Edge Administrator’s Guide provides
details regarding preference options.
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Exploded parts lists

You can use the Parts List command and options in the Parts List Properties dialog
box to define and place an exploded parts list on an assembly drawing.

Use the General page (or the Parts List command bar) to:

• Select the default Solid Edge Exploded parts list style from the Saved Settings
list.

• Define a custom exploded parts list style.

Use the Options page to:

• Show the item numbers that were created in the assembly.

Using item numbers from the model ensures the parts list item numbers do not
change unless the model does. Otherwise, item numbers are generated on-the-fly
by the Parts List command.

Note

You can use the assembly model item numbers when the Maintain item
numbers check box is selected in the assembly document on the Item
Numbers page, Solid Edge Options dialog box. To learn more, see Help
topic Item numbers in assemblies.

Use the List Control page to:

• Display subassemblies and subassembly parts in an exploded parts list.

• Choose the item numbering format:

– Level based item numbers, which indicate the hierarchy of an exploded parts
list.

– Flat list item numbers.

• Show the top level assembly in a row by itself.

Use the Columns page to:

• Select and format the Item Number data column.

• Select additional data columns—Mass (Item), Mass (Quantity), Miter Cut 1,
and Miter Cut 2—when generating parts lists for assembly models containing
frames, pipes, or tubes.

• Indent the item numbers or the content of any column.

Use the Sorting page to:

• Sort the item numbers in the same order that they are shown in Assembly
PathFinder.

Note

Unless the assembly has been saved in V17 or later, the parts list order
may not match the Assembly PathFinder order.
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Activity: Assembly reports

Overview

The objective of this activity is to demonstrate some of the options when
generating an assembly report.

Activity

In this activity you will use different options to create assembly reports.
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Activity: Generating a report in an assembly

Overview

This activity demonstrates how to create and format a report in assembly.

Objectives

You will create different reports based on different options.

Open an existing assembly with all parts active

The assembly you open has assemblies and subassemblies with parts at all levels.

▸ From the Solid Edge start screen, click Open Existing Document. Browse for
top.asm in the folder where the activity files are located.
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Generate a bill of materials report

▸ Expand PathFinder to show all the parts and subassemblies.

▸ Choose the Tools tab®Assistants group®Reports command .
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▸ Select the options shown, and then click Format.

▸ In the Bill of Materials Format dialog box, click Options.

▸ Use the Add and Remove buttons to set the options as shown and click OK.

▸ The report is generated. Observe the results. Save the report as rich text format
as bom.rtf in the folder where the activity files are located.

Generate an exploded bill of materials report

▸ Click New Report to generate an exploded bill of materials report.
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▸ Select the options shown, and then click Format.

▸ In the Bill of Materials Format dialog box, click Options.

▸ Use the Add and Remove buttons set the options as shown and click OK.

▸ The report is generated. Observe the results. Save the report as rich text format
as exploded_bom.rtf in the folder where the activity files are located.

Generate a summary of atomic parts report

▸ Click New Report to generate a summary of atomic parts report.
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▸ Select the options shown, and then click Format.

▸ In the Bill of Materials Format dialog box, click Options.

▸ Use the Add and Remove buttons to set the options as shown and click OK.

▸ The report is generated. Observe the results. Save the report as rich text format
as atomic.rtf in the folder where the activity files are located.

Generate a parts list report

▸ Click New Report to generate a parts list report.

10-18 Solid Edge assembly mt01416-s-1040



Assembly reports

▸ Select the options shown, and then click Format.

▸ In the Bill of Materials Format dialog box, click Options.

▸ Use the Add and Remove buttons to set the options as shown and click OK.

▸ The report is generated. Observe the results. Save the report as rich text format
as parts_list.rtf in the folder where the activity files are located.

▸ Click Close

Assigning top level item numbers in an assembly

Item numbers can be assigned at the assembly level and used downstream in reports
and on a drawing sheet.
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▸ Click the Application button .

▸ Click Solid Edge Options, and then click the item numbers tab.

▸ Set the options as shown.

Note

Item numbers are determined by the Assembly PathFinder order. Item
numbers can be controlled by editing the occurrence properties in PathFinder.

▸ Click Apply, and then click OK to dismiss the Solid Edge Options dialog box.

▸ To view the occurrence properties for the top level of the assembly, right-click
top.asm in PathFinder, and then choose Occurrence Properties.

▸ Click OK.
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▸ Choose the PMI tab®Annotation group®Balloon command .

▸ Set the balloon shape to Circle .

▸ Ensure that the Item Number and Item Count buttons are selected as shown.

▸ Click Lock Dimension Plane .

▸ Select the Front reference plane as shown.
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▸ Annotate the parts as shown. Placement is approximate.

▸ Click Save to save the assembly.

Placing PMI dimensions on a drawing sheet

▸ Click the Application button .

▸ Click New®ISO Draft.

▸ Choose Home tab®Drawing Views group®View Wizard command .

▸ Select the assembly top.asm and then click Open.

▸ Click Next.

▸ Select the front view, click Next and then click Finish.
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▸ Place the view on the drawing sheet as shown.

▸ Choose Home tab®Dimension group®Retrieve Dimensions command .

▸ Select the view. The balloons created in the assembly are placed on the drawing
sheet with the corresponding item numbers.

▸ Save the draft document as top_level.dft.

▸ Close the draft file. The assembly document is displayed..
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▸ Close the assembly.

Assigning atomic top down item numbers in an assembly

▸ Open the assembly top_atomic.asm with all the parts active.

▸ Click the Application button .

▸ Click Solid Edge Options, and then click the Item Numbers tab.

▸ Set the options as shown.

▸ Click Apply, and then click OK to dismiss the Solid Edge Options dialog box.

▸ Choose the PMI tab®Annotation group®Balloon command .

▸ Set the balloon shape to Circle .

▸ Ensure that the Item Number and Item Count buttons are selected as shown.

▸ Click Lock Dimension Plane .
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▸ Select the Front reference plane as shown.
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▸ Annotate the parts as shown. Placement is approximate.

▸ Click Save to save the assembly.

▸ An optional step is to create a drawing sheet as you did for the top level item
numbers, and place the front view and the balloons on the drawing sheet.

▸ Close the assembly.

Assigning atomic top down item numbers in an assembly

▸ Open the assembly top_explode.asm with all the parts active.

▸ Click the Solid Edge application button .

▸ Click Solid Edge Options, and then click the Item Numbers tab.
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▸ Set the options as shown.

▸ Click Apply, and then click OK to dismiss the Solid Edge Options dialog box.

▸ Choose the PMI tab®Annotation group®Balloon command .

▸ Set the balloon shape to Circle .

▸ Ensure that the Item Number and Item Count buttons are selected as shown.

▸ Click Lock Dimension Plane .
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▸ Select the front reference plane as shown.
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▸ Annotate the parts as shown. Placement is approximate.

▸ Click Save to save the assembly.

▸ An optional step is to create a drawing sheet as you did for the top level item
numbers, and place the front view and the balloons on the drawing sheet.

▸ Save and close the assembly. This completes the activity.

Summary

In this activity you learned some of the options available for generating assembly
reports.
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Lesson review

Answer the following questions:

1. When item numbers are maintained, what is the difference between top level
only, Atomic — top down, and expolded — top down?

2. What are level based item numbers?

3. If item number PMI balloons are placed in an assembly document, are you able
to see these in a draft document, and if so, how?

4. Can the user define item numbers and if so how?
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Answers

1. When item numbers are maintained, what is the difference between top level
only, Atomic — top down, and expolded — top down?

The different item number schemes are defined as follows:

• Top level only item numbers are assigned to only the items directly placed
in an assembly. These can be assemblies or parts placed into an assembly,
but not the parts within the assemblies. These items are what pathfinder
displays when every member is collapsed.

• Atomic — top down item numbers are assigned to only the parts that make
up an assembly regardless of whether they are in the top level, or whether
they are in a subassembly. Assemblies do not get item numbers, only parts.

• Exploded— top down item numbers are assigned to both parts and
assemblies by the order they appear in pathfinder.

2. What are level based item numbers?

Level based item numbers will have a number for each part or assembly. Parts
and parts in subassemblies will be designated by which top level member they
belong to, separated by a period. You can quickly tell which parts belong to
subassemblies. See the table below for an example of all item numbering
schemes.

Level 1 Level 2 Level 3
Top
level
only

Atomic
-Top
down

Exploded
- Top
down

Use
level
based
numbers

Top
assembly

A1 1 1 1
P1 1 2 1.1
P2 2 3 1.2
A2 4 1.3

P3 3 5 1.3.1
P4 4 6 1.3.2

P6 5 7 1.4
P7 6 8 1.5

P2 2 2 3 2
P4 3 4 6 3
A2 4 4 4

P3 3 5 4.1
P4 4 6 4.2

P5 5 7 9 5

3. If item number PMI balloons are placed in an assembly document, are you able
to see these in a draft document, and if so, how?
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The view containing the PMI balloons in assembly is placed onto a drawing sheet.
The retrieve dimension command will display the balloons on the drawing sheet.

4. Can the user define item numbers and if so how?

User defined item numbers can be defined by right clicking the top level
assembly in pathfinder, and then clicking occurrence properties. You can:

• Change existing item numbers.

• Add missing item numbers using the Next Available Number command
on the shortcut menu.

• Use the Reset Item Numbers command on the shortcut menu to cancel your
edits and restore the item numbers generated by the assembly structure.
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Lesson summary

In this lesson you learned some of the options available for generating assembly
reports.
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Creating and publishing Virtual Components
When you start a new design project, you may want to define the overall product
structure for the project before creating new Solid Edge documents, or before
positioning 3D geometry for existing Solid Edge documents in the top-level assembly.
In effect, you use a top-down design approach to define the assembly structure using
virtual components as place holders until real components are defined.

You can use the Virtual Component functionality in Solid Edge or in Teamcenter to
define the assembly structure for a new design project.

When you have finished defining the assembly structure, you can publish the
assembly. Publishing the assembly creates the new Solid Edge documents required,
copies assembly sketch geometry to the new documents, and adds the 3D geometry
for existing Solid Edge documents to the assembly.

Virtual components in Solid Edge

The basic workflow for creating and publishing a virtual assembly in the unmanaged
Solid Edge environment is:

• Define the virtual components you need.

• Add existing documents to the virtual assembly structure.

• Assign 2D geometry to individual virtual components.

• Position virtual components.

• Publish virtual components.

To make it easier to understand the concepts and capabilities of the virtual
component functionality in Solid Edge, a Virtual Component tutorial is available.

Virtual components in a Teamcenter-managed Solid Edge environment

While you can use the virtual component functionality in Solid Edge to develop
unmanaged assembly structures, most often in a managed environment, your
product structure is created and modified in another Teamcenter PDM client such
as Teamcenter Structure Manager. Then the empty items that are created in the
PDM client are opened for further development along with the remaining structure
in either Solid Edge or Structure Editor.
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Note

As a best practice, you should choose between using Solid Edge Virtual
Components and a workflow where Teamcenter empty items are created in a
PDM client. Using both in the same structure is not recommended.

Once you have finished defining the assembly structure, you can publish the virtual
components, converting non-modeled objects into physical documents containing
Solid Edge 3D datasets. Publishing the components assigns the Solid Edge template
(part, assembly, sheet metal or weldment), and Teamcenter attributes to the real
document.

The basic workflow for working with Teamcenter-managed virtual assembly is:

• Create the virtual components you need using a Teamcenter PDM client.

• Open the structure in Solid Edge where you can view the structure in PathFinder.

• Add existing documents to the virtual assembly structure.

Note

If you are working in Solid Edge in the Teamcenter mode, you cannot
place unmanaged parts into a Teamcenter-managed virtual component
structure.

• Publish virtual components.

• Upload the real document into the Teamcenter database.

Defining the assembly structure

The Virtual Component Structure Editor command defines the assembly structure
for a new design project in an unmanaged environment. When you click the Virtual
Component Structure Editor command, the Virtual Component Structure Editor
dialog box is displayed.

The Virtual Component Structure Editor defines the name and document type for
new virtual components, and allows you to drag any existing Solid Edge documents
into the virtual assembly structure.

Defining new virtual components

You use the right pane on the Virtual Component Structure Editor to define
virtual components and organize the assembly structure. The Component Type
options on the right pane of the Virtual Component Structure Editor define the
document type for new virtual components:

• Assembly components

• Part components

• Sheet metal components

The Name option assigns a name to the virtual component you are creating.
You can select a default name from the list, or type the name you want in the
Name box.
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You can customize the Names list by editing VCNames.txt in the Solid Edge
Program folder. Separate sections in VCNames.txt define unique virtual
component names for part, sheet metal, and assembly components.

After you define the component type and name, you can click the Add Virtual
Component button on the Virtual Component Structure Editor dialog box to
add the virtual component to the tree structure list. You can also add a virtual
component to the tree structure list by pressing Enter after typing the virtual
component name.

Note

When you create a virtual component, it has no physical position and no
associated graphics. Later, you can position the virtual component and/or
assign graphics to it.

You can use the Promote Component and Demote Component buttons to further
define the assembly structure. For example, if you want to move a component
from a virtual subassembly into the next higher level assembly, you can select
the component and click the Promote Component button.

You can also drag virtual components within the Virtual Component Structure
Editor dialog box to rearrange the assembly structure. For example, you can
drag a virtual part from one virtual subassembly to another virtual subassembly.

11-4 Solid Edge assembly mt01416-s-1040



Virtual components in assemblies

Adding existing documents to the virtual structure

You can also place existing Solid Edge documents into the assembly structure
using the Virtual Component Structure Editor dialog box.

The left pane on the Virtual Component Structure Editor dialog box browses
to and selects existing documents on your computer or another computer on
your network. If you are working in Teamcenter mode, you can select existing
documents from your Teamcenter database.

You can place an existing document into the virtual assembly structure in one of
two ways: as a pre-defined component or as a real component.

Pre-defined components

Pre-defined components are virtual components that are based on an existing
document. You cannot place 3D geometry using a pre-defined component, but
you can create 2D geometry in the parent document (A), then position the 2D
geometry in the assembly sketch (B). You can reuse existing documents in
new design projects without the overhead of 3D geometry.

When you clear the Add As Real Component option on the Virtual Component
Structure Editor, then drag an existing component into the right pane of the
structure editor, the component is placed as a pre-defined component. If you
want to add the document to a virtual subassembly, position the cursor over
the virtual subassembly when dropping the pre-defined component.

Pre-defined components are typically purchased or released parts that are
not subject to significant changes.

Adding real components

When you set the Add As Real Component option on the Virtual Component
Structure Editor before you drag an existing document into the virtual
assembly structure, the 3D geometry associated with the component is added
to the assembly. When this option is set you can only place the component in
the top-level assembly.

The component is placed in the assembly hidden, with no relationships
applied, and is oriented in the assembly by aligning the base reference
planes of the component with the base reference planes in the assembly.

You can position the real component within the assembly sketch using
assembly relationships such as mate and align, or 2D relationships and
dimensions such as Connect and Distance Between.
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Copying virtual and pre-defined components

You can specify that the same part or subassembly occurs more than once
using the Virtual Component Structure Editor dialog box. To specify that a
component occurs more than once, you can select an existing virtual component
or pre-defined component, then click the Copy Definition command on the
shortcut menu.

This copies the component name and component type to the Name box and
Component Type list. You can then press Enter or click Add Virtual Component
to add the component to the tree structure list. You can also add the same
component multiple times by pressing Enter repeatedly.

Saving the tree structure

When you click the OK button on the Virtual Component Structure Editor dialog
box, the virtual assembly structure you defined is added to the PathFinder tab.
You can make changes to the virtual assembly structure later using the Virtual
Component Structure Editor dialog box.

You can dismiss the Virtual Component Structure Editor dialog box without
saving changes by clicking the Cancel button.

Assigning sketch geometry to Virtual Components

You can assign 2D sketch geometry from the assembly layout to a virtual component.
You can create the 2D geometry before or after you define the assembly structure.

Assigning geometry to a virtual component defines its size and position in the
assembly sketch. You can only assign geometry to one occurrence of a particular
virtual component.

When you assign 2D geometry to a virtual component, it becomes the master, or
source component. You can edit the sketch geometry associated with the source
component directly. If there are additional occurrences of a particular virtual
component, they become slave or instance components.

The sketch geometry for an instance component is an associative copy of the
sketch geometry of the source component. When you update the sketch geometry
for a source component, the sketch geometry for the instance components updates
automatically. You cannot modify the sketch graphics for an instance component
directly.

You assign geometry to a virtual component using the Edit Definition command on
the Assembly PathFinder shortcut menu. This command is available only when an
assembly sketch window is open.

When you click the Edit Definition command, a command bar is displayed so you
can select the geometry and define an origin. You can select the 2D sketch geometry
using the cursor or by dragging a fence. When you finish selecting geometry, click
Accept or right-click to proceed to the Orientation Step.
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The Orientation Step defines the origin location for the virtual component and the
reference plane that the 2D sketch graphics are placed on when you publish the
virtual component. You can specify that the graphics are placed on one of the three
base reference planes.

When defining the origin you can specify that the origin is based on a keypoint or a
free space point. With either method you must also define the x-axis direction. When
you click the Finish button, a symbol is displayed that represents the origin (A) and
x-axis direction (B) for the virtual component geometry.

You can constrain to the origin point on a virtual component to position it within
the assembly.

Creating sketch geometry for pre-defined Virtual Components

You create the sketch geometry for a pre-defined virtual component by opening
the parent document, then using the Component Sketch command to create a
component sketch.

There are two types of graphics you can create in a component sketch: component
image graphics, and wireframe graphics. Component image graphics are created
using the Component Image command. This command creates a 2D representation
of the visible edges on a part.

Component image graphics are not individually selectable in the assembly sketch,
but provide a reference envelope.

You supplement the component image graphics with wireframe graphics you
create using the Include command or drawing wireframe graphics manually. The
wireframe graphics can be selected and used for constraining the component sketch
in the assembly sketch.

You typically would create both types of graphics for a component sketch. In
some cases, you may only create component image graphics, then use the virtual
component symbol origin to constrain the pre-defined component in the assembly
sketch.

Using too many wireframe graphic elements can impact performance when placing
the component sketch in the assembly sketch.
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Updating sketch geometry for pre-defined Virtual Components

As discussed earlier, pre-defined components are typically purchased or released
parts. If the parent 3D geometry for a pre-defined component sketch changes, you
must delete the component image graphics and create new graphics using the
Component Image command.

You can then open the assembly sketch and select the pre-defined component within
PathFinder. Click the Update Component command on the shortcut menu to update
the pre-defined component graphics in the assembly.

Replacing pre-defined components

You can use the Replace command on the shortcut menu when a sketch is active to
replace a pre-defined component with another Solid Edge document you specify. you
can select the pre-defined component in Assembly PathFinder or the sketch window.

Displaying Virtual Component sketch geometry

Before you assign assembly sketch graphics to a virtual component, you use the
Show and Hide commands on the Layers tab shortcut menu to display and hide the
assembly sketch graphics. An effective layer management scheme can make working
with complex assembly sketches more productive.

After you assign assembly sketch graphics to a virtual component, you can use the
Show and Hide commands on the PathFinder shortcut menu to display and hide
the virtual component sketch graphics. For example, you can select the virtual
component in PathFinder, or in the graphics widow, then click the Show and Hide
commands on the shortcut menu.

You control the display of dimensions you apply to the sketch geometry by showing
and hiding the layers on which the dimensions were created, both before and after
you assign graphics to a virtual component.

Because geometric relationship handles do not reside on a layer, you always control
their display using the Relationship Handles command on the Tools menu when
in the assembly sketch.

Positioning Virtual Components

You use the Position Virtual Component command on the PathFinder shortcut menu
to position virtual components. This command is only available when you are
editing an assembly sketch. You can position an empty virtual component (a virtual
component that has no geometry assigned), an instance virtual component, or a
pre-defined component.

You can position a virtual component by dragging it from the PathFinder tab and
dropping it into the sketch window.

As discussed earlier, source virtual components are positioned as part of the process
of assigning geometry.

Positioning empty Virtual Components

If you have not assigned geometry to any occurrences of a particular virtual
component, you can select the virtual component in PathFinder, then click
the Position Virtual Component command on the shortcut menu. The virtual
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component symbol is attached to the cursor so you can position the virtual
component on the assembly sketch.

The symbol represents the approximate position for the empty virtual component
in the assembly. Later, you can select the empty virtual component entry
in PathFinder and use the Edit Definition command to assign geometry to
one occurrence of the empty virtual component. This instance of the virtual
component becomes the source virtual component.

The other occurrences of the virtual component update with the graphics you
assigned to the source component, and they become instance components.

You can then add relationships and dimensions to the sketch geometry to
precisely locate the virtual component in the assembly sketch.

Positioning instance Virtual Components

After you assign sketch geometry to a virtual component, it becomes the source
component for additional occurrences of that virtual component. You can select
another occurrence of the virtual component in PathFinder and use the Position
Virtual Component command on the shortcut menu to position the virtual
component on the active assembly sketch.

A copy of the sketch graphics that were assigned to the source component is
attached to the cursor. As discussed earlier, the sketch geometry for an instance
component is an associative copy of the sketch geometry of the source component.
You can apply relationships and dimensions to the sketch graphics or to the
virtual component symbol to precisely position the instance component on the
assembly sketch.

mt01416-s-1040 Solid Edge assembly 11-9



Lesson 11 Virtual components in assemblies

Determining the status of a Virtual Component
The symbols in PathFinder and the Virtual Component Structure Editor dialog box
reflect the current status of the virtual components in the assembly.

Teamcenter-managed non-modeled nodes can either be assembly or leaf nodes.
Assembly nodes contain references or children, while leaf nodes do not contain
references or children. The symbols in PathFinder, Assembly Reports, and the
Property Manager dialog box reflect the state of the virtual components in the
assembly. The following table explains the symbols used:

Teamcenter Solid Edge

ASM PAR PSM Leaf ASM PAR PSM

Source part
Instance
virtual part
that has been
positioned
Position-less
virtual part
whose source
virtual
component
has graphics
assigned
Positioned
Empty
virtual part
(no graphics
assigned)
Position-less
pre-defined
component
Positioned
pre-defined
component

Note

The Teamcenter Status and Checked Out By information displayed in
PathFinder is not available for an object until it is published.
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Publishing Virtual Components

When you are ready to create the document set for the new design project, you
can click the Publish Virtual Components command. You can then use the Publish
Virtual Components dialog box to specify the target folder and template you want to
use to create the document set.

In an unmanaged Solid Edge environment, when you click Publish, all virtual
components are published at one time. The unmanaged Solid Edge documents are
created using the names, folder path, and templates you specified.

If you have associated 2D assembly sketch graphics with source virtual components,
the sketch graphics, including dimensions and relationships, are copied to the proper
document as sketches. The sketch graphics are positioned in the new document
using the Publish On option you specified on the Edit Definition command bar when
you assigned the sketch geometry to the source component.

There is no associative link between the sketch graphics in the original assembly
and the sketch graphics copied to the new documents.

The sketch graphics associated with instance virtual components are deleted from
the source assembly.

You cannot publish a virtual component to the same folder as a real component of the
same name. For example, if you add both a pre-defined component named bolt.par
and a virtual component named bolt to the virtual component structure, they are not
allowed to reside in the same folder when you publish the virtual components.

Conflicts such as these are indicated in the Publish Virtual Components dialog box
using red text and an exclamation mark (!). In this example, you can resolve the
conflict by renaming the virtual component or by specifying a different folder for
the virtual component.

If you do not rename the virtual component or specify a different folder, the existing
document will be used and the new document for the virtual component will not be
created. The existing part is positioned as defined by the virtual component sketch,
but the sketch geometry is not added to the existing document.

Publishing pre-defined components using the simplified representation

If a simplified representation of a part or subassembly exists, you can specify that
the simplified representation is used for pre-defined components. When you set
the Publish Pre-defined Components Using Simplified Representations option on
the Publish Virtual Components dialog box, the simplified representation is used.

This can improve processing time and reduce document size. When you publish
a simplified representation of a subassembly, the subassembly is published as a
single unit and the assembly structure is not loaded into memory. The assembly
structure is also not displayed within PathFinder.

You can use commands on the PathFinder shortcut menu to specify whether the
simplified or as designed version of the parts and subassemblies are displayed.
For more information on working with simplified parts and assemblies, see the
Simplifying Parts and Simplifying Assemblies Help topics.

Publishing documents in the Teamcenter-managed environment

When you are ready to create the document set for the new design project, you have
three options. You can perform an ad hoc publish on a single object by selecting
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the virtual component in PathFinder and dragging it into the Solid Edge graphic
window. You are then prompted to choose the template for the object to give it a
Solid Edge dataset, and then the New Document dialog box displays so you can
check in the real document.

Another option is to use the Publish Virtual Components command. You can then
use the Publish Virtual Components dialog box to select components for either a
partial or full publish, and to determine the template you want to use to create
the document.

During a partial publish, you select a component of an assembly for publishing by
selecting the associated check box. Then you are given the opportunity to assign a
template. The New Document common property dialog box assigns Teamcenter
attributes, and the physical document is created with a Solid Edge dataset.

A full publish involves selecting all components of a structure. The entire virtual
structure is published at the same time. You use the New Document common
property dialog box to assign Teamcenter attributes, and the documents are created
with Solid Edge datasets.

In all three cases, if a virtual component is denoted as an assembly, only Solid
Edge assembly templates are displayed during template selection. If the virtual
component is a leaf node (one that has no references or children), then you can
choose from the 3D Solid Edge templates during template selection.

Virtual Components and assembly reports
If the assembly for which you are creating a report contains virtual components, you
should always use the Reports command in the Assembly environment.

When you run the Reports command from Windows Explorer on an assembly that
has virtual components, the virtual components will not be contained in the report.
If the assembly contains only virtual components, a message may be displayed that
states that no parts are in the file.

When you run the Reports command from Windows Explorer on an assembly that
has virtual components, the Assembly Report shows Teamcenter virtual components
and uses the same symbols for identification that you see in PathFinder.

Assigning properties to Virtual Components
When an active document contains a virtual component, you can use the Property
Manager command to modify existing properties or create new properties for the
virtual component in Solid Edge.

Note

Virtual components created in Teamcenter are shown, but are read-only and
cannot be edited.

When you select the Property Manager command, the Property Manager dialog
box is displayed for editing property values. Any properties that you cannot edit
are disabled and appear in gray.

To edit a value, click the appropriate property cell and type in the new value. When
you edit a property, if the document containing the property is a managed document,
it is checked out to prevent others from making changes. After you edit a property
value, the property cell is underlined to indicate that it has been changed. The cell
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remains underlined until you click the Save button to save the changes or click the
Restore button to set the value back to the previous value. You can use the Copy,
Cut, and Paste buttons to edit information between cells. When you click OK, the
property changes are written back to the document in memory. The changes are not
written until you save the document.

When you publish the virtual components, the properties you assigned to the virtual
components are added to the new documents.

For more information on editing document properties, see Document Properties.
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Activity: Virtual component editor
Activity guides you through the process of laying out an assembly using the virtual
component structure editor and then publishing the assembly to create the basic
design which is further refined.
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Activity: Virtual component editor

Overview

This activity shows top down assembly design using the virtual component structure
editor.

Objectives

The virtual component editor allows a designer to use Solid Edge assembly sketches
as a component layout for a new assembly. The orientation and positioning of future
parts and subassemblies can be defined in the new assembly as well as existing parts
and subassemblies. In this activity, you will use a Solid Edge assembly sketch to
define geometric positions of parts that will be created in a top down method. When
the virtual components are published, the files needed to complete the assembly will
exist and the sketches will be used to create the new geometry.
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Define the virtual assembly structure

▸ Open vc.asm located in the folder where you put the activity documents.

▸ Click the Home tab, in the Assemble group, click Component Structure Editor.

▸ Click the Virtual assembly option to set the type. Type Frame in the Name
box and press the Enter key.

▸ Click the Frame assembly, and then click the Virtual part option. Enter Support
in the Name box.

11-16 Solid Edge assembly mt01416-s-1040



Virtual components in assemblies

▸ Click the Frame assembly, and add the virtual parts Front Axle and Rear Axle.

▸ Click the Virtual assembly button and enter Wheel in the Name box. Enter
Wheel again to create a second assembly of the same name.
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▸ Select the Wheel assembly and click the Virtual part option. Enter Hub, and
then enter Tire in the Name box.

▸ Select vc.asm. Click the Virtual sheet metal option and add the sheet metal part
Deck, then click OK to exit the Virtual Component Structure Editor.
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Assign geometry to parts

Assign geometry from an existing sketch in vc.asm to parts in the virtual component
structure.

Note

Layers are used on the sketch so that geometry can easily be chosen and
assigned to the proper virtual component. Once assigned, a graphic sketch
element cannot be selected, preventing geometry being assigned to multiple
virtual components.

▸ On the Assembly PathFinder, expand the assembly structure as shown by
clicking the + symbol. Right-click Sketch_1 and select Edit Profile.

▸ Click the Layers tab on PathFinder.
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▸ Right-click the Support layer and click Make Active.

▸ On the Assembly PathFinder, right-click the virtual part Support and click Edit
Definition.
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▸ Using the left mouse button, drag a box around the sketch to select everything
on the layer. Click the Accept button.

▸ After clicking Accept in the previous step, the origin of the orientation axis is
ready to be defined. To select the origin of the axis, click the midpoint of the left
most vertical line (point 1) as shown. To orient the x axis, click the midpoint of
the right most vertical line (point 2) as shown.

▸ Click Finish.
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▸ In PathFinder select the Layers tab and right-click the layer Front Axle and
make it active as shown.

Note

Displayed geometry that has been assigned to a virtual component is not
selectable when editing the definition of another virtual component.

▸ On the Assembly PathFinder, right-click the virtual component, Front Axle, and
click Edit Definition.
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▸ Select the Front axle as shown and click Accept.

▸ Position the front axle by selecting the origin point of the axis to be the midpoint
of the line as shown (point 1) and to orient the axis, select the midpoint of the
right-most vertical line as shown (point 2), then click Finish.
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▸ In PathFinder, click the Layers tab and make Rear Axle the active layer. Click
the Assembly PathFinder tab, then right-click the virtual component Rear Axle
and then choose Edit Definition. Select the rear axle and accept. Orient the axis
using the midpoints of the lines shown below, and click Finish.

▸ Click the Layers tab. Right-click the layer Hub and make it active.
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▸ Right-click Layers and click Hide All Layers.

Note

Geometry that has been previously added to virtual components cannot
be hidden by sketch layers and is not available to be added to additional
virtual components.

▸ On the Layers tab, show the layer Rear Axle.

▸ On the Assembly PathFinder tab, right-click the virtual component Hub and
click Edit Definition. Use a fence to select all the geometry on the layer Hub
and click Accept.

▸ Orient the axis using the points shown below, and click Finish.

▸ On the Layers tab, make the layer Tire active and hide the layer Hub.
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▸ On the Assembly PathFinder tab, right-click the virtual component Tire and
click Edit Definition. Use a fence to select all the geometry on the layer Tire
and click Accept.

▸ Orient the axis using the points shown below, and click Finish.

▸ On the Layers tab, show the layer Front Axle.

▸ On the Assembly PathFinder tab, right-click the second occurrence of the
assembly Wheel and click Position Virtual Component.

▸ Click the top of the vertical line that represents the front axle.

▸ On the Layers tab, make the layer Deck the active layer and hide all the other
layers.
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▸ On the Assembly PathFinder tab, right-click the virtual component Deck, and
click Edit Definition. Use a fence to select all the geometry on the layer Deck,
and accept. Orient the axis using the two points shown, and then click Finish.

▸ On the Layers tab, show all the layers.

▸ Click Close Sketch to exit the sketch, then click Finish.
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Create component sketches

Create component sketches in three existing parts to position the parts in the
virtual assembly.

▸ In the Parts Library tab of PathFinder, right-click small_motor.par and click
Open in Solid Edge. Browse to the location where the activity files are located.

▸ On the Home tab, click the command Component Sketch.

▸ Create the sketch on a plane parallel to the top reference plane. Use the keypoint
shown to position the parallel plane.
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▸ Click the Tools tab. In the Virtual group, click the Component Image command.

▸ Click Accept to add the highlighted geometry to the sketch.
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▸ On the Home tab, in the Draw group, click the Include command and include
the edges shown. The Include command is needed to add precise geometry to
the sketch in order to accurately position the part.

▸ Click Close Sketch, then click Finish. Save and close the file.

▸ In the Parts Library tab of PathFinder, right-click wide_seat.par and click Open
in Solid Edge.
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▸ Create a component sketch on a plane parallel to the top reference plane. Use
a keypoint on the bottom face of the mount as shown to position the sketch’s
reference plane.
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▸ Click the Component Image command. Accept the highlighted geometry, and
then select the Include command and include the cutouts and edges shown.
Click Close Sketch, then Finish to complete the component sketch. Save and
close the file.
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▸ In the Parts Library, right click steering.asm and click Open in Solid Edge.
Activate all the parts in the assembly. Create a component sketch on a plane
parallel with the top reference plane. Use the keypoint shown to position the
reference plane.

▸ Click the Application button. Click Solid Edge Options and then click the
Inter-Part tab. Make sure the Include command in part and assembly sketches
box is checked.
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▸ Drag a box to Include all the geometry shown in the sketch. Set the include
options as shown.

▸ Click Close Sketch to exit the sketch, then click Finish.

▸ Save and close the file. This returns you to the assembly.
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Position the component sketches in the existing parts as part of the virtual
component structure

▸ Open the Component Structure Editor and drag the three Solid Edge files where
you created component sketches into the assembly, then click OK.
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▸ The parts with the component sketches will now be positioned in the virtual
assembly. On the Assembly PathFinder, right-click Sketch_1 and then click
Edit Profile.

▸ On the Layers tab, hide the layers named Master_Layout and Dimensions, if
they are not already hidden.

▸ In Assembly PathFinder, right-click the virtual component small_motor.par
and click Position Virtual Component.
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▸ Select the plane shown. The component sketch will show in the preview area.
Click OK.

Note

You will know you have selected the correct plane when the preview
shows your component sketch.

▸ Observe the prompts. On the keyboard, press A to rotate the motor into
the position shown. Click to the left of the sketch and place the component
approximately where shown.

▸ Click the Home tab. In the Relate group, turn off Relationship Handles.
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▸ In the Relate group, click the Connect command, and connect the center of the
circles shown below.

▸ Click the select tool. In Assembly PathFinder, right-click the virtual component
wide_seat.par and click Position Virtual Component.
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▸ Click the Select tool. Use the same procedure to position the seat as you used
to position the component motor. Use the Connect command to position the
seat using the circles shown.

▸ Click the Select tool.

▸ In Assembly PathFinder, right-click the virtual component steering.asm and click
Position Virtual Component.

▸ Use the same procedure used to position the seat to position the steering wheel.
Use the Connect command to position the steering wheel using the circles shown.

▸ Click Close Sketch to exit the sketch. Then click Finish. Save the assembly.
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Publish the virtual assembly

▸ On the Home tab, in the Assemble group, click the command Publish Virtual
Components. This will create real components from the virtual components.

▸ Set the path to correspond to the directory structure you have been using for
this activity and click Publish.
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▸ Notice that now there are real parts Assembly PathFinder. Activate all the parts.
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Create the frame from the sketch geometry

▸ In Assembly PathFinder, right-click support.par and then click Open in Solid
Edge part.

▸ Choose the Home tab®Draw group®Symmetric Offset command, and enter
the values shown.

▸ Set the type to chain.

▸ Select the rectangular perimeter of the sketch as shown below.
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▸ Accept the selection.

▸ Click the Select tool and use QuickPick to select the region shown. Extrude
the selection 8 mm in the +Z direction.

▸ Click the Symmetric Offset command. Using the same values as before, select
the 5 lines shown below. Accept the selection.
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▸ Click the Select tool. Select the region shown below.

▸ Set the Selection mode to add mode as shown below.
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▸ Continue selecting the additional regions required to extrude the remainder of
the frame and extrude them 8 mm in the +Z direction.

Note

Use QuickPick to select the regions easily.

▸ Save and close the file to return to the assembly.
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Model the front axle

▸ On Assembly PathFinder, select frame.asm and then choose Home tab®Relate
group®Ground relationship. This will ground the top level of the frame such
that additional relationships can be added to the remaining parts without
moving the frame.

▸ Assembly PathFinder, right-click the part Front Axle.par and then click Edit.

▸ Use the Coincident Plane command to create a plane parallel to, and 5 mm
below, the x-y plane. Use the Include command or the Project to Sketch command
to project the line of the front axle onto the plane.

▸ Draw a rectangle with a short side that is 5 mm wide and as long as the front
axle sketch element. Lock the sketch onto the plane you created.

▸ Use the Revolve command to create an axle with radius of 5 mm by selecting the
rectangle you created. Use the included line in the front axle sketch to represent
the center-line of the 3D axle. Sweep the revolution 360o to create the axle.

▸ After creating the revolved protrusion, click Close and Return.
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Model the rear axle

▸ On the Assembly PathFinder, right-click the part Rear Axle.par and then click
Edit. Create a revolved protrusion on a parallel plane 5 mm below the x-y plane,
as you did with the Front Axle in previous steps. The radius of the protrusion
is 5 mm.

Click Close and Return to return to the assembly.
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Model the wheel hub

▸ On the Assembly PathFinder, right-click the part Hub.par and click Edit.

▸ Create a 360° revolved protrusion on a parallel plane 5 mm below the x-y plane.
Define the axis of revolution using the dashed line as shown. Use the include
command with the wireframe chain option. Click Finish to complete the revolved
protrusion, then click Save and close to return to the assembly.
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Model the tire

▸ On the Assembly PathFinder, right-click the part Tire.par and click Edit.

▸ Create a 360° revolved protrusion on a parallel plane 5 mm below the x-y plane.
Define the axis of revolution using the dashed line as shown. Click finish to
complete the revolved protrusion, then click close and return.
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Model the sheet metal deck

▸ On the Assembly PathFinder, right-click the sheet metal part Deck.psm and
click edit.

▸ Select the region shown and create the deck. The circles will be the cutout in
the deck. The extent of the tab will be below the profile plane and the sheet
metal thickness will be 3.00 mm.

▸ Click close and return.
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Mirror the wheels

▸ On the Assembly PathFinder show the reference planes.

▸ On the Home tab in the Pattern group, click the mirror command. Select the x-z
plane to mirror about.

▸ In the Assembly PathFinder, select the two assemblies named Wheel.asm, and
on the command bar, click accept.

▸ Set the options shown and then click ok, then click finish.

▸ Assembly relationships can be edited to further position and constrain the parts.
Save and close this file. This concludes this activity.
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Activity summary

In this activity you learned how to create a virtual assembly structure using virtual
components. Sketch geometry in the assembly file was assigned to virtual part
files and once published, the sketch geometry was moved into those files and used
to create parts. Existing parts were placed in the virtual structure and positioned
using component sketches. This is a top down approach to laying out and modeling
complex assemblies.
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Lesson review

Answer the following questions:

1. How is assembly sketch geometry assigned to a virtual component?

2. What is the purpose of a component sketch?

3. What is created when virtual components are published?
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Answers

1. How is assembly sketch geometry assigned to a virtual component?

The geometry can be assigned by editing the profile of a sketch, and right clicking
a virtual component and editing the definition. Geometry from the sketch is
assigned and oriented in the position it will be when the component is published.

2. What is the purpose of a component sketch?

A component sketch creates sketch geometry in an existing part or assembly
needed to position the component in a virtual assembly such that when the
virtual assembly is published, the part will be in the correct position relative to
the other components in the assembly.

3. What is created when virtual components are published?

Part, sheet metal and assembly files are created from designated templates and
if sketch geometry has been assigned to these components, sketches will exist in
the newly created documents. The pathfinder structure is the same as it was in
the component editor. Existing parts that have been positioned with component
sketches are placed in the assembly.

11-54 Solid Edge assembly mt01416-s-1040



Virtual components in assemblies

Lesson summary

In this lesson you learned how to create a virtual assembly structure using virtual
components. Sketch geometry in the assembly file was assigned to virtual part
files and once published, the sketch geometry was moved into those files and used
to create parts. Existing parts were placed in the virtual structure and positioned
using component sketches. This is a top down approach to laying out and modeling
complex assemblies.
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Define Alternate Component Command
Defines a list of documents which are related to the selected part or subassembly.
Alternate components are typically similar in nature, and can be based on documents
that were created independently. Defining a list of alternate components makes it
easier to find and select valid components when replacing parts in an assembly.

A simple example of an application for an alternate component group is where there
are several versions of a part that have different finishing details. The parts can be
independently created or members of a family of parts.

In an assembly where one of the parts is used, you can use the Define Alternate
Components command to specify that all three parts are members of the same
alternate component group.

Note

Note: A special symbol is used in Assembly PathFinder to indicate that an
assembly component is part of a alternate component group.

You can then use the Replace command to replace the part with one of the alternate
component members. When you select a part to replace that is a member of a
alternate component group, the Alternate Member dialog box is displayed so you can
select another alternate component member as the replacement part.

Defining an Alternate Component Group
You can select any part or subassembly in the active assembly to define an alternate
component group. When working with a nested assembly, you cannot select
individual components that are in a subassembly.

Although an alternate component group would typically contain similar parts, you
can define an alternate component group that contains different document types
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than the original component. For example, you can define an alternate component
group that consists of a Part document, a Sheet Metal document, and an Assembly
document.

When you select a component in an assembly, then click the Define Alternate
Components command, the Define Alternate Components dialog box is displayed
so you can browse or search for the documents you want define as alternates for
the selected component.

Defining documents as alternate components is a two step process. First, you browse
or search for documents that you want to add to the Alternate Candidates list in
the left pane of the Define Alternate Components dialog box. Then you can select
documents in the Alternate Candidates list and click the Add button to add them to
the Alternates List in the right pane of the dialog box.

If the component you select to define the alternate components group is a member
of a family of parts or a family of assemblies, all related members from the same
master document are added to the Alternate Candidates list automatically.

The assembly document in which you define the alternate components group stores
the group member data.

Using Alternate Component Groups

As described earlier, a alternate components group makes it easier to find and
select valid components when replacing parts in an assembly. When you select a
component to replace in an assembly, and the component is a member of a alternate
components group, the Alternate Member dialog box is displayed so you can select
another group member as the replacement part.

Note

When you replace an assembly component with an alternate component
that is a different document type than the original component, assembly
relationships can fail to recompute properly.

If you want to replace the component with a component that is not an alternate
components member, you can click the Browse button to display the Replacement
Part dialog box to select another component.

If you create alternate component groups that are used frequently in many
assemblies, you should consider creating an assembly that contains only the master
alternate component and define the alternate components group in this document.
This assembly document then becomes the master document for the alternate
components group definition.

To place one of the group members in an assembly later, you can place the assembly
document instead. If you also set the Disperse This Assembly During Place Part
option on the Assembly tab of the Options dialog box for this assembly, when you
place the assembly into another assembly, it will be placed as a part that contains
the alternate components group data.

This workflow can be useful when you know a part will be replaced later by another
part. For example, you may create a prototype version of a part that you know
will later be replaced by a production version of the part that will be created
independently in a separate document.

mt01416-s-1040 Solid Edge assembly 12-3



Lesson 12 Alternate assemblies

Alternate Components and Alternate Assemblies

You can use an alternate component to replace a component in an alternate assembly
that is a family of assemblies, but not an alternate position assembly. For example,
you can use the Replace command to replace a part in a family of assembly member
with an alternate component, rather than use the Exclude Occurrence functionality
on the Alternate Assembly tab. Although this approach can be quicker than using
the Exclude Occurrence functionality, when you use Revision Manager to copy
or move the assembly data set to a new location, any members of the alternate
components group that are not used in a family of assembly member will not be
included in the data set.

For more information on working with alternate assemblies, see the Alternate
Assemblies Help topic.

Comparing Alternate Components and Family of Parts

Alternate Component groups are similar to a family of parts, but provide
additional flexibility because you can define an alternate components group using
independently created documents and different document types.
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Activity: Creating an alternate assembly
This activity guides you through the process creating alternate versions of an
assembly.
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Activity: Creating an alternate assembly

Objectives

When you complete this activity, you will be able to:

• Convert a normal assembly into an alternate assembly.

• Add members to an alternate assembly.

• Define unique variable values for individual members.

• Replace occurrences for a member.

• Exclude occurrences for a member.

• Exclude and reapply assembly relationships for a member.
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Create an alternate assembly for a valve

Create an alternate assembly for a valve. The valve in the existing assembly is open.
Create an alternate assembly with the valve closed.

▸ Open Alternate.asm located in the folder where you loaded the parts files needed
for this activity. Open the assembly with all the parts active.

▸ On the View tab, click Color Manager, and ensure the following options are set.

▸ Set the use individual part styles option.

▸ Set the show and allow assembly style overrides option.

▸ Clear the Show part face colors option.

▸ Click OK.

Note

You create a family of assemblies by converting a normal assembly
document into an alternate assemblies document. You can only convert
the assembly document once, and you must specify whether you want to
convert it into a family of assemblies or an alternate position assembly. In
this activity, you convert the assembly into a family of assemblies.

▸ In PathFinder, click the Alternate Assemblies tab.

▸ On the Alternate Assemblies tab, click the New button.

▸ In the Alternate Assemblies dialog box, do the following:

▸ Ensure that the Create a Family of Assemblies option is selected.
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▸ In the Name current member box, type Default Type 1 Open and press the Tab
key.

▸ In the Name new member* box, type Type 1 Closed.

▸ Click OK.

Note

On the Alternate Assemblies tab, notice that the Type 1 Closed member is
the active member. When you create a new family of assemblies, the name
you type in the Name new member box becomes the active member.
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Modify the Type 1 Closed family member

Modify the Type 1 Closed family member by overriding the value of the angular
relationship that controls the position of the valve subassembly and handle. First,
add the variable to the member variables list.

▸ On the Alternate Assemblies tab, select the Member Variables option.

▸ On the Tools tab, click Variables to display the Variable Table. Click the Filter
button and set the values as shown, and then click OK.
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▸ Click the ValveAngle variable, as shown.

▸ On the Alternate Assemblies tab, click the Add Variables button.

Note

The variable is added to the Member Variables list. When you add
variables to the Member Variables list, you can no longer edit them within
the Variable Table. You must edit them in the member variables list on
the Alternate Assemblies tab.

▸ Close the Variable Table.

▸ In the Member Variables list, position the cursor over the variable as shown, but
do not click yet.

▸ In the graphics window, notice the faces used to define the angle relationship
highlight as shown in the following illustration.
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▸ Position the cursor over the variable value as shown, and then double click the
left mouse button.

▸ Type 90, and then press the Enter key.

▸ In the graphics window, notice that the handle rotated 90° clockwise. In addition
to the handle, the valve subassembly also rotated.
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▸ On the Alternate Assemblies tab, select the Default Type 1 Open member as
shown.

Note

For the Default Type 1 Open member, the ValveAngle variable was also
added to the Member Variables list, but the valve handle is still in the
open position. The variable value you changed only affected the Type 1
Closed family member.

When you add a variable to the Member Variables list for one member,
the variable is added to the Member Variables list for all members that
contain the variable, but each member can have a different value assigned
to the variable.
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Create the member Type 2 Open

Create another family member, as shown. For this family member, delete the
original handle and place a new handle. Use the replace part command to replace
the TopFlange01.asm subassembly with a different subassembly.

▸ On the Alternate Assemblies tab, click the New button.

▸ In the New Member dialog box, type Type 2 Open, and then click OK.

Note

The new family member has the same characteristics as Default Type
1 Open. When you create a new family member, it has the same
characteristics as the family member that is active when you create the
new member. In this case, the active member was Default Type 1 Open.

▸ On the Alternate Assemblies tab, do the following as shown.

▸ Select the Excluded Occurrences option.
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▸ Ensure that the Apply edits to all members check box is cleared.

Note

When you exclude occurrences, you can exclude them for all family members
or for only the active member. In this case, you want to exclude the handle
for only the active member.

When you exclude an occurrence for all family members, the occurrence is
physically deleted from the assembly file, and it is not added to the excluded
occurrences list.

▸ Click the Assembly PathFinder tab.

▸ In Assembly PathFinder, select Handle01.par and delete it.

▸ A dialog box displays to confirm that you want to exclude the part for the active
family member.

▸ In the Confirm Delete dialog box, click Yes.
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▸ To make it easier to position the new handle, hide the nut part.

▸ In PathFinder, click the Parts Library tab.

▸ On the Parts Library tab, click the arrow on the right side of the Look In list.
Browse to the folder where the activity files are located.

▸ Drag Handle02.par into the assembly window.

▸ Position the handle using FlashFit as directed in the following steps.
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▸ Mate the two planar faces shown.

▸ Axial align the curved faces shown.
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▸ Mate the two planar faces shown.

The handle is fully positioned in the assembly.
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▸ Save the assembly.
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Observe results

Make some observations of the alternate assemblies created so far.

▸ In PathFinder, click the Alternate Assemblies tab.

▸ In the Excluded Occurrences list for the Type 2 Open family member, notice that
Handle01.par has been added to the list.

▸ On the Alternate Assemblies tab, activate the member named Default Type
1 Open.

Note

For this family member, Handle02.par is in the excluded occurrences list.
Also notice that the assembly display updated when you activated this
family member.
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Finish defining the Type 2 Open member

Finish defining the characteristics for member Type 2 Open by replacing a
subassembly.

▸ On the Alternate Assemblies tab, activate the member named Type 2 Open.

▸ Click the Assembly PathFinder tab.

▸ In Assembly PathFinder, select the entry TopFlange01.asm.

▸ Click the Home tab. In the Modify group, click the Replace Part command.

Note

You can use the replace Part command to replace a part or subassembly
within the assembly. When replacing a subassembly, you must select it
within Assembly PathFinder.

▸ In the Replacement Part dialog box, do the following:

▸ Set the Look In location to the folder where the activity files are located.

▸ Set the Files of type option to Assembly Files (*.asm).

▸ Select the assembly file TopFlange02.asm.
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▸ Click the Open button.

Note

Since the replacement subassembly is also a family of assemblies, you
must specify which family member you want to use as the replacement.

mt01416-s-1040 Solid Edge assembly 12-21



Lesson 12 Alternate assemblies

▸ In the Assembly Member dialog box, select the member named 3 screws with
stud, and then click OK.

Note

In the assembly window, notice the replacement subassembly does not
have four Phillips-head screws. In place of one of the screws is a stud that
serves to limit the rotation of the new handle. Also notice in Assembly
PathFinder, the member name is appended to the filename.

▸ In PathFinder, click the alternate assemblies tab.
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▸ On the Alternate Assemblies tab, select the Occurrence Overrides option.

Note

Notice for this member that TopFlange01.asm was overridden by
TopFlange02.asm!3 screws with stud.

When you replace a part or subassembly, the original occurrence is added
to the left column in the occurrence overrides list, and the replacement
occurrence is added to the right column in the occurrence overrides list.
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Create a new family member

Create another family member as shown. For this family member, change the
position of Handle02.par. This family member illustrates how you can exclude
relationships for a part. Excluding relationships for a part allows you to add new
relationships that change the position of the part.

▸ On the Alternate Assemblies tab, click the New button.

▸ In the New Member dialog box, type Type 3 Open Reverse Handle, and then
click OK.

Note

The new member you created is active, and it has the characteristics of
the Type 2 Open member.

▸ On the Alternate Assemblies tab, do the following as shown.

▸ Select the Excluded Relationships option.

12-24 Solid Edge assembly mt01416-s-1040



Alternate assemblies

▸ Ensure that the Apply edits to all members check box is cleared.

Note

When you exclude relationships, you can exclude them for all family
members or for only the active member. In this case, you want to exclude
the relationships for only the active member.

▸ Click the Assembly PathFinder tab.

▸ In the top pane of Assembly PathFinder, select Handle02.par as shown.
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▸ In the bottom pane of Assembly PathFinder, delete the two relationships shown.

Note

Notice that the symbol adjacent to Handle02.par changes to indicate it is
no longer fully positioned.

▸ In PathFinder, click the Alternate Assemblies tab.

Note

Notice that the relationships you excluded were added to the Excluded
Relationships list for the family member named Type 3 Open Reverse
Handle.

▸ Click the Assembly PathFinder tab.

▸ In the top pane of Assembly PathFinder, select Handle02.par.

▸ On the command bar, click the Edit Definition button.
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▸ Establish a Mate relationship between the faces shown.

▸ The handle is mated to the shaft as shown.
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▸ Continue using FlashFit to mate the faces shown.

▸ Click the Offset Type button, and then click Floating Offset.

Note

This setting allows the faces to take on whatever offset value is
appropriate to satisfy the other relationships that position the two parts.

The handle is fully positioned in the assembly.

12-28 Solid Edge assembly mt01416-s-1040



Alternate assemblies

▸ Fit the assembly and then save the assembly.

▸ In Assembly PathFinder, show NutM15.par.
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Observe results

Make some observations of the alternate assemblies created so far.

▸ In PathFinder, click the Alternate Assemblies tab.

▸ On the Alternate Assemblies tab, activate the member named Type 2 Open.

Note

There are two relationships on the excluded relationships list for this
family member. These relationships were added to the list automatically
when you repositioned the handle for the member named Type 3
Open Reverse Handle. When the Apply edits to all members option is
cleared, the relationships you add to position a part for one member are
automatically excluded from the other members that contain the same
part.

Also notice that for this member, NutM15.par is still hidden. When you
change the display of a part for one family member, the display of the
same part in other family members is not changed.
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Create family member named Type 3 Open Reverse Handle.

Create a new assembly document for the family member named Type 3 Open
Reverse Handle.

▸ On the Alternate Assemblies tab, activate the member named Type 3 Open
Reverse Handle.

▸ On the Alternate Assemblies tab, click the save member as button.

▸ In the Save Member dialog box, save the active member (using the default name)
to the folder where the activity files are located.

If a dialog box displays and asks if you want to save the current assembly first,
click the Yes button.

Note

Remember the name and location, because you will be opening this
document in the next step.

▸ Click the Application button. Click the Open button.
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▸ In the Open File dialog box, browse to the location where you saved the new file,
and then open it with all the parts active.

Note

For the new assembly, no family members are listed on the Alternate
Assembly tab.

When you save a family member as a separate assembly, it is saved
as a normal assembly document. Saving family members as separate
assembly documents is useful because some downstream applications do
not recognize assembly documents that have been converted to alternate
assemblies. For example, Simply Motion only allows you to open normal
assembly documents.

▸ Save the assembly.

▸ Close and save both assembly documents.
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Draft family of assembly members

Create a new draft document and place a drawing view of one of the family of
assembly members.

▸ Click the Application button. Click the New button.

▸ In the New dialog box, click iso draft.dft, and then click OK.

▸ Choose the Home tab®Drawing Views group®View Wizard command .

▸ In the Select Model dialog box, select Alternate.asm, and then click Open.

▸ The Family of Assembly Member page of the Drawing View Wizard displays, so
you can specify which family member you want. From the Family member list,
select the Type 3 Open Reverse Handle option, and then click the Next button.

▸ On the Assembly Drawing View Options page, click the Next button.

mt01416-s-1040 Solid Edge assembly 12-33



Lesson 12 Alternate assemblies

▸ On the Drawing View Orientation page, select the iso option, and then click
Finish.

▸ Position the drawing view on the drawing sheet, and then click to place the
drawing view.

▸ Save and close the draft document. This completes the activity.
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Activity summary

In this activity you learned how to create an alternate assembly. In the alternate
assembly, you learned how to add new members, define unique variables
for individual members, exclude member occurrences and reapply assembly
relationships for a member.
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Lesson review
Answer the following questions:

1. In the Alternate Assemblies tab in PathFinder, what two types of assemblies
can you create?

2. In a family of assemblies, which substitutions, modifications or exclusions are
allowed?

3. Can an assembly family member be saved as a unique assembly?

4. How do you place an assembly family member on a drawing sheet?
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Answers
1. In the Alternate Assemblies tab in PathFinder, what two types of assemblies
can you create?

In the Alternate Assemblies tab in PathFinder, you can create a family of
assemblies or an alternate assembly.

2. In a family of assemblies, which substitutions, modifications or exclusions are
allowed?

The list of substitutions modifications and exclusions is:

• Offset values for assembly relationships

• Occurrence overrides

• Excluded occurrences

• Excluded relationships

• Excluded assembly features

• Excluded frames

• Excluded piping routes

• Excluded pattern occurrences

• Excluded fasteners

3. Can an assembly family member be saved as a unique assembly?

An assembly family member can be saved as a unique assembly.

4. How do you place an assembly family member on a drawing sheet?

When the drawing view wizard is run on the alternate assembly, the list of
family members is provided for selection of the correct member
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Lesson summary
In this lesson you learned how to create an alternate assembly. In the alternate
assembly, you learned how to add new members, define unique variables
for individual members, exclude member occurrences and reapply assembly
relationships for a member.
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Creating an adjustable part
Adjustable parts will change relationship values to fit when placed in an assembly.
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Adjustable parts in assemblies

In some designs, there are parts that must react to changing conditions in the
assembly. For example, a spring that is compressed or uncompressed based on the
position of other parts in the assembly.

The Adjustable Parts functionality in Solid Edge allows you to define parameters
in a part model that will adjust with respect to corresponding parameters within
the assembly. This allows you to control the size and shape of the part based on
parameters you define in the assembly.

When you specify that a part is adjustable, the design body in the part model does
not change when the assembly parameters change. An associative copy of the design
body in the assembly changes. The associative copy of the design body is placed in
the assembly automatically and is managed by Solid Edge when you specify that a
part is adjustable within the context of the assembly.

This allows you to place several occurrences of an adjustable part into an assembly,
and each occurrence of the adjustable part will conform to the current parameter
values for that occurrence of the part. For example, one occurrence of a spring
can be shown compressed while another occurrence of the spring can be shown
uncompressed.
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Note

Only the design body for an adjustable part is associatively copied to the
assembly. If the adjustable part contains construction bodies, they are not
associatively copied to the assembly.

Making a part adjustable

To make a part adjustable within the context of an assembly, you first must define
the parameters you want to adjust in the part document. You can then define
corresponding parameters in the Assembly environment.

You can use driving dimensions and variables that control a feature, reference plane,
or construction element as the parameters to define an adjustable part.

When you specify that a part is adjustable, you cannot in-place activate the part
using the Edit command. You can use the Open command to open the part.

Defining the part parameters

The Adjustable Part command on the Tools tab in the Part or Sheet Metal
environments displays the Adjustable Part dialog box so you can define or edit the
adjustable parameters.

When the Adjustable Part dialog box is displayed, you can select features to display
their dimensions, or you can click the Variable Table button on the Adjustable Part
dialog box to display the variable table.

For example, to make the length of the spring shown adjustable, you can add the
variable which controls spring length: SprLngPrt, to the adjustable parameters list
by selecting the variable in the Variable Table.

When you add a variable or dimension to the Adjustable Part dialog box, the
parameter name is added to the Variable Name column (A). You can also add text
to the Notes column (B) to make it easier to remember later what aspect of the
part the adjustable parameter controls.
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Placing adjustable parts in an assembly
When adding an adjustable part to an assembly, you should place and position the
parts which interact with the adjustable part first. This allows you to use the
surrounding parts to define the assembly parameters required to complete the
process. You can specify whether an adjustable part is adjustable or rigid in the
assembly when placing the part or after you position the part in the assembly.

When you drag and drop an adjustable part into an assembly, a dialog box is
displayed that allows you to specify whether the part is rigid or adjustable.

When you set the Place Rigid option, the part placement process proceeds as it
would for a typical part. You can then define assembly relationships to position the
part in the assembly. An adjustable part placed as rigid in an assembly behaves the
same as any other part in an assembly.

When you set the Place Adjustable option, the part placement process is temporarily
suspended so you can define the adjustable parameters in the assembly using the
Adjustable Part dialog box.

Note

When positioning an adjustable part, the option to use a separate Place Part
window is not available. The part is placed in the assembly window so you
can define the adjustable parameters and the assembly relationships in one
window.

Defining the assembly parameters
In addition to the options for selecting driving dimensions and variables, the
Adjustable Part dialog box in the Assembly environment contains options that allow
you to define a measurement variable. This allows you to use geometry on other
parts in the assembly to define variables which will control the size and shape of the
adjustable part in the assembly.

The measurement variable options activate one of the Measurement commands that
are also available on Inspect®Measure. For example, you can use the Measure
Minimum Distance option to specify that the minimum distance between the two
faces shown controls the height parameter of the part.

After you select the elements in the assembly that define the distance you want to
measure, an assembly variable is created automatically and added to the Assembly
Variable cell in the Adjustable Part dialog box for the adjustable part you are placing
or editing.
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There are three columns in the Adjustable Part dialog box in the Assembly
environment: Part Variable (A) Notes (B), and Assembly Variable (C). In this
example, the part variable SprLngPrt is controlled by the measurement variable
SprLngAsm in the assembly.

In addition to defining measurement variables, you can also use assembly
relationship variables for an adjustable part. For example, you can use the offset
value for a mate or planar align relationship as an assembly variable by selecting
the variable value for the relationship in the Variable Table.

The place like a spring option will use the variable created by measuring a distance
to adjust the length of the corresponding variable in the part or sheet metal
document. The position of the parts attached to the adjustable part determines the
length of the variable defining the distance.

The adjust to fit and allow assembly relationships option will use the variable
created by the measurement to change the length of the adjustable part, and
reposition parts within the assembly that are not constrained. The length of the
variable defining the adjustable part length is used to position the unconstrained
parts connected to the adjustable part.

After you have defined all the parameters in the assembly to control the adjustable
part, click the OK button on the Adjustable Part dialog box to resume the part
placement process. In this example, a mate relationship (A) and an axial align
relationship (B) fully position the part in the assembly (C).

You can also specify that a part is adjustable after it has been positioned in the
assembly. First, you must define the adjustable parameters for the part in the Part
or Sheet Metal environment. Then, in the assembly, you can use the Adjustable Part
command on the shortcut menu when a part is selected to specify that the part is
adjustable and then define the adjustable parameters.

Note

When you specify that a part is adjustable, you cannot in-place activate the
part using the Edit command. You can use the Open command to open the
part.
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Updating adjustable parts

When you edit the assembly such that the adjustable part must change, the size and
shape of the adjustable part updates automatically when the Automatic Update
option is set. For example, in this assembly, if you edit the offset value for the planar
align relationship between the valve and body parts, the valve opens.

This causes the size and shape of the adjustable part to update automatically.

Adjustable parts in adjustable subassemblies

You can place a subassembly that contains an adjustable part into an assembly, then
make the subassembly adjustable. For example, you may need to place two instances
of a cylinder subassembly, with each subassembly in different positions.

Each cylinder assembly contains a spring that is an adjustable part, which allows
the spring to change length as the cylinder subassemblies change positions.
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When you make a subassembly adjustable that contains adjustable parts, the
adjustable part variables are promoted to the current assembly.

For more information on creating and using adjustable assemblies, see the
Adjustable assemblies Help topic.

Using reference geometry to constrain adjustable parts

You can use part reference planes or construction geometry to define positioning
relationships for an adjustable part in an assembly, but in some cases this can
prevent the adjustable part from reacting properly to assembly changes.

If this occurs, you can edit the positioning relationship to use geometry on the design
body on the adjustable part instead.

Adjustable parts and Parts Lists

When you place the same adjustable part several times in an assembly in different
states of adjustment, all occurrences have a single part number. If you use
several family of parts members to simulate adjustable parts in different states of
adjustment, you can have more than one part number, because different family of
parts members have unique part numbers. Typically, a single part number is the
preferable result.

Adjustable parts and alternate assemblies

You can use adjustable parts in a family of assemblies. You can edit the assembly
variable used to control an adjustable part on a per member basis by clearing the
Apply Edits to All Members option.
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Activity: Creating an adjustable part

Overview

The objective of this activity is to show how to create an adjustable part to be
used in an assembly.

Activity

In this activity you will create a spring that adjusts its length when placed in
an assembly.

mt01416-s-1040 Solid Edge assembly 13-9



Lesson 13 Adjustable parts and assemblies

Activity: Creating an adjustable part

Overview

This activity demonstrates to create an adjustable part and place it into an assembly.

Objectives

You will create a spring and use it as an adjustable part and a rigid part in an
assembly.

Creating the variable defining the adjustable distance

Sketches created in a part document will be used to define the adjustable variable.

▸ From the Solid Edge start screen, click Open Existing Document. Browse for
spring.par in the folder where the activity files are located.

▸ Select Sketch1 in pathfinder and then select Edit Profile to edit the sketch.

Note

This sketch will be used to create a helix defining the spring. To make the
length adjustable, a dimension controlling the length will be defined.

▸ Dimension the horizontal line in the sketch. The length is 2000 mm.

▸ Click Tools, then click Variables to show the variable table.

13-10 Solid Edge assembly mt01416-s-1040



Adjustable parts and assemblies

▸ Find the variable with the length equal to 2000 and change the name of the
variable name to spring_length.

▸ Dismiss the variable table.

▸ Click the home tab, then click Close Sketch.

▸ Click finish.

▸ Select Sketch2 in pathfinder and then select Edit Profile to edit the sketch.

▸ Place a horizontal dimension between the two rectangles.

Note

The rectangles will be used to create a cutout and shave off the ends of the
spring creating a planar face on each end. The spacing will be controlled by
a formula in the variable table equating the spacing between the rectangles
to the spring_length variable previously defined.

▸ Click Tools, then click variables to show the variable table.
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▸ Find the variable with the length equal to the horizontal dimension just created.
In the formula field, set the value equal to the variable spring_length.

▸ Dismiss the variable table.

▸ Click the home tab, then click Close Sketch.

▸ Click finish.

Create the spring from the sketches

Create the helix from the sketch1.

▸ Hide Sketch2.

▸ On the home tab, in the solids group, click add helix.

▸ Set the create from option to: Select from Sketch.

▸ Select the circle as the sketch chain and then click accept.
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▸ Select the horizontal line as the axis.

▸ Select the left side of the line as the origin of the axis.

▸ Set the method to Axis length and turns and the number of turns to 15.

▸ Click Next.

▸ Click Preview.

▸ Click Finish.

▸ Hide Sketch1 and show Sketch2.
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▸ On the Home tab, in the Solids group, click the Cut command.

▸ Set the create from option to: Select from Sketch.

▸ Select each of the rectangles in the sketch, then click the accept button.

▸ Select the through all option for the extent of the cut.

▸ Select both directions to define the extent of the cut.

▸ Click Finish to complete the cut.
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Define the adjustable variable

The variable defining the axis length of the spring will be defined as the adjustable
variable.

▸ Click the Tools Tab. In the Assistants group, click Adjustable part.

▸ Click the variable table button.

▸ Select spring_length as the adjustable variable.

▸ Dismiss the variable table. Spring_length will be defined as the adjustable
variable.
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▸ Click OK.

▸ The spring is complete. Save and close the document.

Place and define the adjustable part as a spring

The spring will be placed and positioned in the assembly as an adjustable part.

▸ Open the assembly shock_absorber.asm.

▸ In pathfinder, right click shock_absorber.asm and then click Activate to activate
all the parts.
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The subassembly, shock_top.asm, examine the relationships used to position the
subassembly relative to shock_bottom.asm.

▸ In pathfinder, click shock_top.asm. In the lower pane notice that there is an axial
align relationship and a floating planar align.

Note

These relationships keep the cylindrical parts aligned and keep the holes
containing the bushing and sleeve parallel. There is still freedom to move
along the axis of the cylinders.

▸ From the parts library, drag spring.par into the assembly.
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▸ Set the placement choice as Place Adjustable, then click OK.

Note

The adjustable variable in the spring will be controlled by the measured
distance between two faces defined in the next steps.

▸ Click Adjust like a spring and then click the measure button.
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▸ Select the circular face shown for the point to measure from. The measurement
tool will lock to the radial point of the circle when selected.

▸ Select the circular face shown for the point to measure to. The measurement tool
will lock to the radial point of the circle when selected.

Note

The adjustable distance has been set and the spring length adjusts to the
distance defined.

▸ Click OK to dismiss the dialog box.
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The reference planes will be used to position the spring. The next steps will turn on
the planes needed to position the spring.

▸ Click the Select tool. Right mouse click in the assembly window. Click Show/Hide
All.

▸ Hide all the reference planes.

▸ Click OK to dismiss the dialog box.

▸ In pathfinder, right click shock_bottom.asm and then click Show/Hide
Component.
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▸ Turn on the Reference planes for shock_bottom.asm. Then click OK to dismiss
the dialog box.

▸ On the Home tab in the Select group, click Clear Selection.

▸ In the Assemble group, click Assemble.

▸ Using the mate relationship, select the face shown.
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▸ For the target face, click the face shown.

▸ Using the mate relationship, select the face shown.

▸ For the target face, click the face shown.
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▸ Click the construction display to turn on the reference planes for spring.par.

▸ Using the mate relationship, select the reference plane shown.
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▸ Select the reference plane shown as the target.

▸ Using the mate relationship, select the reference plane shown.
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▸ Select the reference plane shown as the target.

▸ The Spring is placed.
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▸ Turn off the display of the reference planes..

shock_top.asm is still free to move along the axis of the cylinders. You will move this
part and the spring will adjust size based on the position of this subassembly.

▸ Click the home tab. In the modify group, click the drag command.
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▸ Drag shock_top.asm to increase the separation distance between the
subassemblies.

▸ The spring will adjust to the spacing between the faces.
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▸ Use the drag command to change the spacing and observe how the spring reacts.

Define the adjustable part as a rigid part

Previously, the spring was set to adjust as a spring. The length of the spring was
determined by the spacing between two faces on different parts. The adjustable part
also be used to determine the spacing between the faces which removes the freedom
to move and makes the assembly rigid. This will be demonstrated in the next steps.

▸ Notice the icon in pathfinder for the subassembly shock_top.asm shows it as
under constrained.
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▸ Click the select tool. In pathfinder, right click spring.par. Click
Simplified/Adjustable. Click Edit Adjustable Part.

▸ Change the behavior to Adjust to fit and allow assembly relationships, and enter
1250 as the Assembly Variable value as shown.

▸ Click OK. Notice that shock_top.asm is now constrained and the variable
defining spring length determines the offset value.

▸ Save and close the document. This completes the activity.

Summary

In this activity you learned how to create and adjustable part and place it in an
assembly as a spring, or to adjust the fit to allow assembly relationships.
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Lesson review

Answer the following questions:

1. Is the following statement true or false? When an adjustable part is placed in an
assembly and adjusts to fit, the part document containing the part also adjusts
to a specific size, as well as every occurrence of that part in the assembly and
other assemblies that it may reside.

2. Fill in the blank in the following statement. When defining a part as adjustable,
the adjustable value is defined by a ________.

3. Is the following statement true or false? After defining a part as adjustable, it is
impossible to place the part as a rigid part.

4. What is the difference between the following placement options of an adjustable
part?

• Adjust like a spring

• Adjust to fit and allow assembly relationships
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Answers

1. Is the following statement true or false? When an adjustable part is placed in an
assembly and adjusts to fit, the part document containing the part also adjusts
as well as every occurrence of that part in the assembly and other assemblies
that it may reside in.

The answer is false.

When you specify that a part is adjustable, the design body in the part model
does not change when the assembly parameters change. An associative copy of
the design body in the assembly changes. The associative copy of the design body
is placed in the assembly automatically and is managed by Solid Edge when you
specify that a part is adjustable within the context of the assembly.

This allows you to place several occurrences of an adjustable part into an
assembly, and each occurrence of the adjustable part will conform to the current
parameter values for that occurrence of the part. For example, one occurrence
of a spring can be shown compressed while another occurrence of the spring
can be shown uncompressed.

2. Fill in the blank in the following statement. When defining a part as adjustable,
the adjustable value is defined by a variable. A dimension value has a variable
associated with it which shows up in the variable table.

3. Is the following statement true or false? After defining a part as adjustable, it is
impossible to place the part as a rigid part.

The answer is false.

The user has the option to place the part as either adjustable or rigid.

4. What is the difference between the following placement options of an adjustable
part?

• Adjust like a spring

• Adjust to fit and allow assembly relationships

When using the adjust like a spring option, the variable length is controlled by
the spacing between the components used to position the adjustable part. When
using the adjust fit and allow assembly relationships option, the spacing between

mt01416-s-1040 Solid Edge assembly 13-31



Lesson 13 Adjustable parts and assemblies

the other components is controlled by the size of the adjustable dimension in the
adjustable part.
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Lesson summary

In this lesson you learned how to create and adjustable part and place it in an
assembly as a spring, or to adjust the fit to allow assembly relationships.
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Creating an adjustable assembly
Adjustable assemblies will change relationship values to fit when placed in a higher
level assembly.
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Adjustable and rigid assemblies

When working with assemblies, it is sometimes necessary to allow movement within
a subassembly while working in a higher-level assembly. In other instances, it can be
necessary to show identical subassemblies in different positions. For example, you
can have two identical hydraulic cylinder subassemblies in an assembly, but need
to show the hydraulic cylinders in different positions.

The Adjustable Assembly functionality allows you to address both of these issues.

Comparing rigid and adjustable subassemblies

Specifying that a subassembly is adjustable allows you to place positioning
relationships between parts in the subassembly while in the higher-level assembly.
This is not possible with a rigid subassembly.

When you specify that a subassembly is adjustable, you are prevented from in-place
activating the subassembly. For example, when you try to in-place activate the
subassembly using the Edit command, a dialog box is displayed that informs you
that the subassembly is adjustable and to use the Open command to open the
subassembly.

Displaying identical subassemblies in different positions

There are several approaches to solving this problem:

You can create uniquely-named subassemblies for each of the otherwise identical
subassemblies. This allows you to assign unique offset values to the affected
relationships, but creates extra files and complicates data management.

You can create a single-level assembly where the subassembly components are
placed as discrete parts, instead of as a subassembly. This also allows you to assign
unique offset values to the affected relationships, but makes it more difficult to reuse
the hydraulic cylinder components later in another assembly. Another disadvantage
of this method is that the parts are listed individually, rather than as a subassembly.
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Alternately, you can use the Adjustable Assembly functionality within Solid Edge.
This approach eliminates the need to create multiple copies of the hydraulic cylinder
subassembly data set or to create single-level assemblies.

Preparing the subassembly

To use the Adjustable Assembly functionality, the subassembly should be left
under-constrained in the range of motion in which you want to adjust. This allows
you to apply the relationship(s) that you want to adjust in the higher level assembly,
not in the subassembly.

Placing the subassembly into the higher-level assembly

You place the subassembly into the higher-level assembly in the same manner as
you would any subassembly. There are several methods available to specify that you
want the subassembly to be considered an adjustable assembly.

To specify that the subassembly is considered adjustable while you are placing the
subassembly, set the Place As Adjustable option on the Options dialog box on the
Assemble command bar.

To specify that the subassembly is considered adjustable after you have completed
positioning the subassembly, select the subassembly in PathFinder, then click the
Adjustable Assembly command on the shortcut menu.

Note

Only subassemblies that contain parts that are not fully positioned can be
marked as adjustable.

You can also specify that a subassembly is adjustable by setting the Place as
Adjustable when this Assembly is Placed into Another Assembly option on the
Assembly tab on the Options dialog box.

Regardless of the method used, a special symbol is used in PathFinder (A) to indicate
the subassembly is adjustable.
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Working with adjustable assemblies

When a subassembly is set to adjustable, all assembly relationships existing within
the subassembly are solved at the level of the active assembly. In other words, the
relationships in the subassembly are promoted to the higher-level assembly for
solve purposes.

The relationships used to position the parts within the subassembly can be viewed
in the bottom pane of PathFinder when you select a part in the subassembly. These
relationships are read-only and the text label is gray to indicate that the relationship
cannot be edited. Displaying the read-only relationships makes it easier to evaluate
the existing relationships and apply the remaining relationships.

For example, when you select cylinder.par:1 in the adjustable assembly named
Actuator.asm:1, three relationships are displayed. The axial align relationship
to base.par (A) was placed in the current assembly. It was used to position the
subassembly in the current assembly, and is editable.

The Mate relationship to piston.par:1 (B) was placed in the current assembly after
the subassembly was made adjustable. Its purpose is to adjust the length of the
hydraulic cylinder subassembly and the relationship is editable.

Notice that no visual distinction is made between relationships (A) and (B), although
one of the relationships was used to position the subassembly in the current
assembly (A), and the other was used to position the two parts in the subassembly.

mt01416-s-1040 Solid Edge assembly 13-37



Lesson 13 Adjustable parts and assemblies

The remaining axial align relationship to piston.par:1 (C) was placed in the
subassembly, is read-only and not editable within the current assembly. Notice that
the text label is gray, indicating that the relationship is read-only.

If you specify that a subassembly is flexible, add positioning relationships, and then
specify that the subassembly is rigid, conflicting relationships can occur. You can
delete or suppress relationships to correct this situation.

Adjustable assemblies and adjustable parts

You can create assemblies that contain adjustable parts within an adjustable
subassembly. For example, you may need to place two instances of a cylinder
subassembly, with each subassembly in different positions.

Each cylinder assembly contains a spring that is an adjustable part, which allows
the spring to change length as the cylinder subassemblies change positions.

When you make a subassembly adjustable that contains adjustable parts, the
adjustable part variables are promoted to the current assembly.
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If you define an assembly variable in the variable table for a subassembly that
controls a part variable, the subassembly variable is promoted to the current
assembly. The promoted variable is a linked variable.

For more information on creating and using adjustable parts in assemblies, see the
Adjustable parts in assemblies Help topic.

Adjustable assemblies and the Drag Part command

If you specify that a subassembly is adjustable, and the combination of relationships
at the active level and the promoted relationships allow movement, you can use
the Drag Part command to reposition the parts. Adjustable assemblies work with
all modes of the Drag Part command.

Because an adjustable subassembly is typically used to drive movement in an
assembly, you may need to provide for that movement by suppressing or deleting
relationships in the related parts and subassemblies.
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Activity: Creating an adjustable assembly

Overview

The objective of this activity is to show how to create an adjustable assembly
to be used in a higher level assembly.

Activity

In this activity you will create and place an adjustable assembly.
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Activity: Creating an adjustable assembly

Overview

This activity demonstrates to create an adjustable assemble.

Objectives

You will place an assembly and define it as adjustable. The assembly will contain
an adjustable part.

Place an assembly containing an adjustable part into a higher level assembly

The assembly you will place will later be defined as adjustable.

▸ Open the assembly arms.asm. Activate all the parts in the assembly.

▸ From the parts library, drag shock_absorber1.asm into the assembly window.

▸ Click the activate button on the assemble command toolbar.
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▸ Using quickpick, activate the part sleeve.par.

▸ Using Flashfit, select the cylinder insleeve.par.
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▸ Select the cylindrical shaft in arm.par as shown.

▸ For the next relationship select the cylinder in sleeve.par as shown.

mt01416-s-1040 Solid Edge assembly 13-43



Lesson 13 Adjustable parts and assemblies

▸ Select the cylindrical shaft in arm.par as shown.

▸ Click the construction display to turn on the reference planes for
shock_absorber1.asm.
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▸ Select the reference plane shown.

▸ Select the face shown in arm.par.

Note

The subassembly is placed and is fully constrained.
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▸ Observe in pathfinder that all the parts of the assembly are fully positioned.

Make the assembly adjustable.

The assembly you will place will be defined as adjustable.

▸ Click the Select tool. In pathfinder, right click the subassembly
shock_absorber1.asm. Click Simplified/Adjustable then click Adjustable
Assembly.
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▸ Click OK to accept the warning message shown.

▸ Observe in pathfinder that all the parts of the assembly are not fully positioned.
Because the assembly is adjustable, the arm has freedom to move.

▸ Click the home tab. In the modify group, click the drag command.

▸ Drag arm.par as shown into different positions. Observe how the spacing
between the cylinders adjusts and that the spring adjusts to the spacing defined
by the new location of the arm.
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▸ Drag the arm to several different positions and observe how the assembly
adjusts.

Note

The assembly shock_absorber1.asm has a mate relationship defined with a
range offset. This limits the range of travel for the shock absorber.

▸ Save and close the assembly. This completes this activity.

Note

Motors defined in the top level of an assembly will move under constrained
parts. If an subassembly contains a motor, the motor will not move the
unconstrained parts unless the subassembly is made adjustable.

Summary

In this activity you placed an assembly with an adjustable part and defined the
assembly as adjustable.
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Lesson review

Answer the following questions:

1. What are the characteristics of an adjustable assembly?

2. How do you prepare an assembly to be adjustable?

3. If a motor exists in a subassembly and you would like to have that motor control
the position of under constrained parts, how could you do it?

4. When a subassembly contains an under constrained part and the subassembly is
made adjustable, constraints to the under constrained part can be made in the
higher level assembly. Where can you view and edit the relationships used to
position the part?

mt01416-s-1040 Solid Edge assembly 13-49



Lesson 13 Adjustable parts and assemblies

Answers

1. What are the characteristics of an adjustable assembly?

Specifying that a subassembly is adjustable allows you to place positioning
relationships between parts in the subassembly while in the higher-level
assembly. This is not possible with a rigid subassembly.

2. How do you prepare an assembly to be adjustable?

To use the Adjustable Assembly functionality, the subassembly should be left
under-constrained in the range of motion in which you want to adjust. This
allows you to apply the relationship(s) that you want to adjust in the higher
level assembly, not in the subassembly.

3. If a motor exists in a subassembly and you would like to have that motor control
the position of under constrained parts, how could you do it?

Make the subassembly with the motor adjustable.

4. When a subassembly contains an under constrained part and the subassembly is
made adjustable, constraints to the under constrained part can be made in the
higher level assembly. Where can you view and edit the relationships used to
position the part?

You can view and edit the relationships of an under constrained part in an
adjustable subassembly in the lower pane of pathfinder.
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Lesson summary

In this lesson you placed an assembly with an adjustable part and defined the
assembly as adjustable.
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Course overview

Course overview

The Explode-Render-Animate application within the Solid Edge assembly
environment is a tool for creating different types of presentations of Solid Edge
assemblies. Exploding an assembly allows you to control the movement, sequence,
and grouping of parts and subassemblies. Rendering a view allows you to define
textures, lighting, shadows, backgrounds, and other properties to create presentation
style images. Motors apply movement to under constrained parts in an assembly
that can be animated. Using Animation, you can combine previously created
exploding sequences and custom camera movement to create animation. Each frame
of the animation can be rendered to create presentation quality animations.

Once you complete the activities in this course, you will be able to control the
sequence and direction of explode events.
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Exploding assemblies
Solid Edge enables you to easily create exploded views of your assemblies. You
can use the exploded views you define in the Assembly environment to create
exploded assembly drawings in the Draft environment. You can also create
presentation-quality renderings and animations of exploded assemblies.
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Creating Exploded Views of Assemblies

Solid Edge enables you to easily create exploded views of your assemblies. You
can use the exploded views you define in the Assembly environment to create
exploded assembly drawings in the Draft environment. You can also create
presentation-quality renderings and animations of exploded assemblies.

To access the commands for creating assembly explosions, click
Explode-Render-Animate on the Tools tab in the Assembly environment. A set
of commands specifically tailored for working with explosions, renderings, and
animations is displayed. You can use the menu commands and the Explode
PathFinder tab shortcut menu to create, view, and edit exploded views of an
assembly.

The operations you perform while creating an exploded view are captured as events
and displayed in the Explode PathFinder tab on PathFinder. You can edit these
events later.

When you have finished defining an exploded view, you can save the exploded view
display configuration to a name you define.
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Exploding Assemblies Automatically

Many assemblies can be quickly exploded using the Automatic Explode command.
You can use this command to explode all the parts in an assembly; or to explode only
the parts in subassemblies you select.

When you explode selected subassemblies, you can select the subassemblies in the
graphic window or the PathFinder.

The Automatic Explode command explodes assemblies based on the relationships
applied between parts. In assemblies where the parts are positioned using mate or
axial align relationships, the Automatic Explode command will quickly give you
excellent results.

The Automatic Explode command cannot explode parts that are grounded. For
example, when you create a new part within the context of the assembly using the
Create In-Place option, the part is positioned using a ground relationship. You can
use the Explode command to manually explode a grounded part, or you can delete
the ground relationship, then position the part using assembly relationships, such
as mate and align.

Exploding Assemblies Manually

The Explode command gives you more control over assembly explosions than the
Automatic Explode command. You should use Explode for assemblies where many of
the parts were positioned without using mate or axial align relationships or when
you want to explode the parts in a different direction than the Automatic Explode
command uses.

The Explode command allows you to define an explode direction for one or more
selected parts. You can select the parts in the graphic window or PathFinder.

When exploding parts manually, you first define the parts you want to explode, then
select a base part and a face on the base part to define the explode direction.

You can also use the Explode command to edit explosions created with the Automatic
Explode command.

Exploding Subassemblies

If you want all the parts in a subassembly to remain a single unit (no offset distance
is applied between the parts), there are two approaches you can use. If you want all
the subassemblies in the assembly to remain a single unit, you can set the Bind All
Subassemblies option available with the Automatic Explode command.

If you only want some of the subassemblies in the assembly to remain a single unit,
you can use the Bind Subassembly command on the Home tab to specify that a
selected subassembly remains a single unit. A symbol is added to PathFinder to
indicate the subassembly is bound.

If you want to explode the subassembly later, you can use the Unbind Subassembly
command to unbind the subassembly.

Modifying an Exploded Assembly

You can use the other commands to modify the position and display of parts in your
explosions.
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Moving and Offsetting Parts

The Move Exploded Part command allows you to move or rotate one or more
parts along the original explode vector, or along another vector you define. You
can use the buttons on the command bar to move only the parts you select (A), or
the selected part and its dependent parts (B).

Note

The Move Exploded Part command cannot reorder parts in an exploded
view by moving a part past any adjacent parts.
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When you select a part to move, an orientation triad is displayed with the
original explode vector axis highlighted. To offset the parts in a new direction,
select one of the other axes, or use the options on the command bar to reorient
the triad to define the vector you want.

When you offset the part in a new direction, a joggle is added to the part and a
new explode event is added to the Explode PathFinder tab.
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Repositioning Parts

The Reposition command allows you to change the order of a part in an exploded
view. To reposition a part, select the part you want to reposition (A), then
highlight a reference part (B) in the explosion. An arrow is displayed to indicate
where the part will be repositioned. If that is not the correct position, highlight
a different reference part. You can reposition a part by placing it into a new
position in its original explode vector or into the explode vector of another group
of parts.

When you reposition a part, the spacing of adjacent parts is adjusted. You can
also reposition all the parts in a bound subassembly.

Collapsing Parts

The Collapse command allows you to quickly return a part to its original
assembly position relative to its parent part, but still show it in the exploded
view.
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Removing Parts

The Remove command allows you to hide a part in the exploded view. When
you remove a part, it is returned to its original, unexploded assembly position.
You can re-display it using PathFinder.
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Flow Lines

Flow lines are used between the parts in an exploded view to represent how the
parts are related to one another. You control the display of flow lines and flow line
terminators in an exploded view using the Flow Lines and Flow Line Terminators
commands on the Home tab.

There are two types of flow lines, event flow lines and annotation flow lines. Event
flow lines and annotation flow lines. Event flow lines are created using the explode
commands and show the path the assembly components follow during an explode
event in an animation.

Annotation flow lines are used to create exploded views for draft documents. The
Event flow lines can be dropped, which converts them into annotation flow lines, and
creates an individual entry in the explode pathfinder for each flow line. Annotation
flow lines can be added or modified to create the desired exploded view.

Once you have completed placing annotation flow lines on an exploded view, a display
configuration must be saved in order to place the exploded view on a drawing sheet.
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Editing Event Flow Lines

You can edit the length of an end segment of a flow line (A), or the position of a
joggle segment (B) of a flow line using the Modify command, or by using the drag
component command.
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Editing Annotation Flow Lines

Annotation flow lines can also be edited with the Modify command. Annotation
flow lines can be modified by dragging the handles and using key points on
destination geometry to determine the length of the flow line.

Displaying and Hiding Individual Flow Lines

You can also display or hide the flow line between two parts using the explode
pathfinder to show or hide the flow lines. The flow line command will turn on or
off the display of flow lines. The flow line terminator command will turn on or off
the display of the arrowheads at the end of each flow line.

Note

You can only select individual flow lines in the graphic window with the
Edit Flow Lines command or in the Explode Pathfinder tab with the
Select Tool.

Deleting Flow Line Segments

For event flow lines, you cannot delete the first or last segments of a flow line, but
you can delete the joggle segment of a flow line using the Explode PathFinder
tab. For annotation flow lines, you can delete segments or complete flow lines
using the modify command.
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Explode PathFinder Tab

The Explode PathFinder tab on PathFinder displays the structure for the current
exploded view configuration in a hierarchal list. As discussed previously, the
operations you perform while creating an exploded view are captured as events and
displayed in the Explode PathFinder tab.

You can use the Explode PathFinder tab to review and modify explode operations.
For example, you can move an explode Group to another position in the explode
structure, add and remove parts from Event Groups, edit the linear or rotational
offset values of an explode event and so forth.

Editing Explosion Offset Distance and Angle

You can use the Select Tool to edit the offset distance or rotation angle for one or
more explode events. You can select a single event in the Explode PathFinder tab, or
multiple events by selecting one or more parts in the graphic window.

Editing Single Events

When you select an explode event entry in the Explode PathFinder tab, the
current offset distance or rotational angle is displayed on the command bar. You
can type a new value to change the distance or angle.

Editing Multiple Events for a Single Part

When a single part has multiple linear offset events, such as for a part with a
joggled flow line, you can change all the linear distance values to a common value
in one operation. Select the part in the graphic window, then type a value in the
Distance box on the command bar. The Distance box on the command bar will be
blank the first time you do this. Only linear distance events are recognized.

Editing Multiple Events for Multiple Parts

You can also define a common linear offset value for multiple parts in one
operation. Drag a box around the parts with the Select Tool, then type a value in
the Distance box. Again, only linear distance events are recognized.
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Saving Exploded Display Configurations

You can use the Display Configurations command on the Home tab to save the
display configuration of an exploded view so you can recall it later. When you
save an exploded view configuration, the set of explode operations used to create
the exploded view is captured and saved. When you activate an exploded view
configuration, the Explode PathFinder tab updates to list the captured operations
for the current configuration.

You can also use exploded display configurations when creating drawings and
technical documents of exploded assemblies, and when creating animations of
exploded assemblies using the Animation Editor command on the Home tab.

Creating Multiple Exploded Views

If you need to create several drawings or animations of the same assembly, but with
different parts displayed or the parts displayed in different positions, you can save
additional exploded display configurations. After you have saved an exploded display
configuration, you can use the Unexplode command on the Edit menu to reassemble
the parts so you can start a new exploded view.

Using Assembly Display Configurations

You can use display configurations of regular assembly windows to control the
display status of parts in an exploded view. For example, when you apply an
assembly display configuration which has a hidden subassembly, the subassembly is
also hidden in the exploded view. The exploded positions of the parts are not changed.

Animating Exploded Views

You can use the Animation Editor command to create an animation of an exploded
view. The Animation Editor tool has options that allow you to specify the explode
configuration, initial state, speed, and animation order. For more information, see
the Creating Assembly Animations Help topic.

Creating Drawings of Exploded Views

When creating a drawing of an assembly in the Draft environment, you can specify
an exploded view configuration name on the Drawing View Wizard to create a
drawing view of an assembly explosion. You can also use the Create Drawing
command on the Application menu under the New command in the main Assembly
environment to create a drawing of an assembly explosion.

Note

The Create Drawing command is not available when working in the
Explode-Render-Animate application.

Flow Lines in Exploded Assembly Drawings

When you create drawings of assembly explosions, the flow lines are automatically
displayed in the drawing views. You can specify whether flow lines are displayed in a
drawing view using the Annotation tab on the Drawing View Properties dialog box.
You can also modify the display of the flow lines using the Draw in View command
on the shortcut menu.
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Overview

• Exploding, rendering, and animating assemblies

• Creating assembly animations

• Drawing Production Overview

• PathFinder in assemblies

Commands

• View Wizard command

• Animation Editor command

• Automatic Explode command

• Bind Subassembly command

• Collapse command

• Display Configurations command

• Modify command

• Explode command

• Move Part command

• Remove command (Explode application)

• Reposition command

• Unbind Subassembly command

• Unexplode command

• Flow Lines command

Procedures

• Collapse a part in an exploded assembly

• Explode an assembly automatically

• Explode individual parts in an assembly

• Remove a part from an exploded assembly

• Reposition a Part in an Exploded Assembly

• Unexplode an Assembly
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User Interface

• Explode PathFinder tab
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Automatic Explode command

Explodes the active assembly by applying a spread distance between parts.

The Automatic Explode command explodes assemblies based on the relationships
applied between parts. In assemblies where the components are positioned using
mate or axial align relationships, the Automatic Explode command quickly gives you
excellent results.

Note

You cannot use this command to explode grounded parts or pipe components.

Steps
The basic steps for automatically exploding an assembly are:

• Specifying the components to explode.

• Defining the explode settings.

Specifying the components

You can use the Select option on the command bar to specify whether all the
parts and subassemblies in the assembly are exploded or only the subassemblies
you select are exploded. When you explode selected subassemblies, you can select
the subassemblies in the graphics window or the Assembly PathFinder tab.

Defining the explode settings

You can use the options on the command bar and the Automatic Explode Options
dialog box to specify how the components are exploded. For example, you can
specify whether the spread distance between parts is calculated automatically,
or you can specify the spread distance yourself.
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When exploding an assembly that contains subassemblies, you can specify
how the parts in the subassemblies are exploded using the Automatic Explode
Options dialog box.

Calculating spread distance

The Automatic Spread Distance button on the command bar allows you to specify
whether the spread distance between parts is calculated automatically by the
Automatic Explode command, or that you want to specify the spread distance
yourself.

• To have the spread distance calculated automatically, set the Automatic Spread
Distance option.

• To specify the spread distance yourself, clear the Automatic Spread Distance
option, then type the value you want in the Distance box.

When defining the spread distance yourself, you can type the value you want, then
click the Explode button to see the result. To try another spread distance, type a new
value, then click the Explode button again.

Binding subassemblies

When using the Automatic Explode command on an assembly that contains
subassemblies, you can specify whether the parts in subassemblies are exploded (A)
or the parts in subassemblies are grouped together as a single unit (B). To keep the
parts in the subassemblies grouped together, set the Bind All Subassemblies option
on the Automatic Explode Options dialog box.

If you want to explode the parts in some subassemblies (A), but not others (B), you
can use the Bind Subassembly command to select the subassemblies you want to
remain a single unit when exploded.
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First, select the subassemblies in Assembly PathFinder, then click the Bind
Subassembly command. A symbol is added adjacent to the subassembly entry in
Assembly PathFinder to indicate that the subassembly is bound.

You can then clear the Bind All Subassemblies option on the Automatic Explode
Options dialog box, and only the bound subassemblies you selected remain a single
unit when you complete the command.

If you want to explode the subassembly later, you can use the Unbind Subassembly
command to unbind the subassembly.

Explode technique

The Explode Technique option on the Automatic Explode Options dialog box allows
you to specify whether the subassembly is considered or ignored when creating
the explosion.

The By Subassembly Level option specifies that each subassembly is considered as a
unique explosion. This keeps the parts in a subassembly adjacent to one another as
they are exploded (A).

The By Individual Part option specifies that the subassembly structure is ignored
when the parts are exploded. The parts are exploded based on their proximity to
one another. This can result in parts in separate subassemblies being intermingled
with one another. (B) This option duplicates the behavior used prior to version
19 of Solid Edge.
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Explode PathFinder tab

The Explode PathFinder tab on PathFinder lists the explode operations in the
order you perform them. You can use the Explode PathFinder tab to review and
modify explode operations. When you save explode configurations, each explode
configuration captures a separate set of explode operations. When you activate an
explode configuration, the Explode PathFinder tab updates to list the operations
captured for that configuration.

Grounded parts

The Automatic Explode command cannot explode parts that are grounded. For
example, when you create a new part within the context of the assembly using the
Create In-Place option, the part is positioned using a ground relationship. You can
use the Explode command to manually explode a grounded part, or you can delete
the ground relationship, then position the part using assembly relationships, such
as mate and align.
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Bind Subassembly command

Groups the parts in a subassembly so they will explode as a single unit when using
the Automatic Explode or Explode commands. To bind a subassembly, you must
first select it using PathFinder.

A symbol is added adjacent to the subassembly entry in PathFinder to indicate
that the subassembly is bound. You can use the Unbind Subassembly command to
unbind a subassembly.
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Unbind Subassembly command

Ungroups a subassembly that was grouped using the Bind Subassembly command.
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Explode command

Explodes one or more parts in a specified direction. The parts (A) selected for
explosion are offset along an explode vector you define by selecting a face or reference
plane on a base or reference part (B).

You can manually explode a single part, multiple parts, and bound subassemblies.
You define the offset distance using the Distance box on the command bar.

Note

Parts that were exploded with the Automatic Explode command can be
re-exploded along a different explode vector using this command.

Steps

The basic steps for manually exploding parts are:

• Select the parts to explode.

• Select the base part.

• Select a face or reference plane on the base part.

• Specify the explode direction.

Exploding Multiple Parts

When you select multiple parts to explode in one operation, you can use the Manual
Explode Options dialog box to specify whether the parts are spread out evenly, or
that the parts are moved as a single unit.

Spreading Components Evenly
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When you set the Spread Components Evenly option, you can use the Manual
Explode Options dialog box to define the explode order you want. You can select
one or more parts in the Explode Order list, then use the Move Up and Move
Down buttons on the dialog box to define the explode order you want. When you
select a part in the list, it highlights in the graphic window. This allows you to
reorder the parts as you explode them.

Moving as a Single Unit

When you set the Move Components as a Single Unit option, the current relative
position of the set of parts is maintained, and they are relocated along the
explode vector you defined.

Exploding Bound Subassemblies

When you select a bound subassembly to explode, it is exploded as a single unit. In
other words, the components within the subassembly are not spread out.
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Collapse command

Returns an exploded part to its original assembly position relative to its parent part.

You can collapse several parts in one operation by holding the Shift key and selecting
the parts you want to collapse. If you select a part that is a component in a bound
subassembly, the entire subassembly is collapsed.

When you collapse a part, the flow line for the part is deleted.
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Explode PathFinder tab

Provides alternate ways of viewing and editing an exploded assembly. The Explode
PathFinder tab displays the structure for the current exploded view configuration in
a hierarchical list. The Explode PathFinder tab helps you work with the components
that make up an exploded view.

This allows you to view the structure and perform edit operations on the current
exploded view configuration. Some of the operations you can perform include:

• You can select an explode event, then edit the offset or rotational value using
the command bar.

• You can use the commands on the shortcut menu to show and hide parts, collapse
parts, show and hide flow lines, and so forth.

• You can add and remove parts from explode Groups and Event Groups. This is
useful when working with animations.

The following table explains the symbols used in Explode PathFinder:

Legend
Part

Assembly

Group

Event Group

Linear Event

Rotational Event

Moved Parts

Unexploded Parts
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Explode groups and event groups

The way the parts and subassemblies are arranged in the Explode PathFinder
tab is based on the operations you performed to create the exploded view. These
operations, or events, are collected into one or more explode operation collections
in Explode PathFinder.

There are two types of explode operation collections: Groups and Event Groups. The
groups and event groups are created automatically as part of the explosion creation
process, but you can edit them later.

Groups

A Group collects all the parts and subassemblies that participate in a common
explode vector. It is possible for a group collector to have additional groups nested
within it. For example, if one part in the explode vector has parts branching off
into a different explode vector, the branched parts will be in a group nested
within the main group. The components within a group animate sequentially.

Event Groups

An Event Group collects all the components that will move simultaneously in an
animation. For example, a pattern of fasteners would typically be in an Event
Group. You can add parts to and remove parts from an event group.

Explode PathFinder and the graphics window

Similar to the PathFinder tab in an assembly, when you select an entry in Explode
PathFinder, the associated parts highlight in the graphics window. For example, if
you select a Group entry in Explode PathFinder, the parts associated with that
entry highlight in the graphic window.
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If you select a part in the graphics window, a box is displayed in Explode PathFinder
to indicate where in the exploded view tree structure the selected part is located.

Explode configurations and explode events

When you save an exploded view configuration, each explode configuration captures
a separate set of explode events. When you activate an exploded view configuration,
the Explode PathFinder tab updates to list the events captured for the current
configuration.

Adding and removing parts from event groups

You can add and remove parts from an Event Group to control which parts move
simultaneously during an assembly animation. The Add To Event Group and
Remove From Event Group shortcut menu commands in the Explode PathFinder
tab allow you to make these types of changes. For example, you may want all the
fasteners in an assembly to animate at one time, even though the results of the
Automatic Explode command placed them in different explode event groups.

Note

The Add To Event Group and Remove From Event Group commands are not
available when the Animation Editor is displayed.

For more information on assembly animations, see the Creating Assembly
Animations Help topic.
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Reordering groups

You can change the order of an explode Group, but not an Event Group using the
Explode PathFinder tab. This allows you to change the sequential order in which the
parts move in an assembly animation.

Use the Select Tool to drag and drop an explode Group to a different location.
Explode PathFinder displays a symbol to show where you can reposition the Group
in the explode structure. The symbol changes if you drag the Group to an invalid
location in the explode structure.
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Display Configurations command

Saves, applies, or deletes a display configuration of an assembly. A display
configuration captures the display status of the parts, assemblies, assembly sketches,
weld beads, and reference planes in an assembly.

Using display configurations can be useful when working with large assemblies.

To apply a saved configuration, you can also use the Configuration drop list on the
Home tab®Configurations group.

You can apply display configurations that were defined in the current assembly,
or display configurations that were defined in a subassembly. To apply a display
configuration defined in a subassembly, you must select the subassembly first.

For more information, see the Using display configurations and Working with large
assemblies efficiently Help topics.
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Display Configuration Options dialog box

Fit View After Apply
Fits the view after the display configuration is applied.

List exploded configuration in modeling mode when applied.
Options for displaying exploded configurations outside of Explode Render
Animate environment:

Prompt For Action
Gives you the choice to apply display settings only, or enter the ERA
environment.

Apply Display Settings Only
Applies the display settings which are not unique to the ERA environment
without entering ERA.

Switch to ERA and Explode
Switches to the ERA environment and applies the saved display
configuration settings.

Use Single Default Configuration
Creates a Solid Edge default configuration rather than a default configuration
associated with a user name.

Apply Activation Override
Allows you to specify how you want to apply the display configuration. When this
option is set, you can specify whether the parts in the assembly are activated
or inactivated when you apply the display configuration. When this option is
cleared, the active or inactive status of the parts is determined by their status
when the configuration was saved.

Activate All Parts
Specifies that all parts in the assembly become active when you apply the
configuration.

Inactivate All Parts
Specifies that all parts in the assembly become inactive when you apply
the configuration.

Maintain Current State
Specifies that the current activation state (inactive or active) of the parts in
the assembly is not changed when you apply a display configuration. Setting
this option improves performance when working with large assemblies.

When you apply a display configuration from the Select Tool command bar,
the current dialog box setting is honored. If you want to change the current
activation or override setting when applying a display configuration, you
must apply the configuration using the Display Configurations dialog box.

Apply Simplify Override
Allows you to specify how you want to apply the display configuration. When this
option is set, you can specify whether the parts in the assembly are simplified or
designed when you apply the display configuration. When this option is cleared,
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the simplified or designed status of the parts is determined by their status when
the configuration was saved.

Use All Simplified Parts (When Available)
Specifies that the simplified version of parts is used when you apply the
configuration.

Use All Design Parts
Specifies that the designed version of parts is used when you apply the
configuration.

Maintain Current State
Specifies that the current simplified state (simplified or as designed)
of the parts in the assembly is not changed when you apply a display
configuration. Setting this option improves performance when working with
large assemblies.

When you apply a display configuration from the Select Tool command bar,
the current dialog box setting is honored. If you want to change the current
activation or override setting when applying a display configuration, you
must apply the configuration using the Display Configurations dialog box.
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Move Part command

Moves or rotates parts in an exploded view in an assembly. You can use this
command to do the following:

• Move one or more parts along the original explode vector or a new vector you
define.

• Rotate one or more parts along the original explode vector or a new vector you
define.

• Move one or more parts within a plane you define.

You can move or rotate a single part, a set of parts, or a part and all its dependent
parts. The same basic steps apply whether you are moving, rotating, or moving
within a plane.

Moving parts along the original explode vector

• To move a single part: select the part, then drag it to the new location.

• To move a set of parts: select the parts, then click the Accept (check mark)
button on the command bar.
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When you click the Accept button, an orientation triad is displayed, with the
X-axis oriented to the explode vector. By default, the original explode vector axis
is selected. Drag the cursor to move the set of parts to the new location.

• To move a part and all its dependent parts: set the Move Dependent Parts option
on the command bar, then select the part you want to move. The part and all
its dependent parts highlight. When you click the Accept button, an orientation
triad is displayed. By default, the original explode vector axis is selected. Drag
the cursor to move the set of parts to the new location.
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Moving parts along a different explode vector

To move one or more parts along a different explode vector, first define the select
set of parts. For example, you can use the command bar to specify that you want to
move a part and all its dependent parts. After you click the Accept button, position
the cursor over the triad axis you want to move along, then drag the cursor. A joggle
is added to the flow line automatically. When you offset the part in a new direction, a
new explode event is added to the Explode PathFinder tab.
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When parts have been moved outside of their original explode vector, you can also
move them back into their original explode vector. Select the parts you want to move,
select the proper axis, then drag the parts back to the original explode vector. When
you get close to the original explode vector, the parts will automatically lock into the
original vector. The joggle segment will be automatically removed.

Rotating parts

To rotate one more parts, first set the Rotate option on the command bar. Define the
select set of parts, then position the cursor over the axis you want to rotate about,
and then drag the cursor to the new location.

Moving parts within a plane

To move one or more parts within a plane, first set the Move Planar option on the
command bar. Define the parts you want to move (A), then define the plane you want
to move the parts within. The movement plane is defined by the X axis (B) and
another axis you select. For example, you can move a part within the plane defined
by the X axis and Z axis (C). Then drag the cursor to the new location (D).
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With the Move Planar option, parts are typically moved outside of the original
explode vector axis. If so, a joggle is added to the flow line.

For additional information on working with exploded views, see the Creating
Exploded Views of Assemblies and Explode PathFinder tab Help topics.
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Remove command (Explode application)

Hides the selected part in the exploded view and returns the part to its unexploded
assembly position.

You can remove several parts in one operation by holding the Shift key and selecting
the parts you want to remove. If you select a part that is a component in a bound
subassembly, the entire subassembly is removed.

You can use the PathFinder tab to re-display the parts later.

14-38 Solid Edge assembly mt01416-s-1040



Exploding assemblies

Reposition command

Repositions a part with respect to another reference part in an exploded view.
This can be useful when you want to change the position of a part after using the
Automatic Explode command.

To reposition a part, select the part you want to reposition (A), then position the
cursor over the reference part (B). The reference part highlights, and an arrow
is displayed on the reference part to indicate which side of the reference part the
selected part will be repositioned to.

If the arrow does not point in the direction you want, highlight a different reference
part. If the reference part is the last part in an explode vector sequence, a dynamic
arrow is displayed to indicate that you can choose the side of reference part where
you want to reposition the selected part.

If the part you select is within a bound subassembly (A), all the parts in the
subassembly will be repositioned (B).
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You use this command to change the order in which the parts are exploded. To
relocate a part without changing its order, you can use the Move Exploded Part
command.
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Explosion Properties dialog box

Configuration
Specifies which explode configuration you want to use.

Use Explode From Configuration
Lists the existing exploded view configurations you can use in an animation.
You can specify one exploded view configuration for an animation.

Speed
Specifies the speed you want to use.

Common Velocity for All Parts
Specifies that the same velocity is used for all parts. You can type a value.

Explosion Duration
Specifies that you want to type a value in seconds for each explode event.

Animation Order
Specifies how you want the animation to start.

Innermost First
Specifies that you want to start the animation by moving the innermost
parts first.

Outermost First
Specifies that you want to start the animation by moving the outermost
parts first.

Initial State
Specifies whether you want to start the animation with the parts collapsed or
expanded.

Collapsed
Specifies that the animation starts with the parts collapsed.

Expanded
Specifies that the animation starts with the parts expanded.
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Activity: Explode

Activity objectives

In this activity, you will use the Explode-Render-Animate application to explode an
assembly. In this activity, you will accomplish the following:

• Use the Manual Explode command to order and sequence the events of an
explosion.

• Define the distances and directions of exploding parts along a time line.

• Group parts and subassemblies and control how they behave during and
explosion and when they explode.

• Creating an animation time line to be used in an animation sequence.

• Use the Automatic Explode command to begin an exploding sequence.

14-42 Solid Edge assembly mt01416-s-1040



Exploding assemblies

Activity: Exploding an assembly

Step 1

In this activity you open an assembly and enter the Explode-Render-Animate
application. You use the automatic explode command to create an exploding time
line used to animate the explosion. Once the initial explosions are created, you use
the manual explode command to group parts and subassemblies, and to sequence the
explosion and define the behavior of the parts as they explode.

You enter the Explode-Render-Animate application and explode the assembly using
the Auto Explode command. You explode the assembly with the bind subassemblies
option set. After the command is finished, you examine the results, and then use the
Unexplode command to reset the assembly.

Note

When using the Auto Explode command, the results are dependent on several
factors. Relationships used in building the assembly determine how the Auto
Explode command behaves. Parts positioned with an axial align will explode
away from the adjacent part in the direction of the axis. The same parts
that can be positioned with an axial align, can also be positioned with mate,
and planar align, however how these parts explode using the auto explode
command may not be as desired.

The behavior of subassemblies using the Auto Explode command can be
defined. Subassembly parts can be bound together as a group causing it
behave as if it is a single part, or the subassembly can be exploded into its
constituent parts.

For the Auto Explode command to give desirable and predictable results, you
must consider which relationships to use during the process of positioning
parts in the assembly.
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▸ Open the assembly explode.asm with all the parts active.

▸ In PathFinder, observe the relationships and grouping of parts in subassemblies
that were used to create the assembly. These relationships and subassemblies
will be used in the auto explode command.
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▸ On the ribbon, choose Tools tab®Environs group®ERA .

▸ On the ribbon, choose Home tab®Explode group®Auto Explode .

▸ On the Auto Explode command bar, select Top level assembly, and then click
the Accept button.
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▸ Click Automatic Explode Options.

▸ In the Automatic Explode Options dialog box, select Bind all subassemblies. Set
the Explode Technique to By subassembly level and click OK.

▸ On the command bar, click Explode, click Finish and then click Cancel. The
results are shown.

Examine the results. The parts that were in the top level of the assembly
exploded, and the subassemblies stayed intact.
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▸ Click the Explode PathFinder tab and observe the grouping. The display shows
that the subassemblies are bound and behave as if they were a single part.

Note

If PathFinder does not contain the tab you are looking for, such as Explode
PathFinder, Parts Library, or Alternate Assemblies, you can display it by
doing either of the following:

• Choose View tab®Show group®Panes , and then select the tab
name from the menu.

• In any of the other open docking windows, such as the Layers tab
or the Sensors tab, click the Display Docking Window Menu button

, and then select the tab name.
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▸ Expand some of the parts and observe the offset values. The Explode PathFinder
allows you to modify events and parameters that define the explosion.
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▸ Select Group 2 in the Explode PathFinder, and in the command bar enter 15
mm for the explode Distance, and then press Enter. This will set a uniform
explosion distance.

Note

If you exit the Explode-Render-Animate application, or use the Unexplode
command to collapse the explosion without saving a display configuration, any
information about the explosion is lost.

▸ Choose the Home tab®Configurations group®Display Configurations command

.

▸ Click New to create a new configuration, type exp01, and then click OK. Click
Close.

▸ Click the Unexplode command to restore the assembly to the unexploded
state. When asked to delete the current explosion, click Yes.
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Step 2

Explode the assembly with the bind subassemblies option turned off.

▸ Click the Auto Explode command.

▸ Select Top-level assembly and click the Accept button.

▸ Click the Automatic Explode Options button.

▸ Deselect Bind all subassemblies and click OK.
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▸ On the command bar, click Explode, click Finish and then click Cancel The
results are shown.

Examine the results. All the parts exploded as if they were in the top level
assembly.

▸ Click the Display Configurations command .

▸ Click New to create a new configuration, and enter exp02, and then click OK.
Click Close.

▸ Click the Unexplode command to restore the assembly to the unexploded
state. When asked to delete the current explosion, click Yes.
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Step 3

Bind the clock hand subassemblies so that they do not explode, and repeat the Auto
Explode command.

▸ In PathFinder, select the subassemblies defining the clock hands.

▸ Click the Home tab®Modify group®Bind command .

▸ Notice the display in PathFinder has changed to indicate the subassemblies
are bound.

Note

If you need to unbind a subassembly, select the subassembly and click

the Unbind command .

▸ Repeat the Auto Explode command with Bind all subassemblies turned off.
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▸ Click Explode, click Finish and then click Cancel. The results are shown.

Examine the results. All the parts exploded as if they were in the top level
assembly except the clock hands.
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▸ You will reposition the parts e_glass.par and e_SE_face.par in the explosion.

Choose the Home tab®Modify group®Reposition command .

▸ Select e_glass as the part to reposition.
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▸ Select G07_60_15.par as the part to place the part next to.
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▸ Select the side away from the clock housing to place the part.

Note

The flow line retains its length and may be longer than desired.
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▸ Reposition the part e_SE_face.par by repeating the steps above. The part to
place the part next to will be e_glass.par. The direction is towards the clock body.
This positions the face between the glass and the rest of the clock.
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▸ Click the Select command and in the Explode PathFinder, find e_glass.par and
e_SE_face.par and set the offset distance to 30 mm.

▸ Click the Display Configurations command .

▸ Click New, enter exp03, and then click Save. Click Close.

▸ Click the Unexplode command to restore the assembly to the unexploded
state. When asked to delete the current explosion, click Yes.

Step 4

Use the Auto Explode command with the Subassembly option set. This is the first
step in creating the final explosion. After the automatic explosion, use the manual
Explode command to further control the events in the explosion.

▸ Click the Auto Explode command.

▸ On the Auto Explode command bar, select Subassembly. Select e_housing.asm,
and then click the Accept button.

▸ Click the Automatic Explode Options button .
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▸ Select Bind all subassemblies. Set the Explode Technique to By subassembly
level and click OK.

▸ Click the Automatic Spread Distance button and enter a value of 15 mm.

▸ Click Explode, click Finish and then click Cancel. The results are shown.

Examine the results. Only the subassembly chosen exploded.
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Step 5

Now use the manual Explode command to refine the explosion events.

▸ Choose Home tab®Explode group®Explode .

▸ In PathFinder, in the subassembly e_housing.asm, select e_feltpad.par, and then
click Accept. This part is on the bottom of the housing and is positioned using a
ground relationship. You will explode it in the same direction as the foot pads.
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▸ Select the e_case.par as the stationary part.
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▸ Select the bottom face of e_case.par as the stationary part face to explode from.
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▸ Select down as the direction to explode.
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▸ Set the offset distance to 35 mm and then click Explode. Click Finish, then
click Cancel.

Step 6

Using the manual Explode command, move the gears as a group. Gears will be
placed between the clock housing and the circular back plane that is used to position
the gears in the clock. You first need to correct the spread distance between the
housing and the back to make room for the gears.

▸ In the Explode PathFinder, select the Event 1 in e_back.par and change the
distance to 60.00 mm.

▸ Click the Explode command .
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▸ In PathFinder, select all the gears and the subassemblies that define the clock
hands, and then click Accept.

▸ Select e_back.par as the part to remain stationary.
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▸ Select the circular face shown as the stationary face from which to explode.
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▸ Select the direction shown as the explosion direction.
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▸ Set the parameters shown, then click OK.

14-68 Solid Edge assembly mt01416-s-1040



Exploding assemblies

▸ Enter a distance of 25 mm and then click Explode, click Finish, then click Cancel.

▸ Click the Display Configurations command .

▸ Click New, and enter exp04. Then click OK. Click Close.

Note

You will overwrite this configuration at a later time. It is good practice to
incrementally save the exploded views in case you need to revert back to
the point at which you saved.

Step 7

Use the Move Exploded Part command to reposition a portion of the explosion.

▸ Choose Home tab®Modify group®Drag Component .
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▸ From the Explode PathFinder, select e_back.par, and then click Accept on the
Drag Component command bar.

▸ On the command bar, select Move .
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▸ Drag the Z axis vertically.
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▸ Position the parts as shown.
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▸ The result is shown.

▸ Choose the Select command, and in the Explode PathFinder, select the event you
just created. The vertical flow line will highlight. Set the distance to 50 mm,
and then click OK.

▸ Click the Drag Component command .
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▸ Select e_backplate.par, and then click Accept.

▸ On the command bar, select Rotate .
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▸ Enter 45o as the angle to rotate about the Y axis. The results are shown.

▸ In the Configuration group on the ribbon, click Save Display Configuration.

Note

The Save Display Configuration command saves the changes to the
configuration name that is currently displayed on the ribbon. This is a
quick way to save a configuration.

Step 8

Animate the explosion.

Note

Creating an animation of an exploded view is the only portion of the animate
command covered in this activity.

▸ Choose Home tab®Animate group®Animation Editor .
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▸ Examine the Animation Editor.

The right pane is the time line for each of the animation events. A motor was
previously defined in this assembly. Controls for playing the animation are
displayed.

The left pane displays the animation events, and the right pane displays the
event duration bars. These can be used to define and sequence the events of
the animation.

▸ Click Animation Properties.

▸ Set the values as shown, and then click OK.
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▸ Right-click the Explosion event, and then click Edit Definition.

▸ Set the parameters as shown.

• Initial State: Exploded.

• Speed: Explosion duration 5 seconds per event.

• Animation Order: Innermost first.

Click OK.

▸ The explosion events are populated in the left pane.

Note

During an animation, you can zoom and pan. It is good practice to
arrange the display window before the animation to fit the animation
in the view. To do this, choose the View tab®Window group®Arrange,
and then choose Horizontal.
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▸ Click Play on the animation controls and observe the explosion.

▸ When the explosion is complete, click Stop on the animation controls.

▸ Click Go to Start on the animation controls.

▸ Now change the sequence of the explosion. Right-click the explosion event, and
then click Edit Definition.
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▸ Set the parameters as shown.

• Initial state: Collapsed.

• Animation order: Innermost first.

Click OK.

▸ Click Play on the animation controls and observe the explosion.

▸ When the explosion is complete, click Stop on the animation controls.

▸ Click Go to Start on the animation controls.
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▸ Now change the sequence of the explosion. Right-click the explosion event, and
then click Edit Definition.

▸ Set the parameters as shown.

• Initial state: Collapsed.

• Animation order: Outermost first.

Click OK.

▸ Click Play on the animation controls and observe the explosion.

▸ When the explosion is complete, click Stop on the animation controls.
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▸ Click Go to Start on the animation controls.

▸ To exit the Animation Editor, click the Animation Editor command again. Click
Yes to save the changes to the current animation.

Step 9

To get all the fasteners to explode at the same time, move all the fasteners into the
same event group for animation purposes.

▸ In the Explode PathFinder, select the fasteners connecting the footpads
to the bottom of the case. Right-click and select Remove from Event

Group.

Note

The event group that contained these fasteners was dissolved because
it no longer contains any events.

▸ Right-click the fasteners and select Add to Event Group.
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▸ Either from Explode PathFinder or in the graphics window, select a fastener in
the group you are adding these fasteners to.

▸ The fasteners now all belong to the same event group.

▸ Click Save Display Configuration.
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Step 10

Replay the animation and observe the behavior of the fasteners now that they are all
in the same event group.

▸ Click the Animation Editor command.

▸ Update the animation with the configuration changes.

▸ Click Play on the animation controls and observe the explosion.

▸ When the explosion is complete, click Stop on the animation controls.

Note

Notice the fasteners exploded simultaneously.

▸ Click Go to End on the animation controls.

Step 11

Add a motion path to the explosion to control movement of the bottom fasteners.

▸ Click the Motion Path command on the animation controls.
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▸ Select the bottom fasteners as the components that follow the motion path,
and then click Accept.

▸ Press X on the keyboard as many times as it takes to lock the XY plane as shown.

▸ On the command bar, enter 35 as the frame count.
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▸ Enter the curve approximately as shown and Accept. Click Finish.

Note

This curve is a free-form 3D space curve locked into the XY plane. Your
results may vary slightly.

▸ Play the animation. Notice the fasteners follow the motion path at the beginning
of the animation.

▸ In the animation time line, drag the motion path event bar to the right as far
as it can go.

▸ Right-click the event bar and check the Properties. These can be modified if
necessary.

▸ Run the animation from the beginning. Notice the fasteners follow the motion
path at the end of the animation rather than the beginning.

▸ Stop the animation and reset to the beginning. Save the changes by clicking
the Save Animation command.

▸ To exit the Animation Editor, click the Animation Editor command.
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▸ This completes the activity. Click Close ERA to exit the Explode-Render-Animate
application. Save the assembly.

Activity summary

In this activity, you used the Explode-Render-Animate application to explode an
assembly. You accomplished the following:

• Used the Auto Explode command to begin an exploding sequence.

• Defined the distances and directions of exploding parts along a time line.

• Used the manual Explode command to order and sequence the events of an
explosion.

• Grouped parts and subassemblies and controlled how they behave during and
explosion and when they explode.

• Created an animation time line to be used in an animation sequence.
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Lesson review

Answer the following questions:

1. Where are exploded views stored?

2. Name two methods of binding a subassembly during an explosion?

3. How can explode events be moved to other explode groups?

4. Why would you use manual explode rather than auto explode?

5. What type of flow lines are created with the auto explode command?
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Answers

1. Where are exploded views stored?

Exploded views are stored as a display configuration. Display configurations are
stored in .cfg files usually having the same name as the assembly document.

2. Name two methods of binding a subassembly during an explosion?

Subassemblies can be bound either using the explode options, or by forcing
an assembly to stay bound by using the bind assembly command. Pathfinder
graphically shows which assemblies are bound.

3. How can explode events be moved to other explode groups?

After selecting the explode events from explode pathfinder, right click and
remove the explode events from the current explode group. Use the same
procedure to add the events to a different group.

4. Why would you use manual explode rather than auto explode?

Manual explode positions assembly components based on which assembly
relationships used to place the components. Sometimes the results do not convey
the intended results. By using the manual explode command, you can control
the placement of exploded assembly components. This can be done after the
auto explode command has finished.

5. What type of flow lines are created with the auto explode command?

Event flow lines are created with the auto explode command. Event flow lines
are used to create animations of exploded parts and will show up in draft
documents. They are stored in a display configuration.
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Lesson summary

In this lesson, you used the Explode-Render-Animate application to explode an
assembly. You accomplished the following:

• Used the Auto Explode command to begin an exploding sequence.

• Defined the distances and directions of exploding parts along a time line.

• Used the manual Explode command to order and sequence the events of an
explosion.

• Grouped parts and subassemblies and controlled how they behave during and
explosion and when they explode.

• Created an animation time line to be used in an animation sequence.
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Flow Lines command

Displays or hides all the flow lines between exploded parts.
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Modify command

Edits a flow line between two exploded parts. You can make the following types of
changes to a flow line:

• You can change the length of a flow line by editing the end point position of
either end of the flow line.

• You can change the location of a joggle segment on a flow line.

• You change the location of the entire flow line.

Changing Flow Line Length

You change the length of the flow line by selecting it at the end you want to edit (A),
then drag the cursor to the new position you want (B).

Changing Joggle Segment Position

If the Move Exploded Part command is used to move the part outside of the original
explode vector, a joggle is added to the flow line. You can use the Edit Flow Lines
command to drag the joggle segment (A) to a new position (B).
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Flow Line Handles

An event flow line mid-segment, or joggle, can be modified by dragging the handle
(A). An annotation flow line can be modified by dragging either of the handles shown
(B), and can be split (C) if needed.
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Changing Flow Line Location

The location and length of a flow line is determined automatically by using the range
box of the parent and child parts. The flow line terminator end originates at the
center of the range box on the parent part. (A) The range box is the theoretical 3D
envelope that the solid body is contained within. For some parts, you may want to
change the flow line location.

To relocate an entire flow line, click near one end of the flow line (A), then click an
edge or face that you want to connect that end of the flow line to (B).
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The flow line position is updated (A). You may also want to change the flow line length
so you can better view the flow line terminator (B) in the current view orientation.

Other Flow Line Operations

You can also perform the following actions on flow lines:

• To display or hide flow line terminators, set or clear the Flow Line Terminators
command on the View menu.

• To display or hide all flow lines, set or clear the Flow Lines command on the
View menu.

• To display or hide an individual flow line, select the part in the graphic window
or PathFinder, then click the Show Flow Lines or Hide Flow Lines commands
on the shortcut menu.

• To delete a joggle segment on a flow line, select the proper event in the Explode
PathFinder tab, then click the Delete command on the shortcut menu. This has
the same effect as using the Move Exploded Part command to move the part
back within an earlier explode vector.

• When you collapse a part with the Collapse command, the flow line is deleted.
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The Show Flow Lines and Hide Flow Lines commands are also available on the
shortcut menu when you select an explode event in the Explode PathFinder tab.

Note

You can only select flow lines in the graphics window with the Edit Flow Lines
command, or in the Explode Pathfinder tab with the Select Tool.
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Activity: Manipulating flow lines in an exploded assembly

Activity objectives

In this activity, you will accomplish the following:

• Modify event flow lines.

• Create and modify annotation flow lines.

• Delete annotation flow lines.

• Split annotation flow lines and then modify them.

• Place an exploded view on a drawing sheet.
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Activity: Manipulating flow lines in an exploded assembly

Step 1

In this activity you open an assembly that has an exploded view that was previously
created. The event flow lines will be modified, then converted to annotation flow
lines with the drop command. During this activity, assembly components will be
repositioned along with the flow lines associated with each component.

▸ Open the assembly computer_speaker.asm with all the parts active.

▸ On the tools tab in the environs group, click ERA.

▸ On the home tab in the configurations group, click the display configurations
command.

▸ Select the configuration named exploded. Click apply and then click close.

Note

The flow lines in this display configuration are event flow lines.
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Step 2

The drag component command will be used modify an event flow line.

▸ Click the drag component command.

▸ Select the assembly component woofer_tube1.par as shown and accept.
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▸ Select the Z axis and enter the distance value of 50 mm.

▸ Click the select tool to exit the drag command. The flow line has been modified
as shown.
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Step 3

An event flow line will be repositioned.

▸ Click the modify command.

▸ Select the flow line shown.
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▸ Click the handle shown.

▸ Select the end point of the line segment shown.
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▸ The flow line is moved as shown.

▸ Save the display configuration.

Step 4

Event flow lines will be converted to annotation flow lines.

▸ Observe the explode pathfinder. Event flow lines are not displayed in explode
pathfinder.

▸ Click the drop command.
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▸ Observe the explode pathfinder. The event flows lines have been converted to
annotation flow lines.

Note

The event flow lines have not been lost. The event flow lines are stored and
saved in the display configuration that was saved prior to dropping the flow
lines. A display configuration with the annotation flow lines should be saved
with a different display configuration name.

▸ Click the display configurations command.

▸ Click New. Enter annotation then click OK. Click Close

Note

The display configuration containing the annotation flow lines has been
saved.
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Step 5

An annotation flow line will be deleted and replaced by a new annotation flow line.

▸ In the explode pathfinder, select flow line 3.
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▸ Delete flow line 3.

Note

The deleted flow line was connected to the part grate2_1.par.

▸ Click the drag component command.
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▸ Select grate2_1.par and accept.

▸ Move the grate2_1.par –300 mm in the Y direction, —100 in the X direction,
and 200 mm in the Z direction.
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▸ A new annotation flow line will be created. Click the draw command.

▸ For the point of the flow line, click the circle shown.
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▸ For the end of the flow line, click the circle shown.
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▸ Click the draw previous and draw next buttons to get the result shown. Click
Finish and then click Cancel.
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An annotation flow line is created.

Step 6

An annotation flow line will be repositioned.

▸ Click the modify command.
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▸ Select the segment handle as shown.
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▸ Drag the segment to the approximate position shown.

▸ Click the split flow line command.
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▸ Select the flow line shown in the approximate position shown.

▸ Click the modify command.
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▸ Select the segment handle as shown.

▸ Drag the segment to the approximate position shown.
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▸ Save the display configuration.

▸ Close ERA and save the assembly.

Step 7

Create a drawing sheet of the exploded view.

▸ Click the Solid Edge Application button. Then click New>Create Drawing. Click
OK when prompted for the default template.

▸ Select the display configuration named annotation in the drawing view wizard.
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▸ Place the exploded view on the drawing sheet.

▸ Save and close all files. This completes this activity.

Activity summary

In this activity, you used the Explode-Render-Animate application to accomplish
the following:

• Modify event flow lines.

• Create and modify annotation flow lines.

• Delete annotation flow lines.

• Split annotation flow lines and then modify them.

• Place an exploded view on a drawing sheet.
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Lesson review

Answer the following questions:

1. What is the difference between an event flow line and an annotation flow line?

2. Can annotation flow lines be stored in a display configuration?

3. Can annotation flow be split and segments modified?
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Answers

1. What is the difference between an event flow line and an annotation flow line?

Event flow lines control animation explode events, and are created with the
explode commands. Dropping the flow lines changes then into annotation flow
lines which can be used in the draft environment.

2. Can annotation flow lines be stored in a display configuration?

Annotation flow lines must be stored in a display configuration to late be placed
on a drawing sheet.

3. Can annotation flow be split and segments modified?

Annotation flow lines can be split into segments and each segment dragged
to a new position.
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Lesson summary

In this lesson you learned that event flow lines, which control animation events can
be changed into annotation flow lines for better assembly annotation of exploded
views. As an annotation flow line, they are easily modified to produce high quality
exploded views of an assembly.
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Course Overview

Course overview

The Explode-Render-Animate application within the Solid Edge assembly
environment is a tool for creating different types of presentations of Solid Edge
assemblies. Exploding an assembly allows you to control the movement, sequence
and grouping of parts and subassemblies. Rendering a view allows you to define
textures, lighting, shadows, backgrounds and other properties to create presentation
style images. Motors apply movement to under constrained parts in an assembly
which can be animated. Using animation, you can combine previously created
exploding sequences and custom camera movement to create animation. Each frame
of the animation can be rendered to create presentation quality animations.

Once you complete the activities in this course, you will be able to:

• Assign material properties and textures to parts and subassemblies.

• Set viewing properties to change lighting, backgrounds, shadows, reflections,
refractions and perspectives.

• Edit material properties to create different results in the final rendering.
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Rendering
Limited rendering is available in Solid Edge assembly using the settings in the View
command. Advanced rendering in assembly is covered here and is contained in the
Explode-Render-Animate environment.
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Working with advanced rendering

The advanced rendering capabilities in Solid Edge are an extension of the
Explode-Render-Animate application. This functionality can enhance the quality
of images used in documents such as customer presentations or marketing and
sales literature.

With the advanced rendering capability, you have a single view style called
presentation view style that contains all of your rendering settings.

A library of predefined entities such as materials, backgrounds, render modes, and
light studios is available. You can customize the library with user-defined settings,
but you cannot edit, delete, or modify the contents of the original library. This
ensures protection for the original data stored in the library. Any custom settings
you add to the library are stored in a separate file. You can have multiple libraries.

The advanced rendering capability uses the Solid Edge display for view
manipulations. It supports part visibility and will only render what is on the screen.
The Sharpen command is available when working with advanced rendering to allow
you to make your graphics crisp and clear. Sharpening the display of the model will
increase the quality of the rendering.

Supported advanced rendering entities

Advanced rendering provides rendering support for these entities:

• Backgrounds

• Foregrounds

• Materials
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• Environments

• Lighting Studios

• Render Mode

• Scenery

• Schemes

Activating advanced rendering

Advanced rendering is activated automatically when you click the Render Scene and
Render Area buttons when you have a Solid Edge Classic license. When you click
these commands, two new tabs are added to PathFinder automatically.

• The Session Entities tab displays the name of the active assembly, along with a
tree structure that shows you the entities that are applied to the assembly. You
can right-click an entity to display a shortcut menu to:

– Edit the properties of an entity as the basis for creating a new entity.

– Detach (remove) a material that you have applied to the model.

– Cut, copy, and paste an entity.

– Rename an entity you created.

• The Predefined Archives tab displays a list of folders that contain predefined
entities, such as backgrounds, foregrounds, and materials. You can right-click an
entity to display a shortcut menu to:

– Create a new archive folder or advanced rendering entity.

– Apply an entity to the model.

– Cut, copy, and paste an entity.

– Rename an entity you created.

– A toolbar on the Predefined Archives page contains commands used to
create, save, open, close, and import customized entities in user-defined
archive folders.

Any material, color, background, light, or scene that you want to customize needs to
be applied to the assembly first, and then modified within the Session Entities tab to
look the way you want it to. When you have adjusted the parameters of an entity so
that it looks good on the model, you then copy the entity from the Session Entities
page to a user-defined entity archive on the Predefined Archives page on PathFinder.

Editing advanced rendering entities

You can use the <Entity> Editor dialog box to edit the advanced rendering entity
settings. To display the dialog box, click the Sessions Entity tab on PathFinder.
Right-click the entity you want to edit. For example, if you want to change the
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material settings for the rendering, right click Materials. On the shortcut menu,
click Edit Definition.

The options on the dialog box change based on the shader you select. A shader is
designed to imitate a real-world look for things such as material, light, and rendering
mode. Every component in advanced rendering is based on a shader, and each shader
has multiple options that allow you to control the look and feel of the renderings.

Applying advanced rendering entities

There are two ways to apply an advanced rendering entity.

• You can select the entity from the library in the Predefined Archives tab and
drag it onto the model in the graphics window.

• You can first select a model part in the graphics window, then right-click an
entity in the Predefined Archives tab and choose Apply To Selected on its
shortcut menu.

After applying the entity, you can use the Render Scene or Render Area command to
see what the change looks like in the model.

Saving an advanced rendered image

You can use the Save As command to save a rendered image.

Guidelines for saving advanced rendered images

When saving images, you should follow these guidelines.

• To calculate the memory requirements for the image, multiply the image size (in
pixels) * 4 (true color). For example, for an image 500 x 500 pixels, the memory
requirements are 10 MB (500 x 500 x 4).

• To calculate the file size for the image, multiply the image size * 3 (true color).

• On the Image Options form, set the Alternate View Style to Presentation View
Style.

Backgrounds

Backgrounds are a simple way of enhancing the screen area behind a model. They
appear in reflective surfaces so they can impact a model’s appearance and add
context to the model’s image.
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Note

Backgrounds in advanced rendering inherit the background in Assembly.

Advanced rendering supports the following background shaders.

• Graduated

A smooth linear transition from one color to another. In other words, there is a
gradual change in background colors as you go from the top to the bottom.

• Image

• Plain

• None
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To learn how to stretch a background image so that it fills the window, see the Help
topic, Set a Background Image in Explode-Render-Animate.

Foregrounds

Foregrounds allow you to add additional view effects that help simulate various
atmospheric effects such as fog. You can add foregrounds from the library or you can
edit the view settings directly.

Note

Foregrounds in advanced rendering do not inherit any assembly settings.

Advanced rendering supports the following foreground shaders.
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• Depth Cue

Depth Cue fades an image to a particular color to portray a sense of depth in
the image.

• Fog

• None

Materials

Advanced rendering includes a wide range of materials to simulate such things
as wood, plastic, marble, and metal. It also supports advanced surface effects for
texture maps and bump maps.
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The material definition is inherited from the style definition in the assembly. For
example, a part with a green style in the Assembly environment will initially
be green material in advanced rendering. The materials applied to a model in
advanced rendering are available only when using the Render Scene and Render
Area commands in the Explode-Render-Animate application. For example, if you
apply a red material to a green part, the part will still be green when you are not
using these commands.

You can apply a material to a single or multiple occurrences of parts. For example,
suppose you have several parts with a material definition of blue. If you change the
material definition to dark blue, all parts with blue material are affected.

Advanced rendering supports several properties and allows you to set the following
settings:

• Color

• Reflectance

• Transparency

• Displacement

• Texture space

When working in Explode-Render-Animate, you can modify the existing materials
to create different colors and properties. Once that is done, you can create a new
archive (.lwa file) for the modified entities, so you can apply them to different
projects whenever you want.

Color support

You can define colors as plain colors, patterns such as wood, granite, and marble,
or a textured map based on a bitmap image. The color settings support shaders
such as plain, woods, marble, and wrapped images.
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Reflectance support

Reflectance properties affect the way light interacts with the materials. You can
use these properties to apply such effects as:

• Mirror reflectance

• Plastic reflectance

• Glass reflectance

• Metal reflectance
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The reflectance settings support shaders such as chrome 2D, conductor,
glass, matte, metal, and mirror. Some of the most common options for these
shaders include:

– Specular factor

The specular factor is the amount of highlight or light reflected from a
triangle where its normal matches the light vector.

With a low specular factor, the appearance of the blue plastic seems to
be dull,

compared to a high specular factor that produces a shiner, almost
mirror-like effect.
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– Diffuse factor

The diffuse factor is the amount of light reflected from triangles where
the light is approximately 45 degrees from the light ray.

A low diffuse factor produces a dark image,

compared to a high diffuse factor.

– Mirror factor
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Transparency support

Transparency is the amount of coverage by a color filter to simulate glass or
some plastic materials. The values range from 0 for transparent to 1 for opaque.
The transparency settings support shaders such as none, glow, plain, and
wrapped image.

You can apply simple transparency to a model,

or combine it with properties such as reflectance, you can produce a more
accurate looking image.

Displacement support

Surface displacement defines surface deformations by applying such effects as
simple surface roughness, patterns such as leather and dimples, or tread plates.
The displacement settings support such shaders as none, casting, leather, rough,
wrapped displacements.
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Wrapped displacement shaders simulate materials with an imprinted pattern.
Some of the common wrapped displacement shaders include:

• Wrapped tread plate

Wrapped tread plates imitates slip resistant shaped tread pattern. Also
known as diamond plate, this material is commonly used for outdoor steps.

• Wrapped knurl

Wrapped knurl imitates handgrips and is a common finish for barbell
handgrips.

• Wrapped dimple

Wrapped dimple simulates a slip resistant bubble-shaped pattern. Also
known as diamond plate, this material is commonly used for outdoor steps.
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• Wrapped leather

Wrapped leather imitates leather and is commonly used for camera bodies,
chairs, and desk ground.

You can use the displacement settings to define a bump map based on bitmap
images. The direction of the light source determines the surface texture of the
rendering. Lighter areas are rendered as raised portions of the surface and
darker areas are rendered as depressions in the surface. A gradient render is
done between the light and dark areas.
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You can use texture mapping to define how a texture is wrapped onto the surface.

Light studios

A light studio is the top-level container for all lights used in a model. It provides
a fast and simple way to change the entire light scheme. You can change such
things as:

• Shadows

• Intensity

• Shadow type

Shadows can be soft or hard. Soft shadows are gradually diffused to create a
more realistic lighting effect. Hard shadows can be colored and are useful for
such effects as stained glass.

• Shadow resolution
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Each light in the light studio has its own set of attributes, such as light type and
color. These attributes are defined by a light shader.

You can quickly turn light sources on and off by setting or clearing the check box
displayed adjacent to each light in the Light Studio branch of the Session Entity
tree on the EdgeBar tool.

Lighting is very important to rendering because it gives a sense of depth to the scene
and highlights the shiny surfaces. Lighting supports the following shaders:

• Ambient light

• Point light

• Spot light

• Distant light

• Sun

• Sky

• More

These shaders contain options that affect the light. Some of the most common
options include color, intensity, and location.

Ambient light illuminates all surfaces regardless of orientation. This is useful for
illuminating the scene that is not illuminated by other light sources.

Point light emits light equally in all directions from a point specified by an X, Y, and
Z definition. This type of light is useful when lighting enclosed spaces or simulating
the effect of a light bulb.
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Spot light emits light from a single point and is contained by a cone. The starting
and ending positions of a light are specified by X, Y, and Z definitions. This type of
light is useful for focusing attention on the model or part of the model.

Distant light emits light parallel to a specific point as if is from a very distant source.
Solid Edge uses distant lights, which are used for general lighting.
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To learn how to use the lighting controls, see the Help topic, Edit Light Entity
Properties for Advanced Rendering.

Render mode

Advanced rendering provides rendering settings that allow you to control such
things as reflections and the amount of light that bounces between objects. Advanced
rendering does not inherit any rendering settings from the Assembly environment.
Any changes you make to the rendering settings in advanced rendering do not
change in Assembly.

Advanced rendering supports two classes of rendering:

• Photorealistic

• Artistic

Each render mode uses a shader to produce special effects and each shader includes
a variety of options. The available options differ depending on the shader you select.

Photorealistic rendering supports ray tracing to show reflections and refractions.
Photorealistic rendering supports such shader options as anti-aliasing, transparency,
and reflections.

• Ray tracing—plots a path of imaginary rays from the observer’s eye through each
pixel on the screen, back to the 3D environment. These rays are tracked as they
bounce from one object to another to the light source.

• Anti-aliasing—a method of displaying elements on a low resolution device to
make the object appear smoother. You can control the level of anti-aliasing. The
more anti-aliasing you apply, the smoother the display will be, but it will also
take longer to process.

You can choose from a variety of artistic rendering modes to make a 3D model look
as if it was hand-drawn, painted, a mosaic, among others.
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Scenery

Scenery allows you to enhance your renderings by adding such affects as tiled floors
or water.

Advanced rendering supports the following types of scenes.

• Circular bases

• Panoramas

• Rooms

• Square bases

• None
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Schemes

Schemes allow you to enhance your renderings by adding background images and
lighting settings listed below:

• 2D Schemes (HDR) with 2d backgrounds and lighting.

• 3D Schemes (HDR) with 360 backgrounds and lighting. The 3D schemes rotate
relative to the view.

Note

These 3D scenes are not displayed during real time rotations. The scene
will need to be rendered again to see the scene.

• Four levels of quality are provided. These are:

– High Quality HDR

– Medium Quality HDR

– Draft HDR

– Ambient Occlusion (AO)

• Schemes:

– Interior Schemes

– Exterior Schemes

– Studios

– 2D Abstract Backgrounds and Reflections

– 2D Exterior Back plates

– 2D Interior Back plates

Examples:
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Note

Digital background images can be substituted by editing the definition of a
scheme in the session entities tab of pathfinder.
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Perspective command

Applies perspective to (A) or removes perspective from (B) the view for the active
window.

You can quickly add or remove a perspective override using this command, but
cannot change the perspective angle with this command.
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Render Area command

Renders a fenced area.

Depending on the type of Solid Edge license you have, you may have advanced
rendering capabilities available to you in the Explode-Render-Animate application
in the Assembly environment. For example, if you have a Solid Edge Classic license,
advanced rendering is available. If you have a Foundation license, advanced
rendering is not available.
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Render Scene command

Renders the active window.

Depending on the type of Solid Edge license you have, you may have advanced
rendering capabilities available to you in the Explode-Render-Animate application
in the Assembly environment. For example, if you have a Solid Edge Classic license,
advanced rendering is available. If you have a Foundation licence, advanced
rendering is not available.
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Activity: Rendering

Activity objectives

You will be working in the context of an assembly named render.asm. In this activity
you will:

• Set parameters for changing backgrounds, foregrounds, light sources, and
perspectives to control the display of a Solid Edge assembly.

• Enter the assembly application Explode-Render-Animate and assign materials
and rendering properties to a Solid Edge assembly.
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• Edit parameters assigned from the predefined archive and better control the
image display of rendered scene.

• Generate presentation quality images of a Solid Edge assembly using the
rendering tools in the Explode-Render-Animate application.

Turn to appendix A for the Activity: Rendering an assembly.
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Activity: Rendering an assembly

Step 1

In the following steps, you will be working in the context of an assembly document
render.asm. Before entering the Explode-Render-Animate application, you will
assign properties to some parts and change some viewing parameters within
the Solid Edge Assembly environment. These settings will carry over into the
Explode-Render-Animate application and will be available there unless they are
overridden by another parameter in that application.

You will make the glass face clear by setting the face style.

▸ Open the assembly render.asm and activate all the parts in the assembly.
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▸ In PathFinder, right-click housing.asm, and then click Edit.

▸ In PathFinder, right-click glass.par, and then click Edit.

▸ On the ribbon, choose View tab®Style group®Part Painter.

▸ On the Part Painter command bar, set the Style to White (glass) and the Select
method to Any.

▸ In the graphics window, select the revolved protrusion to set the face style.

▸ On the command bar, click the Close button.

▸ On the ribbon, click the Close and Return button to return to housing.asm.

▸ On the ribbon, click the Close and Return button to return to render.asm.

Step 2

The numbers for the clock face have been created and stored in a TIFF format
image. You will now assign this image to the clock face as a texture. To do this,
you will create a new face style based on the properties of an existing face style.
You will then modify the face style by assigning the TIFF image as a texture and
then orienting it appropriately.

▸ In PathFinder, right-click SE_face.par, and then click Edit.

▸ On the ribbon, choose View tab®Show group®Hide Previous Level to turn
off the display of the assembly (if it is visible).

▸ Choose View tab®Style group®View Overrides .

▸ Set the Render mode to Smooth with VHL Overlay.

▸ Turn on Textures, then click OK.

▸ Choose View tab®Style group®Styles .
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▸ Set the Style type to Faces Styles.

▸ From the Styles list, select White (glass).

▸ Click New.

▸ In the Name field, type Clockface, but do not press Enter.

Note

When you press Enter, the new style Clockface is created and you return
to the Faces Style menu. To make further changes to the style Clockface,
you need to select Clockface, and then click Modify.

▸ Click the Texture tab.

▸ Browse for the texture file clockface.tif, and click Open.

▸ Click OK to close the New Faces Style dialog box, and then click Close to dismiss
the Style dialog box.

▸ On the ribbon, choose View tab®Style group®Part Painter .
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▸ Set the Style to Clockface and the Select method to Face.

▸ Select the front face of the clock, and then click the Close button on the command
bar.

Note

You will edit the style Clockface to correct the problems with the texture.

▸ Choose View tab®Style group®Styles .

▸ Select Faces Style.

▸ Select Clockface, and then click Modify.

▸ Click the Texture tab, and modify the Rotation angle to 270, such that the
orientation of the clock face is correct.
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▸ Click the Appearance tab. Set the values as shown. Click OK, and then click
Apply.

• Shininess: 0.25

• Reflectivity: 0.20

• Opacity: 1.0

Note

Create the face style in the template and it will be available for future
geometry created with that template.
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▸ Choose View tab®Show group®Hide Previous Level to display the
assembly again.
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▸ On the ribbon, click Close and Return to return to render.asm. Save the assembly.

Step 3

You will now enter the Explode-Render-Animate application and apply settings to
create your desired rendered images.

▸ Choose Tools tab®Environs group®ERA .

▸ Choose Home tab®Render group®Render Setup .

▸ In the Render Setup dialog box, select all of the Automatic Render Options and
Use Progressive Rendering, and then click OK.

▸ In PathFinder, click the Session Entities tab .

Note

The Session Entities tab in PathFinder contains rendering settings
and parameters that have been defined up to this point in time. These
parameters can be edited and the values modified. You will be adding
new values from the Predefined Archives. Values in Predefined Archives
cannot be changed, but once used, the entry in the Session Entities tab
can be renamed and modified.
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▸ In PathFinder, click the Predefined Archives tab .

Note

To use a setting in the Predefined Archives, you will drag the setting
into the rendered scene. To set geometry-specific settings, such as
material textures, you will drag the material onto the desired part. For
view-specific settings, such as backgrounds and lighting, you will drag the
setting anywhere into the rendered scene.

▸ Drag Backgrounds®Graduated®Green into the rendered scene.

Note

Because you set the rendering options to automatically render upon a
background change, the scene is automatically rendered. When this
parameter is turned off, you need to manually render the scene by clicking
the Scene command.

▸ To modify the parameter you just set, in PathFinder, click the Session Entities

tab .
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▸ In PathFinder, right-click Background, and then click Edit Definition.

▸ In the Background Editor, set the Bottom Color to be the color shown, and click
OK. Click OK to exit the Background Editor.

▸ In PathFinder, click the Predefined Archives tab.

▸ Drag Render Modes®Photorealistic®Photorealistic, high quality into the
rendered scene.
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▸ Drag Light Studios®High-Contrast®Left spot with back into the rendered
scene.
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▸ Now modify the parameter you just set. In PathFinder, click the Session Entities
tab.

▸ To see the effect of the left spot on the rendered scene, turn off the Left Spot, and
then click the Home tab®Render group®Scene command.
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▸ Turn on the Left Spot again, and then click the Scene command.

▸ Modify the Left Spot definition. Right-click Left Spot, and then click Edit
Definition.

▸ In the Light Editor dialog box, set the cone angle to 40o.

▸ Click the Placement tab. Click the Front View button, and drag the handles so
that the front looks approximately like the view below.
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▸ Now select the Top View button and drag the handles of the cone to the
approximate position shown.
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▸ Select the Right View button and drag the handles of the cone to the approximate
position shown. Check the top, front and right views. Changes made in one view
could move the viewing cone in another. It may take you several iterations to
achieve the desired results.
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▸ Click OK to exit the Light Editor dialog box, and return to the rendered scene.

▸ Add a new light source. In PathFinder, right-click Lighting Studio and click Add.

▸ Right-click New Spot Light, and then click Edit Definition.
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▸ On the Placement tab, set the viewing cone as shown for the top, front and right
buttons.
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▸ Click OK to exit the Light Editor dialog box and return to the rendered scene.
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Step 4

You will now create presentation quality images.

▸ On the view tab, in the style group, click the perspective command.

▸ On the view tab, in the style group, click the view overrides command.

▸ On the view overrides dialog box, set the perspective to Wide (35mm).

▸ In PathFinder, click the Predefined Archives tab.
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▸ Drag Scenery®3D backgrounds®Interior — Lobby into the rendered scene.

Note

The scene is now in the session entities. By editing the session entity, different
digital images can be substituted for the current images.

▸ In PathFinder, click the Predefined Archives tab .
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▸ Drag Materials®Wood®Mahogany®Polished mahogany onto the part case.par.
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▸ Drag Polished mahogany onto the part backplate.par.

▸ Now assign a different wood to the same two parts. Drag
Materials®Wood®Japanese Oak®Polished Japanese oak onto the
part case.par.
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▸ Drag Polished Japanese oak onto the part backplate.par.
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▸ Drag Materials®Glass®Clear (glass) onto the part glass.par.

▸ Now modify the parameters you just set. In PathFinder, click the Session
Entities tab.

▸ Modify the properties on Polished Japanese oak and reapply it to the parts.
Right-click the material Polished Japanese oak and click Edit Definition.

▸ Change the trunk direction to 0, 1, 0.

▸ Now modify the glass parameters to allow more light to pass through. On the
Sessions Entities tab, right-click the material Clear (Glass), and then click Edit
Definition.
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▸ In the Material Editor dialog box, click the Reflectance tab and set the
transmission factor to 1.30. Click OK to dismiss the dialog box.

Step 5

You will now replace the tread plate scene with textures created in the Draft
Environment. The textures are JPEG format images that have been assigned to
faces of parts in the same manner as the numbers you previously placed on the
clock. Since you know how to do this, there is no need to for you to do those steps. To
see the textures, you will turn off the tread plate and show the textured parts and
then render and save the final image.

▸ On the view tab, in the style group, click the perspective command. This turns
the perspective display off.

▸ In PathFinder, click the Predefined Archives tab .

▸ Drag Scenery®No Scenery into the rendered scene.

▸ The parts wall1.par, wall2.par and wall3.par are hidden. Find them in Assembly
PathFinder and show them.
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▸ Render the scene.

▸ Now save the rendered view as a presentation quality image. Click the
Application button and then choose Save As®Save As Image. Set the file
type to JPEG and then click the Options button. Set the alternate view style
to Presentation View Style. Set the resolution to 300 DPI. Set the units to
Pixels. Click OK and then save the file as Japanese Oak Clock.jpg in the folder
containing the documents for this activity.

Note

From the Predefined Archives, you have taken rendering parameters and
materials and applied them to a rendered scene. There are many combinations
and modifications that can be made to enhance the rendered scene that
were not covered. The workflow for using the predefined parameters and
then modifying them is the same as covered in this activity. You may want
to continue experimenting with the Predefined Archives by using other
backgrounds, environments, foregrounds, light studios, materials, render
modes and scenery not covered in this activity.
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▸ Click the Application button, and then click Save.

▸ Click Close ERA to exit the Explode-Render-Animate application.

▸ Save and close the assembly. This completes this activity.

Activity summary

In this activity you learned how to generate presentation quality images of a Solid
Edge assembly. In the activity, the following topics were covered:

• Creating and editing backgrounds for rendered scenes.

• Creating and editing light sources for rendered scenes.

• Assigning predefined material textures to parts within an assembly.

• Editing the material properties to give the desired result in the rendered scene.

• Placing and then editing predefined scenery to enhance the rendered scene.

• Saving presentation quality JPEG images once the desired rendering options
have been finalized.
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Lesson review

Answer the following questions:

1. What makes the session entities tab appear in pathfinder?

2. How do you apply a texture to a face?

3. What is the difference between the session entities tab and the predefined
archives tab?

4. How do you create a high quality rendered image?
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Answers

1. What makes the session entities tab appear in pathfinder?

In the ERA environment, the session entities tab appears after a scene is
rendered.

2. How do you apply a texture to a face?

Within the part or sheet metal file where the face exists, apply a face style that
contains a texture image. Textures must be turned on in the view format dialog
box.

3. What is the difference between the session entities tab and the predefined
archives tab?

Predefined archives contain settings for backgrounds, light sources, scenery and
so forth. They cannot be changed, however when a setting is used, it populates
the session entities tab in pathfinder. The settings can be edited as a session
entity.

4. How do you create a high quality rendered image?

Settings that contribute to high quality rendered images are:

• In the format view dialog box, set the anti-alias level to high.

• In the style group, set the sharpness to the highest setting.

• From the predefined archives, drag Render Mode>Photorealistic>High
quality into the scene

• When saving the image, click options and set the alternate view style to
be presentation view style.

Note

These parameters affect system performance.
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Lesson summary

In this lesson you learned how to generate presentation quality images of a Solid
Edge assembly. In the activity, the following topics were covered:

• Creating and editing backgrounds for rendered scenes.

• Creating and editing light sources for rendered scenes.

• Assigning predefined material textures to parts within an assembly.

• Editing the material properties to give the desired result in the rendered scene.

• Placing and then editing predefined scenery to enhance the rendered scene.

• Saving presentation quality JPEG images once the desired rendering options
have been finalized.
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Course Overview

Course overview

The Explode-Render-Animate application within the Solid Edge assembly
environment is a tool for creating different types of presentations of Solid Edge
assemblies. Exploding an assembly allows you to control the movement, sequence
and grouping of parts and subassemblies. Rendering a view allows you to define
textures, lighting, shadows, backgrounds and other properties to create presentation
style images. Motors apply movement to under constrained parts in an assembly
which can be animated. Using animation, you can combine previously created
exploding sequences and custom camera movement to create animation. Each frame
of the animation can be rendered to create presentation quality animations.

Once you complete the activities in this course, you will be able to:

• Add a motor to a unconstrained part of an assembly to create movement for
an animation.

• Manipulate animation events and explode events to create an animation of an
assembly.

16-2 Solid Edge assembly mt01416-s-1040



Animating assemblies

Defining motors

There are two types of motors that can be defined in Solid Edge: rotational and linear.

You use motor features to help you observe how a set of under-constrained parts
will move relative to the part you define as a motor. This allows you to design and
simulate complex mechanisms where the movement of a set of interrelated parts
needs to be simulated.
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Motor command

Defines a rotational or linear motor using an element on a selected part. You can
then use the Simulate Motor command to display a kinematic simulation of the
motion in an assembly.

You use motor features to help you observe how a set of under-constrained parts
will move relative to the part you define as a motor. This allows you to design and
simulate complex mechanisms where the movement of a set of interrelated parts
needs to be simulated.

This is useful when working with assemblies that contain moving parts such as
gears, pulleys, crankshafts, parts that travel in grooves or slots, and hydraulic or
pneumatic actuators. For example, you can specify that a crankshaft part (A) in a
mechanism rotates around an axis you specify (B).

You can then use the Motor Simulation command to playback a kinematic simulation
of how the under-constrained parts in the assembly move.

Press F5 to replay the animation.
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You can define properties for the motor, such as the type of motor, the motor rate or
speed, motor direction, and any limits you may want to place on the motor.

When you define a motor feature using the Motor command, an entry is added for
the motor feature to PathFinder. You can select the motor entry in PathFinder
to edit the motor feature later.

Types

You can define the following types of motors:

• Rotation

• Linear

Steps

The basic steps for defining a motor are:

• Specify the type of motor you want, Rotation or Linear.

• Select the part you want to act as a motor.

• Define the movement axis.

• Specify the motor rate and limits.

Specifying Motor Type
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The Motor Type list on the command bar allows you to define the type of motor
you want. You can specify whether you want the motor type to be Rotation or
Linear.

Selecting the Part

You can only select a part that is under-constrained, or has relationships
suppressed. The assembly should also be under-constrained such that the
mechanism is free to move in the proper axes.

Defining the Movement Axis

Depending on the motor type you specify, you can select faces, edges, or
cylindrical axes to define the motor axis. For example, to define a Rotary motor,
you can select cylindrical faces, cylindrical edges, or cylindrical axes.

Specifying the Motor Rate and Limits

The Motor Value and Limits options on the command bar allow you to specify the
speed or rate you want the motor operate at, and any limits on the travel you
want to impose. For example, you may want to specify that a rotational motor
rotates at 1750 revolutions per minute, and makes two complete revolutions
(720 degrees).

You can set the working units you want to use for the angular and linear
velocity of a motor using the Advanced Units button on the Units tab of the File
Properties dialog box, on the File menu.

Motor Definition and Simulation Guidelines

You can define as many motors as you want in an assembly. When you define
multiple motors in an assembly, use the Motor Group Properties dialog box, available
with the Simulate Motor command and the Animation Editor tool to specify which
motors you want to use, whether you want to detect collisions during the simulation,
and so forth.

When working with more than one motor, use the Animation Editor tool to specify
when the motors start time, duration time and stop time for each motor. This allows
you to design and simulate complex mechanisms where the timing and positioning of
the parts is critical to understanding the behavior of the mechanism.

Note

Only motors in the active assembly participate in a motor simulation. If you
want subassembly parts to move in response to a motor simulation, you
need to make the subassembly adjustable, using the Adjustable Assembly
command on the PathFinder shortcut menu.
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Simulate Motor command

Display a kinematic simulation of motion in an assembly. You use motor features to
define how a set of interrelated parts will move. This is useful when working with
assemblies that contain crankshafts, gears, pulleys, and hydraulic or pneumatic
actuators.

Press F5 to replay the animation.

When you click the Simulate Motor button, the Motor Group Properties dialog
box is displayed, so you can specify which motors you want to use, whether you
want to detect collisions during the simulation, and so forth. When you click OK,
the Animation Editor tool is displayed so you can run the simulation. To run the
simulation, click the Play button.

Note

The Simulate Motor command contains a subset of the Animation Editor
functionality. To access the full functionality of the Animation Editor tool, you
must use the Animation Editor command in the Explode-Render-Animate
application. To access the Explode-Render-Animate application, on the Tools
tab, click Explode-Render-Animate.
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Motor Group Properties dialog box

No Analysis
Allows you to move under-constrained parts and observe the results.

Detect Collisions
Allows you to detect collisions during motor animation.

Physical Motion
Allows you to simulate physical motion between parts. This option detects
contact between unconstrained surfaces and applies temporary constraints
between the contacting surfaces. This makes it possible to analyze motion in
mechanisms that contain gears and other forms of sliding contact.

Motor Duration
Specifies how the motor duration is defined.

Use Motor Limits as Duration if Defined
Specifies that the motor limits define the duration.

Default Motor Duration
Specifies the motor duration in seconds. You can type a value.

Available Motors
Lists the available motors. You can use the Add and Remove buttons to add
motors to and remove motors from the Motors in Animation list.

Add
Adds a motor to the Motors in Animation list.

Remove
Removes a motor from the Motors in Animation list.

Motors in Animation
Lists the motors that will be used in the animation.
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Activity: Motor

Activity objectives

In this activity, you assign a motor to a part in an assembly. The motor type is
rotational, and it is applied to a gear in a clock. The speed of the motor is defined so
that the second hand of the clock moves at the operating speed of 1 rpm. The gear
relationships are predefined, and by assigning the motor to the appropriate gear, you
can show motion through motor simulation. This motor simulation is used in a later
activity to create an animation of the clock.
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Activity: Creating a motor

Step 1
You will open an assembly, then inspect and change the rotation units for the
assembly and assign a motor to a part in the assembly. Once the motor is defined, a
motor simulation will be generated to be used later in an animation.

Note

A motor can only be assigned to a part that is under constrained in an
assembly. If the under constrained part used to define the motor exists in a
subassembly, then the subassembly will have to be made into an adjustable
assembly rather than a rigid assembly. By making a subassembly adjustable,
the relationships used to position the parts in the subassembly are promoted
into the higher level assembly and solved at that level.

You will set the Angular Velocity units to revolutions per minute.

▸ Open the assembly motor.asm with all the parts active.

▸ Click the Application button , and then choose Properties®File
Properties.

▸ Click the Units tab, and on the Units tab, click Advanced Units. Set the Angular
Velocity to rpm, and then click OK to dismiss the Advanced Units dialog box.
Click OK to return to the assembly.
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Step 2

Create the motor and define the motor parameters.

▸ In PathFinder, right-click the part G05_62.par and then click Show Only. Click
Fit to see the gear.

Note

As an option, to better understand how the predefined gear relationships
in this assembly, you can review the spreadsheet named clock_gears.xls,
which is located in the same folder as the assembly. This spreadsheet
shows the relationships and gear ratios used to create the clock
mechanism.

▸ Choose Home tab®Assemble group®Motor .

▸ Set the motor type to Rotation.

▸ Set the rotation rate in rpm by entering 1/60.
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▸ Select the gear as the under-constrained part.

▸ Select the interior cylindrical face to define the rotation axis.
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▸ The rotation is defined as counterclockwise as shown. You can change the
direction by clicking the Flip direction button.

▸ Click Finish to complete the motor definition.

Step 3

Once you have defined a motor, you can change a parameter by editing the motor.
Even though the motor is defined correctly, this step shows how you can edit it. You
will ensure that the direction of rotation for this motor is counter clockwise. If not,
you can reverse the rotation.

▸ On the ribbon, click the Select command and select Motor 1 in PathFinder.
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▸ The rotation is displayed. If the rotation is counter clockwise as shown, skip
the next step.

▸ To change the direction of rotation, click Edit Definition. Click the Flip Direction
button, then click Finish.

Step 4

Display the motor. For best visibility, all the parts of the assembly will be shown,
and then some will be hidden.

▸ Click the Select command and right-click motor.asm in PathFinder. Click Show
All.
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▸ Using the same procedure as in the previous step, hide m_housing.asm, and
then fit the assembly.
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Step 5

Create a motor simulation.

▸ Choose Home tab®Assemble group®Simulate Motor .

▸ In the Motor Group Properties dialog box, set the Motor Duration to 180 seconds
(3 minutes) and the other values as shown, and then click OK.

Note

If you need to change any of these values at a later time, right-click Motors
in the time line and then click Edit Definition. You can define multiple
motors in a simulation but for this activity, you define a single motor.
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▸ The controls for playing the animation are shown below.

▸ Click Play to start the animation.

▸ As the animation is playing, increase the Speed to 4x.

Note

Changing the speed to 4x is for animation display purposes only. The
motor is still spinning at the assigned rpm.

▸ Click the Stop button to halt the motor simulation.

▸ Click Go to Start, to reset the animation to the initial point.

▸ Set the Speed back to 1x.

▸ Click the Application button.

▸ Click Save. When prompted to save changes to the animation editor, click yes.

▸ In PathFinder, right-click motor.asm and click Show All.

▸ Save and close this assembly. This completes this activity.
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Activity summary

In this activity, you learned how to create and simulate a motor. The motor
animation created will be used later during the explode sequence. In the activity, the
following topics were covered:

• The speed and direction of a rotational motor was defined.

• Parameters used to define the motor were changed by an editing process.

• The motor simulation was created and run.

• Animation controls and time line were introduced.

• A motor time line was created to be used in exploding and an animation.
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Lesson review

Answer the following questions:

1. Name two types of motors.

2. How do you change the rotational units from degrees per second to revolutions
per minute?

3. Can a motor that exists in a subassembly be used to apply motion to
unconstrained parts in a higher level assembly? If so, explain how.

4. Once a motor is defined, how do you get it to drive unconstrained parts and
see the movement?

5. Can the movement created by a motor be seen during an animation, along with
explosion events?
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Answers

1. Name two types of motors.

The two types of motors are linear and rotational.

2. How do you change the rotational units from degrees per second to revolutions
per minute?

To change the rotational units from degrees per second to revolutions per minute,
click the advanced units button in file properties>units.

3. Can a motor that exists in a subassembly be used to apply motion to
unconstrained parts in a higher level assembly? If so, explain how.

A motor that exists in a subassembly can be used to apply motion to
unconstrained parts in a higher level assembly if the subassembly is defined as
an adjustable assembly.

4. Once a motor is defined, how do you get it to drive unconstrained parts and
see the movement?

The simulate motor command will show the movement created by a motor.

5. Can the movement created by a motor be seen during an animation, along with
explosion events?

The movement created by a motor can be seen during an animation, along with
explosion events.
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Lesson summary

In this lesson, you learned how to create and simulate a motor. The motor animation
created will be used later during the explode sequence. In the activity, the following
topics were covered:

• The speed and direction of a rotational motor was defined.

• Parameters used to define the motor were changed by an editing process.

• The motor simulation was created and run.

• Animation controls and time line were introduced.

• A motor time line was created to be used in exploding and an animation.
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Animating an assembly
Solid Edge enables you to easily create animated presentations of your assemblies.
Assembly animations can be useful for motion studies of mechanisms, visualizing
how parts are assembled into a completed assembly, and for vendor or customer
presentations.
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Animation Editor command

Displays the Animation Editor Tool so you can create, display, and edit animations of
an assembly.

You can define the following types of animation events:

• Camera

• Motor

• Explosion

• Appearance

• Motion Path

You can use the controls on the Animation Editor tool to play, stop, pause, and
rewind the animation in the graphic window.

You can also save an assembly animation in AVI format with the Save As Movie
button on the Animation Editor tool.

Note

When you are working in Solid Edge Embedded Client, AVI files are saved to
unmanaged locations.

For more detailed information on creating assembly animations, see the Creating
Assembly Animations Help topic.
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Animation Editor Tool

Animation List
Lists the existing animations. You can select an animation entry from the list for
playback and editing purposes.

New Animation
Displays the Animation Properties dialog box so you can define the properties
for a new animation.

Save Animation
Saves the current animation.

Delete Animation
Deletes the current animation.

Animation Properties
Displays the Animation Properties dialog box so you can edit the properties for
an existing animation.

Save as Movie
Displays the Save as Movie dialog box so you can save the current animation
as an AVI file.

Camera Path
Displays the Camera Path Wizard so you define the camera path you want.

Display Camera Path
Displays the camera path as a curve in the graphic window. This can be useful in
visualizing the path the camera will take during the animation.

Animation Events List (Left Pane)
Lists the event types available in the current animation. Depending on the
current animation, you can define events or select existing events for the
camera, motor, explosion, appearance, and path you want to use for the current
animation. You can expand, collapse, and select items in the list. Shortcut menu
commands are available that allow you to define the event you want to use for
the animation, delete the current event, and so forth.

Speed
Specifies the speed you want to use for playback purposes. The speed setting
does not affect the speed of an AVI recording, or the relative speed of the
animation entries.

Go to Start
Moves the current frame indicator to the start of the animation.

Previous Frame
Moves the indicator to the previous frame.
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Play/Pause
Plays or pauses the current animation.

Stop
Stops the playback of the animation.

Next Frame
Moves the indicator to the next frame.

Go To End
Moves the current frame indicator to the end of the animation.

Time
Displays the current time in the animation.

Frame
Displays the current frame in the animation.

Toggle Scale
Toggles the timeline scale between frames and seconds.

Zoom Out
Reduces the scale of the animation timeline.

Zoom In
Increases the scale of the animation timeline.

Minimize
Minimizes the Animation Editor.

Motion Path
Displays the Motion Path command bar so you can select components and draw
a curve path to guide component movement.

Appearance
Displays the Appearance command bar so you can create an appearance event.
For example, you may want a part to fade in or fade out in your animation.

Event Timeline and Duration List (Right Pane)
Displays event duration bars, which represent the start and stop times, and
elapsed time for each event in the current animation timeline. You can edit event
duration bars by dragging with the cursor or using shortcut menu commands.
This allows you to customize the animation.
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Basic user-interface elements in the right pane include:

(A) Frame Scale. You can use the Toggle Scale button to change the scale display
between Frames and Seconds.

(B) Current Frame Indicator. The current frame is the frame which is displayed
in the graphic window. You can use the cursor to drag the Current Frame
Indicator to another location to view individual frames in the animation.

(C) Event Duration Bars. Notice that a different color is used at the start and
end locations.

(D) Selected Event Duration Bar. Notice that a scale is displayed when a
duration bar is selected. This can make it easier to precisely relocate a duration
bar with respect to Frame Scale.

(E) Event Duration Bar Key Frame Indicator.

(F) Vertical Scroll Bar. Allows you to scroll the timeline up and down.

(G) Horizontal Scroll Bar. Allows you to scroll the timeline left and right.

Shortcut Menu Commands

The following shortcut menu commands are available. The shortcut menu commands
are context-sensitive. In other words, the commands which are available change
based on what is selected.

Left Pane Shortcut Menu Commands
Delete
Deletes the selected event.

Rename
Renames the selected event.
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Edit Definition
Allows you to define a new event or edit an existing event. The action you
can perform depends on the event type and whether you are defining a new
event or editing an existing event.

Camera
The Edit Definition command displays the Camera Path Wizard when
you click the Camera category entry, and displays the Path command bar
when you select an existing camera event.

Motor
The Edit Definition command displays the Motor Group Properties
dialog box when you select the Motor category entry.

Explosion
The Edit Definition command displays the Explosion Properties dialog
box when you select the Explosion category entry.

Appearance
The Edit Definition command displays the Appearance command bar
when you select an existing Appearance event.

Paths
The Edit Definition command displays the Path command bar when
you select an existing Path event.

Expand All
Expands all the event collections.

Right Pane Shortcut Menu Commands
Cut
Cuts the selected event from the animation and places it on the Clipboard.

Copy
Copies the selected event from the animation and places it on the Clipboard.

Paste
Pastes an event onto the animation timeline.

Delete Duration
Deletes the selected event duration.

Insert Key Frame
Inserts a keyframe at the current cursor position. This option is available
when the cursor is over a camera or motion path event duration bar.

Delete Key Frame
Deletes a keyframe at the current cursor position. This option is available
when the cursor is over a camera or motion path event duration bar.

Insert Camera Location
Inserts a camera location at the current cursor position. This option is
available when the cursor is over a camera event duration bar.
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Add Frames
Displays the Add Frames dialog box so you can add frames or time to an
animation event.

Remove Frames
Displays the Remove Frames dialog box so you can remove frames or time to
an animation event.

Properties
Displays the Duration Properties dialog box so you can redefine the start
time, end time, or elapsed time for an animation event.
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event duration bar

A user-interface element on the timeline (right) pane of the Animation Editor tool.

Event duration bars allow you to visualize and control the timing of events in an
assembly animation.

Event duration bars represent the start time, elapsed time, and end time for an
animation event. There are two basic types of event duration bars:

• Duration bars for explode, appearance, and motor events.

• Duration bars for camera and motion path events. Duration bars for these
event types also support key frames (A).

You can move and modify duration bars using the cursor and shortcut menu
commands.
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Camera Path Wizard command

Runs the Camera Path Wizard, which guides you through the process of creating
a camera path for an assembly animation. The Camera Path Wizard allows you
define the camera path name, camera direction, and so forth. You can use camera
paths as part of an assembly animation.
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Animation Properties dialog box

Animation Name
Displays the name of the animation.

Frames Per Second
Specifies how many frames per second are used to build your animation. You can
specify a standard frame rate, such as NTSC or PAL, or a custom frame rate.

NTSC
Specifies that the NTSC standard frame rate is used to build the animation.

PAL
Specifies that the PAL standard frame rate is used to build the animation.

Custom
Allows you to define a custom frame rate. Type the number of frames per second
you want.

Animation Length
Specifies the duration of the animation in seconds.
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Duration Properties dialog box

Start Frame
Lists the current start frame. You can type a new value to change the starting
time for the event duration.

End Frame
Lists the current end frame. You can type a new value to change the ending
time for the event duration.

Entry Duration
Lists the current duration of the event entry. When you change this value, the
End Frame value also updates.
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Path command bar (Animation Editor Tool)

This command bar is displayed when you are creating or editing Motion Path or
Camera Path events.

Select Parts Step
Specifies the parts you want to follow the motion path. Select the parts you want
in the graphic window. This step is only available when creating or editing a
motion path.

Draw Path Step
Draws a path to guide component or camera motion. You can draw a curve that
defines the path in the graphic window.

Finish/Cancel
This button changes function as you move through the motion path definition
process. The Finish button applies the motion path properties you defined. The
Cancel button discards any input and exits the command.

Select Parts Step Options
Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.

Draw Path Step Options
Activate Part
Activates the selected part.

Keypoints
Sets the type of keypoint you can select to define the motion path curve. The
available keypoint options may be different than displayed below.

Allows you to select any keypoint.

Allows you to select an end point.

Allows you to select a midpoint.

Allows you to select the center point of a circle or arc.

Allows you to select a tangency point on an analytic curved face such
as a cylinder, sphere, torus, or cone.
Allows you to select a silhouette point.

Allows you to select an edit point on a curve.

Open Path
Sets the path curve type to open.
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Closed
Sets the path curve type to closed. The start and end points of a closed
path curve are coincident. If the start and end points you selected are not
coincident, and you set the Closed option, a keypoint that is coincident with
the start point is automatically added to the curve.

When you set this option, the Start and End options are automatically set
to Periodic. Periodic curves are closed, connected, and tangent at the first
and last points on the curve.

Frame Count
Specifies the total frame count for the path.

Straight Path
Creates the path with straight segments.

Blend Path
Creates the path with curved or blended segments.

Hold
Holds the component position until the next key frame.

Deselect (x)
Clears the selection.

Accept (check mark)
Accepts the selection.
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Activity: Animating an assembly

Activity objectives

In this activity, you will use the animation portion of the Explode-Render-Animate
application to produce a presentation quality animation. The animation will be
created and then different effects will be used to edit the animation and give the
desired results. The animation time line you create will consist of a motor driving
under-constrained parts, explosion events, camera events, and appearance events.
The end result will be an .avi movie.
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Activity: Animating an assembly

Step 1

In this activity you will open an assembly that contains a motor and an exploded
configuration. You will use the Animation Editor to manipulate the events that
occur during the animation. You will create an animation that consists of camera
movement, changes in part appearance, part motion paths, exploded views and
motion from motors.

You will define a camera path for a predefined animation.

Note

The description of the animation controls is also covered in the activity
exploding an assembly.

▸ Open the assembly animate.asm with all the parts active.

▸ Choose Tools tab®Environs group®ERA .

▸ Choose Home tab®Animation group®Animation Editor .

▸ Examine the Animation Editor.

The right pane is the time line for each of the animation events. A motor was
defined previously in this assembly. Controls for playing the animation are
displayed.

The left pane displays the animation events, and the right pane displays the
event duration bars. These can be used to define and sequence the events of
the animation.
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▸ Click Animation Properties.

▸ Set the values as shown, and then click OK.

▸ Right-click the Explosion event and then click Edit Definition. Examine the
parameters previously defined for this explosion. Click OK when finished.
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▸ Click the Camera Path command to open the Camera Path Wizard.

▸ Set the values as shown, and then click Next.

▸ Click Preview. Observe the animation preview, and then click Finish. The
camera path is created.
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Step 2

You will view the camera path and then edit the path.

▸ Click the Show Camera Path command. The path is displayed.

▸ Right-click the Camera Path in the event time line, and then click Edit Definition.

mt01416-s-1040 Solid Edge assembly 16-39



Lesson 16 Animating assemblies

▸ On the command bar, click the Draw Path Step group button and observe the
controls.

▸ The camera path can be either open or closed. For this path click Closed.

▸ The key points of the camera path are graphically displayed as points on the
curve. The X-Y-Z axis displays at the location of the key point which is currently
being edited and a preview of what the camera sees at that frame is shown. The
frame count showing the duration of the camera movement is displayed.
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▸ Camera movement and direction can be edited at each key point. The blue
navigation arrows move to the next or previous point for making changes to
those points. Click the Next Point button, which is the right blue arrow.

Notice the camera preview and X-Y-Z axis move to the next point.
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▸ Click the Straight Path button. This changes the curvature of the previous
point from a curve to a straight path.
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▸ Click the Next Point button twice to move the camera.

▸ Click Hold. This freezes the animation until the next key frame is reached in
the time line.
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▸ Click the Next Point button once. Drag the tangency control handle of the key
point.

▸ Drag the handle so that the curve is approximately positioned as shown.
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▸ Click Next Point. Select the X axis of the triad and enter a rotation angle of 5o.

▸ Select the origin of the triad. The curvature tangency handles are available
at the key point.
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▸ Drag one of the handles so that the curve is approximately modified as shown.

▸ Click Finish. Play the animation and observe how the edits to the camera
path affected the animation. After the animation plays, reset the animation by
stopping the animation and then clicking the Go to Start button.

▸ On the camera path event bar, notice the key points are displayed as green
graduation marks. Click and drag any of the key points to a different position.
This changes the time at which a key point occurs, and increases the speed of the
transition from that key point to the key point in the direction you moved the
point. Likewise, the duration of the transition of the camera path is increased
from the key point moved and the point you moved away from.

▸ Play the animation and observe how the edits to the camera path affected the
animation. After the animation plays, reset the animation by stopping the
animation and then clicking the Go to Start command.

Step 3

Add an appearance event to the time line.

▸ Click the Appearance command .
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▸ Select a_case.par and a_backplate.par as the parts for the appearance change,
and then click Accept.

▸ Set the Start style to Use Part Style and the Finish style to Chrome. Set the
Frames duration to 50, and then click Accept. Click Finish.

▸ Find the appearance and play the animation from the beginning through the
first 50 frames. Observe the change to chrome for the parts selected.

▸ Play the animation and observe how the selected parts transition to chrome.
After the animation plays, reset the animation by stopping the animation and
then clicking the Go to Start command.

Step 4

Edit the event bars along the time line.

Note

An event group consists of events occurring either simultaneously or
sequentially. The duration of an event group is defined by the extent of all
the events within that group. Actions such as mirroring and copying of events
must incorporate all the events making up a group.

▸ Right-click the Appearance_1 event bar, and then click Properties. Examine
the values, and then click OK.

Note

The values can be edited in the Duration Properties dialog box if desired.

▸ Click and drag the right side of the Appearance_1 event bar to frame 100.
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▸ Right-click the Appearance_1 event bar, and then click Properties as you did
previously. Notice the changed values.

▸ Right-click the Appearance_1 event bar and choose Copy.

▸ Right-click on the time line after the Appearance_1 event and choose Mirror.
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▸ Observe the new event bar on the Appearance_1 event.

Note

Copying and mirroring an event reverses the effect caused by that event.
By copying and mirroring the appearance event, as the animation plays,
the selected parts transition into chrome and return to their original part
styles. Mirroring is also valid for explosion events. Mirrored event bars
can be moved, or shortened to make the transition happen faster, or
lengthened to make the event happen slower.

▸ Play the animation to observe the changes you made. After stopping the
animation, click Go to Start to reset the animation.

▸ Click Save Animation to save your edits.

Step 5

In the following steps, you will use what you learned in the previous steps to
continue editing the animation. You will not be directed to edit specific events,
however you will edit events you choose based on the general directions given.

▸ Lengthen an explode event by dragging the end of the event bar for that event.

▸ Copy and mirror the explosion event.

▸ Reposition an explosion event that has a sequence of cascading events. Shorten
some of the events and lengthen others.

▸ Generate a new camera path based on saved views.

Step 6

Save an animation.

Note

Animations are saved as .avi formatted movies. There are many different
players available from many different sources. A video codec is a device or
software that enables video compression and or decompression for digital
video. The list of codecs that are available to be used for creating an animation
may differ from one computer to the next. To choose the codec which best
works for the animations you are trying to create needs to be determined
by experimentation.

▸ Animation views can be generated from previously generated 3D view styles. To
see the current 3D view styles available, choose View tab®Style group®Styles

.
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▸ Set the Style type to 3D View Styles.

Note

Existing 3D view styles can be modified or new 3D view styles can be
created to suit your needs.

▸ Click Apply to close the Style dialog box.

▸ Reopen the Animation Editor in Explode-Render-Animate.

▸ Reset the animation to the beginning. Click the Save as Movie command

.
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▸ In the Save As Movie dialog box, click Options.
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▸ Examine the options for creating an animation.

Note

Creating an animation can take considerable system resources depending
on the options chosen. It is good practice to run a small number of frames
rather than the complete animation to preview the results. Once the
settings are satisfactory, then you can run the complete animation.

Notice the view style selection set is the same as the 3D view styles shown in
the previous steps.

Set the quality to 100, and click OK.

▸ Save an animation to a folder of your choice and give it a name of your choice.

Note

To create a rendered animation, render the view just prior to saving the
animation and the animation will use the rendering settings. Rendered
animations typically take more processing time to create.
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▸ To exit the Animation Editor, click the Animation Editor command .

▸ This completes the activity. Click Close ERA to exit the Explode-Render-Animate
application. Save the assembly.

Note

To create a rendered animation, render the view just prior to saving the
animation and the animation will use the rendering settings. Rendered
animations typically take more processing time to create.

This completes this activity. Save and exit the assembly.

Activity summary

In this activity, you learned how to create and edit an animation. The animation
consisted of events defined by exploded views, camera movement, appearance
events, and rendering. Using editing commands, the time line for each event was
able to be edited to produce the desired effect. You created an .avi movie showing
the animation.
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Lesson review

Answer the following questions:

1. How is a camera path represented in an animation?

2. How is an appearance event used in an animation?

3. The frame scale can be displayed in what two types of units?

4. Can explosion or appearance event duration bars be copied and mirrored?

5. What are the different types of event duration bars that appear in the animation
editor time line?

6. What command creates an .avi movie file?
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Answers

1. How is a camera path represented in an animation?

A camera path is represented as a curve. Key points along the curve can be
edited to change camera viewing angle and view previews of the camera display
for that point in the time line.

2. How is an appearance event used in an animation?

Use appearance events to change part colors and visibility during an animation.
For example, you can create fade in and fade out effects for parts in the
animation.

3. The frame scale can be displayed in what two types of units?

The frame scale can be represented in frames or seconds.

4. Can explosion or appearance event duration bars be copied and mirrored?

Explosion and appearance event duration bars can be copied and mirrored.

5. What are the different types of event duration bars that appear in the animation
editor time line?

Types of duration bars are:

• Explode events

• Paths

• Appearance

• Motors

• Camera

• What command creates an .avi movie file?

The save as movie command creates an .avi movie file.
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Lesson summary

In this lesson, you learned how to create and edit an animation. The animation
consisted of events defined by exploded views, camera movement, appearance
events, and rendering. Using editing commands, the time line for each event was
able to be edited to produce the desired effect. You created an .avi movie showing
the animation.
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Introduction
Welcome to self paced training for Solid Edge. This course is designed to educate you
in the use of Solid Edge. The course is self-paced and contains instruction followed
by activities.

Solid Edge self-paced courses

• spse01510—Sketching

• spse01515—Constructing base features

• spse01520—Moving and rotating faces

• spse01525—Working with face relationships

• spse01530—Constructing treatment features

• spse01535—Constructing procedural features

• spse01536—Modeling synchronous and ordered features

• spse01540—Modeling assemblies

• spse01545—Creating detailed drawings

• spse01546—Sheet metal design

• spse01550—Practicing your skills with projects

• spse01560—Modeling a Part Using Surfaces

• spse01610—Solid Edge frame design

• spse01640—Assembly patterning

• spse01645—Assembly systems libraries

• spse01650—Working with large assemblies

• spse01655—Revising assemblies

• spse01660—Assembly reports

• spse01665—Replacing parts in an assembly

• spse01670—Designing in the context of an assembly

• spse01675—Assembly features

• spse01680—Inspecting assemblies

• spse01685—Alternate assemblies

• spse01686—Adjustable parts and assemblies
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• spse01690—Virtual components in assemblies

• spse01691—Exploding assemblies

• spse01692—Rendering assemblies

• spse01693—Animating assemblies

• spse01695—XpresRoute (tubing)

• spse01696—Creating a Wire Harness with Harness Design

• spse01424—Working with Solid Edge Embedded Client

Start with the tutorials

Self-paced training begins where tutorials end. Tutorials are the quickest way for
you to become familiar with the basics of using Solid Edge. If you do not have any
experience with Solid Edge, please start by working through the tutorials for basic
part modeling and editing before starting this self-paced training.
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Tube design workflow

Tube design overview

You can use XpresRoute to create path segments and tubes in an assembly. To access
the commands for tubing, while in Assembly, choose Tools®Environs®XpresRoute .

Tube parts are designed in the context of an assembly, so you can directly model
them within an assembly, using existing part and assembly geometry to ensure
accurate fit and function. Tube parts are fully associative and update with the parts
to which they are connected. Tube wire parts are directed parts. They conform to
the path segment and the options you use to construct the part. When you make
changes to the assembly that cause the path to change, the part will also change.

Tube design workflow

1. Create a path

Use the PathXpres command to automatically create a 3D path for the tube.

To learn how, see Create a tube path with PathXpres.

Use the Line Segment or Arc Segment command to manually draw the path
for the tube.

To learn how, see Create a tube path.

2. Create the tube

Use the Tube command to assign pipe attributes and fittings to a path segment
that defines the route the pipe should follow.

To learn how, see Create a tube.
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Creating path segments

Tubes and Pipes are created along a path segment. You can use the PathXpres
command in XpresRoute to create the path without manually drawing the individual
lines of the path or you can use the Line Segment command or Arc Segment
command to manually draw the path.

Note

In addition to drawing the path segment, you can use the sketch geometry of
an assembly layout to define the path.

Creating the path with PathXpres

Use the PathXpres command to create a 3D path for a tube or pipe without having
to manually draw the individual lines of the path. PathXpres generates a path
between two points that is orthogonal to the default reference planes. These points
must be circular or elliptical element, the endpoint of a segment, or the endpoint of
a sketch element.

In cases where more than one way for the path exists, you can use the Next and
Previous button on the PathXpres command bar to display alternative paths. The
order of the paths goes from the simplest path, with the least number of segments, to
the most complex path. The maximum number of segments in a path that PathXpres
generates is five.

Drawing a Path Manually

You can use the Line Segment command , Arc Segment command , or Path command
in XpresRoute to manually draw the path for the tube or pipe. You can connect arc
segments to line segments or other arc segments.
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Note

The part must be activated before you can attach a line segment to the part.
If the part is not active, you can use the Activate Part button on the Line
Segment command bar to activate the part.

OrientXpres

You use the OrientXpres tool to assist you in drawing lines and arcs in 3D
space when drawing a path manually. As you draw the line or arc segments, use
OrientXpres to lock the orientation of the element parallel to an axis or plane as you
draw it. For example, after you define the start point for a line segment, you can
use OrientXpres to lock the orientation to the y axis.

When you click to define the second point for the line, you can then use OrientXpres
to lock the orientation to the z axis.
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You can continue to lock the axis or plane to assist you in defining the path (A),
(B), (C).

If you make an error when you draw a path segment, you can click the Undo button
to undo the unwanted action. You can then continue drawing the path segment.

If you mistakenly undo the wrong action, you can click the Redo button to restore
the action.

Creating paths with assembly layouts

In addition to drawing the path, you can use sketch geometry that exists in an
assembly layout as input for the path segment.
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Applying relationships and dimensions to path segments

As you add segments to the tube path, relationship handles are displayed on the
segments (A) to indicate the relationships that you are creating. You can display or
hide the relationship handles with the Relationship Handles command.

There are four types of geometric relationships for tube parts:

• Connect relationships

• Coaxial relationships

• Parallel relationships

• Tangent relationship

The PathFinder tab displays the tube path segment relationships.

You can delete any relationship by deleting its handle in the graphic window or
deleting the relationship in PathFinder.

Notice the dashed line separating cylinder4.par and tube1.par. This dashed line
indicates that parts below the line are directed parts.
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Creating linear dimensions on paths

You can use the Axis Dimension command to create a dimension along a principal
axis between a path segment and a reference element. The reference element can be
another path segment, a principal plane, or a part edge.

Creating angular dimensions on paths

You can use the Angle command to place a dimension that measures the angle
between two endpoint-connected tube path segments.
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Dimensioning path segments

You can use the SmartDimension command to dimension the length of a linear path
segment or the radius of an arc path segment.
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Modifying path segments

You can modify path segments by:

• Moving the path segment

• Splitting the path segment

• Creating a 3D curve from the path segment

Moving path segments

You can use the Move Segment command to move a path segment along the plane
to which it is attached. With the command, you simply click the segment you want
to move, drag it to a new position, then release the mouse button. This command
maintains any existing relationships on the path segment and any of the adjacent
tube segments.

Suppose you place a dimension on a segment and later decide you want to change
the dimension value. All you have to do is click the dimension you want to change,
and type the new value in the Dimension Value on the XpresRoute command bar.

Splitting path segments

You can use the Split Segment command to split a path segment into two separate
segments. With the command, you click the segment at the point you want to split.

Relationships and split segments

When you use the Split Segment command, the relationships on the split segment
are maintained on the new segment. In addition, a connect relationship is applied
to the split point of the new segments. The following cases describe how the Split
Segment command works with relationships.

Segment coaxial relationship with a port

When you split a segment that is coaxially aligned with a port, the new segment
attached to the port retains the coaxial relationship. The segment that is not
directly attached to the port has no additional relationships other than the
connect relationships.
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Segment with an axis dimension

When you split a segment containing an axis dimension relationship, the original
axis dimension is maintained between the endpoints of the segment.

Segment with a planar relationship

When you split a segment containing a planar relationship, both new segments
retain the planar relationship.

Segment with a parallel relationship

When you split a segment containing a parallel relationship, the new segment
maintains the parallel relationship.

Creating curve segments

You can use the Curve Segment command to create a 3D curve based on a set of
endpoint-connected path segments. The curve is always tangent to the first and last
segments in the select set and it passes through the first and last points of the path.
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There is an option on the Curve Segment command bar that allows you to define the
points for the curve. You can specify that the curve pass through the

• midpoints of the line segments,

• the endpoints of the line segments,

• or all points of the input segments.

Note

You can use the Hide Input Path and Show Input Path commands on the
shortcut menu to control the display on the path used to create the curve
segment.
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Creating the tube

Once you have drawn a tube path, use the Tube command to create a tube along
the path segment. With the Tube command you can select a single segment or a
chain of segments as the tube path. You can also define tube extents to both ends
of the tube path.

When creating a tube part, you can use the Tube Options dialog box to define
parameters such as material, outside diameter, bend radius, and wall thickness for
the part. To access the Tube Options dialog box, click the Tube Options button on
the Tube command bar.

Defining the tube material

You can use the Material option on the Tube Options dialog box to specify the
material for the tube part. The list of materials is populated from the Material table.

Note

Prior to ST4, specifying the material simply applied an assembly-level style
override to the tube part and did not apply physical properties such as density.

If a material is specified in the template you use to create the tube, it is the default
material for the tube. If no material exists in the template, the default material is
the material used when the last tube was created. If there was no last used material,
the default material is Copper, if Copper exists in the Material Table. If Copper does
not exist in the Material table, the default material is None.

Note

If you click OK on the Tube Options dialog box with Material set to None, a
warning dialog box indicates that the tube file has no density, which causes
the physical property calculations for the assembly to be inaccurate. To correct
the problem, you can select a material with a defined density or you can leave
the material without a defined density.

Editing the tube material

You can edit the tube material:

• With the Material Table command while in the tube part file.
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• With the Tube Options dialog box while editing the tube definition in XpresRoute.

• With the Tube Properties command while editing the tube definition in
XpresRoute.

Defining end treatments

You can use the End Treatment Options dialog box to apply treatment types to
the end of the tube.

The list of available end treatments include: None, Expand, Reduce, Close, and
Flange. To display the End Treatment Options dialog box, on the Tube command
bar, click the End Treatment Options button. You cannot apply end treatment to
a curve segment.
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Opening and editing tube parts

The Edit Definition button on the Select Tool command bar displays the XpresRoute
command bar so you can edit the tube part. You can use the Tube Options dialog
box to make changes to such parameters as the material, bend radius, and wall
thickness. You can also make changes to path segments and edit the extents for the
ends of the tube.

The Open command on the shortcut menu activates the tube part in the Part
environment so you can add features to the tube To save your changes, you can use
the Close command to change the part and return to the XpresRoute environment.
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Managing path display

When working with tube parts, it is often useful to manage the path display. Solid
Edge makes it easy to hide and display the part paths so you can work more
efficiently. To hide a tube path, right-click the tube part containing the path and
click Hide Path on the shortcut menu.

To display a hidden path, right-click the part containing the path and click Show
Path on the shortcut menu.

Displaying tube center lines

When you place tube parts in a draft document, you can display the tube center lines
in the drawing view. To display the center lines, on the Annotation tab of the View
Properties dialog box, select Show Centerlines.
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Generating tube information

You can use tube properties to extract information to create such reports as bend
tables, tube reports, and parts lists.

Outputting bend information

You can use the Bend Table command to create an ASCII text file that contains
information about how to manufacture the tube. You can output the tubes as a select
set or output them all at once. The information consists of columns of data such as
feed length, rotation angle, bend radius, and bend angle.

Creating tube reports and parts list

You can include tube properties defined on the Tube Options dialog box in reports
or parts lists. When you create a tube file, these tube properties are automatically
stored in the tube file and are exposed so that they can be included in reports and
parts lists.

For tube parts created in version 12 and earlier, the tube properties are
added to the tube file when the tube is recomputed. You can use the
WriteTubeFilePropertiesForReportsAndPartsList method on the Tube object in
a Visual Basic program to automatically populate the tube files with the tube
properties.
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Transferring tubes to another assembly

You can use the Transfer command to transfer a tube to a new or existing assembly.
When you transfer a tube, the system copies the path for the tube into the target
assembly and creates an associative link between the tube and the copied path. The
path in the target assembly is not associative to the path in the source assembly, so
you can edit the new path without affecting the path in the source assembly.

All of the parameters of the tube are copied to the new assembly.

Any relationships applied to the path segments in the source assembly are
reestablished in the target assembly. If the part that contains the port remains
below the target assembly, the relationships are reestablished. If the part that
contains the port is transferred to an assembly that is not below the target assembly
no warning is displayed and the associativity of the port is broken. You can use the
Hide Previous Level command to make sure the part containing the port is below the
target assembly. To do this, in-place activate into a subassembly and select the Hide
Previous Level command. If you can see the part in the graphics window, it is at the
current level or below in the tree structure. If the part disappears when you select
the Hide Previous Level command, the part is above the active assembly level. If
you want to move the tube down the tree structure, make sure that the port part
will remain at or below the target level. If the target assembly is below the current
level of the port part, you should transfer the port part to the level of the target
assembly before transferring the tube.

If the tube being transferred refers to sketch elements, a new sketch is created in
the target assembly. The sketch will contain only the 2D elements referenced by the
tube being transferred.
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OrientXpres tool
The OrientXpres tool is an interactive design aid for drawing lines, arcs, and curves
in 3D space, and for editing the position of BlueDots in 3D space. OrientXpres
appears automatically when creating or editing elements which require its
capabilities. For example, OrientXpres appears when drawing line segments in
the XpresRoute and Frame applications, and when editing BlueDots in the Part
and Sheet Metal environments.

Note

BlueDots are only available in the ordered modeling environment.

When working in 3D space, you often need to restrict the placement or movement of
elements to be parallel to a particular axis or plane. The OrientXpres tool provides
that capability. You can do the following using OrientXpres:

• To restrict movement parallel to an axis, select one of the three axes (X, Y, or Z).
You can also cycle through the axes by typing Z key on the keyboard.

• To restrict movement parallel to a plane, select one of the three planes (XY, YZ,
or XZ). You can also cycle through the planes by typing X key on the keyboard.
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• To move the OrientXpres tool to a more convenient location, select the origin,
and drag it to a new location.

• You can press C to clear any locks to planes or axes.
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Activity: Placing tubes in assembly with XpresRoute
Activity guides you through the process of using XpresRoute, and OrientXpres to
route tubing components in an assembly, and then create a bend table of the tubes.
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Activity: Placing tubes in assembly with XpresRoute

Overview

When you complete this activity, you will be able to:

• Add tubes to the design using PathXpres.

• Add tubes by manually creating tube paths.

• Add end treatments to tubes.

• Modify tube paths and update the tube part.

• Edit the tube part after the tube is created.

• Output a Bend Table of the tube parts for manufacturing.
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Use PathXpres to automatically route the first tube path

▸ Open Xpres.asm with all the parts active.

▸ Click the Tools tab. In the Evirons group, click XpresRoute.

▸ Click the Application button. Click Solid Edge Options, and then click the Tube
Properties tab. Set the tube properties values as shown, and click OK.

▸ Click the PathXpres command.
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▸ For the first port, on the part wall.psm, click the front edge of the far right hole.

Note

The front edge is selected so the tube will extend toward the front of the
assembly. If you select the rear edge of the hole, the tube path tries to
project toward the rear of the assembly.
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▸ For the second port, select the rear inlet on the blue part reg1.par as shown.
After you click the rear port, the tube path should highlight.
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▸ Accept the tube path by clicking Finish. The tube path changes to the profile
color and displays the relationships applied along the path.
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Place the tube on the tube path

▸ On the Home tab, in the Tubing group, click the Tube button. If the Tube
Options dialog is not displayed automatically, click the Tube Options button.

Note

The Tube Options dialog box should display as shown. Check the
values against the values in the image below and make any necessary
adjustments.

▸ To select the folder where the part file for this tube will be stored, click the
browse button and select the folder location where the activity files are located.

▸ On the dialog box, clear the show this dialog when the command begins option.
To see this box in the future, click the tube options button on the command bar.

▸ Type tube001 as the new file name and click OK.

▸ Select the tube path just created.

▸ In the Name box, tube001 is displayed. Click the Accept button to accept the
path.
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▸ The result should look like the following illustration.

▸ To accept this result, click Finish.
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Create a new path and a new tube

▸ To construct a second path, click PathXpres.

▸ For the first port of this new path, click the hole to the left of the first hole
selected on wall.psm.

▸ For the second port, click the bottom port on the valve body pvalve.par.
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▸ To accept this tube path, click Finish on the command bar.

▸ To place a tube using this path, click the Tube command.

▸ Select the path just created.

▸ In the name box, type the name tube002.
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▸ Click Preview.

Note

In the 3D window, it looks like the two tubes intersect each other. By
checking the window with the right view of the assembly, you can see that
the two tubes do not interfere with each other.

▸ Click Finish to complete the placement of the tube part.
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Create another new path and tube

▸ Click PathXpres.

▸ Select the far right port on pvalve.par as shown.

▸ Select the top port on the blue reg1.par as shown.
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▸ The resulting path should look like the following illustration.

▸ To see another path option, on the command bar, click the right blue arrow
once. Keep clicking the blue arrow until the path looks like the illustration
below. If you click too many times, use the left blue arrow to cycle back through
the options.

▸ Click Finish to accept this path.
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▸ To construct a tube part from this path, click the Tube command.

▸ Select the path just created, type tube003 for the tube part name, and click
Preview to view the part. The result should look like the following illustration.

▸ Click Finish.

mt01416-s-1040 Solid Edge assembly 17-35



Lesson 17 XpresRoute (tubing)

Create a new path, then move a segment to maintain a clearance

▸ The fourth path will be created in the middle of the assembly. Adjust the view
as shown.

▸ Click PathXpres and construct a tube path from the bottom right port of the
tank2.par to the rear port of the green reg1.par. Do not click finish.
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▸ Cycle through the tube path solution options to get a tube path as shown by
clicking the right blue arrow on the command bar.

▸ Click Finish.

▸ Zoom the area on the top portion of the tube path as shown.

▸ On the Home tab, in the Segments group, click the Move Segment command.
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▸ Hold down the left mouse button over the second segment in the path, and drag
the path segment to the right. Use additional windows to make sure you do not
cause an interference with the other parts in the assembly.

▸ Using this modified path, construct a tube part named tube004. Click the Tube
command, and select this path.

Note

Depending on the new segment position, the software may display a
warning dialog box stating that one of the segments has violated either
the minimum flat length or the bend radius as specified in the options
settings. This is not an error message but a notification that this tube
does not meet the requirements as specified in the Tube Options dialog
box. Take the time to study whether or not the tube path is still valid,
and modify the tube path accordingly. The tube part will not be placed
into the assembly if you click OK.

▸ If this warning is displayed, click OK to dismiss the dialog box.

▸ Click the Move Segment button.
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▸ Select the tall vertical segment, and drag it towards the rear of the assembly.
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▸ To force the tube part to reflect the new tube path, click the Tools tab and then in
the Links group, click Update Relationships. Notice that the tube recalculates
and now resides on the newly modified path.

▸ To construct and modify another tube path, click PathXpres.
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▸ For the first port, select the remaining bottom tube port on tank2.par.

▸ For the second port, select the bottom port on cylinder1.par.
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▸ Cycle through the path options until a path is found that resembles the path
as shown.

▸ Click Finish.
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Modify the tube path and add end treatments

▸ Click the Select tool.

▸ As shown, select the parallel relationship on the line segment.

▸ Press the Delete key to delete it.

▸ Click the Move Segment button.

▸ Select the endpoint of this line segment closest to the rear of the part, and drag
it to the left to make it longer.
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▸ Click the Tube button and construct a tube part named tube005 from this
modified path.

▸ Once tube005 has been placed, click the Select tool and select tube005.par.
Double-click tube005.par in PathFinder to edit the definition, and then edit the
tube by clicking the End Treatment step.

▸ Increase the extent of End 1 by typing 9.92 mm.

▸ Click End Treatment Options for end 1, and edit as shown in the illustration.
Then click OK on the End Treatment Options dialog box.

17-44 Solid Edge assembly mt01416-s-1040



XpresRoute (tubing)

▸ Click Preview, and then click Finish. The end of tube005 is shown.
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Use OrientXpres to manually route a tube path and place a tube

▸ On the Home tab, in the Segments group, click the Line Segment button. You
may see the Line Segment Tips box shown.

▸ As the starting point for the new path, select the middle port on pvalve.par.
Adjust the view angle to get a better view.
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▸ To lock this line segment to this axis, select the vertical axis on OrientXpres.

Note

To move the OrientXpres triad to another screen location, click and grab
the triad by the origin.

▸ Extend this vertical line 40 mm and then click.

▸ Click the axis as shown, and extend the line 40 mm toward the rear of the part
and then click.
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▸ Extend the next line segment the distance to the center of the hole in wall.par.
Do this by selecting the axis shown and then positioning the cursor over the hole
feature. When the center of the hole feature highlights, left-click. The line will
extend to that distance horizontally.

▸ Select the axis and extend the line down to the hole’s center as in the previous
step. Highlight the center, and accept this as the distance.
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▸ Select the axis shown in the illustration, and extend the line to the center of
the top port on green reg1.par.

▸ Select the axis as shown, and extend the line to the port center.

mt01416-s-1040 Solid Edge assembly 17-49



Lesson 17 XpresRoute (tubing)

▸ Select the axis as shown, and extend the line to the port center.

▸ To end the line segment command, right-click. The path is now complete.

▸ From this path, construct a tube part named tube006.
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Place a tube path manually

▸ To construct a second path manually, on the XpresRoute toolbar click the line
segment button.

▸ Select the remaining port on pvalve.par as the starting port. Lock the
OrientXpres into the vertical axis as shown.

▸ Extend this line segment by 50 mm and click.

▸ Lock the next line segment to the plane as shown (click the plane with the mouse
when it highlights), and extend the line 100 mm towards tank2.par. Use the
other views to determine a reasonable height for the line segment. Right-click
to restart the line command.

Note

Locking to the plane allows construction of an angled tube segment.
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▸ Start the next line segment at the end of the previous line segment. Lock the
next segment as shown, and extend it to one of the port centers on tank2.par.

▸ Extend the final line segment to the port center by locking the line to the vertical
axis.

▸ Right-click to exit the line segment command.

▸ From this tube path, construct a tube part named tube007.
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▸ On the Tools tab, in the Assistants group, click Bend Table.

▸ Click the Select All Tubes button and accept. All the tubes in the assembly
should highlight.

▸ The bend information for the highlight tube part displays in the right portion of
the dialog box. To view other tube part information, highlight the tube part file
on the left portion of the dialog box.

▸ Click Save. Solid Edge will construct .txt files for each tube part in the folder
specified in the Bend Table dialog box.

▸ Save and close this file. This completes the activity. However, if time permits, use
the remaining ports to practice constructing additional tubes in the assembly.
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Lesson review

Answer the following questions:

1. What is the difference between PathXpres and OrientXpres?

2. What defines a tube?

3. If a path segment is moved, does the tube change to reflect the new position
of the path segment?

4. After deleting a tube part, can the tube name be reused?

5. What information is contained in a bend table?
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Answers

1. What is the difference between PathXpres and OrientXpress?

PathXpres finds as many valid solutions for routing between two points. You can
view each solution and choose the one you desire.

OrientXpres allows you to route the path manually. Tools exist in path express
to lock the direction of the path segments to either planes or axes.

2. What defines a tube?

A tube is defined by a path which routes the tube, and a part file which contains
the geometry of the tube. The part file shows up as a part in the assembly
pathfinder.

3. If a path segment is moved, does the tube change to reflect the new position
of the path segment?

Paths are associatively linked to the tube part. Changes in the path cause the
tube to change. The Tools>update all relationships command will refresh the
tube geometry.

4. After deleting a tube part, can the tube name be reused?

A tube name can be assigned to another path if the tube part file is first deleted.
If not, when creating the new tube, a message showing the part file exists will
display.

5. What information is contained in a bend table?

The bend table contains the information needed to manufacture the tube.
Segment properties such as length, rotation, radius, and angle format is
contained in the bend table. Bend tables can also be formatted for X,Y, and
Z radius format.
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Lesson summary

In this lesson you learned how create tube paths both automatically and manually
using OrientXpres. Once created, the tube paths were edited and tubes placed on
the different paths. A bend table was created for the tube paths created.

• The XpresRoute provides the basic tools for creating tubes for fluid and air
transfer. Other tube part features can be modeled by in-place activating to the
part environment.

• XpresRoute provides editing, modification, and output tools for creating and
manufacturing these types of tube parts.

• PathXpres is an automated method of generating a 3D tube path between two
ports. Solid Edge calculates as many solutions as possible for connecting the two
ports, where the solution solves a maximum of five (5) segments.

• OrientXpres activates automatically when you click the line segment command.
This tool allows PathXpres to lock the line segment direction or planar
orientation along a specific vector regardless of the mouse position on the screen.
OrientXpres is activated by default, but its options are not active.

• The Tube command is used to construct a tube part file from a tube path. The
tube path must exist before the tube part can be constructed. When the tube
command is clicked, the command bar updates to show the options and steps
required for tube part creation.

• The Bend Table command is accessed on the Tools tab. Bend table allows the
extraction of tube information to an ASCII text file for use on the shop floor.
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